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Chapter 1. Overview

Chameleon ATX for Windows (including the Windows 3.1 and Windows 95 operating
systemsrombines an NFS client/server and a powerful set of network applications, all
built on top of TCP/IP for Microsoft Windows. Network drives appear and act as local
drives through the use of the NFS (Network File System) protocol.

Through the exclusive use of TCP/IP for all network communication, the user is
guaranteed transparent access to a wide variety of systems that support these same
protocols. Your Windows-based PCs can seamlessly integrate into existing network
environments, or expand small networks into large ones, without the painful changes
commonly associated with these transitions.

Most applications have both client and server capabilities. This permits building of
peer-to-peer networks of PCs without the use of a centralized workstation or mainframe.
This also eliminates the need for a proprietary protocol for PC-to-PC communication; it
also means that TCP/IP no longer needs to be used only to provide host access.

NetManage products are not adaptations of previous DOS products. Instead they are
unique applications that take full advantage of Windows-based systems.

Product Features

Chameleon ATX for Windows incorporates a number of features not normally found in
other networking products such as:
* NFS client and server

e Mounting and unmounting of network drives from within the Windows File
Manager

*  Multiple windows running multiple TCP/IP sessions

» Applications that include both client and server functions
* Implementation as Windows DLL (not a TSR)

* Use of a Windows point-and-click user interface

» Context-sensitive online help

e TCP and UDP protocol support

» Integrated serial dialing and gateway access

» Policy Management Architecture Enforcer lets you manage the amount of
bandwidth available to specific application traffic. For more information, refer to
the NetManage Configuration Guide.
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» Policy Management Architecture, a feature provided by some major router
manufacturers, can guarantee bandwidth to specified IP traffic. For more
information, refer to the NetManage Configuration Guide.

* NetWare IP, a feature offered by Novell to allow Windows clients to access Novell
servers using the Internet Protocol (IP). For more information, refer to the
NetManage Configuration Guide.

» Go IntraNet! feature, which lets you start many NetManage applications with
destinations from a single location.

e Tech Support Wizard, provides the means to automatically report problems and ask
guestions of the NetManage Technical Support Department. More information on
this feature and other support-related feature is provided in a later chapter of this

manual.

» Optional TCP/IP development kits

Chameleon ATX Applications

The Chameleon ATX product includes a wide variety of network applications.
Application icons, listed in the following table, are arranged by type.

Note: Not all the applications listed are available for the three operating systems. The
differences among applications for each operating system are noted in each
chapter for your information.

[

Tool Icon Description
NetManage TCP/IP
Custom oy Lets you set up and configure your TCP/IP client.
You can create LAN or dial-up interface profiles
Dialer = | Lets you establish dial-up connections to the
= Internet and modify interfaces
Host Access
Telnet I Lets you connect your PC with a UNIX or VMS
i host and many types of BBSes using Telnet or
asynchronous connections
TN3270 Emulates 3270 terminals for connecting to IBM
hosts
TN5250 Emulates 5250 terminals for connecting to IBM
hosts
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Tool

Icon

Description

PR3270 Printer

Note: Icon displays only in Windows 95 and
Windows 3.1.

E-Mail and Messagin

«

Z-Mail® Pro

B

Lets you send and receive electronic mail

— Emulates an IBM 3287 system printer and enables
@ you to print IBM S/370 and S/390 Sessions to
various printers. The 3270 Printer application
makes the printer appear to the host as if it werg¢ an
IBM system printer.
Session Managef g Lets you manage multiple terminal emulation
b & | sessions from within a single program
VBA Script ﬁ Lets you dynamically reconfigure the user
Editor 24y | interface, perform random access file operations,
Visual Script | automate tasks, modify current functionality, andl
Player i e handle incoming events with the Telnet and ASCII
_ ESEE | terminal, TN3270, TN5250, Z-Mail® Pro, and
VBA Script wias | FTP applications
Player 20
TS
File and Print
FTP Lets youconnect to FTP servers and transfer filejs
= to and from wide variety of remote computers
FTP Server % Letsother Internet users directly access files on
your PC
TFTP @ Lets you transfer one file at a time to and from
= remote host computers that do not support FTP
NFS Utilities Cé:j) Converts text files and displays file name mapping
between UNIX and Windows
LPR fg Lets files be printed remotely over the network
LPD f‘ﬁ
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Tool

Description

Z-Mail® Pro
Administration

Providesadditional functions for managing Z-
Mail® Pro

ver,

ms

Mail Alias Lets you expand a mail alias for a particular ser
Viewer which allows you to see the individual e-mail
addresses that are included in the aliases
Mailbox E,.L Converts messages stored in various mail syste
Converter [~7] | tothe Z-Mail® Pro message base
Outbox —_ Delivers sent messages as soon as the Outbox
? receives them. Includes all messages sent usin

Mail® Pro, Tag-It!, Phone Tag, Forum, and
NEWTCal

g Z-

Directory Server

e

Lets you keep a company-wide address book, of
any other address book, available for other user

Phone Tag

Provides a handy method of recording and seng
phone memos

ng

Rapid Search

Indexing Agent

Automatically tracks and finds all text indexed b
the Indexing Agent

Provides full text indexing for mail messages an
Web pages

Tag-It!

Provides a method of sending informal message
other people

s to

Group Collaboration

NEWTCal

Lets you schedule appointments in an online
calendar

Forum (formerly

Lets you subscribe to news groups on the Useng

:t’

NEWTNews) and to read and post articles
InPerson™ E}ﬂ Lets you have audio and video online working
ﬂ'@ sessions with people in other locations
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Tool

Description

Internet Access

WebSurfer

Lets you browse hypertext documents published
World Wide Web (WWW) servers

Personal Web

on

with or without sound

Lets you publish multimedia hypertext documents
Server on the WWW
WebSpider Lets you create and design documents over the
E | Wwww
NEWTNews &%, | Lets you subscribe to news groups on the Usenét,
(now called 2% | and to read and post articles. Also considered part
Forum) of Group Collaboration.
Archie™ '!-‘ Lets you view and retrieve public-domain files
= | from anonymous FTP hosts
Talk Lets you participate in real-time conversations with
: remote users
Acts as both a client and server, and responds 1o
remote talk requests with a pop-up dialog box and

Internet Relay

Lets Internet users chat with one another in rea

Chat (|RC) time

NEWTView Lets you display, copy, and print bit-mapped
graphics files produced by various applications

Gopher Lets you browse thousands of public Gopher
information servers

NEWTSound

Lets you play a sound file
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Tool Icon Description

TrueSpeech /gl | Third-party embedded application that lets you
bring real-time, streaming audio playback over the
Internet using WebSurfer

RealAudio ) | Third-party embedded application that lets you
bring live and on-demand audio to the desktop
over the Internet using WebSurfer

Internet Viewer | = Lets you view several different features of the

%I Internet from a single, integrated application,
including a News client, a Weather viewer, a Stock
guote service, and a Web browser

Whols '|_® Provides information about other network users
'l | including phone numbers and e-mail addresses

Desktop Management

NEWTToolbar Iﬁ Maintains a list of applications that you can start
without having to switch to another window

Virtual Desktop | [ | Lets you use a large virtual screen
Manager 0

Ping Checks your connection to a specified computer
Finger 5 Displays information about users on a specified
;%_L computer
Bind Provides name server functions as a simplified
Domain Name Server (DNS)
PC Net-Time [ | Lets you synchronize the time between your PC

##4+) | and any time server

Name Resolver ﬂ"—' Lets you easily retrieve the IP address of a known
=L=] | host or the hostname of an IP address
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Tool Icon Description

R-Commands Lets you enter and execute the rcp (remote copy)

and rsh (remote shell) UNIX commands in a
Windows environment

File & Disk Q g Creates an up-to-date local copy of files in a

Replicator specified directory of a remote host

Modem Server | S&% | |ets you use one of your PCs as a modem server
for other PCs on the same LAN

NISLookup Lets you display information retrieved from NIS
£ J including map entries, domain and server names

Look@Me Third-party embedded application and plug-in that
1| | lets you view another Look@Me user's screen
anywhere in real-time

Other Products

NetManage is committed to expanding network capabilities in line with existing
products, such as ChameleonNFS for Windows NT. We will maintain our high
standards for ease of use and integration with Windows.

Our current set of products includes:

e Chameleon: TCP/IP applications package for Windows

» ChameleonNFsS for Windows: TCP/IP applications package for Windows, including
NFS client and server for Windows.

» Chameleon for Windows 95: TCP/IP applications package for Windows 95

» ChameleonNFsS for Windows 95: TCP/IP applications package for Windows 95,
including NFS client and server

» Chameleon/X: Chameleon bundled with Xoftware

¢ ChameleonNFS/X: ChameleonNFS bundled with Xoftware

» Internet Chameleon: Internet dial-up access

«  NEWTWatch: SNMP-based desktop management

NEWT-SDK: Development kit for TCP/IP DLLs and ONC RPC/XDR

* NEWT IntraNet ActiveX: Development kit for ActiveX Controls

« JetMail Client and Server: Mail services applications for small businesses
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NetManage Intranet Server: Suite of server applications for Windows NT systems

ECCO Lite™, ECCO Professional™: Personal information management and
workgroup communications applications

NetManage IntraNet HostLink™ (formerly Swift™): Full-featured terminal
emulation solution for Windows PC users who need access to AS/400™ and IBM
mainframe systems

Xoftware for Windows 3.1, Windows NT, and Windows 95: X Windows System
display server for Windows products

Chameleon/X for Mac™ OS: Chameleon bundled with Xoftware for the Mac OS

ChameleonNFS/X for Mac™ OS: ChameleonNFS bundled with Xoftware for the
Mac OS

WinSock SDK for Mac™ OS: Developer kit using WinSock API for the Mac OS

Chameleon for Mac™ OS with PacerTerm: TCP/IP package applications package
for the Mac OS

We also have native-language versions of some of our products in:

Dutch
French
German
Japanese
Spanish

Using This Manual

There are now two manuals for the Chameleon ATX for Windows product:

The first manual, NetManage Configuration Guide, contains the configuration and
setup information for NEWT for Windows 3.1 and Windows 95. You do not need to
read the first manual if you are using the Microsoft TCP/IP stack instead of NEWT.
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The following table indicates how to use the NetManage Configuration Guide for
the different environments in which you can run NetManage products.

Environment Guide Reference

Windows NT Chapter 2. Then refer to the User’s
Guide for your NetManage product.

Windows 95 and using NEWT Chapters 1 through 9. Then refer to
the User’s Guide for your NetManage
product.

Windows 95 and using the Microsoft Chapter 2. Then refer to the User’s

TCP/IP stack Guide for your NetManage product.

Windows 3.1 and using NEWT Chapters 1 through 9 and Appendixes

A and B. Then refer to the User’s
Guide for your NetManage product.

Windows 3.1 and using the Microsoft Chapter 2. Then refer to the User’s
TCP/IP stack Guide for your NetManage product.

* The second manual, Chameleon ATX for Windows 95 and Windows 3.1 User's
Guide, contains information about each application included for all three Windows
operating systems.

To use these documents, you are assumed to be familiar with Microsoft Windows 95, or
Windows 3.1, DOS, and basic TCP/IP terminology. You will find troubleshooting
sections at the end of most chapters, which provide a simple way to quickly diagnose
any problems you may encounter. The Glossary at the end of the manual also defines
basic terminology.

Finding Help

Most applications include online documentation in the form of standard Windows help.
This is available at all times from within the application, and includes a glossary of
terms, limiting the need to refer to this documentation. The help files for all
applications are included within the \netmanag (for Windows 3.1) directory or
\netmanag.95 (for Windows 95) directory, and are named with the file extension *.hlp.
The Additional Online Information sections in this manual list many of the help topics
available for an application.

To access online help from any application, select Contents from the Help menu. You
can navigate through a variety of topics by choosing the buttons along the top of the
window, as well as by clicking on underlined text. Hypertext links are provided to
cross-reference information.
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Note that a context-sensitive help button is included within many dialog boxes. When
you choose the Help button, specific help information relating to that particular dialog
box is displayed.

You may obtain printed information by selecting Print Topic from the File menu; you
may also copy text using the Edit menu.

Some application help files contain hypertext links to other help files, called embedded
help files. Embedded help files are supporting help files that describe additional features
available in Chameleon ATX. These features often apply to more than one application,
S0 you can access these embedded help files from within more than one application help
file. If you access an embedded help file within an application help file and you want to
return to the original application help file, click the Back button on the toolbar the
number of screens you have read to return to that help file.

Starting Applications

How you start NEWT applications depends on whether your NetManage product is
installed in a Windows 3.1 or Windows 95 environment.

There is no need to quit a particular application to start another. Each application is
totally independent of the others. You may minimize an application to help conserve
screen space, if the desktop becomes too cluttered.

Starting Applications in Windows 3.1

To start an application in Windows 3.1, choose (double-click) the corresponding icon.
To start another copy of the same application, double-click the icon again. Some
applications may be opened multiple times.

Starting Applications in Windows 95
To start an application in Windows 95, do the following:

1. Choose the Start button to open the Start menu, then choose the Programs
command.

2. From the menu that appears, choose the program group that contains the
application you want to start.

3. From the menu that appears, choose the application you want to start.

10 Chameleon ATX User's Guide



Configuration Files

Every application uses a configuration file to maintain its settings. This file is
automatically loaded every time the application is started. Use the File menu to create a
new default configuration (New), save the current settings (Save or Save As...), open
another configuration file (Open...), or exit the application (Exit). If you quit an
application without explicitly saving changes, the application displays a dialog box
asking if changes should be saved.

Dialog Box Fields

A down arrow button next to a dialog box field indicates that additional predefined
selections are available for that value. Click on the button and a drop-down list box
appears, containing these selections. Some dialog box fields may also allow you to type
in an alternate selection.

Error checking is performed on values entered into dialog boxes. Invalid values will
result in a beep and display the insertion point at that field. Other dialog boxes may not
permit an action until all required fields have been supplied: for example, you cannot
send mail until you specify the destination address.

Fields in which IP addresses are entered have a red button to the left of the first field.
You can use this to clear the entire address entry.

Status Bar

All applications provide you the option of showing or hiding the application's status bar.
The status bar is displayed at the bottom of the application window, where it shows
messages and provides status and statistics about the current application.

Toolbar

The Toolbar menu item allows you to display or hide an application's toolbar. The
toolbar gives you quick mouse access to several of the application's common functions.
Smart Buttons

The option to display toolbar icons, including each icon's description, is available in all
applications.
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Changing Column Width and Order

In some applications you can change the width of each column or field. You can also
rearrange fields if you want to view them in a different order. To change the width of a
column:

1. Position the mouse pointer at the right side of the column border for the column you
want to resize.

2. Drag the column border to the desired size.
To move a column:

Select the column you want to move and drag it to its new position.

License Violation Detection

A license violation occurs when multiple copies of a single licensed copy of the product
are present on a network. Under the license agreement, each copy of the product is for a
single user only and must not be shared.

Chameleon ATX is not copy-protected and may be freely installed on any type of disk.
Although you can make as many copies of the product as you like, the software notifies
all illegal copies of a license violation.

Each copy of the software must have a unique serial number and key code. When the
software detects a duplicate serial number on the network, a message is displayed on all
duplicate serial numbered copies. This message interrupts all work in progress on the
computers involved.

Note: All network activity is disabled after the license violation has been detected. The
Chameleon ATX applications appear to run normally, but communication over
the network is disabled.

Customer Support

Before you use Chameleon ATX, complete the registration card enclosed and mail it to
NetManage. This will ensure that you will be provided with customer support. It will
also allow us to keep you up-to-date on new products as they are introduced.

See the chapter about the Tech Support Wizard for more information.

NetManage provides world-wide support for its customers. We can be reached at the
following:

12 Chameleon ATX User's Guide



West Coast
0 Sales Phone

O Sales Fax
O Support Phone
0 Support Fax

0 NetManage, Inc.
10725 De Anza Blvd.
Cupertino, CA 95014

East Coast
0O Sales Phone

O Support Phone
0 Fax

Internet
0 Sales
0 Support

Compuserve
BBS
International

Internet

France

O Phone
0 Fax
Germany
O Phone
0 Fax
Israel
O Phone

0 Fax
Japan
O Phone
0 Fax

(408) 973-7171
(408) 257-6405
(408) 973-8181
(408) 973-8272

USA

(603) 888-2800
(603) 888-3500
(603) 888-0304

sales@netmanage.com
support@netmanage.com

70640,1074
(408) 257-3794, 8-N-1

intl_sales@netmanage.com
intl_support@netmanage.com

+33-1-47720808
+33-1-42046599

+49-(0)8165-9470-0
+49-(0)8165-9470-147

+972-(0)4-8550234
+972-(0)4-8550122

+81-(0)332218400
+81-(0)332218484
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UK

O Phone
O Fax

+44-(0)1483-881800
+44-(0)1483-881818

14
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Chapter 2. Support Wizard

The Support Wizard provides the means to automatically report problems and ask
guestions of the NetManage Technical Support Department. It also lets you launch
WebSurfer to get additional online information. By using this function you will get
answers to many of your questions without calling Technical Support. The Support
Wizard makes it possible to collect files, screen shots and additional information
Technical Support engineers need to analyze your problem or to handle a request.
Please use the Support Wizard only after reviewing the online documentation and
Technical Support’'s Web resources.

You are welcome to submit any type of question using the Support Wizard. It can be a
feature request, a question about a particular problem or any other issues relating to the
NetManage product line.

Submitting a Request

You can submit a request by selecting the Support Wizard option in the Help menu. A
series of dialog screens will lead you through a step by step procedure for registering
yourself, reporting the problem, creating a log file (if applicable to the application), and
sending the data.

The following sections describe the procedure.

Understanding the Submittal Process

The Guide screen explains the Support Wizard and the submittal process. It also lists
important numbers and addresses for contacting NetManage. After you have read about
the process, choose the Next button to continue.

Registering

Complete the form on the User Information screen to register yourself. Your name and
e-mail address are required. If you do not enter data in a field you will receive a
message telling you what is missing. In this case, choose the OK button and enter the
missing information.

Chameleon ATX User's Guide 15



Telnet - User Information

Flease EnterY'our Personal Data

MName: [4ahn Smith

Company: [Triple A

Title: I

Email: Ijnhn@mplea o

Help <Back | Mext> | Cancel |

Field Description Required
Name Enter your name. Yes

Company Enter the name of the company you represent. If you areNp
private user, enter your name.

Title Enter your job title. No

e-malil Enter the e-mail address you would like Technical Suppor¥es
to use to contact you. In most cases, all contact will be by e-
mail.

Choose the Next button to continue to the next screen where you can enter additional,
optional user information

Describing the Request
Use the Problem Report screen to describe the problem.

Telnet - Problem Report

Prablem type ICDnnectiDn Problem LI
Example: | Can't connectas VT220 terminal

Flease Enter Description

| cannot connectto Telnetas a YT 320 Terminal]

Help <Back | Mext> | Cancel
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1. Select a problem category from the list in the Problem Type drop-down menu. If
one of the predefined options does not describe your problem, choose the Other
option.

2. Add a short explanation in the Description area. You must enter a description to
continue. Try to make it concise but clear, to enable the support team to understand
your request.

3. Choose the Next button to continue.

Capturing Data

The Snap and Log screen for capturing data is application dependent. You will only see
this screen if the application supports the submittal of log files and/or screen shots.
Applications that do not support log file submittal will display the Files to Send Screen.

To submit a log file and/or screen capture:
1. Select Run Diagnostic Session.
2. Choose the Next button to continue to the Log Screen.

If you do not need to submit a log file or screen shots even though the application
supports it:

1. Select Skip Diagnostic Session.

2. Choose the Next button to continue to the Files to Send Screen.

Sending a Log File

1. Select the Always on Top option to keep the log file on top. This will let you see
exactly what is being entered in the log file as the session progresses.

2. Choose the Start button. This will open a log file of your entire session and change
the Start button to a Pause button. If there are parts of your session you do not want
to record, such as your password, choose the Pause button. When recording pauses,
the button changes to Resume. No data is recorded in the log file until you choose
the Resume button.
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Note: If you want to open a log file but are already connected to a host, it is
recommended that you close the connection. Then restart the Support Wizard
and connect again. This will ensure that the log file includes only data relevant
to the specific problem.

Sending a Screen Shot

You can also submit a screen capture. The screen capture can be in addition to or
instead of a log file.

To send a screen shot:

1. Select the Screen Shot option on the Log Screen. A Snapshot Description screen
will appear. You must enter a short description of the screen you have captured or
you will not be able to continue. If you want to send the entire desktop, select the
All Screen option before choosing the Screen Shot button.

2. Choose the OK button to return to the Log Screen.

Selecting Files to Send

The Files To Send screen lists files related to the session. You can then decide which
files to send. These files are compressed and zipped into one file that is automatically
sent to NetManage. Your choices are:

» Add File. Choose this option to see the Add File Screen where you can select
an additional file you want to send, if it is not in the existing list. Choose the
OK button to continue. The next screen will help you send the data.

» Select All. Automatically selects all files in the list.
» Deselect All. Automatically deselects all files in the list.

Choose the OK button to continue.
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Sending Data

The final step in the submittal process is to send the data. Indicate the way you want to
send the data by selecting one of these options.

Send via the Internet

Select this option to automatically send your files to the Technical Support team.
Files are sent by e-mail or FTP depending on their size.

Choose the Send button. If Z-Mail® Pro is running, the Finish screen is displayed.
This screen notifies you that your request has been submitted to the Support
department. Choose the Finish button to return to the main application.

Note: Z-Mail® Pro must be running to enable the files to be sent. If you are not
logged into Z-Mail® Pro, the Z-Mail® Pro Login Screen will be displayed.
Enter your user name and password and choose the OK button. Z-Mail® Pro
will automatically be activated.

To enter an e-mail or FTP address other than the default:

» Choose the Advanced Button. This displays a screen requesting the alternate
address to which you want to send files. Enter the address.

* Choose the Use Default button to cancel the alternate address and return to the
How to Send Data screen.

* Choose the Use Alternate button to return to the How to Send Data screen with
the alternate addresses.

Save to Directory

This option lets you save your file to a specific directory and send it later from a
Internet connected computer, or by surface mail, if necessary.

Note: You may want to use this option if your computer is not connected to the
Internet, and you cannot send the files directly. You can save the files to a
directory, copy them to diskette and take them to a machine that is
connected.

« Enter the directory name or choose the Browse button to see a list of your
available directories. You will then receive a dialog stating the name of the
file.

* Use a MIME compatible Internet Mail application to send the file as a MIME
attachment. Do not send this data in uuencoded or any other format. For
information on how to send this file via the Internet, choose the Help button on
this screen.

Note: If you are using surface mail, please use the NetManage mailing address
closest to your location, and send it to the attention of Technical Support.
Refer to any NetManage manual for a listing of NetManage offices.
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» Choose the Save button to continue. The Finish screen is displayed. This
screen notifies you that the file was saved to disk, the file name and how to
submit it at a later date.

* Choose the Finish button to return to the main application.

Launching WebSurfer

In addition to submitting a request, the Technical Support function lets you launch
WebSurfer by selecting one of the following options in the Help menu to get more
information. Although these are separate options in the Help menu, they are also part of
the Support function. You should review the online material before contacting the
Support department.

Help Option Web Site Launched
About NetManage Takes you to the NetManage home page

(http://www.netmanage.com) where you
can learn more about the company and its
products.

Register With Us Takes you to the NetManage Product
Registration Web page. Fill in the form to
register and ensure that you will be
provided with the latest updates on new
products as they are introduced.

Technical Support Web Site Technical Support Web Site opens a drop-
down menu with Home Page and
Application FAQ options. Selecting Home
Application FAQ Page takes you to the Technical Support
Web page where you can obtain additional
technical information. Application FAQ
brings you to a Web page containing
answers to frequently asked questions.

Home Page

Online Manual Takes you to the NetManage Online
Manual Web page. You will see an index
of chapters that you can select from and
review online.
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Chapter 3. Go IntraNet!

Go IntraNet! is a feature that lets you easily start other NetManage applications. The
menu includes specific configuration data, allowing you to select sessions, destinations,
or programs.

This feature can be activated either as a menu in a NetManage application or by
selecting the Go IntraNet! icon on the NEWTToolbar. When a command is selected,
the appropriate application is started with the requested destination or from a list of
previously defined .CFG files, connection profiles, history lists and hotlists. You can
also use Go IntraNet! to copy selected text into Z-Mail® Pro and WebSurfer
applications. Go IntraNet! is simply a faster and more efficient way to perform these
operations.

Activating NetManage Applications

The following sections describe the procedures for using Go IntraNet! to activate
NetManage applications.

General Information

The first command of Go IntraNet! changes every time you open the menu. However, in
all cases, selecting this command displays general information about NetManage from a
local Web page which means you do not have be connected to the Internet to access this

page.
Shoot Selected Text As

Select the Shoot Select Text As command to copy selected text into Z-Mail® Pro and
WebSurfer applications. This command is displayed only if the application allows text
selection. NEWTToolbar allows copying selected text from any Windows application.
Copying information with this command in Go IntraNet! produces the same results you
would get if you copied from the Windows clipboard except you do not have to leave
your current application.

The Shoot Select Text As command lets you place selected text in the following
locations:

» address or body of Z-Mail® Pro message
* URL destination of WebSurfer
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Copying Selected Text Using NEWTToolbar

To use Go IntraNet! to copy selected text into the URL destination of WebSurfer, mail
address or mail text of Z-Mail® Pro using NEWTToolbar, do the following:

1. Select the text you want to copy from your current application.
2. Choose Go IntraNet! from NEWTToolbar.

3. Choose the WebSurfer URL command from the drop-down menu of the Shoot
Select Text As command. The WebSurfer main window appears with the selected
text in the URL destination.

OR: Choose the Mail Address option from the drop-down menu of the Shoot Select
Text As command A new mail message appears with the selected text in the
Address field.

OR: Choose the Mail Text option from the drop-down menu of the Shoot Select
Text As command A new mail message appears with the selected text in the body
of the mail message.

Copying Selected Text From an Application

To copy selected text into the URL destination of WebSurfer, mail address or mail text
of Z-Mail® Pro from an application, do the following:

1. Select the text you want to copy from your current application.
2. Choose the Go IntraNet! menu of the current window.

3. Choose the WebSurfer URL command from the drop-down menu of the Shoot
Select Text As command. The WebSurfer main window appears with the selected
text in the URL destination.

OR: Choose the Mail Address option from the drop-down menu of the Shoot Select
Text As command A new mail message appears with the selected text in the
Address field.

OR: Choose the Mail Text option from the drop-down menu of the Shoot Select
Text As command A new mail message appears with the selected text in the body
of the mail message.

Note: If you are not logged into Z-Mail® Pro, the Z-Mail® Pro Login Screen is
displayed. Enter your user name and password and choose the OK button. Z-
Mail® Pro is automatically activated.

FTP

To activate FTP select the FTP command. By default, you can activate the NetManage
FTP Server or an anonymous FTP. If you have created your own connection profiles,
they will also be listed.
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1. To activate an anonymous FTP, choose the FTP To command. You will be
prompted for the host name. Either type in the host name or select one from the
drop-down list. This list contains a history of the last 20 sites you have FTPed
through Go IntraNet!.

2. To activate the NetManage server or one of your connection profiles, select the
server name from the option list and the relevant FTP window is displayed. Fillin
the fields as you would in any FTP application.

Terminals

To activate one of the Host connectivity applications: Telnet, TN3270, TN5250, Rlogin,
or Asynch select the Terminals command. Go IntraNet! will prompt you for the host
name and display the Connection Dialog.

Telnet, Async, TN3270 and TN5250 display all the connection profiles and let you enter
a new host name. The history list contains the last 20 hosts entered. Rlogin displays all
the connection profiles defined.

WebSurfer

To activate a specific URL on the WebSurfer, select the WebSurfer command. To enter
a URL:

1. Choose the Goto URL option.

2. Enter the URL in the text box or select a URL from the drop-down list. This list
contains a history of the last 20 URLs entered.

Upon installation you will be able to select the NetManage home page or a list of default
URLs in addition to the Goto URL option. As you create folders with your favorite
URLs (hotlists), they will also be displayed hierarchically.

To go to a URL within a folder just choose the item.

Forum

To connect to an online news group and activate the Forum application, select the
Forum command. Type a newsgroup name in the dialog box or select a server from the
list provided. For every server you will see a list of subscribed news groups.
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To open a particular news group:
1. Choose the Open Newsgroup option from the drop-down menu.

2. Type the newsgroup in the text box or select a newsgroup from the drop-down list.
This list contains a history of the last 20 newsgroups entered.

Note: If you are not logged into Forum, the Forum Login dialog is displayed. Fill in
the required information and you will be logged in automatically.

Z-Mail® Pro

To activate Z-Mail® Pro or related applications from the E-Mail and Messaging group,
select the Z-Mail® Pro command. You can send Tag-it! or Phone Tag memos or start
Outbox.

To send mail:
1. Choose the Send Mail To command from the drop-down menu.

2. Enter any e-mail address or select an address from the drop-down list. If you are
not logged into Z-Mail® Pro, you will see the Z-Mail® Pro Login Screen. Enter
your user name and password and choose the OK button. Z-Mail® Pro will
automatically be activated.

To send mail to NetManage Sales or Support departments, choose the corresponding
option from the option list.

To retrieve mail, choose the Retrieve Now command.

InPerson

To activate InPerson, select the InPerson command. Choosing the Invite: option
prompts you for the name of the person you want to conference with and makes the
connection.

Choose Invite to see a list of predefined members in the phone book. Either choose a
name from the list or add any other name.

Talk

To activate Talk, select the Talk command. Choose Talk With: and you will be
prompted for the remote user name. Users with an existing conversation profile will also
be listed in the list box. For more information on the Talk address format, refer to the
Talk chapter in this manual.
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Gopher

To activate the Gopher application using settings in the gopher.cfg file, select the
Gopher command. You can then browse thousands of public Gopher information
servers.

Search

To search the Internet, select the Search command. This activates Archie, WWW or
Rapid Search. In the dialog box, enter the terms you want to search for. Otherwise,
select one of the terms from the drop-down list box. This list is a history of the last 20
terms you searched.

Servers

Select the Start Servers command to activate FTP Server, WWW Server, Directory
Server, or Modem Server.
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Chapter 4. Telnet and ASCII Terminal
Emulation

The Telnet and ASCII Terminal application is a terminal communications program that
allows you to connect your PC with a UNIX or VMS host compatet various types of
BBS (bulletin board servicglising the following connection types:

» Telnet TCP/IP protocol
* Rlogin
* Async communications protocol

Telnet and ASCII Terminal can be invoked in several ways as described in online help.
The typical connection is over an Ethernet or Token Ring LAN. The connection may
also be established using a modem on both the local PC and the remote host computer,
or an RS232-C cable can be used to connect the PC to the remote host computer.
(RS232-C is the physical-layer protocol standard used for asynchronous
communications.)

Note: An animated icon of a telephone indicates that a connection is established when
the Telnet and ASCII Terminal application is minimized.

The current preferences and host name can be saved to a configuration file (default is
TELNET.CFG). The configuration file is loaded when the Telnet and ASCII Terminal
application is started.

—=Fi Telnet - archie.rutgers.edu [AA) - e
File Edit Disconnect Script Session Settings Help

sunDs UNTH (dorm. Putgers. edu) (ttyun)

Login: I

*

Feady Y1100 NUM | 5, &

Supported Terminal Types

The Telnet and ASCII Terminal application allows you to emulate the following
terminal types: TTY, ANSI, ANSI-BBS, ANSI-SCO, AT386, VT52, VT100, VT220,
VT320, VT340, VT420, TVI950, TVI955, WYSES50, and WYSEG0.
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Starting Telnet and ASCII Terminal

As with all the terminal emulator applications, there are several methods for starting the
application. One way is to use the command line options. See online help for a list of
other methods.

Command Line Options

You can use command line options to automatically connect to a host when you invoke
Telnet and ASCII Terminal.

To do this for a Telnet Connect Type, select the Program Manager File/Run option
(Start/Run in Windows 95) and type:

Telnet.exe [<host>] [<port>] ] [options]

where <host> is the IP address or host name to which you want to be connected.
where <port> is the TCP/IP port you want to use for the connection (usually 23)

Some options are:

Option Meaning
-f <config> uses specified configuration file
-k <keyboard> uses specified keyboard file

-i opens the Telnet and ASCII Terminal application minimized (iconized)

-s <script> automatically executes the specified script file when starting Telnet and ASCII

Terminal

-c<description> connects to the host identified by the specified connection profile description.
Connection profile names that include a space character must be enclosed in dc

quotes (").
For example,
TELNET.EXE SUNNY 23 -F CA\NETMANAG\SUNNY.CFG -C TEST1

invokes Telnet and ASCII Terminal, connects to the host Sunny on port 23, specifies the
configuration file for this terminal session, and invokes the connection profile named
Testl.

A complete list of options is given in the online help.

28 Chameleon ATX User's Guide



Connecting to a Host

The connection details that you must specify for the Telnet and ASCII Terminal
application depend upon whether you are using the Telnet connection type, the Rlogin
Connection Type or the Async Connection Type. The Telnet and ASCII Terminal
Connect menu contains three tab dialogs allowing you to specify connection-type options
for Telnet, for Rlogin, and/or for Async.

If you have already defined one or more connection profiles, you may highlight and
select a connection profile from the list box. If additional details are required for the
connection, the appropriate connection type dialog (Telnet, Rlogin, or Async) will be
displayed automatically.

Session Menu

The Session Menu is displayed only after you make a connection to a host. The specific
Session Menu differs, depending on the selected connection type. See online help for
more information about Session Menu commands.

Telnet Connection Type

The Telnet connection type provides virtual terminal services for a wide variety of
remote systems over a TCP/IP network, using the Telnet protocol. You can use the
Telnet connection type to connect to any computer that is connected to the Internet. The
Telnet connection type operates over a TCP/IP stack as a full WinSock-compliant
application.

= Connection Dialog
Telnet | FRlogin | Asunc
Host: Boston |E|

Emulate: |VT32|] E' Port: ‘23 El

Connection Profile

Type |Mame hd

| 1] 4 | | Cancel | | Help ‘

Telnet connection settings are defined using the Settings/Preferences command
(Terminal, History and Printer sub-options). If you are not using a predefined
connection profile, you must add the following information to connect to a host:

Host: You must provide the application with a remote host name (or IP address) to
which you wish to connect.
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Note: You can specify a shortened version of the host name (such as "rainbow") if the
name is listed on the local domain name server or host table. Otherwise, you
must specify the IP address or the full Internet host name.

Emulate: The default terminal emulation type is VT320. You can select a different
emulation type from the scrolling list.

Port: Telnet's default port number is port 23. Connection to a specific port (other than
port 23) is provided for additional devices with terminal login capabilities (such as
network routing hubs). You may have multiple Telnet and ASCII Terminal sessions
active concurrently.

If you have already defined a connection profile for a Telnet connection type, its name
will be displayed in the list box.

NVT Mode

When you first connect to a host, before any Telnet negotiation takes place, the
connection is in NVT mode (line mode). In NVT mode, anything you type is echoed
locally to your screen and is sent to the host only when you type ENTER or RETURN.
This mode is indicated in the status bar, which displays "NVT" instead of the emulation
type selected.

For most hosts, Telnet negotiation procedures take place as soon as you are connected to
the host, at which point Telnet is automatically set to the emulation type selected. (You
will see the selected emulation type displayed in the status bar.) However, a few hosts

do not negotiate these options, in which case, the session remains in NVT mode. To
force the session into an emulation mode, you can deselect the Session Menu/NVT
command. To resume NVT mode, reselect the Session Menu/NVT command.
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Rlogin Connection Type

The Rlogin Connection Type establishes a remote login session from your terminal to
the remote machine (user directory), specified as host.

[= Connection Dialog

Telnet Rlogin | Async |

Huost: J cupt

Emulate: ]VT32D |_ij

Connection Profile

Tupe |Name 'Vf

Lok | [cancel] [ beb |

If you are not using a predefined Connection Profile, you must specify the following
information in the Rlogin Connect dialog box:

Host: Specify the remote host to which you wish to connect.
Username Specify both the local user name and the remote user ndoilwas:
* Local User Name This is the username that gives you permission to access the

remote machine or remote user directory.

The remote machine may have files named /etc/hosts.equiv and .rhosts, containing
a list of trusted host names with which it shares user names.

You may log in without entering a password—even if the name of your local
machine is not in the /etc/hosts.equiv database—if there is a line in the .rhosts file
in the home directory of the login on the remote machine with either of the
following:

» your local machine’s name (if the login name is the same as yours)
» your local machine’s name and your user name.

* Remote User NameThis is the name of the remote user on the host, who has
given your Local User Name permission to access that user's directory.

Asynchronous Connection Type

The Asynchronous (Async) connection type allows you to connect to a remote host using
the serial COM port of your PC. When you select the Async connection type, the
Connection dialog box does not contain a host field; rather, it contains a Dial field.
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= Connection Dialog

Telnet ‘ Rlogin Async

Emulate: [ANSI-BBS  [#] | More...

Connection Profile

Type |Name +*

| 0K | |Cancel| | Help |

Dial: Specify the number that you wish the modem to dial. You may leave this field
blank if you wish to connect directly to the COM port.

If you do not specify a phone number, the Async connection type connects to the COM
port by default. When you set up this type of connection, a blank screen is displayed.
You can then specify additional commands to connect and log in to a remote host, or to
communicate directly with the modem. When connecting to the COM port, you can
manually specify modem commands (such as the AT Command) or specify commands
relevant to any other equipment connected to that COM port (such as a remote host via
an RS232-C cable).

Emulate: You can use the default terminal emulation, ANSI-BBS, or select another
terminal emulation from the list. For example, when the ANSI-BBS emulation is
selected, the default terminal setting is 25 lines, the default font is NewtPC, and the
default background is black.

More: You can choose the More button to display the Asynchronous Communication
Settings dialog to define or modify your settings before you connect. Alternatively, you
can also define these settings in Settings/Preferences/Async menu option.

- Asynchronous Communications Settings

Communication Dialing

Port Baud Rate Timeout
comeliicee=
Flow Control Stop Bits Retries

|None |i| |1 |i| 3 @
Parity Data Bits Method
|None |i| |B |i| ® Tone
[ Parity Check [X Set DTR (| Pulse

[ Wait callback

Receive buf size:| 4 @K
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Using a Connection Profile

If you have already defined a Connection Profile that meets your current needs, you can
select the connection profile description (name) from the list box and choose the OK
button, or double-click the description name.

The list box contains two column headings, as follows:

» Type: Indicates whether the connection profile is for an Async, Telnet or Rlogin
connection type.

» Name Indicates the name specified for the connection profile description via the
Settings/Connection Profile... command.

You can control the order of the connection profile displays in either or both of the
following ways:

» Double-click on the Type or Name column heading to sort all connection profiles
according to that characteristic.

» Double-click on the arrow in the upper right corner of the list box to sort the
connection profiles in ascending or descending order.

Working in a Session

When a connection has been made and you have logged in to the remote host, your PC
performs all functions offered by an actual terminal connected to a host.

In addition to the terminal session features, you will also have access to other features
provided by using a PC with MS-Windows and Chameleon ATX installed, such as:

* Fonts

* Logfile

» Capture to file

e Cutand paste

» History buffer

* Clear and reset

+ Colors

» Recording scripts

For general information about fonts, colors, cut and paste, scripts, and the log file, see

online help. The following sections of this chapter describe the Capture to File, History
Buffer, Clear and Reset features.
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Capture to File

Using this function, you may store the whole session as it is displayed on the screen in a
text file (with the extension .cap) for later use (such as to review, edit, print, or insert the
file into an e-mail message or another text file).

To use this feature, you can either choose the Capture button or choose the File/Capture
to file menu command. You are then prompted to select Text Only or All data.

Text Only: Captures and stores only data displayed in the session window on a line-by-
line basis.

All data: Captures and stores all communications between the host and the terminal,
including both data and escape sequences.

When you have selected whether Text Only or All data are to be captured, you are
prompted with a Capture incoming data to file dialog box.
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In the Capture Incoming data to file dialog box, enter the file name to which data will be
captured and its location. You may choose to Append the contents of this session to an
already existing file by choosing the Append check box.

When the session is ended or you wish to stop the capture, you can either choose the
Capture button or choose the File/Capture to File command.

You are then prompted with a Stop Capture YES/NO dialog box.

L:. il e “
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After you have completed capturing the data to a file, you may use the file as you would
use any plain ASCII text file.

Copy and Paste

The Edit menu provides Copy and Paste functions. The Edit/Select all menu option
allows you to choose which part of the terminal session is to be selected, as follows:
» All of the currently displayed data (the current terminal session)

*  Only the history buffer data

» Both the current terminal session and the history buffer

File @Il Connect Settings Scri|

& =)

Select all

Options...

Clear History

Note: You can also select a portion of the terminal session and/or the history buffer. To
do that, drag the mouse pointer to select any part of the data on the screen.

For information on copy and paste options, see online help.

History Buffer

The history serves as a continuation of the terminal page. When a history buffer exists,
the top portion of the window displays the history buffer and the bottom portion of the
window displays the current terminal page.

When you have reached the terminal page size limit, a vertical scroll bar appears and
you may scroll both the history and terminal page windows. If you change the window
to a size that does not match the terminal page size, a scroll bar will appear as soon as
the terminal window limit is reached.

The history buffer provides virtual storage of the terminal session. Data from the
terminal session is stored in the history buffer when the terminal page limit has been
reached.

For example, assume that the terminal page is set to 24 lines (page size). When the 25th
line of the terminal session is echoed from the host, the first line of data from the

terminal session moves to the history buffer. The original first line of the terminal

session will become the first line of the history buffer. The second line of the terminal
session will move to the history buffer as soon as the 26th line is echoed from the host,
and so on.
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This means that the information from the terminal session is not lost when the terminal
page limit is reached. Instead the data moves to the history buffer on a "first-in, first-
out" basis.

History Settings: You set the size of the history buffer by choosing the Preferences
command from the Settings menu and then choosingigtery... command from the
menu that appears.

The history buffer limit can be set to a specific number of kilobytes (1 KB of buffer
contains approximately 8 lines of history) or to the Maximum option. The maximum
size of the history is 4000 KB (which is approximately equivalent to 32000 lines). The
minimum history buffer size is 0 KB. Select 0 KB if you prefer to work without a

history buffer. You can select which directory will serve as the history virtual buffer.
When selecting the size of the history and choosing the directory, check to be sure that
there is enough free disk space.

= History Settings
Histoy buffer size limit
Kiyte:  [I0 [ [ Maxinum
-Eam:el

Directory for virtual buffer:

Directory: |[C:AWINDOWSATEMPA

[ Separate history scrolling

Separate history scrolling With this option, the terminal session window and the
history window are separated from each other by a split bar. Each window has its own
vertical scroll bar, allowing you to scroll each window separately.

When the Separate history scrolling option is not selected, the terminal session window
and the history window share a common vertical scroll bar that allows you to scroll them
as a single window.

Choose the mode that is more convenient for you.

Copying or Capturing the History: The history content is not flushed when you end

the session. All information stored in the history virtual buffer may be copied to a
permanent ASCII file using the copy and paste commands. If you specify the Capture to
file function before the session begins, you can capture the history buffer data to a file
during the session.
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Clear and Reset

The Telnet and ASCII Terminal application provides the following options for clearing
data:

Clear Terminal Page Clears the current terminal page and puts the cursor in the home
position at the beginning of the terminal page window. The lines cleared from the
terminal page are copied to the history buffer to avoid any loss of data.

Reset Terminat In addition to clearing the terminal page, this option resets all
terminal settings to their original settings when you started the connection. Some
applications change the value of these settings during the session. Use this option to
clear the buffer and to reset the terminal to its initial state.

Clear History: Prompts you with a YES/NO dialog box to clear the history buffer. You
can use this option to begin a new session with a clean history buffer.

The Settings/Preferences menu option displays a pop-up menu that lets you select
terminal preferences for Telnet and Asynchronous connection types, and Async
communications settings for an Async Connection.

Using the Settings Menu

The Settings menu allows you to specify a variety of options, including various terminal
preferences, mapping your keyboard, and more. These settings are saved to a Telnet
configuration file, if you select the option for saving your configuration file. Refer to
Telnet online help for detailed information about using the Settings menu.

Logging a Session

The Settings menu includes the Log command, which allows you to debug programs,
report problems, and record demos. See online help for a list of steps in logging a
session.

Mapping Your Keyboard

Choose the Keyboard... command from the Settings menu remap and view your
keyboard. The PC keyboard displayed in the Keyboard Remap window is based on the
keyboard setting specified in the International dialog of the Windows Control Panel.

For methods of mapping keys, see online help.
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Terminal Preferences

Terminal preferences for Telnet and Asynchronous sessions include the following:

Emulation type

Keys
CR -> CR/LF

National character replacement

Scroll mode
Page size

Miscellaneous
Host Status Line

Cursor

Answerback Message

Terminal Preferences m

Emulation Type

Page Size
Calumns: ¢ 80 132
Bows: 24 hd

National Character Set(7hit)
[ NRCReplacement

Answerback Message

CR-» CR/LF
I™ Inbound

™ Outbound
Cursor

& Block

" Vertical Line
[~ Dim

Scroll Mode

" Smooth & Jump

Top Host Statusline
Hidden h

Baottom Host StatusLine

Hidden h
OK

Cancel |

Build...

Miscellaneous

I Local Echa

W Sound

I™ Exit On Disconnect
W Auto rap

Help ‘

Emulation Type: Specify the emulation type to be used as a default setting when a
connection is made without using a connection profile. This default emulation will
appear as the selected emulation type when you choose the Connect button or the

Connect command.

Keys: Allows you to select the function of some commonly used keys.
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» BACKSPACE may be set to either BACKSPACE or DELETE.
» Keypad mode may be set to either Numeric or Application-dependent

e Cursor may be displayed either as Normal (programmed by NetManage) or
Application-dependent.

CR -> CR/LF: The UNIX operating system usually ends each line of a text file with a
carriage return (CR), whereas DOS usually ends each line of a text file with a carriage
return / line feed (CR/LF). Thigption specifies how the end of lines are to be treated
when data is transferred between a host (which uses UNIX) and a terminal (which uses
DOS):

* Select Inbound to convert each CR to CR/LF when data is transferred from the host
to the terminal.

¢ Select Outbound to convert each CR to CR/LF at the end of a line when data is
being transferred from the terminal to the host.

National Character Set (7 bit} Telnet and ASCII Terminal application supports 8-bit
character sets. Some computers or applications have only 7-bit character sets. If you
would like to copy and use the National Character Set's special characters on a 7-bit
system, select the NRC replacement check box option.

For example, you may wish to use the UK pound sign on a system that does not support
the 8-bit character set. The UK pound sign is not included with the standard 7-bit
character set. Use the NRC replacement option to copy it onto the 7-bit character set as a
replacement for a character that you do not use.

Scroll Mode: Set whether the cursor movements will be Smooth or Jump. Jump mode
uses less resources, so that sessions in Jump mode will be displayed faster than sessions
using Smooth mode.

Page SizeSpecifies how the display will appear when a connection is made. You may
specify 132 columns (if this format is requested by the application running on the host),
or you can use the default 80 columns page. You may also define the number of rows per
terminal page. This parameter also sets the buffer size (as discussed previously in the
"History Buffer" section of this chapter).

Miscellaneous Terminal SettingsThis section of the Terminal Preferences dialog box
includes the following settings:

Local Echa: Any key entered in a terminal session is passed to the remote host, and the
host's response is echoed onto the terminal display. Thus, the character that you type is
not the one you see immediately reflected on the PC display: what you see is the remote
host echo to your typing. If you wish to see both the terminal and the remote host
responses to your entry, use the Local Echo option.
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You may toggle on/off the following additional settings within the Miscellaneous section

of the dialog box:

* Sound

« Exit on Disconnect

» Black Background (option is available only when ANSI-BBS is the selected
emulation type)

Cursor. Set the cursor shape to one of the following options:

* Block
* Vertical Line
e Dim

Answerback MessageSpecifies a sequence of characters that are sent to the host when
AE (Control E) char is received. You can choose the Build button to create a sequence of
characters which has the same attribute as a keyboard macro, that is, it may contain
<ESCAPE>, <ENTER>, \xHH, and so forth.

Host Status Line: Support the status line commands of certain terminal emulation
types. The status lines can be set to the following values:

+ Hidden: This is the default value.

» Always Visible: If supported by the selected terminal type, this value indicates that
the status line should be displayed just after the connection and remain displayed
until the session is disconnected.

* Host Initiated: This value allows the status line to be hidden or displayed by
commands sent from the host.

Asynchronous Communications Settings

You can use the Settings/Preferences Async menu suboption to specify the
communications settings for an Async connection type.

The Asynchronous Communications Settings dialog box has two main portions:
Communications Parameters and Dialing Parameters. It also has buttons on the side that
provide access to additional options.

Communications Parameters

Communications parameters specify how the COM port is used for data transfer. The
application can automatically select the appropiat@munications parameters for

your system. This is the recommended method. To enable this automatic configuration,
choose the Detect button.
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= Asynchronous Communications Settings

Communication Dialing
Port Baud Rate Timeout
[Cow— I i e
Flow Control Stop Bits Retiies
None  [2] 1 EREE
Parity Data Bits Method
None 8 @® Tone
" Parity Check [X Set DTR O Pulse
[T Wait callback

Receive buf size:|4 K

Note: The Detect option finds and automatically inserts the appropriate value for port,
baud rate, flow control, stop bits, parity, and data bits..

Port: Select the default COM port to be used for the async session. This is the
physical port to which either the modem or a RS232-C cable is connected.

Baud Rate Select the baud rate of your local modem or the baud rate of the remote
modem. The range is 300-115200 bits per second (BPS).

Flow Control: Select the way flow control is handled between the sending and
receiving devices. The Flow Control options are None, CTS/RTS and XON/XOFF.

« None Select this option if the remote system uses no overflow method.

 CTS/RTS (clear to send / request to send). Using CTS/RTS flow control, the
sending device activates the RTS signal when it is ready to send data. When the
receiving device is ready to receive data, it activates the CTS signal. The receiving
device actively controls the receipt of data, thereby preventing an overrun.

*  XON/XOFF. XON/XOFF causes your system to pause when the buffer fills. When
a fast device is connected to a slower device, the data may be sent to the slower
device faster than it can be processed. Even though devices often use buffers,
sometimes the slower device cannot keep up with the rate of receipt. XON/XOFF
flow control may be used to prevent the faster device from overflowing the slower
device’s buffer and causing data loss. Select XON/XOFF if you don't know what
flow control method is used.

In data communications environments, one device sends a message to another
device to establish a communications channel. The two devices then send messages
back and forth that enable them to agree on data flow speed. (The Detect option
finds and inserts the appropriate value automatically.)

Stop Bits, Parity, and Data Bits These settings have to be identical on both ends of the
communications. Check with the remote end so that you can match these settings to
have a usable session between your two modems.

Set DTR: Set DTR (data terminal ready) if you wish the terminal to indicate that it
is powered up and ready to send and receive data.
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Wait Call Back: If you are connecting to a host that provides a call-back service (dials
back to your PC), you can use this option. When this option is selected, the Telnet and
ASCII Terminal application dials to the host, then disconnects and waits for the host to
call back.

Rx buf size You can specify the size of the receive buffer used for the Async
Communications. You may experience loss of data if the program does not
process data received from the other device fast enough. The larger the receive
buffer, the less data you may lose.

Dialing Parameters

These parameters specify the way the local modem dials to the modem of the remote
host. Specify one of the following values, or use the default values:

Timeout. Specify the length of time in milliseconds (ms) for a timeout in case the
remote end does not respond. The default is 60 ms.

Retries. Set number of retries in case a timeout occurs. The default is 3 retries.

Method. Specify Tone or Pulse to indicate which method is being used for dialing.
The default is Tone.

Modem

The modem button lets you select a modem type to be used for your async connection. If
you want the Telnet and ASCII Terminal application to Dial, you must first select a
modem type and then type the number to be dialed in the Connect menu (or include it in
a Connection Profile)

1. Select your modem model (or the most compatible one) from the scrolling list box.

2. Choose the Install button to have it installed.

Note: If you are familiar with configuring modems, you can continue to specify the
details of the modem configuration when the appropriate modem name is
displayed in the Modem Installed field. To specify a detailed modem
configuration, choose the Setup button.

Do not change the specific settings unless you are familiar with the
technical issues of setting modem parameters: consult your modem user’s
guide for the correct settings. Otherwise, simply leave the default settings.
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The default settings will work for most configurations. Incorrect settings
of the modem may cause it to miscarry the connection or to be reinitialized.

Note: NetManage supplied strings in the Modem Settings dialog are as follows:

"M (CTRL+M): ASCII#13, ENTER
~ ( Tilde): time delay, each '~'is a one second delay

= Modem Settings

Modem Hame: “
[2400 baud Hayes compatible
ancel

Settings
Modem [nit:
[FM-ATXAEDVT ™|
Dial Prefix: Dial Suffix Binary TX: Max Speed:
[aTDT [*m [ 2400 [2]

Answer Setup:  Hang Command:  Binary RX:
["M-ATS0=1~ [+ss~—ATH® |

Detect

The Serial Port Diagnostic pop-up box is displayed when you choose the Detect button
in the Asynchronous Communications Parameters dialog box. Use this option to
properly configure and confirm the connection for the asynchronous connect type.

Note: Ensure that your modem is plugged in and powered on before using this option.

When you choose the Detect option, the application automatically detects the
communications parameters in your PC and inserts the appropriate values (for COM
port, baud rate, and so forth) in the Asynchronous Communications Settings dialog box.

You can also use the Detect option to confirm or diagnose the status of the serial ports.

Connection Profile

Defining a connection profile is the most efficient way to establish a connection. The
Connection Profile dialog box lets you specify all the necessary information for
connecting to a remote host. Telnet sessions and asynchronous sessions use different
connection profiles, because they differ from one another in some of their connection
parameters.
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Telnet Connection Profile

The Telnet Connection Profile dialog contains the following fields:

Connection Profile
Field

Description

Host

Emulate

Port

Reply As

Telnet | FRilogin | Aspnc
Description m Add
Host: [nummy ]| [[Modity
Emise:  [orim e[
Reply As: [vT420 New
Login Prompt: |Iogin: lcon
Uszername: |yoav Help
Pwd Prompt: |passw0ld:

Pwd: | xxxxxxx

Login Script:  [|ogin.scr

Logout Seript: [logout. scr

Connection Profile

Type |Name L 4
Telnet Unix host

Telnet Unix host-vt220

Meaning

Name of the connection that appears in the list box in the
Connect dialog box. Must be specified.

Name or IP address of the remote host to which you wish to
connect. Must be specified.

Desired emulation type. Choose from the scrolling list box.
The default terminal type is VT320.

The default port is 23, the Telnet communications port.
This port is appropriate for most configurations. You can
specify an alternate port if so desired.

Some Telnet hosts require that the terminal identify itself
differently than the standard Telnet name (for example,
DEC-VTL1 instead of the usual VT100). If your host needs
such identification, input the appropriate emulator type into
this field. You may type any character string into this field.
The default reply is the same as the emulator type.
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Connection Profile

Field Meaning

Login Prompt The login prompt that you would see on your screen. Should
be used if automatic login is desired. Case sensitive.
Optional.

Username The user name that you use to login. Should be used if

automatic login is desired. Optional.

Pwd Prompt The host password prompt that you would see on your
screen. Should be used if automatic login includes
password. Case sensitive. Optional.

Password The password that you normally enter after you have
entered your username. Component of automatic login with
password. Optional.

Icon You can save the current Connect Profile description as an
icon. The icon will be displayed in a window group on your
desktop, consisting of customized Chameleon ATX
Terminal Emulations. By selecting this icon, you can
connect from your desktop to a terminal emulation session
using the options specified for this Connection Profile.

Login Script You can type or browse to select the name of a script file
that automatically logs into the host when you connect to a
host by using this profile. Optional.

Logout Script You can type or browse to select the name of an existing
script file that automatically logs out of the host specified by
this profile when you close the application. Optional.

Connection profile list The list box contains the connection profiles that you have
already defined.

Note: If you want to include the Login Prompt and the Password Prompt as part of your
Connection Profile, you should connect and log in to the host and write down the
prompts that are displayed for username and password. The specified text string
must match the prompts (or a portion of the prompts) as they are displayed.

Itelnet Security Connection Profile

Itelnet is a specific type of Telnet connection. It is a security mechanism provided by
Sun for the Sun/OS platform and allows users to gain access through a security gateway
to other corporate internal users or out to the Internet.
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For an Itelnet connection, you need to fill out your Connection Profile dialog box as
follows:

Connection Profile

Field Field Entry

Description: Itelnet

Host Name: Name or IP address of the host to which you are connecting.
Port: Must be 4514

Emulated Terminal: Name of the terminal you want to emulate.

Note: Fill out the remaining fields just as you would for any other connection profile.

Rlogin Connection Profile

The Rlogin Connection Profile dialog contains the following fields:

[ ConnectionProfilc |
Telnet Rlogin |  Asnc
Description:  [Rlogin to My Unix
Host: [rommy.notmanage com  [3]| (i ]
Emulate: V320 [&] Pot:[513 [ [(eice ]
User Name
i
ot [

Login Script: |
Logout Script:

Connection Profile

Type |Name L 4
Telnet Unix host
Telnet Unix host-vt220
Connection Profile
Field Meaning
Description: Name of the connection that appears on the List field in the

Connect option dialog box. Must be specified.

Host Name: Name or IP address of the host to which you are connecting.
Must be specified.
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Connection Profile
Field

Port:

Emulated Terminal:

Local Username

Remote Username

Icon

Login Script

Logout Script

Connection profile list

Meaning

The default (513) Telnet communications port.

Name of the terminal you want to emulate. The default is
VT320.

Specify the username that gives you permission to access the
remote machine or remote user directory.

The remote machine may have files named /etc/hosts.equiv
and .rhosts containing a list of trusted host names with which
it shares user names. Users with the same user name on both
the local and remote machine may rlogin from the machines
listed in the remote machine’s /etc/hosts.equiv file or .rhosts
file without supplying a password.

Specify the name of the remote user on the host, who has
given your Local User Name permission to access that user’s
directory.

You can save the current Connect Profile description as an
icon. The icon will be displayed in a window group on your
desktop, consisting of customized Chameleon ATX Terminal
Emulations. By selecting this icon, you can connect from your
desktop to a terminal emulation session using the options
specified for this Connection Profile.

You can type or browse to select the name of a script file that
automatically logs into the host when you connect to a host by
using this profile. Optional.

You can type or browse to select the name of an existing script
file that automatically logs out of the host specified by this
profile when you close the application. Optional.

This list contains the connection profiles that you have
defined.
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Asynchronous Connection Profile

The Asynchronous Connection Profile dialog contains the following fields:

Telnet | FRilogin Async

Description:  [My favorite BBS

Dial #: 9.04-1234567 E
Emulate: |aNS1-BBS  [#] [ More .

Login Prompt: | userid:

Username: | guest

Bl e

Help

Pwd Prompt: | password:

Pwd: | xxxxxx

Lagin Script: | atlogin.scr
Logout Script: atlogoff. scr

Connection Profile

«

Type |Mame

Telnet Unix host
Telnet Unix host-vt220

The Asynchronous Connection Profile dialog box contains the following fields specific
to asynchronous connection types. (See the descriptions of the Telnet Connection
Profile fields for information on the fields that are the same.)

Connection Profile
Field

Dial

More

Meaning

Type in the number you wish the modem to dial to when
utilizing this connection profile. If you do not specify a
telephone number, the async connection type connects to the
COM port by default. When connecting to the COM port, you
can manually type in modem commands (such as the AT
command) or commands that are relevant to any other
equipment connected to that COM port (such as, a remote host
via a RS232-C cable).

Choose this button to specifgramunication settings to be
associated with the current connection profile. See the section
"Asynchronous Communication Settings" for detailed
information on these settings.
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File Transfer

When a connection has been made, you can transfer files using any of the following
telecommunication protocols:

. ASCII

. CIS B+

«  KERMIT (default)
- XMODEM

+  XMODEM-1K
*  YMODEM/Batch
« ZMODEM

Files may be transferred as binary (text and control codes) or ASCII (text only).

To transfer files between computers, both computers must use the same file-transfer
protocols. The file-transfer protocols are responsible for error detection and ensuring
that extraneous data is not stored in the transferred files.

The choice of a file-transfer protocol depends on your configuration. Before transferring
files, verify that the file-transfer protocol on the local computer is the same as the file-
transfer protocol being used by the remote host. You may also set a default file-transfer
configuration using the Settings/File Transfer menu command.

File Transfer can be used for sending files (File/Send File) or receiving files
(File/Receive File).

= Send File

Ascl €IS B+ | Kemit | Mmodem |Mmodemik | Ymodem | Zmodem
Send File
= Cancel
[~ Send full path name [~ SendFile Info
File Mame: -Halp

Browss

Options
™ Besume Dawnload [ Check Method
Macro Build
[% Use Host Initisted File Transfer

The transfer steps are similar for sending and receiving files:
1. Select the file-transfer protocol.
2. Input the necessary information in the protocol-specific dialog box that appears.

3. Type or select the file name and its directory.
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& Feceivefile |
oo | CSBe | Kemit | ¥modem |XmodemK | Ymodem  Zmodem
Receive File
[ Receive full path name
M
| Erowse
Cptions
[~ Resume internpted tansfer
Macro | Build
[ Use Host Initiated File Transfer

Note: The Drag and Drop feature can also be used to automatically send files from
your PC to the host. Before using this feature, it is recommended that you fill in
the Macro field in the Send File dialog box. Refer to Telnet online help for
detailed information about the Drag and Drop feature.

Printing with Telnet and ASCII Terminal

There are several ways to print using the Telnet and ASCII Terminal application. You
must set up the printer (whether it is an attached or network printer) in the Windows
Control Panel. As with any other Windows application, you may select to print to any
installed printer.

Printer Settings

Printer settings may be defined in the Settings/Preferences/Printer menu option.

Printer Settings
Frinter Control Mode oK
[ Do naot Translate Printer Codes

| ok |
Cancel
Add Form Feed

Hel
& None © Before © After © Both =F

Delay Printer Cloze

[v Usze Dielay Printer Cloze

For E Sec [ Unlimited

Page Size

Mumber of ines in page E

Printer Control Mode : All print commands and data are communicated from the

remote host to the printer via the Telnet and ASCII Terminal application. Sometimes

the application running on the remote host may send escape sequences (such as, skip to
a new page, switch to a different font, and so forth) directly to the printer. This is
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sometimes referred to as a printer "passthru” state. If you wish to use this mode, select
the option "Do not translate printer codes" before sending print jobs to the printer.

Add Form Feed You may select whether each print job should be separated from the
next by adding a blank page before the job, after the job, or both before and after.
Alternatively, you may disable this option by selecting None. There are some devices
that require a Form Feed at the end of the print job to enable a printout. In such cases,
select the After option.

Delay Printer Close You can use this option to allow a specific or unlimited time delay
for the printer to complete its job before the host issues a CLOSE command. This option
can be used to prevent extraneous form feeds from occurring when using host printer
Controlled Mode

Some hosts send a single print job as multiple sequences of lines. Each sequence of
lines is followed by a Stop Mode command, causing a brief pause. When the stop
interval expires (timeout), the printing resumes with the next sequence. If you enable
the Delay Printer Close command for the specified timeout, the printing will resume on
the same page. Otherwise, the next sequence of lines will be treated as a separate print
job.

Page Sizelf the Use Courier Font option is selected, you may also specify the number
of lines that will be printed on each page. The default number of lines per page is 66.
You can specify from 1 through 200 lines per page. If you specify a number of lines that
is out of range, the default value of 66 lines is used instead. If you do not select the Use
Courier Font option, you cannot specify the number of lines in a page (the option is
disabled), and the printer uses the default printer font. To print special characters as
line drawings or international characters, you must select Courier Font.

Print Mode

Use the File/Print menu option to select the Print Mode. The Telnet and ASCII
Terminal application supports three print modes: Screen, Auto, and Control.

Screen Mode In Screen mode, you may print all or a selected part of the data currently
displayed on the session screen. This option is also available by choosing the screen
button from the toolbar.

The range options for Screen Mode are as follows:

» All: prints the number of lines specified as the buffer size. This may include blank
lines if the buffer size is larger than the number of lines that has been used.
» Selection printsonly a selected number or block of lines.

» Terminal Page prints only any actual data in the terminal page.
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Auto Mode: In Auto Mode, incoming data is echoed to both the printer and the terminal
display. The data is kept in the printer buffer until this mode is disabled, at which time
it is printed.

Control Mode: In Control Mode, all incoming data is directed to the printer. Nothing is
displayed on the terminal while this mode is enabled.

Additional Online Information

The online help file for Telnet and ASCII Terminal includes a description of each menu
command, plus further information in the "How to Use" section:

e Command Line Options

e Setting up Telnet and ASCII Terminal

» Defining Key Mapping

» Defining a Button Pad

e Using Scripts

*  Printing with Telnet and ASCII Terminal

* Transferring Files

» Dragging and Dropping Files from PC to Host
» Setting Colors

Troubleshooting

If you experience difficulties using the Telnet and ASCII Terminal application, refer to
the following items:

0 Use the Diagnose Connection command in the Help menu to make sure that the
connection is operational. (If your last connection was a Telnet connection type,
this option invokes the Ping application. If your last connection was the async
connection type, this option invokes the Detect function.)

O If the window display appears incorrect, verify that emulation was specified
correctly.

0 Disconnect and change the history setting in the Preferences dialog box to scroll
further back.

0 Select Reset Size from the Settings menu if full-screen applications appear to not fit
correctly within the terminal session window.

O Check to see that the appropriate font and size is installed if graphic characters
appear incorrectly.

0 Check to see that the appropriate font and size is installed, or scroll horizontally, if
132-column mode does not fit within the terminal session window.
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Tips for Telnet Connections

0 Make sure that the remote system provides a Telnet server.

O Ensure that the port is specified correctly; it should be the default (23) in almost all
cases.

Tips for Asynchronous Connections

0 You can use the Diagnose Connection Option under the Help menu or the Detect
option in the Asynchronous Communications dialog box (under
Settings/Preferences/Async) to check your Async connection.

O Check to see that the modem is connected..

0 Check to see if the line is available. If there is only one available phone line and
someone is talking on it, you will not be able to connect to the host.

0 Check to see that you are using the correct COM port (the one to which the modem
is connected).

O Check to see that the modem was reset.

0 Check to see that the communications parameters on the local end match the
communications parameters on the remote end.
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Chapter 5. TN3270 Terminal
Emulation

TN3270 is a terminal emulation communication program for IBM mainframe systems.
This application offers 3270 protocol support for IBM hosts with IBM's TCP/IP via
supported TCP/IP attachment devices.

Note: Support for other Connection types is available with the NetManage HostLink
product.

TN3270 D ﬁ

TCP/IP

IBM Host

Protocol: Telnet mﬂ[ﬂﬂ-ﬂm
=

Port 23

. Gateway to the Internet
!

TN3270

Features

The TN3270 application includes the following features:

* TN3270 emulates any IBM 3278 or 3279 terminal (models 2, 3, 4, or 5 with full
SAA compatibility and RFC 1041).

e The TN3270E standard is now supported according to RFC1647. You can print
TN3270 sessions to the IBM 3287 printer using the 3270 Printer application
provided with this release.

» International character sets are supported. The PC keyboard displayed in the
Keyboard Remap window is based on the keyboard setting specified in the
International Dialog of the Windows Control Panel.
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»  Other windows applications programmers can use the EHLLAPI interface for
sending and receiving data with the IBM host using terminal emulation services.

* You may have multiple instances (up to the number of sockets) of the TN3270
application active concurrently.

» Tolog onto a host other than 3270, use the Network Virtual Terminal (NVT) mode.
* An animated icon signals whether the connection is active or inactive.

3270 Terminal can be invoked either with arguments {TN3270 host | faptiond}
or without arguments. A list of 3270 Terminal command line options is provided in the
online help.

Note: To start 3270 Terminal from a command line in Windows NT and Windows 3.1,
you can use the Windows Program Manager/File Menu/Run... command. In
Windows 95 use Start/Run.

The current preferences and host name can be saved to a configuration file (default is
TN3270.CFG). The configuration file is loaded when the TN3270 application is started.
You can have different configuration files for each session. The default configuration
file the next time you open a connection will be the last configuration file that you
saved.

Note: An animated icon of a telephone labeled "3270" indicates that a connection is
established when the TN3270 application is minimized.

Starting 3270 Terminal

As with all the terminal emulator applications, there are several methods for starting the
application. See online help for detailed information.

TN3270 Command Line Options

General Information on starting emulators from a command line and a list of common
command line options is included in the online help.

Connecting to a Host

To connect to a host system on the network, choose the Connect command from the
menu bar. If a connection profile has already been defined, you can select a name from
the Connection Profiles list box.

Note: The Connect menu contains five tab dialogs: TN3270 (Telnet), NWASAA, Coax,
NT Server Connection, and 802.2. However, only the TN3270 tab dialog is
usable; the other connection types are available only with the HostLink product.
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Defining a Connection Profile

A connection profile allows you to set and store a list of frequently used connections.
The connection profile names will be listed in the Connect dialog box, and allow you to
connect automatically to a host. To create a connection profile, you must define a
description and host name (or IP address). You may also specify additional options, as
desired (see "TN3270 Connection Options").

TN3270 Connection Type

You can use the TN3270 Connection Type to connect to any 3270 IBM host that has a
TCP/IP interface, connecting that host with the Internet. The TN3270 Session is
performed over a TCP/IP stack as a full WinSock compliant application.

TN3270 Connect Options

If you are not using an existing Connection Profile from the list box, you can add the
following information to complete the connection details:

Connect Option Meaning

Host Specify the TCP/IP name or IP address of the host that you
want to connect to. If you have not specified a host in a
Connection Profile, you must specify a host in the Connect
dialog. There is no default value for this option.

Note: You can specify a shortened version of the host name
(such as "rainbow") if the name is listed on the local
Domain Name Server or Host Table. Otherwise, you
must specify the IP Address or the full Internet host
name.

Port Specify the TCP/IP port that your host uses for Telnet. In
almost all hosts, the port number is 23 (default).

Model Defines the maximum screen size to be used. The default
model is Model 2. The appropriate Model depends on the
application, which is running on the remote Host, and the
user’s display capabilities. 3270 Terminal supports the
following models:

* Model 2: 24 Lines, 80 Columns (default)
* Model 3: 32 Lines, 80 Columns.
* Model 4: 43 Lines, 80 Columns.

e Model 5: 27 Lines, 132 Columns.

Note: Model 2 is always used for the initial login phase.
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Connect Option

Meaning

Short Name for
HLLAPI

HLLAPI short name that will be assigned to the session if
available. When you create the first session, the default name is
A. The default name for the second session is B, and so forth.
You can choose any letter from the list (A through Z).

The More button allows you to specify advanced settings. See "Advanced Options for
TN3270 Connections."

a _____ Connectio |

TN3270 | NwdSah | Cosx | NTSsrver | 8022
st vy
Port: ’23—@ Model:
Short Name for HLLAPL:  [A [2]

Connection profiles

Type Name *
8022 AS/400

8022 Sales

Coax DFT

NTServer LAN1
Nw45AA  SNA1
TH3270 Accounting

| 0K | ‘Eancel| | Help |

TN3270 Connection Profile

To create a Connection Profile choose the Connection Profile command from the

Settings menu.
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= Connection profile

TN3270 | Nw43AA | Cosx | MTSewer | 8022

Description |Accounting

Host : [wombat netmanage. com |E| Modity

Pot: [23 [£] Model [2(24x80) [¢] | [ Delete

Short Name for HLLAPI:  [A [2]

Login prompt: | Icon
Help

|
|
|
Login Script:
Logout Script: ’—

Conneclion profile

Tvpe Name
802.2 Sales

NwASAA SNAT
L TN3270  Accounting

ry
Coax DF =
NTServer LAN1
L]
4]

The TN3270 Connection Profile dialog box contains the following fields:

Connection Profile

Field Meaning
Description Name of the connection that appears in the list box in the

Connect dialog box. Must be specified.

Host Name or IP address of the host to which you are connecting.
Must be specified.

Port The default port is 23, the Telnet communications port. This
port is appropriate for most configurations. You can specify an
alternate port number if so desired.

Model Terminal model (defines the maximum screen size used). You
can accept the default or select another screen size:

Model 2: 24 x 80 (default)
Model 3: 32 x 80

Model 4: 43 x 80

Model 5: 27 x 132

Short Name for HLLAPI short name that will be assigned to the session if

HLLAPI available. When you create the first session, the default name is
A. The default name for the second session is B, and so forth.
You can choose any letter from the list (A through Z).
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Connection Profile

Field Meaning
Login Prompt The login prompt that you would see on your screen. Should be

used if automatic login is desired. Case sensitive. Optional.

Username The username that you use to login. Should be used if
automatic login is desired. Optional.

Pwd Prompt The host password prompt that you would see on your screen.
Should be used if automatic login includes password. Case
sensitive. Optional.

Password The password that you normally enter after you have entered
your username. Component of automatic login with password.
Optional.

Icon You can save the current Connect Profile description as an

icon. The icon will be displayed in a window group on your
desktop, consisting of customized Chameleon ATX Terminal
Emulations. By selecting this icon, you can connect from your
desktop to a terminal emulation session using the options
specified for this Connection Profile.

Login Script This is optional. You can type or browse to select the name of a
script file that automatically logs into the host when you
connect to a host by using this profile.

Logout Script You can type or browse to select the name of an existing script
file that automatically logs out of the host specified by this
profile when you close the application. Optional.

Connection profile list The list box contains the connection profiles that you have
already defined.

Note: If you want to include the Login Prompt and the Password Prompt as part of your
Connection Profile, you should connect and log in to the host and write down the
prompts that are displayed for username and password. The specified text string
must match the prompts (or a portion of the prompts) as they are displayed.

Advanced Options for TN3270 Connections

To specify additional options, choose the More button in the Connect To or Connection
Profile dialog box. An Advanced Settings dialog box appears with the following
options. Select the desired options, and choose the OK button.
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Advanced Options

Advanced Settings m

¥ Use THN3270E Protocal

—

W Extended Data Stream
=

Device Name:

[~ Autoreconnect

[ Exiton Disconnect

Graphics
¥ Enshle Settings
Title
¥ Use Default
oK. | Cancel ‘ Help ‘
Meaning

Use TN3270E
Protocol

Device Name

Extended Data
Stream

Extended Attributes

Select this option if you want to be able to print this terminal
session to an IBM 3287 printer using the 3270 Printer
application..

Device namesgmilar to an "LU name." This option allows
the TN3270 session to be assigned to a particular device name.
The TN3270E protocol allows the TN3270 server to organize
terminal and printer device pools. The server can assign these
device pools for use by specific applications and/or users.

Select Extended data stream if your Display terminal can
support it, and if the application running on the Host requires
it.

The Extended Data Stream option emulates an IBM terminal
that supports structured field commands. If you select the
Extended data stream feature, the Extended Attributes option is
automatically selected. If you do not select this option, you will
not be able to use structured field support.

This option enables individual characters within a field to be
assigned different Attributes (such as highlighting, colors,
reverse video, underline and blinking modes). Otherwise,
Attributes affect the entire field. You may select to use
Extended Attributes as a separate option, even if you do not
select to use the Extended Data Stream option.
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Advanced Options

Meaning

Autoreconnect

Exit on Disconnect

Graphics

Title

Automatically reconnects the terminal to the host when the host
disconnects you.

Exits from the TN3270 application (and closes it) when you are
disconnected from the Host.

Check the Enable option to enable graphics support. Choose
the Settings button within this section of the dialog box to
display another dialog box with specific graphics options. (see
the section "Graphics Settings").

This is the name that appears in the title bar of the terminal
emulation window when you are connected to the specified
terminal emulation session. If you do not specify a title name,
the host name appears in the title bar by default.

Graphics Settings

You can set graphics options by choosing the Settings button within the Graphics
section of the Advanced Settings dialog box (To access the Advanced Settings dialog
box, you must choose the More button within the Connect or Connection Profile

dialogs.)

Graphics m
W AFA Graphics

W Llze Graphic Mouse

¥ Program Symbols Graphics:

Host font size: w12 -
(0]4 | Cancel‘ Help ‘

The Graphics Settings are as follows:

Graphics Options

Meaning

APA Graphics Provides IBM3179G and IBM3192G terminal emulation,
including APA graphic support This option lets you show
graphs on your Session display and use the mouse as a graphic
pointer. These are vector graphics.
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Graphics Options Meaning

Program Symbol Lets the host program the fonts to be displayed on the terminal.
Graphics The default font size is 9X12.
Host font size You may select a different font size from the pop down list in

the dialog box. (The font size selected by the Fonts command
from the Settings menu must match the font size selected for
the Program Symbol Graphics, if the Program Symbol Graphics
option is enabled.)

Capturing Files

TN3270 allows you to capture a session to a printer or a file. The Capture command is
in the File menu. The parameters for the capture may be set by using the Capture
command from the Settings menu. See online help for a description of these settings.

Scripts

A script is a file of commands that automate one or more procedures that can be done
with the terminal emulation application. You can choose the language for recording the
script and the run mode for playing it. The recording language can be: VBA or
Simplified. The run mode can be: VBA or Cham4.5.

» Simplified: Provides a limited set of commands that can be used to create a script
for automated login. This type of script can be run from Telnet, TN3270 and
TN5250 Terminal Emulation applications, either by specifying the script name in
the connection profile or by running the script after a connection has been made. If
you edit a script using the Simplified Script Type, you must run the script as Cham
4.5.

» VBA: Refers to NetManage Visual Basic for Applications. This Script Type is
compatible with the standard Microsoft VBA and supports Visual Basyntax. It
also supports OLE automation and function calls for external DLLs. If you edit a
script using VBA, you must also run it using VBA.

For additional information, see the Visual Script Editor/Visual Script Player chapter of
this manual and the online help.

Using the Edit Menu

The Edit menu provides copy and paste functions for text and graphics. (The graphics
options are available only if enabled through the Advanced Settings of the Connect or
Connection Profile dialog.) You can use these functions to extract text (or graphics) to
use in other applications. All text pasted to the emulation window is transmitted
directly to the host system. For additional information, see online help.
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Using the Settings Menu

The Settings menu allows you to specify a variety of options, including various terminal
preferences, such as cursor type; settings options for file transfer and file capture; and
more. These settings are saved to a TN3270 configuration file, if you select the option
for saving your configuration file. Refer to TN3270 online help for detailed information
about using the Settings menu.

Logging a Session

The Settings menu includes the Log command, which allows you to debug programs,
report problems, and record demos. See online help for a list of steps in logging a
session.

Mapping Your Keyboard

Choose the Keyboard... command from the Settings menu remap and view your
keyboard. A display of a PC extended keyboard and a IBM 3270 keyboard appears. The
PC keyboard displayed in the Keyboard Remap window is based on the keyboard setting
specified in the International dialog of the Windows Control Panel.

:‘:j Keyboard Mapping [_ 0] x|
Eile Help
IBM 3270 KEYBOARD
atn| Cral |1|2|3|4|5|5|?|8|9|D| | I Ougl] FM | |PFi3|FF14|PFig
q | | e I I | u | I | | p I ¢ | 4 | ETab Inz | Del| |FF16|PF17)PF 1
EEC| I I | d | f I g | h | i I k | | | I | 1 | ML Upl| On|| |PF13|PFaafrFzd
| I I | b | I m | | I ! | Shift | - FFza| FFa3|FFa4
Space | Al | Enter
Script PC Extended Keyboard
|PFI|F'F2|F'F3|PF4| |prs]pre] pra pre| |PF9|PF1UIPFH|PF12|| = o
ol elslslslelslol-]-] s ns JromdlPat] wed[ o [ - -
Tablqlwlelr|t|y|u|i|o|p|[|]|'| D=l [EECHPAZ| [Hema]l Up fPATL +
alsldlflglhlilklll;l'lEnter d= =5
s =l e lelelelnlnl T [0 st ™ =
Crl ar | | an EAREE E B Ins || D=l
Terminal key: P key: Mapped to:

Setting Hotspots

Hotspots allows you to enable word selection and define PF templates. After a hotspot
has been defined, you can activate the hotspot during a session by selecting a hotspot
(using the right mouse button) displayed on the screen. Selecting a predefined hotspot
invokes its associated function-key call or terminal command. A hotspot can also be
used to invoke a Visual Script. Refer to TN3270 online help for detailed information
about setting Hotspots.
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Transferring Files between a PC and a Host

To transfer files between a PC and a host, perform the following steps:

1. You may choose the File Transfer Setup command from the Settings menu to
specify general file-transfer settings (or you may access the File Transfer Settings
dialog box by using the More button in the Send File or Receive File dialogs).

2. Choose the Send File or Receive File command from the File menu to perform the
actual transfer.
File Transfer Setup Options

Choose the File Transfer Setup command from the Settings menu to specify general file-
transfer settings or use the More button in the Send File or Receive File dialogs to select
these options.

= File Transfer Setup
Host FT Program Name: |[[J[s}1g103

[* Host-performed ASCIIJEBCDIC conversion

|
Reszponze Timeout [sec] |3g EI

[ Use expanded packets

| (1] 4 | |Eagcel| | Help |

Host File Transfer Program Name Specifies the name of the host program that
executes file transfer operations. The default name is IND$FILE. If the operating
system on the host uses a different file-transfer program, you must type in the
appropriate file-transfer program name.

Translation Table File: If nonstandard ASCII-EBCDIC translation is required, you can
provide a file that contains the conversion table. A sample translation file,
EBASCII.TAB, is automatically copied into younétmanag " directory.

Response TimeoutSpecifies maximum time, in seconds, that the terminal emulation
waits for a host response to a PC request. The default is 30 seconds.

Use Expanded PacketsThe default packet size is 2K. If you know that the remote host
supports packets larger than 2K, you may choose the Use expanded packets option. This
option takes effect only if the extended data stream option (in the Connect To dialog

box) has also been configured.
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Sending Files

Choose the Send File command from the File menu to transfer a local PC file to the
remote IBM host. The Send File options differ somewhat for the different host
operating systems. Select the appropriate tab dialog for your host operating system:
CMS, TSO, or CICS. For detailed information on the options for each of these

operating systems, see online help.

For example, the CMS tab displays the following Send File dialog box:

= Send File
CHS | 750 | Cics |
Local fle: [ CAEVENTIME EXE =]
Femate file: IE\-"ENTIME EXE ﬁ
rFile Conversiorr E xigting File
Fepl
™ ASCI/EBCDIC Conversion O Fzsles
O Append
[T CRAF O Prompt
rHast File Format
O Fized O Variable ®

I axirurn Record Size (bytes): I

Additional Optiong:

| (n]S I |Eancel|

| Help I More...l

The following fields need to be completed:

Local File. Type the local file name (with the full path) or use the Browse button to

select the file.

Remote File If you do not select or type a remote file name, the file is copied to the
default disk of the remote host with the same name as the local file.

Note: Remote file names do not contain a period before the file extension. IBM hosts

use a space instead.

If you wish to select a different location, use the Browse button. The TN3270 then
displays a message box announcing that it is "Filling host disk list."
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When the file list is ready, you are prompted with the CMS File List dialog box.

= CMS File List

Select:
Files: Disks:
0
File list:

[ +]
ALL HOTEBOOK A |
ALL HOTEINDX A
ATTP EXEC ]
B n ]
B EXEC ]
BAK IDXSAVE II

oK Cancel

Browse

Disk: Select A through Z disk name from the Disk list. The asterisk ("*") indicates the
default disk. TN3270 will display file lists only for the disks that you are permitted to
access. Choose the Browse button to get the list of files currently stored in the selected
disk.

File Conversion The default transfer is in binary mode. You may select to transfer the
file using the ASCII/EBCDIC Conversion option. This converts PC ASCII files into
IBM EBCDIC format. Each ASCII file line ends with CR/LF. You may choose to treat
each CR/LF as a end of data in a field by selecting the CR/LF check box.

Existing File: You may select the following options for transferring to an existing file:
» Replace: Overwrites an existing host file, or creates a new file if the host file does

not exist. If the host file exists, its attributes are preserved.

» Append: Adds the file to the end of the host file, or creates a new file if that file
does not exist.

» Prompt: Checks if the host file exists. If it exists, you are prompted to replace the
existing file or abort the transfer.

Host File Format. The host file may be formatted with fixed or variable field length.
Select Fixed, Variable, or Defadtir the transferred and converted file. A line of data in
a PC file is converted into one field of the host file.

Note: If the data in a line exceeds the field length, the extra data is lost. It is important
to remember this before selecting a fixed field length.

Additional Options: Valid commands are as follows:

» Quiet - The transfer proceeds without displaying any message boxes during the
operation.

* No Progress- The transfer proceeds without displaying the progress box during the
operation.
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Use the More button if you wish to display "File Transfer Setup” dialog box.

When you have completed specifying the file-transfer settings. choose the OK button to
start the Send File operation. A dialog box is displayed with all the transfer details.

Fixed details are:

* Local file name

* Remote file name

» Status of operation

e Total size of transferring file

Dynamically changing details are:

* Bytes transferred

* % transferred

» Actual FT (file transfer) time elapsed
» Estimated completion time

The TSO and the CICS tab dialog boxes for File Transfer contain similar fields. The
TSO tab dialog box has an additional Space button, which displays a Remote File
Allocation dialog box for specifying additional information regarding the file being

transferred.

=| Send File

CMS T50 CICS

Remote file: || Space Media

" ASCI/EBC Haost File Max Block Size [bytes):

[ CRALF

File Conversiol | C) Tracks O Cylinders O Blocks @ Default

Host File Form|

Local file: “ Fh:mnle file allocation

e ] [oxk ] [cencer] [ Hew |
Additional Options:
[ ok | [cancet] [ hew | [Moe.. |

Note: The CICS tab dialog box adds an option to send a clear signal to the host prior to
beginning of the transfer operation. Also, the CICS tab dialog box omits the

record size options.
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Receiving Files

Choose the Receive File command from the File menu to transfer a file from a remote
IBM host file to the local PC. The Receive File options differ somewhat for the different
host operating systems. Select the appropriate tab dialog for your host operating system:
CMS, TSO, or CICS. For detailed information on the options for each of these

operating systems, see online help.

Using HLLAPI

HLLAPI (High-Level Language Application Program Interface), which is compatible
with IBM EHLLAPI (except for a few unsupported functions) is available when you
connect to a host. You can use HLLAPI to program in high-level languages such as
COBOL, Pascal, BASIC, or C. Refer to TN3270 online help for more detailed HLLAPI
information.

Additional Online Information

The online help file for TN3270 includes a description of each menu command, plus the
following information in the "How to Use" section.
» Connecting to a Host

» Defining a Connection Profile

» Defining Key Mapping

» Defining a Button Pad

 Command Line Options

e Setting Up TN3270

e Setting Colors

* Setting Hotspots

e Transferring Files between a PC and a Host
» Using the Script Interface

e Using HLLAPI

+ OfficeVision

e Tips on Using TN3270

Troubleshooting
If you experience difficulties using the TN3270 application, refer to the following items:

O Ensure that the Connect port is correct: it should be the default (23) in almost all
cases.
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Choose the Diagnose Connection command from the Help menu to verify
connectivity to any remote system to which you want access if a failure to connect
has been reported.

If the window display appears incorrect, verify that the extended data stream and
extended attribute was specified correctly when you connected.

Verify that you are using the correct model (commonly 2 or 3).
If you cannot continue typing, press the RESET key.

If you have disconnected from your application without logging off and you cannot
log in again, use the reconnect option (in TSO) or ask your system administrator to
cancel your login (in CMS).

If you cannot use INDS$FILE file transfer, make sure that the IBM host command is
correct. To test it, type the command (IND$FILE, or another command that replaces
it) from the ready prompt of TSO or from the running state of CMS. The host will
respond with the version number of your IND$FILE program.

Note: In some early versions of IND$FILE, you will see a blank screen and the cursor

O

will move to the lower right corner of the screen. If this occurs, press PF2 twice
to return to normal operations.

Make sure to start file transfer from the ready prompt of TSO or when CMS is in
the running state
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Chapter 6. TN5250 Terminal
Emulation

TN5250 is a terminal communications program connecting your PC and an IBM
AS/400 host. This application offers 5250 protocol support for IBM hosts with IBM's
TCP/IP via supported TCP/IP attachment devices.

Note: Support for the PCS APPC connection type is available with the NetManage
HostLink product.

W

TN5250

TCP/IP
=
T
]
Protocol: Telnet
Port 23 W
==\
AS/400
' AS/400 Host: Boston Office
d i Host: Accounting
TN5250
Features

The TN5250 application includes the following features:

*  Monochrome terminal emulation
* IBM Office Vision commands

» International character sets are supported. The PC keyboard displayed in the
Keyboard Remap window is based on the keyboard setting specified in the
International Dialog of the Windows Control Panel.

e Other windows applications programmers can use the EHLLAPI interface for
sending and receiving data with the IBM host using terminal emulation services.
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* You may have multiple instances (up to the number of sockets) of the TN5250
application active concurrently.

* An animated icon signals whether the connection is active or inactive.

TN5250 can be invoked in several ways, as described in online help. TN5250 can be
invoked either with arguments {TN5250 host [ ppjpptiong .}or without arguments.
A list of 5250 Terminal Emulation command line options is provided in the online help.

Note: To start TN5250 from a command line in Windows NT and Windows 3.1, you
can use the Windows Program Manager/File Menu/Run... command. In
Windows 95 use Start/Run.

The current preferences and host name can be saved to a configuration file (default is
TN5250.CFG). The configuration file is loaded when the TN5250 application is started.
You can have different configuration files for each session. The default configuration
file the next time you open a connection will be the last configuration file that you
saved.

Note: An animated icon of a telephone labeled "5250" indicates that a connection is
established when the TN5250 application is minimized.

Starting 5250 Terminal Emulation

As with all the terminal emulator applications, there are several methods for starting the
application. See online help for detailed information.

TN5250 Command Line Options

General Information on starting emulators from a command line and a list of common
command line options is included in the online help.

Connecting to a Host

To connect to a host system on the network, select the Connect command from the menu
bar. If a connection profile has already been defined, you can select a name from the
Connection Profiles list box.

Note: The Connect menu contains two tab dialogs: TN5250 (Telnet) and APPC Router.
However, only the TN5250 tab dialog is enabled; APPC Router is available only
with the HostLink product.

TN5250 Connect Type

You can use the TN5250 Connection Type to connect to any AS/400 IBM host that has
a TCP/IP interface, connecting that host with the Internet. The TN5250 Session is
performed over a TCP/IP stack as a full WinSock-compliant application.
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TN5250 | APPC Router |
| =]
Bo 23 B Moger  [reeen
ShorNemeforHLAPL  [~] Mo |

Connection profiles

Type MName *
THEZ50 Marketing

OK | Cancel‘ Help ‘

If you are not using an existing connection profile from the list box, you can add the
following information to complete the connection details:

Connect Option
Host

Port

Model

Meaning

Specifies the TCP/IP name or IP address .of the host that you
want to connect to. If you have not specified a host in a
Connection Profile, you must specify a host in the Connect
dialog. There is no default value for this option. You can
either type a name or choose one from the list.

Note: You can specify a shortened version of the host name
(such as "sunny") if the name is listed on the local
Domain Name Server or Host Table. Otherwise, you
must specify the IP Address or the full Internet host
name.

Specifies the TCP/IP port that your host uses for Telnet. In
almost all hosts, the port number is 23. Use the default port
(port 23) or select a different port.

Defines the maximum screen size of the terminal emulation.
You can choose one of the following screen sizes:

* Model 2: 24 lines, 80 columns (default)
* Model 5: 27 lines, 132 columns
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Connect Option Meaning

Short Name for Specifies session name. Choose a session short name for

HLLAPI HLLAPI or use the default value. The default session name is
A for your first session, B for the second session, and so forth.
If you want to choose a different session name, select a letter
from A-Z from the pull-down menu to identify your session.
The only valid session names are from A-Z, therefore you can
only have 26 sessions at a time.

For information on additional settings, see "Advanced Options for TN5250".

Advanced Options for TN5250 Connections

Advanced options for TN5250 Connections are as follows:

Advanced Option Meaning

Autoreconnect Reconnects the 5250 session if you are disconnected by the
host.

Exit on Disconnect Closes the 5250 Terminal application when you disconnect the
session.

Monochrome Enables the AS/400 monochrome terminal emulation.

Title This is the name that appears in the title bar of the terminal

emulation window when you are connected to the specified
terminal emulation session. If you do not specify a title name,
the host name appears in the title bar by default. (You can
specify a Title in the Connect to or Connection Parameters
dialogs, but not in the Connection Profile dialog.)

Defining a Connection Profile

A connection profile allows you to set and store a list of frequently used connections.
The connection profile names will be listed in the Connect dialog box, and allow you to
connect automatically to a host. To create a connection profile, you must define a
description and host name (or IP address). You may also specify additional options, as
desired (see "TN5250 Connection Options"). For general information on creating,
modifying, and deleting connection profiles, see online help.

Connection Profile

To create a Connection Profile, choose the Connection Profile command from the
Settings menu. A connection profile allows you to set and store a list of frequently used
connections. The connection profiles names will be listed in the Connect dialog box,
and allow you to connect automatically to a host.
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TN5250 Connection Profile

To create a Connection Profile for the TN5250 Connect Type, choose the Connection
Profile command from the Settings menu and select the TN5250 tab.

=
TN5250 | APPE Router
Description | Marketing
Host : |asill]l].nelmanage.com E Modify
Pot: [23~ [2] Model [2(24x80) [¢] | [ Delete
Short Name for HLLAPI:  [A [&
Login prompt: | lcon
| [hete ]
|
|
Login Script: |
Logout Script: |
Connection profile
Type HName L 4
APPC Router Main AS /400 Office Yision
f TNb250 i

The TN5250 Connection Profile dialog box contains the following fields:

Connection

Profile Field Meaning

Description Name of the connection that appears in the list box in the Connect
dialog box. Must be specified.

Host Name or IP address of the host to which you are connecting. Must
be specified.

Port The default (23) Telnet communications port.

Model Specifies maximum rows and columns on the screen. Relevant
values are:

model 2 (24 x 80)
model 5 (27 x 132)
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Connection
Profile Field

Session Short
Name for HLLAPI

Monochrome
Terminal

Login Prompt

Username

Pwd Prompt

Password

Login Script

Logout Script

Connection Profile
List

Meaning

(High-Level Language Application Program Interface) enables
other applications to communicate with your terminal emulation
session. Each session should be defined with a different name.
When you create the first session, the default name is A. The
default name for the second session is B, and so forth. You can
choose any letter from the list (A through 2Z).

Select if you want monochrome terminal emulation.

The host login prompt that you would see on your screen when you
login. Optional. Use for automatic login. Case insensitive;
accepts partial matching.

The username that you use to log in. Optional. Use for automatic
login.

The password prompt that you would see on your screen.
Optional. Use for automatic login. Case insensitive; accepts
partial matching.

The password that you normally enter after you have entered your
username. Optional component of automatic login.

This is optional. You can type or browse to select the name of a
script file that automatically logs into the host when you connect
to a host by using this profile.

This is optional. You can type or browse to select the name of an
existing script file that automatically logs out of the host specified
by this profile when you close the application.

This list box contains the connection profiles that you have
defined.

Note: If you want to include the Login Prompt and the Password Prompt as part of your
Connection Profile, you should connect and log in to the host and write down the
prompts that are displayed for username and password. The specified text string
must match the prompts (or a portion of the prompts) as they are displayed.

You may include additional options in your Connection Profile by choosing
the More button. See "Advanced Settings for TN5250" for details.
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Capturing Files

TN5250 allows you to capture a session to a printer or a file. The Capture command is
in the File menu. The parameters for the capture may be set by using the Capture
command from the Settings menu. See online help for a description of these settings.

Scripts

A script is a file of commands that automate one or more procedures that can be done
with the terminal emulation application. You can choose the language for recording the
script and the run mode for playing it. The recording language can be: VBA or
Simplified. The run mode can be: VBA or Cham4.5.

» Simplified: Provides a limited set of commands that can be used to create a script
for automated login. This type of script can be run from Telnet, TN3270 and
TN5250 Terminal Emulation applications, either by specifying the script name in
the connection profile or by running the script after a connection has been made. If
you edit a script using the Simplified Script Type, you must run the script as Cham
4.5.

» VBA: Refers to NetManage Visual Basic for Applications. This Script Type is
compatible with the standard Microsoft VBA. and supports Visual Basyntax.
It also supports OLE automation and function calls for external DLLs. If you edit a
script using VBA, you must also run it using VBA.

For additional information, see the Visual Script Editor/Visual Script Player chapter of
this manual and the online help.

Using the Edit Menu

The Edit menu provides copy and paste functions for text and graphics. All text pasted
to the emulation window is transmitted directly to the host system. For additional
information, see online help.

Using the Settings Menu

The Settings menu allows you to specify a variety of options, including various terminal
preferences, such as cursor type; settings options for file capture; and more. These
settings are saved to a TN5250 configuration file, if you select the option for saving your
configuration file. Refer to TN5250 online help for detailed information about using the
Settings menu.

Logging a Session

The Settings menu includes the Log command, which allows you to debug programs,
report problems, and record demos. See online help for a list of steps in logging a
session.
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Mapping Your Keyboard

You can remap and view your keyboard by selecting the Keyboard command from the
Settings menu. A display of a PC extended keyboard and an IBM 5250 keyboard
appears. Note that the PC keyboard displayed in the Keyboard Remap window is based
on the keyboard setting specified in the International dialog of the Windows Control
Panel.

;?: Keyboard Mapping
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File Help
IBM 5250 KEYBOARD
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Tablqlwlelrlllylulilolpl[l]l'| DelEofPand] [Hemd] Up |Paug|maed
alslal elalndi bl ] ] ene <- B
st = e e e e [nm] ][] s ™ Eeor] On [panrEnted
cul an | | an Erver| [« on] = In= || Del
Terminal key: FCkey: IMapped to:

Setting Hotspots

Hotspots allows you to enable word selection and define PF templates. After a hotspot
has been defined, you can activate the hotspot during a session by selecting a hotspot
(using the right mouse button) displayed on the screen. Selecting a predefined hotspot
invokes its associated function-key call or terminal command. A hotspot can also be
used to invoke a Visual Script. Refer to TN5250 online help for detailed information
about setting Hotspots.

Using HLLAPI

HLLAPI (High-Level Language Application Program Interface), which is compatible
with IBM EHLLAPI (except for a few unsupported functions) is available when you
connect to a host. You can use HLLAPI to program in high-level languages such as
COBOL, Pascal, BASIC, or C. Refer to TN5250 online help for more detailed HLLAPI
information.
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Additional Online Information

The online help file for TN5250 includes a description of each menu command, plus the
following information in the "How to Use" section:
» Connecting to a Host

» Defining a Connection Profile

» Defining Keyboard Mapping

» Defining A Button Pad

e Command Line Options

e Setting Preference

» Defining Keyboard Mapping

e Screen Size and Automatic Font Adjustment
e Setting Colors

*  Setting Hotspots

» Using the Script Interface

e Using HLLAPI

Troubleshooting
If you experience difficulties using the TN5250 application, refer to the following items:

O Ensure that the Connect port is correct: it should be the default (23) in almost all
cases.

0 Use the Diagnose Connection command from the Help menu to verify connectivity
to any remote system to which you want access if a failure to connect is reported.

O If you cannot continue typing (for example, the keyboard is locked), press the
RESET key or enable the Auto-Reset option in the Settings/Preference menu.
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Chapter 7. 3270 Printer Emulator

The 3270 Printer application allows you to print IBM S/370 and S/390 sessions to
various printers. While the 3270 Printer application makes the printer appear to the
IBM host as if it were an IBM system printer, it also processes and translates the print
jobs received from the host into a protocol that can be handled by a regular Windows
printer.

Note: If you are using a 3270 terminal (either real or emulated), you must print via a
real IBM system printer or an emulated IBM system printer.

Assign Device to Printer

3270 Printer
Printer Device
ﬁ Output to Printer
.H/
—
IBM Host
Any Pri nter
Any Protocol

, Al
N

3270 Terminal

The 3270 Printer application can be used in any of the following ways:

» By any user of a real or emulated 3270 terminal connected to the system host

» For printing to a local attached printer, a network printer, or a printer connected to
the host by coaxial cable

* For printing a session from the TN3270 application
Note: You must choose the "Use TN3270E protdagtion within TN3270 for

that terminal emulation session if you want to print using the 3270 Printer
application.
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Printing with the 3270 Printer Emulator

To print using the 3270 Printer application, you should use the following procedure:
1. Start the printer application.

2. Select connection settings for the session to which you wish to connect.

3. Establish a connection to the host.
4

Minimize the associated printer application. (This is optional. You can leave the
application in its non-iconized form, if you prefer.)

5. Select any additional print options and start the print job from within your terminal
session.

Note: The 3270 Printer application can be invoked in several ways, as described in
online help. 3270 Printer can be invoked either with arguments {PR3270 host [
port ] [optiong }or without arguments. A list of command line options is
provided in the online help.

Supported Printer Configurations
A print job processed through the 3270 Printer application can be directed to:

* A designated printer attached to the PC workstation
e Aprintfile
* A network printer

Note: A network printer can be connected using any valid type of connection (such
as, a Novell printer, TCP/IP LPR/LPD printer, and so forth.)

The printer settings options available within the 3270 Printer application depend upon
the printer settings specified in the Windows Control Panel.

Connecting to a Session

When you first open the 3270 Printer application, the Basic dialog box is displayed.

#F 3270 Printer - PR3270.CFG [_ 0] x|
File Connect ZSettngs Help
Ermulated Frinter Buttons
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To print a terminal session, you must connect the printer emulator to the host. You can
connect the printer emulator to the host in any of the following ways:

» Non-preconfigured Connection.

» Preconfigured connection in a connection profile list
* Customized icon

» Connection via the Session Manager application

The Connect and Connection Profile dialog boxes contain tab dialogs for various
connection types. However, only the TN3270 tab is accessible for this product. If you
want to use other connection types, you must use our HostLink product.
Non-Preconfigured Connection

A non-preconfigured connection allows you to connect the printer emulator to a single
session. When the session is disconnected, the settings are lost. The next time that you
want to connect to the host, you must re-enter the connection details.

To connect to a host via the printer emulator application dialog box, do the following:

1. Choose the Connect menu command from the basic 3270 Printer application dialog
box.

2. A specific connection-type Connect To dialog box will be displayed and you can
enter the necessary connection details.

3. When you have specified the desired connection details, choose the OK button.

Preconfigured Connection in a Connection Profile List

A preconfigured connection profile appears in the list box of the Connect To dialog box.
When you choose the profile name, the application connects to the session described by
that profile.

To create a Connection Profile, choose the Connection Profile command from the
Settings menu, and specify the connection details according to the desired connection

type.

Customized Icon

If you wish, you can save a connection profile as an icon. The customized icon appears
in a window on your desktop, allowing you to open the printer session from there.
Connection via Session Manager

You may also connect to a Printer Emulator session by using the Session Manager. See
the Session Manager chapter or online help for additional information.
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TCP/IP Connection Type Options

If you wish to print a TN3270 terminal session, either choose the Connect menu item or
choose the Connection Profile... command from the Settings menu. Then specify the
following connection details in the dialog box that appears:

Host Name Specify the host name or the IP address of the terminal session.

Port: The default port is the standard Telnet port, 23.

TN32?I]|NW4SAA| Coax |NTServer| g02.2 |

Host: | ﬂ

Caonnection Profiles

Type MName

TM3IZ70 Myprinter
THIZTD  laser

0];% | Cancel Help

More/Advanced Settings

If you do not specify any particular setting in the Advanced Settings dialog, and select
TN3270E protocol, the 3270 Printer application will request the TN3270E server to
assign any available device name from its generic pool of printer devices. The

TN3270E server also maintains separate pools of printer devices that can only be used to
satisfy specific terminal session requests. Specify desired options, as follows:

» Use TN3270E ProtocalPrinting with TN3270 protocol can be done using one of
2 standards: TN3287 (as defined in RFC 1646) and TN3270E (as defined in RFC
1647). You should know if the Telnet server supports these extensions to the
standard TN3270 protocol. If the TN3270E option is selected, 3270 Printer uses
TN3270E for the printing protocol. If the option is not selected, it uses protocol
TN3287.

» Device Name The Device Name command requests that the TN3270E server
assign the specified device name from the pool of devices reserved for use with the
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Device Name command. The Device Name command may be used when requesting
either a terminal or printer session. If the specified device name is not available,
the server denies the request.

e Associate The Associate command requests that TN3270E server assign the
specified device name from the pool of devices reserved for use with the Associate
command. These are printer device names, which are paired with the specific
terminal device names. If the specified device name is not available, the server
denies the request.

Note: To request a specific device name, you must specify the name in either the Device
Name text box or the Associate text box. You cannot specify device names in
both text boxes.

Controlling the Print Session

The basic dialog box includes a section of emulated printer buttons. These buttons
represent buttons that appear on actual IBM system printers. The printer buttons
provide the following functions:

* Hold: If you choose the Hold button, it stops the host from sending more data to the
printer. This provides you with the ability to manually halt additional input from
the host: for example, to add paper to the printer or to correct a paper jam. In cases
where the print queue is too long, the host will generally detect the problem itself,
and stop sending additional data until the print queue has begun to clear. When the
printer is in a hold state, the Hold button is replaced with a Release button. Choose
the Release button, when you are ready to have the print job continue.

» Cancel This button becomes available only when a print job is being processed. It
allows you to cancel (stop) the current print job.

* PAl andPA2 (Program Acces$: The use of these buttons depends upon the host
application.

* FF (Form Feed: In order to use this button, you must first choose the Hold button.
FF directs the printer to start printing at the beginning of a new page. The printer
will resume printing at the beginning of a new page when you release the printer by
reselecting the Hold button.

* Resume This button allows you to resume a print job. If you are using an LU1
printer, you must choose this button to resume printing after having used the Cancel
button. If you are using an LU3 printer, the host can resume printing itself, whether
or not you choose the Resume button.

Checking the Print Session

You can check the status of your print sessions by choosing the Advanced button from
the basic dialog box. This buttons displays another dialog box, which displays the real
time status of the host, the PC, and the printer.
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Using the File Menu

The 3270 Printer application has the standard HostLink application File menu options
(New Configuration, Open Configuration, Save Configuration, and Save Configuration
As), relating to the printer emulator’s configuration file. The Printer Emulator’s
configuration file saves settings such as connection profiles and preferences that you
have specified during a printer emulator session. The Exit command from the File
menu closes the printer emulator application.

Using the Settings Menu

The 3270 Printer application allows you to select the following settings:

Preferences

The Preferences menu options displays a dialog box that allows you to select detailed
options (such a fonts, use of carriage returns and line feeds, etc.) regarding the format of
the printer output.

Note: You cannot change Preferences during a print session. Also, some options
cannot be selected concurrently with other options. In that case, options that
cannot be selected are grayed out.

= Printer Session Settings

Fonts Treat "ML" as.__.
® Printer Default [ 8 LPI C Ch

I LF
C Monospace [ Condensed @ CRALF

C au [Sccctfort ]| © sonore
MPP ’E@ MPL ’W@ Frinter Timeout.zec |10 @

[ Word Wraping at MPF [X Host Overwrites Settings

[ Send FF at End of Job [ Upper Case Only
M arginz [charz)

Left |0 Right |0 Top (D Bottom |0
Hex Transparent Data

Header Trailer [~ Inhex

On error...
(" Ignore ) Wait test & retry ) Manual resume

0K | | Cancel | | Help
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Fonts: Allows you to specify details regarding the printer font.

»  Printer default font: You can use this option only if your printer supports
IBM/EPSON printer escape sequences. Some dot matrix printers support this
standard. Most laser printers do not support this standard.

e 8LPI: Prints 8 lines per inch (smaller font). This option is available only when the
Printer default font is selected. Otherwise, it is replaced by the Select font button.

* Monospace Uses fonts, where each character has the same width. If this option is
not selected, the printer uses proportional fonts (if the printer, itself, supports these
fonts).

» Condensed Condenses the space between the characters. This option is available

only when the Printer default font is selected. Otherwise, it is replaced by the Select

font button.

» All: Uses both proportional and monospace fonts.

» Select Font Displays a font dialog box, allowing you to select the desired print font
from a list of possible fonts.

Treat "NL" as : Allows you to specify how the printer behaves when a new line (NL)

escape sequence is received from the host.

* CR: Prints from the beginning of a line.

» LF: Advances the paper one line.

* CRILF: Prints from the beginning of a line and advances the paper one line

» Ignore: Disregards the NL escape code. Prints as many characters on the line as
can be fit into the line using the specified font and page setup.

MPP: Specifies "Maximum Presentation Position." Indicates to the maximum number
of characters that can be printed on a line. The default is 132 characters.

MPL : Specifies "Maximum Presentation Lines." Indicates the maximum number of
lines that can be printed on a page. The default is 60 lines.

Word Wrapping at MPP : When this option is selected, the printer moves a word to the
next line if there is not sufficient space to fit the word in the current line.

Send FF at end of job Advances the printer one page length or to the top of the next
page when the print job is completed.

Host overwrites settings This option is set by default. It indicates that the print
settings specified on the host will override any settings that have been specified in the
Printer Emulator application.

Upper Case only Prints all characters in upper case.

Margins: Allows you to specify margins of the printed document
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Hex Transparent Data Allows you to specify a header and trailer (of printer escape
sequences) that can be passed transparently by the Printer Emulator to the printer. The
header specify the beginning of the transparent data and the trailer specifies the end of
the transparent data. The Hex Transparent Data option can be used if you want to
preserve control sequences (from another application or device) that determine the
printing format. This option is available only when the printer default font is selected.

In hex: Distinguishes the header and trailer from regular data by embedding an escape
character ( a character that would never occur in normal data) in these fields. To do
this, highlight one or more of the characters in the header or trailer fields and select the
In hex option..

On Error : Specifies options for error recovery in cases where the printer issues its own
error messages (such as, out of paper, paper jam).

Print to File

Allows you to redirect output from the real Windows printer to a file. You can either
type the filename or choose the Browse button. The file will be produced by the printer's
driver rather than by the printer application; therefore, to use this option, you must have
specified the Print to File option in your Windows Control Panel. This option is
available only when the printer session is disconnected or on hold.

= Open File to Print to...
File Hame: Directories:
= Ist} e-‘netmanag
o
= netmanag
7 newtprof
Save File as Type: Drives:
Printer files (- LST)  [¥] [He: e

Printer Setup

Allows you to change the printer setup options that have been specified in the Windows
Control Panel. In this example, the default printer has been specified in the Windows
Control Panel as Printing to a File. If you want to change the printer setup for this
session, you can select a different printer by choosing the Specific Printer option. This
option is available only when the printer session is disconnected or on hold.
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= Print Setup

@ Default Printer:
ancel
[currently Generic / Text Only on FILE:)
() Specific Printer: Options...
|Genelic Z Text Only on FILE: H
Paper
O Size:  [Lelter81/2x11in
o ™

Additional Online Information

The online help file for PR3270 includes a description of each menu command, plus the
following information in the "How to Use" section:

* Using 3270 Printer

e Starting 3270 Printer
 Command Line Options

»  Printing with the 3270 Printer
e Connecting to a Host

» Defining a Connection Profile

Troubleshooting

If you experience difficulties using the 3270 Printer application, refer to the following
items:

O Ensure that the Connect information is correct.
O Ensure that you have connected a virtual printer in the Windows Control Panel..
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Chapter 8. Session Manager

Session Manager is an application that allows you to manage multiple terminal
emulation and printer emulation sessions from within a single program.

With Session Manager you can perform the following functions:

* Open the terminal emulator and printer emulator applications
* View existing terminal sessions

« Disconnect and exit from a selected emulation session

»  Show status of existing emulation sessions

» Invoke an existing connection profile

You can open, close or view multiple sessions at the same time.

;'i Session Manager - SMNGR.CFG
FEile Session Settings mGD Intraletl  Help
| 8/ 8|
Application | Profile Name Connection Host Connection Ti *
= 5250 Marketing TH5250 nummny
& 320 laser TH3270 nummy
5 3270 Myprinter TH3270 nummy
Double click or press Enter to selectthe session Sessian Status:| Mo session Session Time

Viewing Session Status

The Session Manager window displays the status of terminal and printer emulation
sessions and the names of any existing connection profiles created within the emulator
applications.

The Session Manager window includes the following columns:

Icons: The icon column can contain one or more icons.

A terminal icon identifies list box entries for terminal emulation sessions.
A printer icon identifies list box entries for printer emulation sessions.

A lightbulb icon identifies each emulation session previously saved to the Session
Manager configuration file or currently connected. When a session is connected, the
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lightbulb icon is illuminated. A profile icon represents existing emulator connection
profiles.

Application: The name of the emulator application is displayed for currently connected
or previously saved emulator sessions. For 3270 and 5250 emulators, this column also
includes the HLLAPI session nhame.

Profile Name: A connection profile name is listed for existing connection profiles.
Connection profiles are not listed in the Session Manager window if they are created
while the Session Manager is running: they will be listed when the Session Manager is
closed and restarted.

Note: You cannot create a connection profile within the Session Manager application.
You create connection profiles within the emulator applications. Session
Manager lets you view and activate existing connection profiles from the various
emulator applications.

Connection Indicates the connection type (such as VT100) being used for a
communications session.

Host: Indicates the name of the remote host for the terminal emulation session.

Connect Time When there is a connection, this column contains a timestamp,
indicating the start time of a currently connected session. The start time is indicated in
the format of hours:minutes:seconds. This column also indicates the amount of elapsed
time (within parentheses, in minutes or hours:minutes) since the beginning of the
session. The elapsed time is not indicated until at least one minute has elapsed.

Additional Online Information

The online help file for Session Manager includes a description of each menu command.

Troubleshooting

If you experience difficulties using the Session Manager application, refer to the
following items:

O Ensure that the terminal emulator's Connect port is correct: it should be the default
(23) in almost all cases.

0 Use the Diagnose connection item from the Help menu to verify connectivity to any
remote system to which you want access if a failure to connect has been reported.
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Chapter 9. Visual Script Editor/Visual
Script Player

Visual Script Editor is an editor used to write or modify scripts. The editor is user-
friendly, helps you to learn the script language, and assists you in building the
commands.

What is a Script?

A script is a sequence of ASCII text lines stored in a file. You can create scripts to
automate a variety of tasks, such as:

* Logintoa host

»  Perform file operations

* Log data communications to a file

* Synchronize transmissions between host and local computers

» Print, copy and delete files.

The Script utilities allow you to dynamically reconfigure the user interface, perform
random access file operations, automate tasks, modify current functionality, and handle
incoming events. For example, you could write a script to customize an end-user

interface that would allow non-technical users to easily access various programs on a
variety of hosts.

Note: One of the easiest and most effective ways to familiarize yourself with Visual
Script Editor/Player capabilities is to run the demo scripts provided with this
application. Run one of the script files (such as, demo.vba or demol.vba) to see
how a script works. You can copy a sample script file and edit it to suit your
needs.

Components of the Script Utility

There are three main components of the script utility:
* Visual Script Editor

» Script language

* Visual Script Player (VSP and VBAVSP)
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The Visual Script Editor is used to create or modify script files. The Visual Script Editor
application allows you to use any of two Script Types for editing your script:

» Simplified: Provides a limited set of commands that can be used to create a
script for automated login. This type of script can be run from Telnet, TN3270
and TN5250 Terminal Emulation applications, either by specifying the script
name in the connection profile or by running the script after a connection has
been made.

» VBA: Refers to NetManage Visual Basic for Applications. This Script Type is
compatible with the standard Microsoft VBA, and supports Visual Basic
syntax. It also supports OLE automation and function calls for external DLLs.

The Script language consists of the sequence of commands that make up the script. The
components and rules of the Script language depend on the selected Script Type. For
details on language components and rules, see the online help.

Note: If you have scripts that have been created using Cham 4.5, it is recommended
that they be converted to VBA scripts. VSP, which must be used to execute Cham
4.5 scripts, is still provided for backward compatibility. However, support for
Cham 4.5 script types is limited.

The Visual Script Player executes the commands specified in the script file. There are
two Visual Script Players:

* VSPruns scripts that have been created using the Cham 4.5 or Simplified
Script Type.

* VBAVSP runs scripts that have been created using either the Cham 4.5 or
VBA Script Type. Using this script player you can test your scripts by setting
breakpoints, single stepping through the script, and watching as the variables
change.

Note: You can invoke either one of the Visual Script Player applications from within
Visual Script Editor by choosing the Run command. The choice of VSP
application to be invoked depends upon which option is currently selected for the
Run As option under Settings/Script Type.

Help
The Visual Script Editor online help (represented by the question mark icon) provides
information on the Visual Script Editor components and on using the menus.

Assist

The Assist menu option (represented by the question mark with a pen icon) invokes a
dialog box that contains explanations of the Script commands and actually assists you to
write a script. The contents of the Assist changes depending on which Script Type mode
you have currently selected.
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The Assist dialog contains the following parts:

Command Class This pop-down box in the upper right corner of the dialog lets you

filter the selection of commands listed in the Script Commands list box. The contents of
this list changes depending on which Script Type mode you have currently selected. If
you have selected Simplified Mode, the only Command class available is Simplified. If
you are using standard VBA, you can select to view All the commands or one of the
listed categories (such as File, Dialog, Emulation).

Script Commands This scrolling list box provides an alphabetical list of the commands
available for the current Script Type in the selected Command Class. The default list
shows all the commands available for the Script Type currently being used.

Command Description This block contains the syntax, the definition, and an example
of the command you have highlighted in the alphabetical list of commands. The Assist
Screen contains a Print button that allows you to Print the current Command
Description, current class commands, or all commands, so that you can have a hard-
copy for reference.

Current Command: This field contains the script command line that you have
highlighted.. When you select or enter command parameters for that command, the
specified parameters are added to the Current Command line.

To build a script using the Assist menu, do the following:

1. Highlight a command in the Script Commands list box. The command description
is displayed in the Command Description box.

2. Choose the Select button. The selected command is displayed in the Current
Command line, and text boxes appear prompting you to input any parameters that
are part of that command. Open the drop-down menu to see a list of valid
parameter types.

3. Specify the requested information for the parameters in the appropriate text boxes.
The parameters you specify appear in the Current Command line. If you fail to
specify a required parameter, an error message will appear prompting you to specify
that parameter.

4. You can move within the script or edit it as you work. To add a new line choose the
New Line button. To move up or down within the script use the up or down arrow
button. Repeat these steps for any other commands on the Assist list to continue
building your script.

5. Choose the Close button when you have completed building the script. Your
selected command and selected command parameters now appear in your script
template.
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Additional Online Information

The online help file includes a description of each menu command, plus further
information in the "How to Use" section.

* VBA Script Type Language Components
» Editing a Script

* OLE Automation in VBA

* Using the OLE Browser

Troubleshooting

If you experience difficulties using this application, refer to the following items:
0 Ensure that the terminal emulation can be invoked manually.
O Ensure that terminal emulation short names are correct.

O Ensure that the syntax in your commands matches the syntax of samples in the
Assist Command Description box.
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Chapter 10. FTP - File Transfer

The FTP application provides file transfer services between remote computers and your
local computer through the use of the File Transfer Protocol (FTP). FTP displays both
the local and remote directory structures in the same way local files and directories are
displayed in Windows. You can browse directories as well as select multiple files for
transfer in either direction.

NetManage also provides an FTP Server application, which permits other FTP clients
access to selected local files and directories. Server access can be restricted for security,
and client and server may run concurrently.

FTP

FTP lets you establish a connection to a remote system and then create, remove, rename,
or transfer files and directories to and from that system. For ease of use, you can define
connection profiles that can be used to connect to frequently used FTP servers.
Discussions on establishing connections, transferring files, and creating connection
profiles follow.

Establishing Connections

Establish an FTP connection to a remote system if you want to create, remove, rename,
or transfer files and directories to and from that system.

To connect to a remote system, do the following:

1. Start FTP.

The FTP window appears. After you establish a connection, you can use this
window to create, remove, rename, or transfer files or directories to and from a
remote system as discussed in the Transferring Files or Directories section in this
chapter.
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2.

3.

Choose the Connect menu option to open a Connect dialog box similar to the
following:

Enter the host name or IP address, username, and password by doing one of the
following:

» Enter the information in the appropriate fields.

» If you previously defined a connection profile for the server to which you want
to connect, select that profile in the Description box. This automatically enters
the host, user, and password information defined in the profile.

If a password is not specified, FTP prompts you for this information when you
connect. For systems to which you do not have specific login rights, select
anonymous from the User drop-down menu and then use your e-mail address as the
password. You can set up FTP to automatically use your e-mail address for
anonymous as discussed in the Setting Preferences for FTP Client.

Select the remote system type from those listed in the System field.

In most cases, FTP automatically determines the remote system type. If during this
connection, FTP reports that it could not determine the system type, you may need
to specify the exact system type.

If you do not know the system type to which you are connecting, select Other.
Selecting Other allows you to use the Info buttons to view the files and directories in
the remote system list boxes. Then you must type the directories and filenames
when you transfer or change directories. You may also clear the Retrieve detailed
file listing option in the Preferences dialog box to get all the directories and
filenames in raw (NLST) format.

If the connection is established through a firewall system, ensure that the Use
Firewall check box is selected. Otherwise, go to the next step.

A firewall is an intermediate computer that provides security to a network, such as
the Internet. As discussed in the Defining a Firewall section, you can define a
default firewall that more than one connection can use and you can define firewalls
for specific connections.

Note: If you select the Use Firewall check box and there is no firewall information
available for the connection, the Firewall dialog box appears. For details on
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entering information in this dialog box, see the table included in the
Defining a Firewall section.

To monitor a connection to a firewall, choose the Log... command from the Settings
menu. If the Start button is available, choose it to start the Log. It will then change
to the Stop button.

6. Choose the OK button on the Connect dialog box to connect to the designated
system and return to the FTP window.

The host or IP address of the connected system is displayed in the caption of the
FTP window, or in the icon title if FTP is minimized. The greeting message from
the remote system is displayed along the top of the window. You can use the FTP
window to transfer files as discussed in this chapter.

Note: Once you establish a connection, you can store the connection information as a
connection profile. The connection profile feature is particularly useful for
connections that you need to frequently establish.

Transferring Files or Directories

The FTP window lets you transfer files and directories as well as create, remove, and
rename files and directories. This window appears when you start FTP or establish a
connection. In this window, folders represent directories, and folders containing an
arrow represent symbolic links. FTP treats symbolic links as directories.

To transfer files or directories, do the following:

1. Specify the file or directory you want to transfer and the directory or file to which
you want to transfer.

You can either type the names in the Directory and Files fields or choose the names
from the window’s list boxes. Local files and directories are specified on the left
side of the window, and remote files and directories are specified on the right side.
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When specifying file and directory names, you can:

» change to another directory by either double-clicking the directory name or by
typing the name in the local or remote Directory field and then choosing the
Change button.

» create a file or directory by typing its name and then choosing Create.

» remove or rename a file or directory by selecting it and then choosing the
appropriate button (Remove or Rename).

» display additional details about a directory by selecting it and then choosing the
Info button.

2. Specify a file transfer mode by selecting either the ASCII or Binary option. If you
are unsure as to which mode to use, select Binary.

All transfers are executed in either ASCII (text) or Binary (image) mode.
Transferring a file in the incorrect mode may corrupt that file. ASCII mode
performs carriage return/line feed translation and is only needed when transferring
text files for use on a non-Windows system. Unless you transfer text files to or from
a UNIX FTP server, choose Binary.

3. Transfer the file or directory.

The left Append, Copy, and View buttons signify append, copy, or view remote-to-
local. The right buttons signify append, copy, or view local-to-remote.

Note: You can also copy files or directories by dragging them to the appropriate
list box.

The View button lets you transfer a file and open it in the appropriate viewer with
one click. When you select a file and choose a View button, FTP retrieves the file
and gives it to the appropriate viewer application. If FTP reports that it is unable to
view a file, associate a viewer with that file’s three-letter extension.

Selected files and directories are transferred with the same name, unless you type a
new name in the local or remote edit box. Files or directories with illegal names

will be translated and prefixed with the exclamation character (!) if a new name is
not specified. For example, a UNIX file named init-logcode.c copied to the local
system will be translated to the filename !INIT-LO.C.

Creating Connection Profiles

Use connection profiles to set and store a list of frequent destinations. You can define a
host, port number, user, password, system type, account, remote directory, local
directory, and a description field for each destination. FTP saves profiles to a
configuration file (FTP.CFG is the default). The configuration file is loaded when you
start FTP.
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Create a connection profile for a destination if you plan to use that destination
frequently. To create a connection profile, do the following:

1. Choose the Connection Profile... command from the Settings menu.

The Connection Profile dialog box appears.

2. Enter information in the Connection Profile dialog box fields, which are described
in the following table.

Field
Description
Name:

Port:

System:

User:

Password:

Account:

Remote:

Description

Name of the connection profile.
Name or IP address of the host to which you are connecting.

The number of the port to which you want to connect. The
default is 21.

The port setting should be 21 unless you need to connect to a
specific FTP server that is available on a non-standard port.

FTP server type that the client expects to see.

Username that is to be entered when user logs in to FTP
Server.

Password you want entered at the password prompt. This will
be invisible to the user.

Optional account command (ACCT) to be sent when
connecting.

Default directory on the remote system. This directory is used
when FTP Client establishes a connection to FTP Server.

Chameleon ATX User's Guide 101



Field Description

Local: Default directory on your system. This directory is used when
FTP Client establishes a connection to FTP Server.

If this connection is to use a firewall, see the Defining a Firewall section.
Otherwise, go to the next step.

A firewall is an intermediate computer that provides security to a network, such as
the Internet.

Choose the Add button to add the profile to the Connection Profile list box. Then
choose the Close button.

Defining a Firewall

A firewall is an intermediate computer that provides security to a network, such as the
Internet. For information on the effect of a firewall, see your online help.

You define a firewall to provide information about a firewall system through which a
connection will be established. If more than one connection is to share the same
firewall, define a default firewall. If you plan to use a firewall for a specific connection,
define the firewall for that connection.

To define a firewall, do the following:

1.

2.

Do one of the following:

» If more than one connection will be going through the same firewall, choose
the Preferences... command from the Settings menu. Then select the Use
Firewall by Default check box and choose the Set Default Firewall... button.

» If the firewall is for a specific connection, choose the Connection Profile...
command from the Settings menu. Enter information in the Connection Profile
dialog box fields as discussed in the Creating Connection Profiles section.
Then select the Use Firewall check box and choose the Set Firewall... button.

In the Firewall dialog box that appears, enter information in the fields that are
described in the following table. Then choose the OK button.

You must obtain information for the firewall, firewall user, and firewall password,
and type of firewall connection from your network administrator.

Note: For a more detailed description of the firewall options, see your online help.

Field Description
Firewall: Enter the IP address or the machine name of the firewall.
User: Enter the username that lets you access the firewall computer.
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Field Description

Password: Enter your password to the firewall computer. This is invisible to the
user.

Note: If the firewall password times out, see your network
administrator. Some firewalls have passwords that
automatically time out after a certain time period. You may
have to use Telnet to change the password on the firewall.

Port: The number of the port to which you want to connect. The default is
21. Some firewalls may use another port number.

Use SITE Select this option to use the SITE command to connect your local

command network to the firewall. The firewall, firewall user, and firewall

password fields are required.

Use USER after Select this option to use the USER command to connect your local
logon network to the firewall. The firewall, firewall user, and firewall
password fields are required.

Use USER with Select this option to use the USER command to connect your local
no logon network to the firewall. The firewall field is required, but the firewall
user and firewall password fields are ignored.

Use proxy Select this option to use the OPEN command to connect your local
OPEN network to the firewall. The firewall field is required, but the firewall
command user and firewall password fields are ignored.

3. If you opened the Firewall dialog box from the Connection Profile dialog box, finish
adding or modifying the connection profile by choosing the appropriate button.
Then choose the Close button.

FTP Server

FTP Server lets you give Internet users access to your PC files and directories. You can
restrict access to an FTP server by defining users and assigning passwords as discussed
in this chapter. You can also configure the server to define the server's time out value
and specify how many users can be connected to the FTP server simultaneously as
discussed in the online help.

Restricting Access to an FTP Server

You restrict access to an FTP server by defining a user list. This list specifies who is
authorized to access the FTP server.
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To define a user list for an FTP server, do the following:

1.

2
3.
4

7.

Start FTP Server.
Choose the Users... menu option to open the Users dialog box.
Choose the Add button.

Enter the username and password.

If the username is "anonymous", you do not need to specify a password. This is
because the server will expect a password that is a valid Internet mail ID in the form
user@company.com. The server will ignore other types of password entries.

Specify the user’s access by doing one of the following:

» Grant user’s access to all of the server’s local drives, directories, and files by
selecting the All Drives option.

» Restrict user’s to a specific directory and its subdirectories by selecting the
Restricted to option. If necessary, choose the Dir... button and browse until you
locate the desired directory.

If you want the user’s access to be read-only, select the Read Only check box.

Read-only users can retrieve files. They cannot, however, send the retrieved files to
the FTP server or create or rename directories or files.

If you select the Read Only check box, the following operations are denied: put,
append, delete, rmdir, mkdir, and rename.

Choose the OK button.

After you add a user to the user list, you can modify the information for that user or
delete the user from the list. For details, see the FTP Server online help.

Additional Online Information

The online help file for FTP includes a description of each menu command, plus the
following information in the "How to Use" section:

Automated File Transfers
Creating a Connection Profile
Creating Macros

Defining a Firewall

Deleting a Connection Profile
Establishing a Connection
Modifying a Connection Profile
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Running FTP from the Command Line

Setting Preferences
Transferring Files or Directories

The online help file for FTP Server includes a description of each menu command, plus
the following information in the "How to Use" section:

Deleting Users from the User List
Disconnecting Users

Modifying the User List

Restricting Access to an FTP Server

Setting Preferences

Troubleshooting

If you experience difficulties using FTP, refer to the following items:

O

Make sure the remote system provides an FTP server and that the server is running.
Note that some operating systems (for example, VMS), do not include TCP/IP
services with the standard package, and not all TCP/IP hosts run an FTP server.

If you fail to connect, choose the Diagnose Connection option from the Help menu
in FTP Client. This option invokes the Ping application, which can show you if the
host is accessible.

Use the Log command as discussed in your online help to aid you in diagnosing
problems.

Verify that the username and password were entered correctly if the FTP client
reports a failure to login.

If during connection, FTP reports that it failed to determine the system type, or if
you connect successfully but are unable to see any files, you may need to specify the
exact system type. If you are unable to determine the remote system type, you can
select Other from the list.

When you connect as Other, all the file and directory names in the Remote Files list
are displayed. You may enter the appropriate name to transfer files or change the
current directory. You can also clear the Retrieve Detailed File Listing option in
FTP’s Preferences dialog box to retrieve all files and directories in raw (NLST)
format.

Make sure that the correct transfer type (ASCII or Binary) is chosen. Transferring
a file in the incorrect mode may corrupt that file. Unless you transfer text files to or
from a UNIX FTP server, choose Binary.

Make sure the clients have the necessary permission for specific operations (for
example, write access to a directory).
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Chapter 11. LPR/LPD

The LPR and LPD applications allow files to be printed remotely over the network. The
NetManage LPR application uses the Line Printer Remote (LPR) protocol and functions
as the client side of the remote printing process; it allows you to print to network

printers that are running LPD. The NetManage LPD application uses the Line Printer
Daemon (LPD) protocol and functions as the server side of the remote printer process; it
makes your local printer accessible as a network printer for remote users that are
sending files with LPR.

Using LPR
LPR allows you to print a file to a remote LPD printer.

LPR will continuously retry to send your file to the printer. You can view the status of
your job by opening the Log file and checking the retry status of the job. Depending on
the status, you may choose to remove your job from the LPR queue by highlighting the
job listing in the LPR window and choosing the Delete Job command from the LPR
menu.

Printing a File Using LPR

When you print a file using LPR, the file does not go through the Windows printer
driver defined in the Control Panel’s Printer dialog box; instead, it is redirected to a
remote printer as specified in LPR.

To print a file to a remote network printer, do the following:

1. Start LPR and choose Print File... command from the LPR menu. The Print File
dialog box appears.

Print File

4]

Host |l | Binter: fip
File Name: Directories:
st dhnetmanag. 95
Carcel
Tnetm - b -
advants.bt
24 netmanag 95
alteret bt 1 activer Setup...
cookies.tit L1 egibin —
lack @bt 1 find i
netcom bt b -
portaltst =l = Bl
List Files of Type: Drives
[Teat () =] [= 4 dived =]

2. Enter the remote host name (or IP address) and the remote printer name. Then
select your file.
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3. If you are printing to any standard LPD printer, you are done. For other
implementations of LPD, however, do the following:

a) Choose the Setup... button to open the LPR Setup dialog box.

b) Enter the desired information in the LPR Setup dialog box:

e User Name: your username.

» Class: the class name, if your print server supports this feature for
prioritizing print requests (optional).

» Job Name: \your job name, which is printed on a banner page if your
printer supports this feature (optional).

e Print Format: the file’s print format. Choose one of the following formats:
PostScript, text (raw, unformatted text file), text with pr (unformatted text
file with a heading, page number, and pagination), or Sun Raster.

Note: The remote printer must support the designated format. If you specify
PostScript and the printer cannot interpret the PostScript commands, the
file will not print. If this occurs, try using the text option.

¢) Choose the OK button to send your file to the printer.

You can print to a file and then send that file to a remote printer. To do so, do the
following:

1. Inthe Control Panel, choose Printers, and then select your default printer.

2. Direct your default printer to print to a file by doing one of the following:

» If you are using Windows 3.1, choose the Connect button. Scroll down the list
of ports until you see File and choose the OK button. You may be prompted for
a filename.

e If you are using Windows 95, choose the Properties... command from the File
menu. Then select the Details tab. In the Print to the following port option,
select File and choose the OK button.

3. Choose the Print File... command from the LPR menu. Then use the Print File
dialog box to select the file and send it to the remote printer.
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Controlling Print Jobs

The Control menu allows you to perform the following commands: Print Any, Status
(Short), Status (Long), and Remove Job. You can use these commands to check if your
print job has already printed or is still in the queue. You can also remove print jobs
from the queue.

To check the status or control the print job:

1. Choose the Control menu option.

LPR Control

T e
-

Printer Commands
& Print Any

" Status [Short)

" Status [Long)

" Bemave Jab

L

2. Enter the relevant information into the fields of the LPR Control dialog box, as
follows:

» Host: The name of the remote host (must be specified to select any of the
commands).

» Printer: The name of the remote printer (must be specified if you have selected
any of the commands).

» User: Your username (must be specified if you have selected the Remove Job
command).

» List: If you do not enter any print job names in this field and you select Remove
Job, LPR will remove all of your print jobs from the queue. If you want to
select which of your print jobs will be removed from the queue, you can specify
the job names in this field. If you enter one or more job names, only those print
jobs will be removed. (You must own those print jobs).

If you selected the status command (short or long) and you do not enter a
print job name in the list field, LPR will display the status for all print jobs
for the specified printer. If you enter your username, status for all of your
print jobs will be listed. If you enter one or more job numbers, status for
that job or jobs will be listed.

e Query commands are as follows:
e Print Any: Print all jobs.
e Status (Short): Display a summarized version of your print job status.
e Status (Long): Display a more detailed version of your print job status.
 Remove Job: Delete a print job from the printer queue.
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Note: These options are independent of LPD.

LPR Printing from within an Application

In Windows 95, you can configure your system so that you will be able to use LPR to
print while working in another application. Before you can use LPR to print from

within another application in the Windows 95 environment, you must first start the LPR
service from the network and then add a printer. Separate discussions on each task
follow.

In the Windows 3.1 environment, you cannot print to a remote printer from within an
application. If you want to print a file from another application, you must configure a
network printer to print a file, print to a file, and then send that file to a printer. For
details, see the Configuring a Network Printer for LPR in Windows 3.1 section.

Starting the LPR Service from the Network

To start the LPR service from the network, do the following:

1. Choose the Start button to display the Start menu.

2. Choose the Settings command and then the Control Panel command.

3. Choose the Network icon.
The Network dialog box appears.
4. Choose the Add button that is available on the Configuration tab.
The Select Network Component Type dialog box appears.
5. Select Service from the list of components and then choose the Add button.

The Select Network Service dialog box appears.

6. Select NetManage from the list of manufacturers and NetManage LPR Printer
Sharing from the list of network services.

7. Choose the OK button.
Adding a Printer
To add a printer, do the following:

1. Open the Add Printer Wizard. To do so choose the Start button, choose the Settings
command, and then the Printers command. Next, choose the Add Printer icon.
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2. Use the Add Printer Wizard as discussed in your Microsoft documentation. When
prompted for the network path of the printer that you want to use for LPR printing,
use either of the following formats to enter the desired print server, host, or printer:

\\server:LPR:printer
\\server\LPR\printer

For example, suppose a host’s name is rainbow and a printer’'s name is iris. You
could add iris as an LPR printer using either of the following formats. Printing
from within other applications can then be sent to iris using LPR.

\\rainbow:LPR:iris
\\rainbow\LPR\iris

Print Format when Printing from within an Application

If you are printing from within an application, the default print type is "v" (Sun raster
format).

If you need to override the print format, add the following line to your configuration file,
which is LPR.CFG by default:

format=<options>
The following table describes the options you can include in your format statement.

Note: The print format options are all dependent on the LPD implementation at the
remote site. The remote LPD and remote printer must be able to interpret these
options.

Option Meaning

c Plot CIF file

d Print DVI file

f Print formatted file
g Plot file

I Print file leaving control characters

n Print ditroff output file

0 Print PostScript output file

p Print file with "pr" format

r File to print with FORTRAN carriage control
t Print troff output file

\Y Print raster file
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For example, to set the print type to "print formatted file:"
format=f

Printing PostScript Files

You can print PostScript files on a printer that is capable of interpreting and producing
the PostScript format.

To print PostScript files, do the following:

1. Install the appropriate PostScript printer driver for your specific printer in the
Printers section in the Windows Control Panel. Then, select that printer from the
Installed Printers list.

2. Choose the Setup button. View the setup screen to confirm your selection. Choose
the Close button and then exit the Control Panel.

3. Ifyou are using LPR/LPD in the Windows 3.1 environment, edit your WIN.INI file
to include the CtrID=0 statement.

You enter the CtrID=0 statement in your WIN.INI file under the section that
contains the name of your redirected PostScript printer. (You must enter the
CtrID=0 statement because PostScript drivers add CtrID to the beginning of a print
job, and the UNIX system interpret CtrID as an end of file indicator.)

For example, if you installed an Apple LaserWriter printer driver and connected it
to the LPT1 printer in the Control Panel, enter the following:

[APPLE LASERWRITER , LPT1]
CtrID=0

If you installed an HP LaserJet 4/4 printer driver and connected it to the LPT1
printer in the Control Panel, enter the following:

[HP Laserjet 4/4, LPT1]
CtrlD=0

4. Save your changes. Then restart Windows to make the changes effective.

Configuring a Network Printer for LPR in Windows 3.1

If you are in the Windows 3.1 environment and you want to print a file from another
application, you must configure a network printer to print a file, print to a file, and then
send that file to a printer. To do so, do the following:

1. Direct your default printer to print to a file by doing the following:

a) Open the Control panel and then select the Printers icon.

The Printers dialog box appears.
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b) Select a printer and choose the Connect button.
c) Select File from the list of ports and then choose the OK button.
d) Choose the Close button to close the Printers dialog box.

2. Choose the print command in the application from which you want to print. Enter
a filename when you are prompted to do so. The information you want to print is
saved to afile.

3. Open LPR and then choose the Print File... command from the LPR menu.
The Print File dialog box appears.

4. Select the file specified in step 2. Then send the file to the remote printer as
described in the Printing a File Using LPR section of this chapter.

Diagnosing Client and Host Transmission Problems

To diagnose any client/host transmission problems, use the Log... command to verify
communication between a client and host and to verify the transfer of print files. The
Log command keeps a log of data transmissions between the client and host.

Choose the Log... command from the Settings menu before sending the file to the
printer. LPR will automatically start recording the transmissions as soon as you send
the file.

Using LPD
LPD accepts print jobs from remote users and responds to LPR queries on status.

To use LPD in Windows 95 or Windows 3.1, simply open the application to make it
available. You can then minimize it.

To use LPD, simply open the application to make it available. You can then minimize
it.

Other users can print to your LPD server if they specify your machine’s IP address or
host name.

LPD sends print jobs to the printer specified in LPR. If that printer cannot be found
LPD sends the print job to your default printer.

Additional Online Information

The online help file for LPR/LPD includes a description of each menu command, plus
the following information in the "How to Use" section:

» Configuring a Network Printer for Non-NFS Environment (Windows 3.1 only)
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Controlling Print Jobs

Diagnosing Client and Host Transmission Problems
Printing a File

Printing PostScript Files

Troubleshooting

If you experience difficulties using the LPR application, refer to the following items:

O

Check the host side of your printing procedure. Check with your system
administrator about the printcap file, which contains all the necessary parameters
and other important information about the various printers connected to the host,
and how the host handles the filtering. The printcap file is used by LPD
implementation in a UNIX environment; the NetManage LPD does not use this file.

PostScript printing problems may occur if you are using LPR in the Windows 3.1
environment and your print server is running on a UNIX machine. If you
experience PostScript printing problems, enter the CtrID=0 statement in your
WIN.INI file under the section that contains the name of your redirected PostScript
printer.

You must enter the CtrlID=0 statement because PostScript drivers add CtrID to the
beginning of a print job, and the UNIX system interpret CtrID as an end of file
indicator.

The network button is active if a network is installed in the Networks dialog box in
the Control Panel, and when an LPT port is free. If the network button is dimmed,
make sure your network is installed and that an LPT port is free.

Use the Ping application to verify connectivity to any remote system to which you
want access if a failure to connect is reported.

Not every LPD implementation supports the PostScript function. If the PostScript
function does not work, select the text option.

If an LPR print job keeps spooling in the Windows 95 environment, check to see
whether the server is up. A spooling problem can occur because the Windows 95
Add Printer Wizard does not check the status of the server when you add an LPR
printer.
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Chapter 12. TFTP - File Transfer

The TFTP application provides rudimentary file transfer services, using the Trivial File
Transfer Protocol (TFTP). The application allows simple file transfer to and from a
remote system without any directory or file listing. Normally, the FTP application is
recommended for file transfer services, since it is supported across many systems.
However, if your remote system does not support FTP, you may need to use TFTP.

Server functions are also provided permitting other Chameleon TFTP clients and non-
Chameleon clients access to selected local files and directories. A TFTP server is
generally used for checking or testing in a development environment.

The current connect parameters, server parameters, and options can be saved to a
configuration file (default is TFTP.CFG). The configuration file is loaded when the
TFTP application is started.

TFTP Client

The TFTP Client transfers files to and from the remote system (Server). Timeout values
may be altered and a log produced.

Transferring Files
To transfer a file to or from a remote system, complete the following steps:

1. Select the Transfer menu. The File transfer dialog box appears:

= File Transfer

Host Name:
Remote File:
Local File:
Directory:

Directories:

netmanage.co.il
bind_hlp

c:\netmanag

Files:

-1

email]
gopher]
news]
newtprof]
outbox]
webdocs]
websurf]

archieac. gif
atermapi.dil
bind_exe
bind_hlp
bpdskdIldll
bullet.gif
cerfnet.cfg
cerfnet_dib

Transfer Type
) Receive
® Send

Transfer Mode

1. Inthe Host Name drop-down list box, type or select the host name or IP address of
the remote system.

2. Select the Transfer Type option button:

Receive: Specifies that you want to receive a remote file at the local system.
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Send: Specifies that you want to transmit a local file to the remote system.
3. Select the Transfer Mode option button (ASCII or binary).

All transfers are executed in either ASCII (text) or Binary (image) mode. ASCII
mode performs carriage return/line feed translation and is only needed when
transferring text files for use on a non-Windows system. If you encounter problems
or data corruption, it is usually best to transfer in Binary mode.

If you are unsure as to which mode to use, select Binary.
4. Type or select the Remote File.

If Receive Transfer Type is selected: a remote filename does not need to be
specified.

If Send Transfer Type is selected: a remote filename specifies how to rename the
transferred file on the remote host. If a filename is not specified, the remote
filename will be assumed to be the same as the local filename.

5. Type or select the Local File:

If Receive Transfer Type is selected: specify the same directory as the default
directory set through the Server... option of the settings menu.

If Send Transfer Type is selected: specify the name of the file you want to transfer
to the remote Host.

6. Choose the OK button to begin the transfer.

Creating a Log

TFTP lets you create a log (record) of the file transfer operations in your application
window and save it into a log file (TFTP.LOG). Select the Preferences... option from
the Settings menu and select the appropriate option button. Choose the OK button to
start the log. Log entries show transfer start and end summaries, as well as server
enabling and disabling.

Setting Timeout

Select the Timeout... option from the Settings menu to modify Timeout values.

The Retransmission value (between 1 and the total transmission seconds) indicates when
to send the first retransmission after a failure to receive an acknowledgment.

The total transmission timeout (between 1 and 9999 seconds) indicates the value for the
entire transmission; extend this value if you plan to transfer a very large file.

116 Chameleon ATX User's Guide



TFTP Server

Set the TFTP Server through the Server... option from the Settings menu. This
determines the public directory for TFTP Clients and enables the TFTP Server. The
public directory is shared between all TFTP Clients. TFTP Clients cannot access any
files or directories outside of this public directory. The Server On check box is used to
enable and disable the TFTP Server.

= Server

Public Directory:
c:\netmanag

email]
gopher]
news]
newtprof]
outbox]
webdocs]
websurf]

Cancel

[T Server On

The TFTP Server is activated in two ways:

* Onthe Server side: select the Server On option from the Settings menu.

* Onthe Client side: a client can automatically activate the TFTP Server, if the
following steps have been completed on the TFTP Server side:

a) Save the TFTP settings with Server On selected, to the TFTP configuration file.

b) Through custom, choose the INETD configuration option from the Services
menu and create a TFTP Server on port 69 (refer to online help for more
details).

Note: The INETD configuration option does not apply to Windows NT users.
c) Restart windows.
Any messages sent to the TFTP Server will automatically activate the Server. After
the end of the connection, the TFTP Server closes.
Additional Online Information

The online help file for TFTP includes a description of each menu command, plus the
following information in the "How to Use" section:

* Transferring Files

» Setting Timeout

» Creating a Log

Chameleon ATX User's Guide 117



e Setting the TFTP Server

Troubleshooting
If you experience difficulties using the TFTP application, refer to the following items:

0 Make sure the remote system provides a TFTP server and that the server is running.
The TFTP server must be explicitly turned on and the application must be running.
Some operating systems do not supply TCP/IP services with the standard package
(for example, VMS).

0 Use the Ping application to verify connectivity to any remote system to which you
want access if the TFTP application reports a failure to transfer.

0 Make sure that the transfer type (ASCIl/binary) is chosen correctly. Transferring a
binary file when the transfer type specifies ASCII, may cause a failure.

0 Make sure you have permission for specific operations (for example, write access to
a directory). The TFTP log can be used to help diagnose access failures.
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Chapter 13. File and Disk Replicator

File and Disk Replicator creates an always-up-to-date local copy (replication) of the files
from a specified directory of a remote host. The application repeatedly runs an update
session that creates a local replication of a directory subtree on a remote host served by
an FTP server. As many as 100 different replications of different sites can be handled
simultaneously.

Updates are created using a minimal transfer scheme: only files that do not exist in the
local site, or files that are different than the ones in the local site, are retrieved from the
remote site. You may also specify that the local files which no longer exist on the
remote host are deleted.

Note: File and Disk Replicator is available only for Windows NT and Windows 95.

Using File and Disk Replicator

To replicate remote hosts you must first create and enable profiles, then select the
Connect menu item. The replicating session starts. File and Disk Replicator will run the
enabled profiles according to the information specified in the profile’s information and

in preferences. File and Disk Replicator should be left running to constantly update
local directories according to the time frequencies set in the Connection Profile. File
and Disk Replicator updates the local host with files and directories from the remote
host(s) - not vice-versa. File and Disk Replicator displays a log in the main window,
displaying the progress of file transfer and statistics about the transfer once completed.
These messages may also be written to a log.

Creating Connection Profiles

The Connection Profiles command from the Settings menu is used to create, modify or
delete File and Disk Replicator profiles, and to enable and disable them.
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The dialog window initially appears in a restricted size. Choose the More>> button to
extend the dialog and display all the available settings.

The following may be specified for each profile:

» Description: Specify a name for the profile. Existing profile names appear in the
profiles list box on the bottom part of the Connection Profiles dialog.

» Host section: Specify the remote Host to replicate:

« Name: The name or IP address of the Remote host where the directories and
files to replicate are located.

» Port: The number of the port to connect to. The default is 21. The port setting
should always be 21 unless you need to connect to a specific FTP server
available on a non-standard port.

» System: FTP server type. If unknown, Auto is the default. File and Disk
Replicator will try to identify the system.

Note: Specifying an incorrect system may result in faulty replicating and even data
loss (if the Delete local files that were deleted from remote site box was
checked). Therefore it is advised that you set this field to Auto.

» Login section: Specify the login details for the remote Host to replicate.

» User: The user name that will be used when logging into the FTP remote host.
If no user name is specified, anonymous will be used as a default.

» Password: The password used to log into the FTP remote host. The password is
not displayed.

» Directory section: Specify which directories should be replicated.

» Remote: The directory on the remote host to replicate. The sub directories of
the specified directory will also be replicated.

* Local: The directory on your local machine to which the remote directory will
be replicated.
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You can use the Browse button to select a local directory.

» Replication frequency: Specify the time frequency (in Days, Hours and Minutes)
that the remote host will be replicated.

» Profiles: Displays a list of all the profiles set in the current configuration file. An
asterisk to the left of a profile name indicates it is enabled. To enable and disable,
select the profile name and choose the Enable Profiles or Disable Profiles button.
The disabled profiles are kept in the configuration file, but are not executed when
replicating.

In its enlarged mode (after choosing the More>> button) the dialog also contains the
following settings:

» Only replicate files: when checked, sets the cut-off date specified below:

» Check the first radio button to replicate files changed only within the last
number of specified days.

» Check the second radio button to replicate files changed after the specified date
(in Hours, Day in Month, Month and year).

» Add: Specify the amount of time (Hours and Minutes) that should be added to the
time of the remote host, in order to get the local time (value may be negative).
Failing to set this correctly might cause File and Disk Replicator to fail to update
local files when the remote file was changed in the last 24 hours.

» Check the Delete local files that were deleted from remote site box for all local files
which no longer exist on the remote site to be removed from the local site. This
option ensures a complete replication.

» Profile-specific data transfer: Specifies the FTP data transfer mode ( ASCII or
Binary). If not specified, the data transfer setting from the preferences will be used.

When complete, choose the Add button. The new profile is added to the list of profiles
and it is enabled. To modify a profile, select the profiles, perform any required changes
and choose the Modify button.

Making File and Disk Replicator Connections

Choose the Connect option to start the replicating process.

Note: The menu option changes to Disconnect allowing you to disconnect the
replicating session.

All the enabled profiles begin the replicating process, then repeat it automatically at the
specified intervals. The main window displays the replicating messages. At the end of
each connection, statistics will be printed to the screen detailing the number of
directories and files checked, and the number of files and total bytes retrieved.

Choose the Disconnect option to stop the replicating processes. A confirmation pop up
will appear.
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Note: The menu option changes to Connect allowing you to connect the replicating

session.

Setting Preferences

The Preferences dialog allows you to specify the various global replication settings
which affect all profiles.

When the Write logfile box is checked, the File and Disk Replicator messages are
written to a log file (in addition to displaying messages in the main window). The
specified log file is used for all the replication profiles. When the box is not
checked, no log file is written. Specify the log file name and directory to be used.
Check the Append logfile box for log entries of each session to be appended to the
entries from the previous session.

The Alarm level specifies if messages should also appear as pop-ups (in addition to
being displayed to the screen and written to the log file - if one has been specified),
and if so, which messages.

The Messaging level specifies which level of messages will be displayed to the
screen and written to the log file (if one has been specified).

The Data transfer section specifies the FTP data transfer mode. The default is
Binary.

Additional Online Information

The online help file for File and Disk Replicator includes a description of each menu
command, plus the following information in the "How to Use" section:

Creating Log Files

Creating, modifying and deleting a replication profile
Creating a new configuration file

Opening a replication session and running Profiles

Troubleshooting

If you experience difficulties using the File and Disk Replicator program, refer to the
following items:

O Due to the fact that local files may be deleted or overwritten during a replicating
process, it is advised to refrain from using the local replicate site as an actual
working environment. If you wish to modify or save files that have been replicated,
it is advised to move them away from the local replicate directory.

O All error messages begin with the word Error:, to help searching for errors in the
log.
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0 The Connect option is dimmed when no replicate profiles exist (or none are
enabled) in the Connection Profiles dialog.

O Specifying an incorrect system in a connection profile may result in faulty
replication and even data loss. It is advised to set this field to Auto.

O If the remote host is a UNIX host, enter the directory name exactly as it appears on
the UNIX host. That is:

/market/asia/stats
and not
C:\market\asia\stats

O As a precaution, File and Disk Replicator will not delete local files in the following
cases:

When the local site bears no resemblance to the remote site
When the remote site is empty
If certain connection problems occur while replicating.

O The default replicate settings from the Preferences dialog are used only when a
specific replicate profile does not contain overriding information.

O File and Disk Replicator is not case sensitive, but UNIX machines are case
sensitive. File and Disk Replicator will not differentiate between similar file names,
written in a different case. Therefore, only one file will be replicated in the instance
of two similar names of UNIX files, but with different cases. Also, an incorrect file
maybe copied over an existing local file, because the name, (but not the case,
making it a different file on UNIX), is the same.
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Chapter 14. NFS Utilities

The file conventions used by Windows are different than those used by NFS files, which
are specified by UNIX standards. NFS Utilities provides smooth integration between
your local Windows files and your network files. This chapter discusses using NFS
Utilities to do the following:

» converting text files between UNIX and Windows

» displaying filename mapping so you can view UNIX filenames and their
corresponding mapped Windows filenames

Note: You can display filename mapping only while one or more NFS drives are
mounted. However, you can convert files at any time.

Converting Files

To indicate the end of a line, UNIX and Windows text files use different termination
characters. Specifically, UNIX uses the <LF> character to mark the end of a line while
Windows uses the two-character combination <CR> <LF>.

To convert one end-of-line convention to the other in a text file, do the following:
1. Choose the NFS Utilities icon to display the NFS Utilities window.
2. Choose the Convert... command from the Utilities menu.

The Convert Text File dialog box appears.

Convert Text File
Filename:  [-
Ditectory:  d'\netmanag.35

Close

Directaries: Eiles:

[] - Tt dibs -
[actives] j 1 nietm. bt ZI

[cai-hin] 1psiiap

[find] 3270.e01

[lib] 3270.vba
{plug;\s] ' dhamebtt. gif
webdacs| 4prebutt.gif
lwebspid] | S50sor 7

Uniix to windows =

3. Select or type the name of the file you want to convert.

If the desired file is not in the current directory, select items in the Directories box
until you locate the correct directory.

4. Select the conversion direction (Windows to UNIX, or UNIX to Windows) and
choose the Convert button.
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Displaying Filename Mappings

Windows filename conventions are more restrictive than those in UNIX. Because of
this, some UNIX filenames need to be mapped to Windows-compatible filenames.

NFS automatically maps UNIX filenames to Windows filenames. This mapping is
identical to the mapping performed in a variety of other DOS-based NFS products.
Mapped filenames appear in the form XXXXX~YY.ZZZ. Atilde (~) is inserted as the
sixth character and the next two characters are a uniquely generated key. In addition, a
tilde (~) replaces any periods that appear in the UNIX filename.

To display original UNIX filenames and their corresponding mapped Windows
filenames, do the following:

1. Mount an NFS drive from a UNIX computer or server. You mount drives in
Windows NT or Windows 3.1 through the File Manager. You mount drives in
Windows 95 through the Windows Explorer. For details, see the NFS chapter.

The connection you establish must be maintained during the rest of this procedure.
You can minimize the File Manager or Windows Explorer window after you make
the connection.

2. Choose the NFS Utilities icon.

3. Choose the Mappings... command from the Utilities menu.

The current filename mappings are displayed in a Filename Mappings window
similar to the following figure. Filenames listed under the NFS Name column are
the original UNIX filenames.

= Filename Mappings =
[windows Name NF5 MHame

_lwp_~“BA.2 _lwp_exit.2
_lwp_~CA.2 _lwp_cond_timedwait. 2

[ ]

0

Additional Online Information

The online help file for NFS Utilities includes a description of each menu command,
plus the following information in the "How to Use" section:

» Converting Files
» Displaying Filename Mapping
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Chapter 15. Z-Mail® Pro and Z-Mail®
Pro Administration

The Z-Mail® Pro application provides electronic mail services for both TCP/IP and

SNA network environments. To communicate within the standard Internet (TCP/IP)
environment, Z-Mail® Pro uses the Simple Mail Transfer Protocol (SMTP) to both send
and receive mail, and the Post Office Protocol (POP2 and POP3) to retrieve mail from a
server. You can use these protocols to directly integrate with UNIX mail. Z-Mail® Pro
supports MIME (Multi-purpose Internet Mail Extensions ) which allows attachment of
files to mail messages.

Z-Mail® Pro in a previous version was called Mail.
Features include the ability to:

» read and prepare messages off-line, saving you connection costs

» attach multimedia files to your messages through MIME (Multi-purpose Internet
Mail Extensions)

» view a message in regular text format or in standard HTML (Hypertext Markup
Language) format and edit HTML formatted text directly in WebSpider

» support MAPI-enabled (Messaging Application Programming Interface)
applications

* route messages to others one after another

» retrieve message header only information using the Smart Pop feature

» create rules for automatically filtering and filing incoming mail

» create your own personal address books

» attach binary files through uuencode/uudecode

» set up multiple mail accounts

» create rules to activate the new Z-Mail® Pro scripting language (using VBA scripts)
» view graphic attachments using Images
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IMAP

Z-Mail® Pro uses the IMAP4 (Internet Message Access Protocol), which is a
client/server protocol , for manipulating remote message files. Remote and local folders
are fully integrated in Z-Mail® Pro, messages are viewed and folders managed in the
same way. IMAP accesses mailboxes (folders) on remote servers as if they were local
mailboxes, using the same commands such as moving to folders, search, marking
messages. For further information on these functions, see the IMAP Transport section
in this chapter. IMAP features include:

» access to multiple hierarchical structured mailboxes on the same or different remote
servers

+ shared mailboxes between users

» only headers displayed - only when you view a message is it fetched, avoiding
unnecessary retrieval of large attachments and saves bandwidth.

» allows you to manipulate remote mailboxes (as if they were local folders): creating,
renaming, opening and deleting mailboxes, and searching the current remote folder.

» allows you to download specific messages or the full contents of a specific remote
mailbox.

* empties remote trash

» by selecting your private remote INBOX folder, you may read you new mail through
the IMAP server.

» Periodic/on demand checking and retrieval of recent mail from all connected
INBOX folders.

» dragging and dropping between folders; messages from your old folders can be
easily moved into new IMAP remote folders.

» right click of the mouse (or alt + enter) to access drop down menu commands on
remote host.

e connecting and disconnecting of remote servers from the main window.
e supports other NetManage messaging applications, such as Phone Tag, Tag-it!.

Fax

To send and receive faxes, Z-Mail® Pro uses the separate Chameleon Fax Server to
translate the messages into/from a format suitable for faxing. For further information
see the Using Z-Mail® Pro Fax section in this chapter.

» send and receive faxes and route incoming faxes

» view, store, and print faxes from various file formats
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PROFS/OV

To communicate with an IBM host, Z-Mail® Pro uses the PROFS/OV protocol. For
further information see the PROFS/OV Transport of, section in this chapter.

Z-Mail® Pro Administration

The Z-Mail® Pro Administration application allows you to manage your Z-Mail® Pro
database. Z-Mail® Pro Administration is a separate icon that is used exclusively with
Z-Mail® Pro.

Note: For detailed online help information about Z-Mail® Pro Administration, select
the Help button from within the Z-Mail® Pro Administration application.

Setting up Z-Mail® Pro

This section describes, step-by-step, how to set up a Z-Mail® Pro account for the first
time user and how to add additional users. It also includes a brief discussion about Z-
Mail® Pro configuration files and the Z-Mail® Pro log feature.

Setting Up a New Z-Mail® Pro Account for a User (First Time
Only)

To set up a Z-Mail® Pro account for a user for the first time, you need to complete the
New User dialog box. Note that if you want to use the Phone Tag, Tag-It!, Forum,
NEWTCal, Mailbox Converter and InPerson applications, you need to have this account
set up.

To set up a Z-Mail® Pro account for a user for the first time, follow these steps:
1. Open Z-Mail® Pro. The Z-Mail® Pro - New User dialog box appears.

2. Under Local, enter the user's name, user's password (optional), user's name in real
life, and local mail directory in the designated fields.

The local mail directory identifies where all configuration files and individual mail
messages are saved on your machine. You may set up a separate mail directory for
each user. For example, the mail directory, c:\netmanag\email\steven, is set up only
for user Steven.

Choose the OK button.

3. The Z-Mail® Pro Transport Setup dialog box appears. You may select any one of
the check box items:

* Internet Mail: Indicates that you want the Z-Malil® Pro application to be set up
for handling standard Internet e-mail. You need this transport to use Internet
Mail and Forum.
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* IMAP4: Indicates that you want the Z-Mail® Pro application to be set up for
handling mail on remote servers using the IMAP4 protocol. If you want to
select this option see the IMAP section in this chapter.

» Internet Fax: Indicates that you want to email the Chameleon Fax Server, and

have it fax the message to a fax machine.

If you want to select this option see

the Using Z-Mail® Pro Fax section in this chapter.

* Mainframe Malil: Indicates that you want the Z-Mail® Pro application to be set
up for handling mail between your PC and an IBM host. If you want to select
this option, see the PROFS/OV Transport of Mail section in this chapter.

Choose the OK button.

4. The Network Setting dialog appears, with a tab for each of the Mail transports you
selected earlier. Use the various tabs to set the appropriate information.

Internet Mail Tab

Use the Internet Mail Network Settings tab dialog to specify information for standard

email:

Network Settings m

Internet hiail lMalnframe Mall] Intarnet Fa:(] IMAAF ]

Mail Server
Host: |ra\nb0w ﬂ

User. |bet1y

Fasswd: |‘“"°‘°‘

Mail Dir. |

Outgoing Mail Gatewsy:,

W Delete retrieved mail from server |gat92|

|

Erom Addrass |beﬂy<beﬂy@netmanage.co.il)

-

[0],9 Cancel

Internet Mail Setting Description

Host Specify the name of the computer system acting as the

mail server.

User Specify the mail user.

Passwd

Mail Directory

Specify the password for the mail user.

Specify the mail directory (the directory where incoming

mail is stored). This is optional.

Delete retrieved mail from
server

Select this option if you want your mail automatically
deleted from the server after you have retrieved it.
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Internet Mail Setting

Outgoing Mail Gateway

From Address

IMAP4 Tab

Description

Type or select the name of the mail gateway. A mail
gateway routes all mail messages that are transmitted to
the Outbox. A mail gateway is often used for access to
the Internet. The mail gateway must be configured to
perform as an SMTP relay.

If you do not define a mail gateway in Z-Mail® Pro, the
mail gateway you define in Outbox is used instead.

Type or select the name in the From field you want to
appear as the sender when mailing a message.

Example: Jane Doe <jane@netmanage.com>

Use the IMAP4 Network Settings tab dialog to specify information for Remote
mailboxes using the IMAP4 protocol:

Network Settings n

InternetMalI] NMainframe Ma\l] Internet Fax  IMAPY }
Server inforrmation

IMAP sener:

Username :

Fassword

Name:  [IMAR1] Achsanced...

|imap

|e\|a

|

IMAP Mail Setting

Connection Name

IMAP Server

User name

Password

Description

Enter the name you want to appear on the IMAP
tab in Network Settings. This field will appear only
when installing multiple IMAP transports.

Specify the fully qualified name or IP address of the
computer system acting as the mail server.

Specify the mail user for remote login
authentication.

Specify the password of the mail user for remote
login authentication.
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Use the Advanced button to set the following:

Keep messages cache between Viewed messages are automatically saved on the

sessions

IMAP cache location

Shared Mailboxes

Connect when mail starts

Delete through Trash

local drive for while Z-Mail® Pro is running.
Select this option, to save these messages after
exiting mail, and retrieve on reactivating mail.

Enter, or use the browse button to select the
directory where to store the cache files.

Enter the additional mailboxes you want to access
into the top text box

Choose the Add button. The additional mailboxes
are listed.

To modify or delete a shared mailbox, select the
mailbox from the list and choose the appropriate
button.

Use this option only with Washington style servers.
this is dependent on mailbox privileges allocated to
your logged in user.

Select this option, for connection to this specific
server to be automatically established when you
open your Z-Malil® Pro application.

Messages are deleted immediately, and not moved
into the trash folder. This make deletion faster, but
removes any possibility to retrieve messages
accidentally trashed.

Advanced IMAP settings
Server: imap User: michaelk
Caching
¥ Keep messages cached between sessior
IM&P cache location: |C:\netmanag 35hemailzvi Browse
Shared mailboxes
List of ather mailboxes to view under curent privilage
[~ iads
Jhome/shani/ Add
“michael/ Q
tom? Hemave
General
¥ Connect when mail starts
Ok | Cancel Help |
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Note: More than one IMAP transport can be added by selecting the Add button and
then double clicking on the IMAP4 item.

Internet Fax Tab

Use the Fax Network Settings tab dialog to specify information for sending faxes:

Network Settings n

\ntemetMﬁl\l Mainframe Mail Intemet Fax WIMAPAI l

FaX Server

Email Address |faxser\.f5@ntemange com

Mail Gateway
& Lse Default
| |

Mame: |FAxE
OK | Cancel

Fax Setting Description

Fax Server Specify the email address of your Chameleon Fax Server (available
from your system administrator)

Mail Gateway  Select the Use Default radio button (the mail gateway), or enter the
name of the gateway you require.

Name Enter the name you want to appear on the fax tab in Network Settings.

Mainframe Mail Tab

Use the Mainframe Mail Network Settings tab dialog to specify information for PROFS
or OV mail:

Network Settings n
Internet ksl Mainframe dail llnternet Fax] IhAAF4 ]
VHERAD pratlse From Address: |shani<sham)
Universi -
v Initialization cmd |PROFS TERMMLTTY
HEHIg) S8y Termination cmd.; |F’ROFS TERMRNL
' PROFS :
Date format; |mm!ddfyy American ﬂ
Send File: [SENDFILE
W Delete retrieved mail
- Open Mail: [OPENMAIL

Advanced.. Fun PROFS/0v. |[OFFICE
(0] % Cancel
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Mainframe Mail Setting Description

TN3270 Profile Select the TN3270 profile that you want to be invoked
upon opening mail. If you do not have an appropriate
connection profile, use the 3270 Terminal application to
set a connection profile. Then, exit the 3270 Terminal
application and start Z-Mail® Pro. The profile must
contain the following information:

Model = 2
Port = 23, the Telnet communications port.

Mailing System Select PROFS or OfficeVision. You must select one of
these systems.

Delete retrieved mail from  If this option is selected - your mail is automatically

server deleted form the mainframe after you have retrieved it.
If this option is not selected - messages are not deleted
from the mainframe after their retrieval.

From Address Enter the address you want to automatically appear in
the from field of messages you create. This is a required
field.

Initialization Indicates either a command that puts PROFS/OV in line

mode, or an EXEC that contains initialization
commands for the PROFS/OV application running on
the host system (Such a command or script is generally
provided by the host administrator).

Termination Additional CMS commands or EXECs that should be
executed after running PROFS/OV

Date Format Select the date format for your PROFS/OV system.

Send File Default: sendfile (or sf)*. This is a required field.

Open Mail Default: openmail*. This is a required field.

Run PROFS/OV Default: PROFS (or OFFICE)*. This is a required field.

After you have specified these settings, Z-Mail® Pro will automatically invoke the
appropriate settings when you select the type of mail that you want to create.

Note: When upgrading from a previous version of Z-Mail® Pro, you will not need to
create a user account again. The following message will be displayed the first
time Z-Mail® Pro is opened after upgrading from release 4.5 and earlier: "This
version requires a conversion of your current messages into a new format. This
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may take a while." Choose the Continue button to complete the conversion.
Your rules, folders, and messages will remain intact. If you have release 4.5 or
earlier you must use this conversion of your old messages to use them with this
version of Z-Mail® Pro.

Setting Up Z-Mail® Pro Accounts for Additional Users

Once you have set up an account for the first user, you can set up mail accounts for
additional users, by first logging in as Postmaster and then as User. The steps are as
follows:

Postmaster Login Steps

To log in as Postmaster and set up accounts for additional users, do the following:

1.

Open Z-Mail® Pro. The Z-Mail® Pro - Login dialog box appears. Select
Postmaster from the Username drop-down list box and choose the OK button.

The Z-Mail® Pro Transports Setup dialog box appears.

» If you do not want to receive or send mail as a postmaster, for instance you only
want to add/modify additional users, choose the cancel button.

» If you want to send/receive mail as Postmaster, select the appropriate check box
item(s): Internet Mail, IMAP4, Internet Fax or Mainframe Mail and choose the
OK button. The Network Settings dialog box appears. Choose the Apply and
then OK buttons.

Choose the Mailboxes... command from the Services menu to display the Mailboxes
dialog box.

Note: The Mailboxes... command under the Services menu only appears when you are

logged in as Postmaster. This is the only dialog box in which you can add and
delete users and specify a user's mail directory.

4. Enter the user's name in the User text box and choose the Add... button. The Enter

Information for new user dialog box appears.

Under Local, enter the user's name, user's password, user's name in real life, and
local mail directory in the designated fields.

The local mail directory identifies where all configuration files and individual mail
messages are saved. You may set up a separate mail directory for each user. For
example, the mail directory, c:\netmanag\email\steven, is set up only for user
Steven.

Choose the OK button.
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Logging into Z-Mail® Pro as a User

To login into Z-Mail® Pro as a user, do the following:

1. Open Z-Mail® Pro. The Z-Mail® Pro - Login dialog box appears. Enter your
previously defined user name and password and choose the OK button.

2. The Z-Mail® Pro Transport Setup dialog box appears. You may select any one of
the check box items: Internet Mail, IMAP4, Internet Fax and Mainframe Mail .
Choose the OK button.

3. The Network Setting dialog appears, with a tab for each of the Mail transports you
selected earlier. Refer to the previous section that discusses how to set up a new Z-
Mail® Pro account to enter network settings information.

4. After you have entered these settings, Z-Mail® Pro will automatically invoke the
appropriate settings when you select the type of mail that you want to create. You
can now begin using Z-Mail® Pro.

Z-Mail® Pro Icon

When you minimize the Z-Mail® Pro application, an animated icon of a mailbox
appears. When new mail arrives in the current folder, the mailbox door opens.

Organizing Your Z-Mail® Pro Messages

In order to organize your messages efficiently, the Z-Mail® Pro application allows you
to create folders into which you can place your mail messages.
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When the main Z-Mail® Pro window is displayed, you will notice that the window is

split into two panes: the left pane is called the Containers pane and the right pane is
called the Contents pane. The Containers pane is also split into two panes; the top pane
contains a list of all local mail folders, and the bottom pane contains a list of remote
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mail folders accessed by IMAP4 (Internet Message Access Protocol). The Contents pane
contains a list of all the messages in the current folder.

In the Containers pane, the names of existing folders, for both local and IMAP, are
displayed along with each folder's icon, number of unread messages and total number of
messages. The default folders in descending order are: Inbox, Draft, Routing, Sent
Mail, Template, and Trash. All folders you create are listed alphabetically.

Note: You cannot delete the Inbox, Draft, Routing, Sent Mail, Template, or Trash
folders. These folders always appear at the beginning of the Folder list even
when they are empty.

In the Contents pane, a list of all the messages in the current folder are displayed. You
can drag and drop a message from the right side of the window into the desired local
folder on the left side, much like moving files into directories in File Manager.

Creating and Sending Z-Mail® Pro Messages
To create and send a Z-Mail® Pro message:

1. From the main Z-Mail® Pro window, choose the Create button, or choose the
Create command from the Message menu, or CTRL-E.

2. A new mail message window appears. If you have enabled settings for more than
one transport (Internet Mail, Internet Fax or Mainframe Mail), the New Mail dialog
box contains a drop-down list to select the desired Mail Transport.

» Internet: Select this transport to create a standard Internet Mail email message.

* Internet Fax: Select this transport to send a fax using NetManage’'s Z-Mail®
Pro Fax Server

 PROFS/OV: Select this transport to create an IBM mail message.
» News: select this transport to post a message to a specified newsgroup.

The Date field is automatically set to the current date and time. The From field is
automatically set to the From field that you defined in Network Settings. If this has
not been defined it is automatically set to your user@localhost.domain and when
this host has also not been defined, to user@popserver. .

3. You may address your message as follows:

» Enter the e-mail name and address of the person you want to send the message
to in the text box next to the To field. Then, using the down arrow, select
either To (primary recipient), cc (carbon copy), or Bcc (blind carbon copy).

» To add additional recipients from an address book: choose the Address button
to display the Address Book dialog box containing your address book(s) and
their entries. Then, select or type each entry you want to add as a recipient, and
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choose the To, Cc, or Bcc buttons. Choose the OK button to return to the new
mail window.

* News: If you have selected News, type the newsgroup you require and press
ENTER. When the address appears in the field belo@News:>is
automatically added to the address.

 PROFS/OV: If you have selected PROFS/QV, type the address you require and
press ENTER. When the address appears in the field bel@PROFS:>5is
automatically added to the address. (If Internet is selected, pressing ENTER
copies the address to the field below, without any additions.)

If the PROFS/OV address is written on the mainfram@sasid)host,
type the mail address field aserid@host . After pressing ENTER, it
appears in the field below as

<@PROFS:userid@host> (or as <@OV:userid@host>).

Note: To route your message to others, choose the Add Routing Slip command
from the Message menu.

If desired, you can select the Confirm Read and Confirm Delivery options. Select
Confirm Read if you want the system to return an acknowledgment that the
addressee opened the message. Select Confirm Delivery if you want the system to
return an acknowledgment that the message reached the addressee's mail server.
Acknowledgments are returned directly to your Mail Inbox folder.

Note: This option is applicable only if the receiver of the message is running Z-
Mail® Pro.

If desired, select the priority type of the message you are sending. You can select
high, normal, or low priority. Normal priority is the default. If you assign high

priority to your message, then a red exclamation point appears next to your message
header in the recipient’s Inbox. Assigning low priority to your message causes a
down arrow to appear next to your message header in the recipient's Inbox.

Type the subject and message text, and if desired, choose the Feelings menu to add
a smiling, frowning, or winking symbol in your message.

Choose the Send button to transmit your message to the Outbox. The message is
immediately queued in the Outbox for subsequent delivery to it defined destination.
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Encryption

Encryption is a means of permitting higher security for your mail. The contents of a

mail message are encoded, and secured with a key. A key is like a password. The
Sender creates a key and informs the receiver of the encrypted message of the value of
the key used. The receiver will use this same value to create a key to decrypt the text.

If the receiver does not have the appropriate key ( key with the same name and value) in
the key list, a dialog box appears, and the value must be entered. The user may create
numerous keys, each key has a name and value. In one message, you may use as many
different keys as required. Encryption uses algorithm DES-40.

Select a key for encryption of the \WHOLE text

Few Name * New

Key

Delete

e

Todify

| Ok | | Cancel | | Help

Encrypting Text

Encrypt text encodes a message or a selected portion of a message, which can later be
decoded, to return to plain text. To encrypt text do the following:

1. Select the text in the mail message you want to encrypt.

Note: If no text is selected, the whole message will be encrypted.
2. Choose Encrypt Text from the Message menu.

The Encryption dialog appears.
3. Select the Key you require for encryption, or create a new key.

To create a new key, enter the following:

* Name: the name that will be listed in the Key List.

* Value: the password needed to decrypt the message. The password uses the
first ten characters. The password is not case sensitive.

The key icon (under Value) changes to represent the security level of the password.
The more characters you enter, the safer the password, and the longer the key icon.
It is recommended for maximum security you use the ten characters.

Note: You must obtain the appropriate Key value from the person that sent the
message.
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____ NewKey |

Enter a new key [name and value)

Name: [gHaAN|

Walue:

«Q [1234

[ Longer key values are safer |

[™ Use the key now without saving it

| Ok | | Cancel |

4. Select the OK button. The text is now changed into encrypted text.

Decrypting Text

Decrypting text removes the encryption and returns the text to readable text. To Decrypt
text, do the following:

1. Choose Decrypt from the Message menu.
2. If you have the correct key in your key list, the message is automatically decrypted.

3. If you do not have the key, the New Key dialog appears. Enter the value for that
key. For messages encrypted with a number of different keys, you will be prompted
for the value for each key.

The new key and its value is saved in the key list.

To decrypt just one block of encrypted text, select only that text, then choose
Decrypt.

All encrypted messages are saved in the database as encrypted. After decrypting, when
you forward the message, encryption is again enforced.

Viewing Z-Mail® Pro Messages

You can view a message in standard text format. You can also view a message in
HTML format or the Web page of a referenced URL path contained in the message (see
section on viewing HTML documents).

1. Select the desired folder, and then the message you want to view.

2. Choose the View button to display the message or double-click on the message.

The view window displays the date, source address, subject, list of recipients, and
the message text. You cannot modify any of these fields, however the Copy
function within the Edit menu is available. The Copy function allows you to
transfer highlighted message text to other applications.

Choose the uudecode option to decode and save a uuencoded binary file that has
been sent as a message you are viewing.
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An override option to show the mail header is also provided. The initial setting of Show
Header is determined from the setting in the Preferences dialog box.

Replying to and Forwarding Z-Mail® Pro
To reply to a message in any folder:
1. Select the message.

2. Select the Reply to Sender or All option from the Message menu, or choose the
Reply button located on the mail message

A window identical to the sending mail display appears. The Date and From text
boxes are set normally. If you Replied to All, the list of recipients contains the
source address of the original message and also any carbon copy addresses. Note
that in many cases your own address also appears. If you do not want to receive a
copy of the message you want to send, delete your name from the list.

3. Enter your message and choose the Send button to send the mail.

The text of the original message, for both reply and forwarding, can be left intact
with a separator indicating where the original message begins (depending on your
setting in Preferences). The text insertion point is placed above this separator so
that you can type your reply or forward text above the original message.

To forward a message from any folder:
1. Select the message.

2. Choose the Forward button. A window identical to the sending mail display
appears.

3. Enter the recipient and your message and choose the Send button to send the mail.

Viewing and Editing HTML Documents

Z-Mail® Pro provides the ability to view an HTML formatted document in standard
HTML format when it is part of the message body, included as an attachment, or
referenced as a URL path within a message. You can also edit an HTML formatted
document, in WebSpider, when it is part of the message body, included as an
attachment, or referenced as a URL path within a message.

Viewing an HTML Document

You can easily view an HTML document, or directly link to its web page without having
to use a web browser. To view an HTML document when it is part of the message body
or as an attachment, do the following:
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1. Select the message that contains the HTML formatted document. If it is in an
attachment, view the attachment.

2. Choose the Display in HTML command from the Message menu.

3. The HTML formatted document appears in standard HTML format. You can view
this document and any of its jumpers or links as you would if using a web browser.

Note: The Display in HTML command is a toggle. When selected, it displays an
HTML formatted document in standard HTML format, when unselected, it
displays an HTML formatted document in standard text format.

To view an HTML document when it is referenced as a URL path within a message, do
the following:

1. Select the message that contains the URL path reference.

2. Choose the Display in HTML command from the Message menu. The referenced
URL path appears highlighted in blue.

3. Single click the highlighted URL path to directly link to its web page. You can
view its web page in Z-Mail® Pro or in WebSurfer.

Editing an HTML Document

You can also edit an HTML formatted document by sending it directly to WebSpider,
NetManage’s Web authoring tool. After editing in WebSpider, you can send it as a mail
message to another user. To do this:

1. Select the message that contains an HTML formatted document.

2. Choose the Edit HTML command from the Message menu. WebSpider is
automatically launched and the HTML formatted text from mail message now
appears in the WebSpider window.

3. Edit the HTML document as desired.

4. Choose the WebSpider Send button to send the edited HTML document as a mail
message.

Routing Messages to Others

The Routing Slip feature lets you send a message to a predefined route of addresses in
the order you specify. Instead of sending a message to multiple recipients
simultaneously, the Routing Slip feature lets you send a message to recipients one after
the other. That is, after the message is viewed by a recipient, he or she can choose
whether to send it to the next recipient on the routing slip.
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Creating and Routing Messages

To create and route a message to others, do the following:

1.

From the main mail window, choose the Create button, or choose the Create
command from the Message menu, or CTRL+E. A New Mail window appears.

Choose the Add Routing Slip command from the Message menu. A New Mail-
Routing Slip dialog box appears.

Choose the Add Address button to display the Address Book dialog box that
contains your address book(s) and their entries. Then, select or type each entry you
want to add as a recipient to your routing slip and choose the To button. Choose the
OK button to return to the New Mail-Routing Slip dialog box. Notice that all malil
recipients are listed and numbered in the Route text box.

To modify the order of recipients, select an address and move it using the arrow
buttons to the right of the address list.

If desired, select the Return At End, and/or the Allow Modifications options, and
choose the OK button. The name "Routing List" appears in the address textbox.

The Return At End option sets your address as the last address on the route, thus
making the route into a loop. The Allow Modifications option indicates that you
allow the recipients to modify the message's text as the message is routed along.

If desired, you may later edit the route before sending it or deleting it. Do this by
displaying the Routing Slip dialog box or by selecting Routing List in the address
text box and choosing the Modify or Delete buttons, respectively.

Finish completing your message and choose the Send command from the Message
menu, or choose the Send button to mail the message. The newly sent message is
placed in the Routing folder.

The status of the routed message is updated as the message moves along from one
recipient to the next. Whenever the status is updated, the message is marked as
unread. All routed messages are stored by default in the Routing folder.

Viewing Routed Messages

You can view a routed message the same way you view a regular message. Routed
messages are stored in the Inbox folder unless otherwise moved by a previously set rule.

When you view a routed message, a new menu named Routing appears in the menu bar.
This menu has three options: Route to Next, Information, and Block Route.

The Route to Next option lets you send the message to the next recipient listed in the
route and notify the originator of the progress along the route. If the route has the Allow
Modifications option set, you may modify the message text by typing in the text area
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before routing to the next recipient. The original text of the message will be retained,
while the new text is available to future recipients.

The Information option lets you display information about the route. The Routing
Information dialog box appears containing a list of addresses (if you are a recipient) or
the message status (if you are the originator).

The Block Route option lets you stop the message from being routed to any other
recipients. The originator of the message is also automatically notified that the routing
has stopped.

Deleting Z-Mail® Pro Messages
To delete one or more messages:
1. Select the message(s) you want to delete.

2. Choose the Trash icon or the Delete option from the Message menu.

The deleted message is automatically transferred to the Trash folder. All messages
remain in the Trash folder until you select Empty Trash from the Services menu or
until you exit Z-Mail® Pro (depending on your setting in Preferences).

To delete a folder, refer to the Folders section in Z-Mail® Pro online help.

To empty the local Trash folder, select Empty Trash from the Services menu. You can
also select the Empty trash on exit option from the Preference menu if you want to delete
Z-Mail® Pro in the Trash folder each time you exit Z-Mail® Pro. To empty a remote
Trash folder, select the Trash folder, click the right mouse button, and select Empty.

Appending Z-Mail® Pro Messages to a File

Z-Mail® Pro allows you to append the contents of one or more messages to the end of a
specified existing file.

While viewing or creating a message, select the Append to File... option from the
Message menu and specify the file you want to append to. The contents of the message
will be appended at the end of the specified file.

Note: If you select more than one message, the information will be appended in the
order in which you selected the messages.
Saving Z-Mail® Pro Messages to File(s)

Z-Mail® Pro allows you to save the contents of one or more messages to a new or
existing file.
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While viewing or creating a message, select the Save to File... option from the Message
menu and specify or select the file to which you want to save the message. The contents
of the message will be saved to the specified file.

Note: If you select more than one message, the information will be saved in the order in
which you selected the messages.

Creating and Updating a Draft Message

You can save and store an unfinished mail message and then send it at a later date by
using the Save As Draft and Update Draft mail features. This is useful when you wish
to complete other tasks, before sending the mail.

To create a draft message:

1. Select the Create... option from the Message menu. A New Mail message form
appears.

2. Enter any information or text required, as you normally would when creating a new
message.

3. Save the unfinished message by selecting the Save As Draft option from the
Message menu. The unfinished message is now saved in the Draft folder.

Note: The Draft folder always appears at the top of the Folder list, after the inbox
folder, even when it is empty. You cannot delete the Draft folder.

To update an existing draft message.
1. Select the Draft folder and then select the draft message you want to update.

2. Make the desired changes to the message and select the Update Draft option from
the Message menu and close the message.

The draft message is now updated and stored in the Draft folder.

To complete and send a draft message, simply select the desired draft message and
complete it. Then send the message by choosing the Send icon on the Toolbar or select
the Send option from the Message menu. The draft message is automatically deleted
after you send it.

Creating and Saving a Template

To create a template:

1. Select the Create... option from the Message menu. A New Z-Mail® Pro template
appears.

2. Enter the subject and message text you want to be part of the template. If desired,
you can also enter an addressee. You can create a template without entering a
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subject, however a template is easier to identify in the Template folder if it contains
a subject.

3. Save the template by selecting the Save Template option from the Message menu.
The template is now saved in the Template folder.

Note: The Template folder always appears at the top of the Folder list even when it is
empty. You cannot delete the Template folder.

To update an existing template
1. Select the Template folder and then select the template you want to update.

2. Make the desired changes to the template and select the Update Template option
from the Message menu and close the template.

The template is now updated and stored in the Template folder.

To complete and send a template, simply select the template and add any additional
information. Then send the template by choosing the Send icon on the Toolbar or
select the Send option from the Message menu.

Using Attachments

The Z-Mail® Pro application allows you to attach a physical file or a pointer to a file in
a mail message. If you send a pointer to a file, then the recipient can access the file
through the FTP client. However, for the recipient to access the file through the FTP
client, the sender’'s FTP server must be running on his or her system.

All files can be either binary or ASCII. For example, you can attach a spreadsheet file
(binary) to a mail message that you are sending to a list of recipients.

Sending a File as an Attachment

To attach a file to a mail message, do the following:

1. Create a new message.

2. Choose the New... command from the Attachments menu.

3. Select or type the name of the file you want to attach to your current message.
4

File Type selection includes text, Message, Application, Audio, Image and Video.
The Subtype field will change according to the defined Type.

5. Choose the OK button to attach the specified file to your mail message.
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Attachment Description

D escrptian:

File Path:
| MM 354M il e

Tupe: Subtype:

APPLICATION — » octet-stream =
(]9 | Eancel| Help |

Viewing and Saving File Attachments

To view a file attachment of an incoming message, do the following:

1. Select the message that includes the attachment., and click on the file attachment
you want to view.

2. Choose the View command from the Attachments menu. The attached file appears
using the appropriate editor. For example, if the attached file a .BMP file, the file
will be opened using Window's Paintbrush application. Files use the File Manager
Association file extensions.

To save a file attachment to a specific location, do the following:

1. Select the message that includes the attachment, and click on the file attachment
you want to save to another location.

2. Choose the Save command from the Attachments menu. The Save Attachment As
dialog box appears.

3. Select the desired drive, directory, and file type. Enter the name of the file you want
to save the attachment as in the Filename text box.

4. Choose the OK button.

Uuencoding and Uudecoding Messages

Uuencode and uudecode allow the mail user to convert binary files from and into ASCII
format. Choose the uuencode option to uuencode a binary file before you send it out and
the uudecode option to uudecode a message you have received as a specified file on your
machine.

Note: A mail message can have both a file attached to it and a uuencoded file included
in its body.

To uuencode a file, do the following:

1. Create a new Z-Mail® Pro message.
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2.
3.

4.

Select the uuencode... command from the Message Menu.

Select or enter the file that you want to uuencode and choose the OK button. The
file will display in ASCII form in the body of your mail message.

Fill out both the To and Subject fields and send your message.

To uudecode a file mailed to you, do the following:

1.

2
3.
4

Select the message you want to uudecode.
Choose the View button to display the message.
Select the uudecode... command from the Message menu.

Select or enter the file to which you want the uudecoded message to be saved. Then,
choose the OK button. The file is now converted into its original binary format.

Note: Some mail applications can uudecode only one uuencoded file at a time.

Therefore, you may want to uuencode only one file at a time.

Using the Spelling Checker

To check the spelling of your mail message:

1.

With the cursor in the body of the mail message you are creating, select the text in
which you want to check spelling. If you do not select text, the entire mail message
is checked beginning at the cursor.

Select the Check Spelling... option from the Tools menu. The Spelling Check
dialog box appears if there are errors.

The spelling checker begins checking the selected text or the mail message. When
it finds a word that is not in any the default dictionary it displays the word in the
dialog box and highlights it in the message.

For each word found, you can:

» Correct the spelling - In the Replace With field, type the correct spelling. Or,
in the Suggestions field, select a correction. Then, choose the Replace button to
change the current word only, or Replace All to change all instances of the
word.

» Leave the word unchanged and continue the spelling check by choosing the
Ignore button.

» Skip the current word and all other instances by choosing the Ignore All button.

» Add the word to a user dictionary so the spell checker will not consider it
misspelled in the future.
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3. The Spell Checking is Complete dialog box appears when the speller is finished.
Or, choose the OK button to return to the mail message.

Retrieving Message Headers

The Smart POP feature lets you retrieve message header information only (subject, date,
time, sender) without needing to retrieve the entire message or attachments. This feature
applies only to Internet protocols.

Note: The Smart POP feature is considered an advanced Z-Mail® Pro option and
should be used with caution.

Normally, most users want to retrieve their mail messages in their entirety including
attachments. However there may be circumstances, during serial dialup for example,
when you only want to retrieve the message headers only. This is very convenient for
users who do not want to retrieve large messages from the server to their own machine
when working remotely.

The Smart POP dialog box has the following options.

Option Description

Retrieve Headers Only for Lets you retrieve message headers only for messages that

messages over xx KB are above a certain size. All messages under the stated size
are retrieved in their entirety. You can set the maximum
message size in the KB text box. (Default is 1024 KB)

Always retrieve headers Lets you retrieve message header information only from

only messages on the server. The entire message still resides on
the server. If desired, you can later retrieve an entire
message by double clicking on the header message icon or
by selecting a command from the menu or toolbar that
needs the entire message (such as reply or forward).

Always retrieve entire This is the default setting. Lets you retrieve all messages as
message you normally do. That is, in their entirety including
attachments.

Do not apply rules to the If selected, this option does not apply all rules to entire
Header Only messages messages that you retrieve. This option applies rules only
to the entire message and not the header only message.

Confirm before retrieving If selected, displays a prompt stating that the message

the entire message resides on the server and it asks you if you want to retrieve
the message now. You can also choose not to display the
prompt again by selecting the Don't display this prompt
again option.
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When a message belongs to another Z-Mail® Pro related application such as Phone Tag
or Tag-It!, or is part of a routing slip, then the message is retrieved in its entirety.

Note: If you want to retrieve header only messages at a later date as entire messages,
first change the option on the Smart POP tab to Always retrieve entire message,
then choose the Refresh from Host command from the Message menu.

Using the Offline Option

Anytime you launch Z-Mail® Pro, after you have an established account, you will need
to enter information into the Z-Mail® Pro Login dialog box. This dialog box prompts
you for your username and password. It also provides you with the Offline option.

The Offline option disables the automatic timers for sending and receiving mail. If you
select Offline, you will need to:

1. Manually retrieve your messages by selecting the Retrieve Messages option from the
Mail menu.

2. Open Outbox and manually send all queued outbound messages.

Suppose you select one interface in Custom for Dial On Demand and want to work
offline before actually sending or retrieving mail. Selecting the Offline option allows
you to prepare a batch of e-mail for sending and it will not cause your dial-up
connection to be initiated until you explicitly choose to send or retrieve mail.

Search

Search lets you search Z-Mail® Pro headers and mail messages for specific strings. A
string can be a letter, word, or phrase. To search for a specific string in a mail header or
message body, do the following:

Personal folders search criteria
Search Condition
If |Subiect ﬂ |E0ntains ﬂ || ﬂ
Folders to gearch Options
docs - Selact all
Draft = 22 [ Casze sensitive
dad
expand j Unselect al ™ wildeard/Regular expression
Go | Lloze |

1. Choose the Search... command from the Message menu. The Search dialog box
appears.

2. Inthe Search Condition section enter the following:
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* Left box: Select which field to search for the string: Subject, From field, To
field, Sender or Message body.

« Middle box: Select the determining parameter: Contains, Does not contain,
Equals to or Is not equal to.

* Right box: Enter the string match in the search.

3. Inthe Folders to search section, select the folder or folders you want searched.
Choose the Select all button if you want all the folders searched.

Note: On remote servers, only the selected mailbox is searched.

4. In the Options section, select Search Trash if you want the Trash folder
automatically searched each time. Select Case sensitive if you want the string you
are searching for to be in the exact case you entered. Select Wildcard/Regular
Expression if a wildcard symbol is included in your search string.

5. Choose the Go button. A window containing a list of all messages that contain the

stated search conditions appears. The date, subject and sender of each message are

listed.

Double click to view the selected message.

Creating Your Personal Address Book(s)

You can access the Address Book by choosing the Address Book... command from the
Services menu in Z-Mail® Pro, or by choosing the Address Book... button located on the
Z-Mail® Pro compose window. The Z-Mail® Pro compose window appears when you
choose the Create... command from the Message menu.

Use the Address Book, which you access from the Services menu, to set up or create
your Address Book. This dialog box lets you add individuals to your list, create new
groups, and add members to new or existing groups.

Use the Address Book, which you access from the Z-Mail® Pro compose window
(Create command), to add recipients to a message you are about to send. You can add
new individuals to your list or add members to an existing group, butafmotcreate

a new group.

Adding Individuals to an Address Book

To add an individual to an Address Book:

1. Open the Address Book from the Services menu or the Z-Mail® Pro compose
window and enter the user's name and e-mail address. For example,

John Doe <john@netmanage.com>

555-111@mcimail.com
71234.1234@compuserve.com
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john@[156.27.10.107]

2. Choose the Add Name command from the Edit menu. The name appears on the list
and is automatically added to the Address Book.

Adding Groups to an Address Book
To add a group to the Address Book, do the following:

Note: You can only add a group to the Address Book that you accessed from the
Services menu.

Choose the Address Book... from the Services menu.
Open the Address Book you want to add the group to.
Type the group name and then check the Group option.

Choose thddd Name command from the Edit menu.

o w0 E

Select the name or names you want to add as a group members and choose the OK
button. The selected names appear in the Group Members list. All group names
appear in the Address Book dialog box in square brackets. For example,
[groupnamé

6. Select an individual name and choose the Members... command from the Edit menu
to see if they belong to a group.

You may rename entries by selecting them and pressing the Rename button. Select one
or more entries and press the Delete button to remove them from the Address Book.
Addresses are automatically saved when you enter them.

Creating Additional Address Books

You can create a new address book or add additional address books that are stored
locally. You can also allow access to an existing address book that resides on a remote
host.

To create a new or add another address book:

1. Open the Address Book from either the Services menu or the Z-Mail® Pro compose
window.

2. Select the Add Address Book... option from the Address Book menu. The Add
Address Book dialog box appears.

3. Select the location of your address book: Local or Remote. For creating and
accessing address books which are stored on a mainframe, please refer to the
PROFS/OV Transport section.
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4. Name: Enter the name of the new Address Book, this will appear in the Address
book list.

5. File text box: Enter the Address Book's path and filename. You can enter the path
directly or use the Browse button to browse for the selected drive and directory. For
a new address book, you will be prompted to confirm you want to create a new file.

Note: Your Address Book filename must use a .ADB extension. For example, the
new Address Book called Joe could reside in: C:\NETMANAG\JOE.ADB.

6. Host (remote): Enter the name of the host in the Host text box. This is where the
Address Book you want to access remotely is stored.

7. Choose the OK button.

You can open the remote Address Book by double clicking on its name in the listbox.
The first time you open the book, the application connects to Directory Server,
downloads all the addresses, and displays them in the listbox.

These addresses are cached in a local file so you can open the Address Book over and
over without having to go through the network. However, if you want to update the
Address Book contents from the network, then choose the Update Remote command
from the Address Book menu.

Deleting Existing Address Books

You can also delete existing address books by selecting the address book you want to
delete, and then selecting the Delete option from the Address Book menu.

ECCO Setup Option

The ECCO Setup option in the Address Book dialog is provided for the convenience of
ECCO users. If you have the ECCO software package on your system, you can add e-
mail addresses from your ECCO phonebook into one of your Z-Mail® Pro address
books. You can choose to add all the e-mail addresses from your ECCO phonebook or
only a selected set of addresses. Do the following:

1. Open the Address Book from the Services menu and choose the Add New Book...
command from the Address Book menu.

2. Enter the name of your ECCO phonebook as you want it to appear in your Z-Mail®
Pro Address Book listings in the Name text box. Enter the path and filename of the
ECCO phonebook file in the File text box.

3. Choose the ECCO Setup...command from the Options menu. The ECCO Setup
dialog box is displayed.
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4. Enter the column name from your ECCO Address Book that contains e-mail
addresses into the Field Name text box in the ECCO Setup dialog box. The default
is E-Mail.

Note: In releases prior to ECCO 3.0, the column name for e-mail addresses was an
optional, user-specified name in the ECCO phonebook. Therefore, the name
you enter in the Field Name text box depends on what you named the
column in your ECCO phonebook. For example, if the ECCO phonebook
column name was E-Malil, then you need to enter E-Mail in the Field Name
text box.

5. In the Criteria drop-down list box, select All to add all the e-mail addresses from
your ECCO Address Book to the Z-Mail® Pro Address book. Or scroll to select an
alpha character to add only the addresses beginning with that character.

For example, if you want to include only e-mail addresses beginning with the letter
B, select the letter B from the list.

Setting Rules

You can associate attributes to your incoming messages by selecting the Rules... option
from the Services menu. For example, you can create a rule so that all messages
addressed to you are automatically moved to a specific folder. Or, create a rule so that all
messages you receive from a particular person are automatically forwarded to another
person.

Chameleon ZMail Pro rules
Rules: n
Bule name: |Vaca||un Rule
* fy rule
Activate
" This iule applies to any message
Mew & Only when criteria is matched
Delete String to match: |miEhaE|k
Add Field:  |From ~| [ Matchcass
Modify Action
" Move to Folder :
" Fomard [
Close: " Delste
Help * RunScript : Edit seript
c:vnetmanag. 324maill. vba DEFALULT_OF « Browse
— =]

The following steps show you how to create a rule where all messages whose chosen
field contain a specific name or string are automatically moved to specific folder.

1. Enter the name of the rule in the Rule name: field. In this example, test2 is the
name of the rule.

2. Enter the string (single word or several words) you want the system to search for in
the String to match: field. In this example, the name Support is the string.
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Select the field (From, To, Subject, or Sender) where the string is located. In this
example, the name Support would have to appear in the To field.

Select the action you want executed when the matched string is found: Move to
Folder, Forward, Delete or Run Script (see online help for information on running
scripts). In this example, any message whose To field contains the name Support
will be automatically moved to a folder named Urgent.

If you want to select a folder to which incoming messages are automatically sent,
the folder does not have to previously exist. You can define the folder when you
make the rule.

Choose the Add button to add the new rule.

The Rules list window, in the right of the dialog box displays all rules. Active rules
are marked with an asterisk. Select a rule and chose deactivate or activate ( the
button toggles between the two states) to change the status of the rule. The Up and
Down buttons allow you to change the positions of rules in the list. If you have
more than one rule that contains the identical string to match, then the system will
apply the first rule that is listed in the Rules list.

Using Command Line Options

You can use one or any possible combination of the following options to customize your
Z-Mail® Pro login. The options are:

-u{ usernamgautomatically enters the user's Mailbox name.
-p{ password automatically enters the user's Mailbox password
-offline enables the Offline option

-nologoremoves the splash screen (large Mailbox with copyright information) upon
startup

To set one or more Z-Mail® Pro command line options, do the following:

1.
2.

Single-click (highlight) your mail icon. Z-Mail® Pro can be closed or opened.

From the Program Manager, choose the Properties... command from the File menu.
The Program Item Properties dialog box appears.

Enter the option or options at the end of the Command Line text box.

For example, to set up Z-Mail® Pro so that your username and password are
entered automatically, thus bypassing the login box, enter the -p and -u options as
follows:

C:\NETMANAG\MAIL.EXE -UJack -Pmypassword

where Jack is the user's mailbox name and mypassword is the user's (Jack) mailbox
password.
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Note: All options are case insensitive.

If you use the -p option your password will appear in the command line text box,
thus making mail less secure.

Sorting the Date, From, Subject and Status Fields

You can sort by the Date, From and Subject fields while viewing the contents of a folder.
The Date column is The From field is arranged The Subject field is also

1. Select the folder containing the messages you want to sort.

2. Double-click in the field above the column of :

» Date: sorted by either the date the message was sent or received.

» From: sorted alphabetically to allow you to view all messages sent from a
particular sender.

» Subject: sorted alphabetically to allow you to group messages sent about the
same topic.

» Message icons: sorted by Status

Message Priority: All messages in the folder are sorted in order of High,
Normal, and Low priority.

Message State: Select this option to sort your messages in order by the
following states: marked, header only, unread, and read.

Message Type: Select this option to sort your messages in order of text
messages only and then messages with attachments.

The arrow to the right of the Subject field determines how messages in each field are
sorted:

Attaching a Signature

You can design a signature that is automatically attached to the end of each mail
message you send out. To create a Z-Mail® Pro signature, do the following:

From within Z-Mail® Pro, select the Signature... option from the Settings menu. The
Signature... dialog box appears.

1. Type in your own personal signature that you want to attach to outgoing mail.

2. Ifdesired, select the Attach to outgoing mail box if you want it automatically
attached to every outgoing message.
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Changing Your Password
You can change your password at any time. To change your password, do the following:

1. Select the Password... option from the Settings menu. The Password dialog box
appears.

2. Enter your current password in the Old Password field.
3. Enter your new password in the New Password field.

4. Enter your new password again in the Confirm Password field and choose the OK
button.

Note: You can change the passwords for all users by logging in as Postmaster and
accessing the Mailboxes dialog box.

Setting Timing Parameters

You can specify Retrieve timing parameters by selecting the Timers... option from the
Settings menu.

Retrieve time values specify how often mail is retrieved from the mail server. Your

Inbox queries the server periodically, as specified by this time value. You can also select
the Retrieve Mail option from the Message menu to manually retrieve server mail, if

mail is not automatically retrieved.

Using IMAP Transport

IMAP4 is used to manage messages on a remote host. IMAP provides access to multiple
hierarchically structured mailboxes on the same or different remote servers and to
shared mailboxes between users. Only headers are retrieved, which avoids unnecessary
retrieval of large attachments and saves bandwidth. When a message is viewed, it is
fetched and stored online in the local cache for the duration of the mail session.

Configuring IMAP

You may access multiple remote servers, or add numerous occurrences of the same
server with different user names. Additional servers are added through the Network
Settings dialog. Refer to the previous section Setting Up a New Z-Mail® Pro account
for a User, for detailed information on the Network Settings Dialog.

Each server you add appears as a separate branch on the Remote tree displayed in the
left pane of Z-Mail® Pro’s main window. Messages can be moved between mailboxes
on the SAME server (same user tree), or to local folders.
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Shared Mailboxes

IMAP allows access to shared mailboxes on the remote host. Messages can be accessed
by a number of users. Messages are not deleted from the shared mailbox unless they are
explicitly deleted by the Delete command.

Mailboxes are shared in one of two ways, depending on the type of server being used.

» Cyrus types of servers: When you log in, all shared mailboxes are displayed, and
private mailboxes are in a sub-folder of the users inbox. The system administrator,
by modifying permissions, is responsible for restricting the access to private
mailboxes.

*  Washington university types of servers: When you log in, only the user’s private
inbox and tree of private folders. To share mailboxes on this system, additional
mailboxes must be added through the IMAP4 tab of Network Settings. Enter the
path o the other mailboxes you need to see into the shared mailbox textbox. The
mailboxes are displayed in accordance with the permissions the login user has been
allocated.

Using Z-Mail® Pro Fax

Z-Mail® Pro, used in conjunction with the separate Chameleon Fax Server application
lets you create, send, receive, and view faxes. When creating a message within Z-Mail®
Pro, you can send a message to both mail and/or fax addresses. Working with fax
messages and attachments is basically the same as working with mail messages.

Faxes are sent to a Fax Server computer for translation into a faxable format before
being sent. The Fax Server translates the fax message into TIFF or DCX images. The
Fax Server is a mail client with unique capabilities designed specifically for dealing with
fax messages. For information about the Chameleon Fax Server, refer to the Chameleon
Fax Server guide.

Note: Before proceeding, confirm that the Fax Server Administrator has authorized you
as a licensed Z-Mail® Pro Fax user.

Configuring Z-Mail® Pro Fax

To configure Z-Mail® Pro Fax, choose the Internet Fax tab from the Network Settings
command and enter the Fax Server’'s e-mail address (for example,
faxserver@hostserver). You can add multiple fax servers, each with its own name. If
uncertain, contact your Fax Administrator.

Folders are used in the same way as Z-Mail® Pro folders, except for fax messages, the
special folder defined will be displayed as black, by default. Fax folders can be designed
to automatically store any incoming fax messages, outgoing faxes, fax attachments and
notifications according to the specifications set.
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Creating/Sending a Fax Message

You can both send and receive faxes, directly from Z-Mail® Pro. The same fax message
can also be sent as mail to an e-mail address.

To create and send a fax message:
1. From Z-Mail® Pro, choose the Create...command from the Message menu.

2. Fillin the From, Subject, and Confirm information as requested. You may also
enter a comment, if desired.

3. Choose the Internet Fax transport in the Transports drop down list and type in the
fax phone number.

The message will now be marked as a fax. When sent, the message will be routed to the
Fax Server of your choice. Once at the Fax Server, the message and any attachments are
converted to TIFF or DCX images then transmitted to the fax address provided.
Notification will be sent when the fax arrives at its destination. If the fax fails, for

whatever reason, the sender also receives notification.

Sending Attachments with a Fax

Files created and saved in any application that is supported under Windows (and
installed on the Fax Server) can be attached to the fax message. The recipient of the fax
message can then view and print the message and attached document as a TIFF or DCX
image.

To attach a file to fax messages:
1. Choose the Attadbutton.
2. Adialog similar to the Open File dialog is displayed. Choose or enter the file name.

3. Choose the OK button. The attached file will now be seen in the mail list and will
be sent along with the fax message to the designated fax address.

Notification

Whenever a fax has been transmitted, successfully or unsuccessfully , a notification
message is sent to the originator of the fax stating the fax status.

Receiving and Viewing an Incoming Fax

Incoming faxes are very similar to incoming mail except that fax messages and their
attachments are images that are converted from a text file or data to an image file such
as a TIF or DCX (depending on the fax board). A fax message can only be manipulated
as text if an Optical Character Recognition (OCR) utility is available. Incoming faxes
are listed as such in the incoming mail display.

Chameleon ATX User's Guide 159



To view a fax select the fax message from within Z-Mail® Pro. You can also use
NEWTView to view the fax. Before viewing a fax message, save the fax image to a
directory of your choice. Then associate the viewer with either TIFF or DCX file type to
display the message.

Using PROFS/OV Transport

Z-Mail® Pro provides electronic mail services between your PC and IBM hosts using
PROFS/OV. The PROFS/OV communications run over a 3270 Terminal session, using
HLLAPI.

PROFS/QV is an electronic mail transport that allows your PC to communicate with an
IBM mainframe, using the IBM internal mailing system (PROFS or OfficeVision/VM).
This universal Malil client allows easier migration from a Mainframe-only environment
to a LAN-based environment, as follows:

* You can send a mail message to both Internet and PROFS/QV recipients at the
same time.

* You can receive mail in your Inbox folder from both Internet and PROFS/OV
senders.

Configuring PROFS/OV Mail

Before starting PROFS/OV for the first time, you must set up information for the
underlying 3270 Terminal session and Z-Mail® Pro’s connection to that session, as
follows:

1. Create and save a TN3270 Connection Profile, then exit the TN3270 application.

2. Open the Z-Mail® Pro application and choose Mainframe Mail from the Z-Mail®
Pro Transports Setup dialog.

3. Specify the appropriate information in the Mainframe Mail dialog box of Network
Settings.

Note: After you have specified these settings, Z-Mail® Pro will automatically invoke
the TN3270 Connection Profile when you choose to create PROFS or OV mail.
Z-Mail® Pro will also automatically close the connection when it is exited.
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Setting Up the TN3270 Connection Profile

TN3270 |NwdSAA | Comsx  |NTServer| 8022
Desctiption |Un|versny Addd
Host [123.9033144 || Modiey
gor [3 B  Made Z2dx80) v Deleta
ShortName forHLLAPE [P =] More Mew
Login Prompt: |USERID leon
Userarme: |sham Help
Pwdl. Fromat: |PASSWORD

Fassword: |*’“"’“"’“"

Login Script: |

Logout Script: |

Connection Profile

Type Name +
TN =
TN3Z70  haifad 1
M =~

The TN3270 Connection Profile should contain the following information:

Field

Description

Host

Port

Model

Short Name for
HLLAPI

Login Prompt

Username

Pwd Prompt

Description

Specify the name of the connection profile. Later you will specify
this same name in the Network Settings of the Z-Mail® Pro.

Specify the name or IP address of the IBM host to which you want
to connect.

Specify port 23.
Specify Model 2.

To fill in the short-name box, select a letter from the drop-down
list. You cannot simply click the cursor in the box and type the
letter. Optional.

The login prompt that you would see on your screen. Should be
used if automatic login is desired. Case-sensitive.

The user name that you use to login. Should be used if automatic
login is desired.

The host password prompt that you would see on your screen.
Should be used if automatic login includes password. Case-
sensitive.
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Field Description

Password The password that you normally enter after you have entered your
username. Component of automatic login with password.

Icon You can save the current Connect Profile description as an icon.
This is unnecessary for use with Mainframe Mail because the
TN3270 profile is invoked by Z-Mail® Pro automatically.

Login Script You can type or browse to select the name of a script file that
automatically logs into the host when you use connect to a host by
using this profile.

Logout Script You can type or browse to select the name of an existing script file
that automatically logs out of the host specified by this profile
when you close the application.

This is unnecessary for use with Mainframe Mail because Z-Mail®
Pro automatically logs out of the TN3270 session.

Connection The list box contains the connection profiles that you have already
profile list defined.

Prompt for Automatic Login

If you want to include the Login Prompt and the Password Prompt as part of your
Connection Profile, you should connect and log in to the host and write down the
prompts that are displayed for username and password. The specified text string must
match the prompts (or a portion of the prompts) as they are displayed. They are case-
sensitive.

Getting to the Ready Prompt

To set up the underlying TN3270 session for Mainframe Mail, you must create a profile
that gets you to the host's Ready prompt. Therefore, your profile must either contain a
login script that brings you automatically to that point, or the following components of
automatic login: login prompt, username, pwd prompt, and password.

Note: See TN3270 online help for additional information.

Create Mall

If only the PROFS/QV settings are enabled, mail is automatically sent via the
PROFS/OV transport. If the SMTP Network settings are also enabled, the New Malil
dialog box contains a drop-down menu to select PROFS/OV or SMTP:

After selecting PROFS/QV, type the address you require and press ENTER. Note that
when the address appears in the field bele@PROFS:=is automatically added to the
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address. (If the SMTP is selected, pressing ENTER copies the address to the field
below, without any additions.)

If the PROFS/QOV address is written on the mainfram@sesid)host, type the
mail address field aserid@host . After pressing ENTER, it appears in the field
below as

<@PROFS:userid@host> (or as<@OV:userid@host> ).

=3 New Mail #1 [-]~
File Edit Message A Tools Feelings Help

E A =

Date:  Wed, 12.Jul 95 15:10:56 PDT [__Address.. [ Modify. |[ Delete |

Fiom: | @netmanage.co.il [#] [PrOFs]#][Boc] #]]

To: <@PROFS:Belly>
Cc: <@PROFS:Ronen>
Bec: ¢@PROFS:Gael>

Subject: |
Confirm: [~ Read [C Delivery Priority: [Normal :

Folder.

Optimize Sending of Large Messages

You can optimize the way your message is sent to the mainframe according to your
personal usage:

1. Choose the Setting -> Network Setting dialog. Select the PROFS/OV property sheet.
2. Choose the Advanced button.

3. Select thé&Jpload Mode parameter. Its possible values are:

» TEXT- upload message line-by-line. This is suitable for short messages, possibly

containing dot commands.

* FILE (or.GF) - message file is transferred to the mainframe and inserted to
PROFS/OV in a screen-by-screen mode. When sending large messages this mode is
faster that the previous one. It supports dot commands.

 .IM - message file is transferred to the mainframe and inserted to PROFS/QOV at
once. This is the fastest method, but any dot commands in the message will not be
processed by PROFS/OV.

4. Choose OK.

Downloading Mainframe Address Books

PROFS/OV can access and download directories from the host’'s mainframe to your
local system. To update an existing address book with the mainframe address books
(nicknames and Distribution Lists), choose Update Remote from the Address book
option. You can create a new address book to contain these addresses:
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Choose Address book from the Services menu.
Choose Add New Book... option from the Address book menu.

Select PROFS or OV.

A

Enter the name you want the address book to be called.

Note: This can be any name you choose - it does not have to be the name of an
address book on the mainframe.

5. If you want to download a specific file, type its mainframe file name (i.e. <file
name> <extension> <disk>) in the Host text box.

6. Choose OK.

7. Choose the Update Remote command from the menu Address Book., or double click
on the Address Book’s name.

Restricting Address Book Download

The default address book download will bring all the nicknames and distribution lists
from the mainframe, regardless of their location (i.e. including other disk you have
access to). In large enterprises this operation might take a long time and overflow the
capacity of the Z-Mail® Pro Address Book.

If you want to restrict the scope of download to your local disk, do the following:

1. Postthe Setting -> Network Setting dialog. Select the PROFS/OV property sheet.

2. Choose the Advanced button.

3. Select théADB Retrieve Locally parameter and set it XES
4. Choose OK.

News

You can configure news servers through the news tab of network settings. For details on
using this option, refer to the Forum chapter.
Rapid Search

Choose Rapid Search from the Services menu to activate the Rapid Search application.
Refer to the Rapid Search chapter and online help for more information.
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Mail Alias Viewer

Choose Mail Alias Viewer from the Services menu to activate the Mail Alias Viewer
application. Refer to the Mail Alias Viewer chapter and online help for more
information.

Using the Outbox

Anytime you send a message it first goes to the Outbox and then is delivered to the mail
gateway, if defined. This includes all messages sent using Z-Mail® Pro, Tag-It!, Phone
Tag, and messages you post using Forum and NEWTCal.

The Outbox attempts to deliver a message as soon as it receives it. Messages that
remain in the Outbox past a specified amount of time expire and Z-Mail® Pro messages
are returned to the sender as undeliverable. If one of the messaging applications (such
as Z-Mail® Pro, NEWTCal, and Forum) was invoked in an Offline mode, the Outbox
would accumulate the sent messages until an explicit Send is performed.

Opening the Outbox

You can start Outbox as you do other applications or you can choose the Outbox
command from the Services menu.

Using the Messages Menu

The Messages Menu in Outbox lets you view, send, and delete messages in the Outbox.
Simply select the desired message and then select either the View, Send, Delete, or
Abort options.

You can also use the Pause Sending Message option to stop messages in the Outbox
from being sent. This is especially useful if you are using a dialup connection.

For example, before you disconnect you can select this option and the Outbox will not
try to send messages. Then, when you reconnect you send your messages again by
deselecting this option.

Use the Check Unmatched Message Files... option from the message menu when sent
messages fail to arrive to the Outbox. This option manually places the sent messages
into the Outbox list.
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Z-Mail® Pro Administration

The Z-Mail® Pro Administration application allows you to manage your Z-Mail® Pro
database. To use Z-Mail® Pro Administration, do the following:

1. Quit the Z-Malil® Pro application if it is open.

2. Start Z-Mail® Pro Administration. The Z-Mail® Pro Mailbox Administration-
Login dialog box appears.

3. Enter the username and password and choose the OK button. The Z-Mail® Pro
Administration window appears. There are five options available:

* Merge two mailboxes

» Compact mailbox

» Generate mailbox from message files
* Remove unmatched entries

* Rebuild folder information

4. Select one of the five options and choose the Start button.

Merge Two Mailboxes

Select this option to merge the messages from any mailbox into the current mailbox.
Messages in the source mailbox remain unchanged. All messages are copied into the
current user's mail directory, and are added to the current mailbox. The mailboxes
(user's .DAT files), in the email/user directory, must have the same name.

Compact Mailbox

Select this to reduce the mail database file size by eliminating empty space in the
Mailbox that occurs when you have deleted numerous messages.

Generate Mailbox from Message Files

Select the Generate mailbox from message files to generate or create a new database.

Remove Unmatched Entries

Select the Remove unmatched entries option to remove entries in the mail database that
do not have actual message files associated with them.

Rebuild Folder Information

Select the Build Administration folder information option to have the Z-Mail® Pro
Administration rebuild the folder hierarchy from the files and directories on the disk.
Choosing this will automatically be followed by a Generate to rebuild the mail database.
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Note: Z-Mail® Pro Administration renames the folders, based on the names of the
directories on the disk. If desired, you may rename your Z-Mail® Pro folders
later. However, this should only be necessary for folder names that could not be
used as a DOS directory name.

Additional Online Information

The online help file for Z-Mail® Pro includes a description of each menu command,
plus the following information in the "How to Use" section:
» Creating and Sending Mail Procedures

e Creating and Using an Address Book

» Defining a Z-Mail® Pro server and Gateway

» Displaying Mail Messages

» Faxing a Message

* IMAP Transport of Mail

PROFS/OV Transport of Mall

» Saving Changes to a Configuration File

e Setting Up Z-Mail® Pro

» Using Command Line Options

* Using the Outbox

» Viewing and Editing HTML Documents

Note: For more information about Z-Mail® Pro Administration, Outbox, and the
address book, refer to the application's online help.

Troubleshooting

If you experience difficulties using Z-Mail® Pro, refer to the following items:

General Information:

O If you are having trouble starting Z-Mail® Pro, make sure the path in your mail.cfg
file correctly points to your mailbox directory.

O If you cannot open your mailbox because you forgot your password, then edit the
MAIL.CFG file and remove the encrypted password next to your name. For
example, if John=fg78%3$, then fg78%%$ is the encrypted password.

0 Use the Ping application to verify connectivity to the domain portion of any
destination address if Z-Mail® Pro reports a failure to deliver. Verify connectivity
to your mail server is defined.
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O

Use the logging feature ( form the Settings menu) to help diagnose client
transmission and mail server retrieval problems. Check replies for connection
errors or destination address errors.

Make sure the user name portion of the destination address is defined at the
destination. The Postmaster may define new users by using the Mailboxes item
under the Services menu.

Internet Mail Information:

O

If you are having trouble retrieving Internet mail, make sure that the remote system
supports the SMTP protocol. Verify that the POP2 or POP3 daemons are running
on the mail server system. The POP2 known port is 109 and the POP3 port is 110.
To verify if the daemons are running, use the Telnet application to connect to ports
109 or 110. The system replies with a message indicating if the correct daemons
are running on ports 109 or 110.

If you have trouble sending Internet mail, verify that SMTP is available on the

remote host, and you have specified the correct mail gateway address under Internet
Mail Network. Also verify that the To: field (destination address) is complete. For
example, steven@netmanage.com.

For POP2 only, you also need to verify that the mail directory settings are correct.
Make sure that your password and mail path (/user/spool/mail/username) are
correct. Contact your system administrator for more information.

Mainframe Mail Information:

U
U

U
U

O
1.
2
3

Make sure a TN3270 profile has been defined and saved.

Make sure that the TN3270 profile specifies port 23, model 2, and brings you to the
host Ready prompt. See TN3270 Profile for additional information.

View the TN3270 window to verify that it is at the Ready prompt.

Check the Initialization command specified for Mainframe Mail Network Settings:
it has to link the PROFS/OV mini-disks and set PROFS or OV/VM to line mode.

PROFS/OV in line mode will generate the following sequence of requests:

Addressee
Subject

Message Body

Outbox Information:

O

O

If you are having trouble sending mail, make sure that the remote system supports
the SMTP protocol.

If you have trouble sending mail, verify that SMTP is available on the remote host,
and you have specified the correct mail gateway address under Network settings.
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0 Use the Ping application to verify connectivity to the domain portion of any
destination address if Outbox reports a failure to send.

Mail Administration Information:
O Back up the user's e-mail directory and then do a Generate or Rebuild.

Chameleon ATX User's Guide 169






Chapter 16. Indexing Agent and Rapid
Search

Indexing Agent

The Indexing Agent automatically tracks and indexes all text you have retrieved. It is
used with Rapid Search to provide full-text index creation and rebuilding for the
WebSurfer and Z-Mail® Pro applications.

The Indexing Agent must be running before you can open the Rapid Search application.
Also, the Indexing Agent must run continuously so that Web pages can be indexed. To
ensure that the Indexing Agent is always running, the Chameleon setup program places
it in the Program Manager startup group. The Indexing Agent will not work unless it is
minimized.

Note: Additional Indexing Agent functions are available through the Control Menu.
To access the Control Menu, click once on the minimized Indexing Agent icon to
display the list of commands available.

Rapid Search

Rapid Search finds all text indexed by the Indexing Agent in both the WebSurfer and Z-
Mail® Pro applications. All indexing is performed as a background task and requires
no action by the user.

In WebSurfer, all text from all Web pages you have viewed will be indexed. In Z-Mail®
Pro, all text from all messages in your Z-Mail® Pro database will be indexed, whether
or not you have read them. You can start Rapid Search from the Rapid Search icon, or
directly from within WebSurfer and Z-Mail® Pro.

To start a search, do the following:

From WebSurfer, choose the Rapid Search command from the Tools menu. From Z-
Mail® Pro, choose the Rapid Search command from the Services menu.

The Rapid Search dialog box is displayed.

Enter information in the fields that are described in the following table:

Field Description
Search For Enter the text that you want to find.
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Field Description

In Title Only Search for text that appears only in the title of a Web home
page or the Subject field of a Z-Mail® Pro message.

Only Include Items Box
Web Search for text that appears only on Web pages.
Malil Search for text that appears only in Z-Mail® Pro messages.

Note: Select both check boxes to search for text that appears on Web pages and in Z-
Mail® Pro messages.

From/Site Enter the name of the message's author to search for in Z-
Mail® Pro messages. Enter the name of the Web site (for
example, netmanage.com) to search for in WebSurfer.

To/Cc Enter the name of the recipient to search for in Z-Mail® Pro
messages. This field does not apply to Web sites.

Word List Shows the list of words you want to search for.
Folder/Date/From/Site/ Shows results of a completed search.
Subject Box

For Web pages:

* Folder column shows the location of the stored text (for
example, from your hot list) on your local drive.

» Date column shows the date the search was conducted.
e  Site column shows the Web site name.

»  Subject column shows the text found.

For Z-Mail® Pro messages:

» Folder column shows the location of the text found (for
example, in your Inbox) on your local drive.

» Date column shows the date the message was created.

e From column shows the name of the person who created
the message.

*  Subject column shows the topic of the message.

When you have filled out the fields required, choose the Find button or choose the Find
command from the Edit menu to begin the search.
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Note: You need to type text in at least one field in the Rapid Search dialog box to
conduct a valid search. You can also type text in more than one field to do
multiple searches.

Additional Online Information

The online help files for Rapid Search and Indexing Agent include a description of each
menu command.

Troubleshooting

If you experience difficulties using Rapid Search or Indexing Agent, refer to the
following items:

O If you cannot open Rapid Search, make sure that the Indexing Agent is already
open. It can only run minimized.

0 Make sure that you have enough memory and disk space to run both Rapid Search
and Indexing Agent at the same time.

0 Close and reopen Rapid Search if you are receiving frequent error messages.

0 Rebuild your index by choosing the Re-create Index command from the Control
menu if your system starts to run very slowly or crashes.
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Chapter 17. Mall Alias Viewer

Mail Alias Viewer provides you with a list of all mail addresses listed under an alias.
For example, Mail Alias Viewer will list all the mail addresses that are included when
you send mail to the alias, salesteam@netmanage.com.

Using Mail Alias Viewer

To use Mail Alias Viewer do the following:

1. Open the Mail Alias Viewer application or Alias Viewer from the Services menu in
Z-Mail® Pro.

= Mail Alias Viewer - MAIL.NETMANAGE.COM n -
File Settings Help

Host  |RAINEDW/MNETMANAGE.C E Aliag: |DDE@NETMANAGE.EDM El Expand I

<alberti@netmanage. co.ilx
<art. schmidi@engdns. bandley? >
| <brent i '
<|anet@engdns.bandley1 >
<jeani@netmanage. co.il> Addressbook,
<shanif@netmanage. co.il>
<wdh(®age. diego: S o Mail
K.aren Ewing [contractor] <karen@netmanage. com: S T
Linda Sachs <lindasi@netmanage. com?

For Help, press F1 Elapsed Time 0:13 Mumber of users:10

2. Enter the following information:

» Host: the name of the Host where the alias list for the group you want to
expand is stored. (Ask the system administrator of this mail gateway for the
name of the Host).

» Alias: the name of the Alias you want to expand.
3. Choose the Expand button.
All addressees under this alias are listed.

4. Select one of the email addresses. It appears in the status bar.

5. Select one of the following options:
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» Addressbook: Saves the address to the address book you select.

* Send Mail: Brings up the edit message dialog, with the address automatically placed
in the from field.

» Abort: The Expand button toggles to Abort, when the expand process is in process.
Choose Abort to terminate the process, before completion.

Personal Icon Database

To view Personal icons associated with an email addressee, select the personal icon
library location:

1. Select Personal icon database from the Settings menu.

2. Select the appropriate drive and directory where the icon files are stored.
3. Choose the OK button.
4

The personal icon of the addressee is displayed, when the address is selected.

Additional Online Information

The online help file for Mail Alias Viewer includes a description of each menu
command and a "How to Use" section.

Troubleshooting
If you experience difficulties using the Mail Alias Viewer, refer to the following items:

0 Make sure the host name to which you are trying to connect is correctly entered.

O If Mail Alias Viewer reports a failure to connect, use the Ping application to verify
the connection to the host.
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Chapter 18. Mailbox Converter

The Mailbox Converter is used to convert messages stored in various Mail systems into
the Z-Mail® Pro message base. This conversion process needs to be run only once, to
convert accumulated messages from a different Mail system into Z-Mail® Pro. You may
also run the Mailbox Converter from a command line.

How to Use the Mailbox Converter

To use the Mailbox Converter, close your messaging applications and Forum, then
complete the following steps:

1. Start the Mailbox Converter application.

2. At the prompt, Z-Mail® Pro Login, enter the username and password as you use
when you login to the Z-Mail® Pro messaging applications .

Note: If any messaging applications or Forum are already running, close them at the
prompt.

3. Select the type of source Mail system you want to convert and enter any specific
information that the source Mail system requires:

e cc:Mail: Enter the VIM Login required when you run cc:Malil.

» Eudora: Enter the directory where Eudora Mailboxes (files) are located or the
Mailbox name.

 PROFS/OV: Not necessary to enter any details. The necessary information is
retrieved from Mail's settings.

» UNIX: Enter the directory where the UNIX Mailboxes (files) are located or the
Mailbox name.

* Z-Mail® Pro: Select the Z-Mail® Pro username for the mailbox you want to
convert. Select the Convert Aliases check box to have all your aliases
converted into a Chameleon ATX mailbox.

4. The Mailbox Converter dialog appears.
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5.

8.

L |

= Mailbox Converter

Select a zource folder and a destination falder for conversion.
A new destination folder can be created.

Source folders Destination folders

LOGIMPRO +
M METYISIO |
LOGINFRO OPERATOR
METYISI0 out
OPERATOR Routing
TIPS TEMP ||
TRASH Template -

[® Mark meszages as "Read"

Select one or more source folders or choose the Select All button if all folders are
required.

Source folders are the Mail folders containing the Mail in the original format that
you want to convert into Z-Mail® Pro.

When converting Eudora Mail, PROFS/OV or UNIX, select Mark messages as Read
check box for all Mail to be displayed as read. If the check box is not selected, all
Mail will be displayed as unread.

When converting cc:Mail, the source folders list contains only the Inbox folder.

Select the destination folder where you want the selected mail to reside after
conversion.

If you require an additional folder select the Create button and type the folder name
in the New Folder dialog.

Selecting the Convert All button overrides the destination folder selection.

Choose the Convert button, to convert the Mail in the Source folders and place into
the destination folder.

Or choose Convert All, to convert all the Source folders into Z-Mail® Pro folders
with the same name as the original source folder.

In case of a duplicate name (same name for source and destination folder), the
Folder already exists dialog appears.

Repeat this procedure, as necessary, for converting other folders.
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9.

Choose the Update Folders button. Your Mailbox is regenerated to include the
converted files.

10. Choose the close button. If you did not chose to update folders earlier, you will be

prompted to do so now.

Folder already exists!

This dialog appears when the folder you are trying to create already exists as a Z-Mail®
Pro folder. Choose one of the following options:

Append messages to existing folder

The messages in the selected source folder will be converted and placed into the
existing Z-Mail® Pro folder of the same name.

Always Append messages to existing folders

The messages in the selected source folder will be converted and placed into the
existing Z-Mail® Pro folder of the same name. This action will automatically be
taken for any future source folders with the same name as destination folders. This
message will not appear again.

Skip this folder

The selected folder will not be converted.

Create a new Z-Mail® Pro folder

Enter the name you require for a new folder. This folder will be created and the
Mail for the selected folder converted and placed here.

Select another existing folder

Select which folder you want the Mail from the selected source folder to be placed
in after conversion.

Running Mailbox Converter from a Command line

Do the following to run Mailbox Converter from a command line:

1.
2.

Select Run... from the File menu in the Program Manager.

Enter the application name and path, such as

C:\netmanag\converter.exe

Add the appropriate source system parameter:

-S source system, such as PROFS, ccmail, Eudora, UNIX
Note: this parameter must be entered

Add any other required source system parameters:
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-d Eudora mailbox directory

-f Eudora or UNIX mailbox file
-mp Z-Mail® Pro password

-mu Z-Mail® Pro user

-p password in cc:Mail

-u username in cc:Mail system

Note: -d and -f parameters can not be used together.

Additional Online Information

The online help file for Mailbox Converter includes a description of each menu
command and a "How to Use" section.

Troubleshooting

If you experience difficulties using the Mailbox Converter, refer to the following items:

O

O

Ensure that you are already defined as a Z-Malil® Pro user, before running Mailbox
Converter.

Ensure a PROFS/OV transport has been defined in Z-Mail® Pro before converting
Mainframe folders

Before running Mailbox Converter, close all messaging applications ( Z-Mail® Pro,
Phone Tag, Tag-it!, NEWTCal and Forum), otherwise the "Mail is already running"
dialog appears.

If the first dialog displays garbage entries, check that mailcvt.cfg exists in your
netmanag directory. Its items should be of the type:
<source name>=<existing DLL name>.

If there is a problem, please contact NetManage Tech Support for a valid file.

If "Missing DLL" error message appears after selecting cc:Mail, you must install
cc:Mail on your machine, and its directory should be in your path. Furthermore, if
running on Windows NT or Windows 95, the 32 bit version of cc:Mail should be
installed.
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Chapter 19. Directory Server

The Directory Server lets you keep a company-wide address book, or an ECCO phone
book available so that other users can easily access it. The Directory Server can also be
accessed as a regular Whols server through NetManage's Whols client application.

You can place any regular address book that has an .ADB extension or an ECCO
phonebook that has a .CEO extension on the Directory Server. However, only one file
(one address or phone book) can be made available on the server at a time.

Launching the Directory Server

You can launch Directory Server manually, or you can launch it through the Internet
Services Daemon (INETD). To launch it through INETD, refer to the NetManage
Configuration Guide for more information.

Note: You cannot launch the Directory Server using INETD if you are using Windows
NT.

To launch it manually, choose the Directory Server icon to display the Directory Server
dialog box.

e —— —w
| Ly Wi Pt WRALEL De L . -I
LE -

Configuring the Directory Server

The Configure command in the Settings menu lets you select the address book file you
want to make available to users. You can select a regular address book file ((ADB), or
an ECCO file (.CEO).

For example, suppose you have two files: one is a regular address book called
NetManage, with the filename C:\NETMANAG\EMAIL\JANE\NETMAN.ADB, and

the other is an ECCO-based phone book with the filename C:\ECCO\NETMAN.ECO.
You can choose which of these files you want to make available on your server.
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To place an address book on the Directory Server, do the following:

1.
2.

5.

Start Directory Server.

Choose the Configure... command from the Settings menu. The Configure dialog
box appears.

Under Data File Type, select the Address Book (.ADB) option.

Enter the complete path of the address book you want to make available in the
Filename text box. Choose the Browse button to search for the address book's
correct path if you do not already know what it is.

Choose the OK button.

To place an ECCO-based phone book on the Directory Server, do the following:

1.
2.

6.

Start Directory Server.

Choose the Configure... command from the Settings menu. The Configure dialog
box appears.

Under Data File Type, select the ECCO (.CEO) option.

In the Filename field, enter the complete path of the ECCO phonebook, which you
want to make available on the server. Choose the Browse button to search for the
phonebook's correct path if you do not already know what it is.

In the Email Name field, enter the name of the field in the ECCO phone book that
specifies the e-mail address. The default is Email.

Choose the OK button.

Additional Online Information

The online help file for Directory Server includes a description of each menu command,
plus the following information in the "How to Use" section:

Launching the Directory Server
Configuring the Directory Server
Manually Setting Up an Address Book File
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Chapter 20. Phone Tag

The Phone Tag application provides an easy-to-use method of recording and sending
phone memos. It allows you to create phone memos from your PC and send them
directly to people, without having to write the memo down on a piece of paper and
physically handing that person the memo. This application is also helpful for telephone
operators and other employees who take a lot of phone memos for other people.

You can set Phone Tag (through the Preferences menu) so that a Phone Tag memo
someone sends you automatically pops up on top of any other Windows application you
are using.

Phone Tag provides a template for your mail memo, so you can simply type in the
memo, and you do not have to worry about typing the other extraneous information (for
example, date time and so on). This information automatically appears in the template
when you bring up the phone memo template.

Opening Phone Tag

You do not have to log in to use Phone Tag if you are already logged into Z-Mail® Pro,
Tag-It!, Forum, or NEWTCal. All five applications share the same login ID. Note,
however, that you must have a Z-Mail® Pro account and have Z-Mail® Pro running to
receive Phone Tag memos. You also can send a Phone Tag memo to someone who does
not have the Phone Tag application. This person would receive the Phone Tag memo as
a regular e-mail message.

Phone Tag uses the same login information and gateway settings used in Z-Mail® Pro.
Set up the username, password, gateway, and server through the Z-Mail® Pro
application (using Postmaster to add a user). Refer to the chapter titled, Z-Mail® Pro
and Z-Mail® Pro Administration, in this manual for additional information.
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Creating Memos

To create a memo, do the following:

1. Choose the Create... command from the Memo menu. The Phone Memo-Create
template appears. The following toolbar icons appear on the top of this template:
Send the memo, Date and time stamp outgoing memo, Bring up Address book,
Create a memo, and print a memo.

= Phone Memo - Create =
GO
p [ B grgas [P 12.08PM
H ARES CODE
afer e
Exr
] Pax
E g Our next Doc meeting is scheduled for 7 4. 0. tomornow
Mm|S
E|A
M E T | s Sachs dindas@mail netmanz
o[ gt DJEE™ Ol 0" Ojgse™ O O
Bring up addiess book.

2. Enter information into the following fields:

 To: The e-mail address of the person to whom you are sending the memo.
This field must contain a valid mail address or alias recognized by Chameleon
Z-Mail® Pro. To send to more than one user or mail alias, separate them with
commas.

* From: The caller. This is the person leaving the phone memao.
« Of: The company name of the person listed in the From field.

» Date: The date the memo is sent. This field is automatically stamped. It can
be overwritten with current time by checking the Time Stamp button.

» Time: The time the memo is sent. This field is automatically stamped. It can
be overwritten with current time by checking the Time Stamp button.

Note: The Date and Time stamp must conform to the international date and time setup
under the Control Panel.

» Area Code: Area code of the caller.

* No.: Phone number of the caller.

» Ext.. Phone extension of the caller.

e FAX#: Fax number of the caller.

* Message: Contains a message from the caller.

» Signed: The name of the person (operator) who is recording the phone memo.
This field is automatically filled in with the sender's default From field set in Z-
Mail® Pro.
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The following fields may be checked to indicate what the caller wants to convey in
the message:

Phoned, Call Back, Returned Call, Wants To See You, Was In, Will Call Again,
Urgent.

Sending Memos

To send a memo after you enter all information into the phone memo, select the Send
Memo toolbar icon or press CTRL+S to send the memo.

Note: The To, From, and Signed fields are required. The To field must be a valid e-
mail address or alias recognized by Chameleon Z-Mail® Pro. The Signed filed is
automatically signed in with the name set as default in the Mail from field.

Forwarding Memos

You can forward a Phone Tag memo by selecting the memo you want to forward and
selecting the Forward option from the Memo menu.

Deleting Memos

You can delete a Phone Tag memo by selecting the memo you want to delete from the
main Phone Tag window and selecting the Delete option from the Memo menu.

Viewing Memos

You can view a Phone Tag memo by selecting the memo you want to view from the
main Phone Tag window and selecting the View option from the Memo menu.

Note: You can scroll through a Phone Tag memo you are viewing by using the up and
down arrow buttons.
Using the Settings Menu

The Settings menu allows you to set preferences, fonts, colors, and use the logging
feature. Refer to Phone Tag online help for detailed information about options in the
Settings menu.

Additional Online Information

The online help file for Phone Tag includes a description of each menu command, plus
the following information in the "How to Use" section:

* Opening Phone Tag
* Creating Memos
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* Sending Memos
* Forwarding Memos
» Deleting Memos
* Viewing Memos

Troubleshooting

If you experience difficulties using the Phone Tag application, refer to the following
items:

O If you receive Phone Tag memos as regular e-mail, ensure that the directory in
which NetManage is installed is in the DOS path and that PHONETAG.EXE is
installed.

O If you are not receiving Phone Tag memos, make sure Z-Mail® Pro is running and
retrieving messages. Have the person sending the Phone Tag send a regular e-mail
message to the same address. If the regular e-mail message is not received, see the
Troubleshooting section in the Z-Mail® Pro application for more information.
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Chapter 21. Tag-It!

The Tag-It! application lets you send informal messages to other people. The Tag-It!
window looks similar to an online version of a Post-It™ note. The messages are
displayed as yellow popup notes. If you want to create longer and more formal
messages, you should use the Z-Mail® Pro application.

You log into Tag-It! the same way you do in Phone Tag, Z-Mail® Pro, NEWTCal and
Forum because Tag-It! uses the Z-Mail® Pro SMTP send mechanism. Tag-It! messages
you receive are automatically opened by Z-Mail® Pro.

Note: Unlike Z-Mail® Pro and Phone Tag messages, you cannot save or print Tag-It!
messages.

Sending Tag-It! Messages
You can easily send a Tag-It! message by taking the following steps:

1. Start Tag-It! to display a Tag-It! window.

£/6/36 12:18PM @ﬂ

To shanii@netmanage. col
From: Linda Sachs <lindas@mail netmana

The conference room has been changed
to the third floor.

-

The window may include a title bar and provides access to the Control menu if you
have specified Tag-It! to do so (as discussed in "Setting Preferences," later in this
chapter). If not, you can display the title bar and make the Control menu accessible
by double-clicking the window or by pressing ESC.

Note: To access the Control menu, you should first make the title bar available by
double-clicking on the Tag-It! window or by pressing the ESC key. Then
press ALT+SPACEBAR tdisplay the Control Menu or click on the small
box in the upper left corner of the window (the Windows Control Menu
icon).
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The window also includes toolbar buttons for the Send, Address, Close, and
Minimize functions.

Specify to whom you want to send your message. To do so, perform either of the
following operations:

» Type the e-mail address of each user in the To: field. Separate addresses with a
comma (,).

» Display the Address Book either by choosing the Address button from the
toolbar, by choosing the Address command from the Control menu, or by
pressingCTRL+A. After Tag-It! opens the Address Book, select a name and
then choose the To button. Continue selecting names and choosing the To
button until you specify all the users to whom you want to send the message.
Then choose the OK button.

The Address Book lists the addresses of the users included in the Z-Mail® Pro
Address Book. For additional information, see the chapter on Z-Mail® Pro in this
manual.
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Type your message in the window.

Either choose the Send button on the toolbar or choose the Send command from the
Control menu or press CTRL+S.

Forwarding Tag-It! Messages

After Z-Mail® Pro opens a Tag-It! message sent to you by another Tag-It! user, you can
forward that message to other users. To do so, take the following steps:

1.

Choose the Forward button from the toolbar or choose the Send command from the
Control Menu or press CTRL+F.

The To: field is cleared, the From: field automatically changes to your login
username, and the Forward button becomes the Send button.

Specify to whom you want to send your message. To do so, perform either of the
following operations:

» Type the e-mail address of each user in the To: field. Separate addresses with a
comma.
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»  Either choose the Address button from the toolbar or choose the Address
command from the Control menu. After Tag-It! opens the Address Book,
select a name and then choose the To button. Continue selecting names and
choosing the To button until you specify all the users to whom you want to send
the message. Then, choose the OK button.

3. If you want to, type additional information in the message you are forwarding.

4. Either choose the Send button on the toolbar or choose the Send command from the
Control menu, or prelSTRL+S.

Setting Preferences

To set up preferences for Tag-It!, take the following steps:
1. Start Tag-It! to open a Tag-It! window.

2. Choose the Preferences option from the Control menu.

Note: To access the Control menu, you should first make the title bar available by
double-clicking on the Tag-It! window or by pressing ESC. Then press
ALT+SPACEBAR to display the Control Menu or click on the small box in the
upper left corner of the window (the Windows Control Menu icon).

= Preferences

Main Window “
[" Show Title
Cancel

Send
@® Cloge on send
) Minimize on send
() Stay on screen on send

Receive

[T Beep on Receipt

[igavo il

[" Minimize on receipt

[" Confirm exit

1. Configure Tag-It! by performing one or more of the following operations:

» Select the Show Title check box if you want Tag-It! to always display the title bar
and make the Control menu available upon startup.

» Specify whether Tag-It! remains running after a message is sent.
» Toclose Tag-It! once a message is sent, select the Close on send option.

* To continue running Tag-It! but minimize the window, select the Minimize on
send option.

* To continue running Tag-It! and leave the window open, select the Stay on
screen on send option.
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» Select the Minimize on receipt option if you want any Tag-It! messages that you
receive to be displayed as minimized icons on your desktop.

» Select the Beep on receipt option if you want Tag-It! to emit a sound when you
receive a Tag-It! message. If you specify a .WAV file, the specified sound file will
be played. If you do not specify a .WAV file, a beep will be emitted.

» Select the Confirm exit option if you want Tag-It! to display a prompt verifying
whether you want to exit Tag-ItThis option is selected by default.

Note: If this option is not selected, you may unintentionally press ALT+F4 and thereby
close the Tag-It! application without having a chance to read a note that you have
received. Therefore, it is recommended that the Confirm on exit option be
selected.

2. Choose the OK button.

Additional Online Information

The online help file for Tag-It! includes a description of each menu command.

Troubleshooting

If you receive Tag-It! messages as regular mail messages (instead of Tag-It! messages),
refer to the following items:

O Ensure that the Chameleon Z-Mail® Pro application is activated (can be
minimized).

O Ensure that tagit.exe is present in your system.
O Ensure that the directory containing the Tag-It! application is in the DOS Path.

O If the above items do not apply, Tag-It! may not be able to start for some other
reason, such as insufficient memory. When Tag-It! is not available, any Tag-It!
messages received by you will be available in Z-Mail® Pro instead.
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Chapter 22. NEWTCal

The NEWTCal application lets you schedule appointments in an online calendar. When
you schedule an appointment, NEWTCal notifies people about the proposed meeting.
You can then use NEWTCal to track responses to your appointment requests. You can
also view your online calendar in a daily, weekly, monthly, or yearly format. NEWTCal
lets you schedule new appointments and modify or delete existing appointments.

Login

When you open the NEWTCal application, the NetManage NEWTCal Login dialog box
appears unless you have already logged into Z-Mail® Pro (or one of the related Z-Mail®
Pro applications, Tag-It! or Phone Tag).

1. Tologinto NEWTCal, type your username and password in the appropriate fields.
(This is the same username and password that you use for Z-Mail® Pro.)

Username: |.lanet

Password: m

[ Offline

NEWTCal - Login

After the login has been completed, NEWTCal displays your online appointment
calendar.

Viewing Your Appointment Calendar

You can view your online appointment calendar in a daily, weekly, monthly, or yearly
format. To do so, select the appropriate option (Daily View, Weekly View, Monthly
View, or Yearly View) from the View menu.
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Setting NEWTCal Preferences

NEWTCal lets you set the number of hours your daily calendar includes. It also gives
you the option of printing your calendar with or without appointment information.

Scheduling Appointments

Set up Z-Mail® Pro before scheduling appointments because NEWTCal uses Z-Mail®
Pro to notify people of proposed meetings. Your mail application must be running (it
can be minimized) for you to send and receive notifications of appointments

Scheduling New Appointments

To schedule new appointments, take the following steps:

1. Perform one of the following operations to open the Appointment Settings dialog
box:

» If your calendar is in a weekly, monthly, or yearly format, double-click the day
you want to schedule the appointment.

» If your calendar is in a daily format, double-click the hour you want to schedule
the appointment.

= Appointment Settings

Description: [Doc meeting 0K

Date: (] dun ][] 11 [DI[] 1986 3]

Time: 12| w00
puation:  [1 [Fuis [0 [Fmin [0 [Fpars
Where: [Engineering bldg

Who: [Karen. Ant. Linda Attendees.
Notes: New release schedule available] || Send Request
-

Alarm

[ On Lead Time: Efwinatets1 2]
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2. Enter the appointment’s description, date, time, length and location in the
appropriate fields.

In the Date, Time, and Duration fields, you can enter information by either typing it
or choosing the up or down buttons.

3. Ifdesired, type additional information about the appointment in the Notes field.

4. Either type addresses in the Who field or choose the Attendees... button to open the
Address Book.
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a) From the Address Book list, select an e-mail address, and then choose the To
button.

b) Continue selecting addresses in the Attendee list box and choosing the To
button until the Attendee List box includes all the desired addresses.

Note: The Address Book is a shared feature of Z-Mail® Pro, NEWTCal, Phone
Tag, and Tag-It! It is accessible from all these applications. To add an e-
mail address to the Address Book, use the Z-Mail® Pro application's

Services Menu, or choose the ECCO Setup option within the Address Book
dialog.

5. Notify people of a proposed appointment by choosing the Send Request button from
the Appointment Setting dialog box.

The Z-Mail® Pro application notifies attendees about the appointment as discussed
in "Responding to Appointment Requests" later in this chapter. If you want to view

the responses to your appointment request, choose the Show Status button. A Status
of Attendees dialog box appears.

= Status of Attendees

Attendee Status Comment
anat Accepled

paula Mo Responst

lindas Mo Responst

mitch Accepted I'll bring the donuts
nathan Accepted Got it.
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6.

When you finish scheduling appointments, close the Appointment Settings dialog
box by choosing the OK button.

Modifying Existing Appointments

To modify existing appointments, take the following steps:

1.

In your online appointment calendar, double-click the appointment you want to
modify. Or click once on the appointment in the calendar display and choose the
Edit Menu/Edit Appointment option. The Appointment Settings dialog box,
containing information for the selected appointment appears.

Modify the fields of the Appointment Settings dialog box as necessary. (See also
"Rescheduling Tips.") Then choose the OK button.

NEWTCal automatically notifies the attendees of the changes you have made to the
appointment time and date.

Rescheduling Tips

When modifying appointments, you can quickly reschedule them by moving them (using
drag/drop) from one location to another in your online calendar:

To reschedule appointments to another day, select the appointment you want to
reschedule (to/from another day on the display or to/from the busybar) and move it
to the new day.

To increase the time of an appointment, stretch the block on the busy-bar.

To reschedule appointments to another time on the same day, display your online
calendar in the daily format as discussed in "Viewing Your Appointment
Calendar." Then select the time of the appointment you want to reschedule and
move it to the new time.

Deleting Existing Appointments

To delete existing appointments, take the following steps:

1.

In your online appointment calendar, double-click the appointment you want to
delete. The Appointment Settings dialog box, containing information for the
selected appointment appears.

Choose the Delete button. Or click once on the appointment in the calendar display
and choose the Edit Menu/Delete Current option.

NEWTCal automatically notifies the attendees that you have deleted the appointment
information.
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Responding to Appointment Requests

If another NEWTCal user sends you an appointment request, a dialog box with
information about the meeting is displayed on your computer terminal.

= Meeting Request
From: Karen Ewing <karen@netma Send Time: | Thu, 6 Jun 96 13:10:29 PDT

Meeting Details

Subject: [Design Meeting
Date: [Wednesday. February 19. 199 Time: [1:00PM PDT

Where: |Ups|ai|s Conference Room Duration: ‘1 Hour(s)

Attendees: [lindas Details: [\ rced ta meet to

discuss an exciling,
new product.

Comment:

[Caccept ][ Decline || Defer ][ piscard |

(I Y || T

The Meeting Request dialog box contains all the relevant information pertaining to the
meeting.

To respond to an appointment request, do the following:

1. Enter optional comments in the Comment box. These comments will be delivered
with your response.

2. Choose one of the following response buttons:

» Accept NEWTCal will automatically add the appointment to the appropriate
date and time in your calendar, and Z-Mail® Pro will send a notification of
your acceptance to the user who sent the Meeting Request.

» Decline Z-Mail® Pro will send a notification of your decline to the user who
sent the Meeting Request.

» Defer: NEWTCal will hold the Meeting Request in its buffer, so that you can
make a decision later. To display the Meeting Requests that you have deferred,
use the Get Pending Requests option from the View Menu.

» Discard: The Meeting Request will be discarded.

Additional Online Information

The online help file for NEWTCal includes a description of each menu command.
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Chapter 23. InPerson

The InPerson desktop conferencing software lets you have an online working session
(conference) with people on a network.

During a working session, each conference member can sketch drawings, type notes,
paste captured images, and import text and image files into the InPerson whiteboard.

The information included in an InPerson whiteboard can be viewed and modified by all
members. For example, suppose you want your co-workers to review your design for a
new gadget. You can take a screen shot of your design and then paste it into your
InPerson whiteboard where everyone can examine it and make comments or changes to
it.

InPerson can also provide audio and video support so that members can talk to and view
one another during a conference.

This chapter

» discusses video and audio support requirements
» describes the InPerson window
e provides an overview of using InPerson

Video Support Requirements

The following items are required if you plan to send video images to other conference
members. However, you will be able to receive video images from other members
without these items.

» video capture card that can support real-time capture in preview mode (as opposed
to overlay)

» avideo camera compatible with your video capture card
* Video for Windows 1.1 or later software

Audio Support Requirements

InPerson’s audio feature requires any Windows compatible sound card.
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About the InPerson Window

The InPerson windownoks similar to the following figure:

Audio/video Toolbar

toolbar

|
Your member |
window |

Another
person’s
member
window

—— Whiteboard

InPerson displays a member window for each participant. A member window image can
be either a video image or a default image file that you specify as discussed in the online
help. The name of a member is displayed in the title bar of that person’s member
window.

The whiteboard is the area in which you enter text and draw objects. The whiteboard
consists of one or more pages. Each whiteboard page is marked by a numbered tab. If
there are multiple whiteboard pages, the tab of the current page is white and the tabs of
the other pages are gray. To turn to a whiteboard page, select its tab. You can also add
or delete whiteboard pages by choosing the appropriate command from the Edit menu.

The InPerson menu bar and toolbar are similar to the menu bars and toolbars in other
Windows applications. For details on the menu bar and toolbar, see your InPerson
online help.

The following table describes the various buttons that are available on the audio/video
toolbar. The table also indicates hardware and software requirements you need for the
functionality of these buttons to be supported.
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Button Requirements Description
For video images: Depress this button to transmit
EE._F e Video capture card the image displayed in your
e Compatible video camera member window.
* Video for Windows 1.1 or late . .
Send Image I indow | Release this button if you do nd

software
For default images: none

want to send other members th
image in your member window.

9X]

Mute

Windows compatible sound card

Depress this button if you do ng
want other members to be able
hear you. You will be able to
hear other members however.

9 ]

Talk

Windows compatible sound card

Note: The audio/video toolbar dog
not include the Talk button
while InPerson is operating
in full-duplex mode.

Depress this button if you want
to lock the recording mode. Yo
Scan then talk to other members
without being interrupted.

Depressing this button is

equivalent to pressing the F9 key

or holding down the F8 key.

If you want to return to listening
to the other members, release

Talk button or press the F9 key,

This is equivalent to releasing
the F8 key if you are holding it
down.

None

When this light is on, it
indicates that you are receiving
sound.
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Button Requirements Description
Windows compatible sound card | \when this light is on, it
ur indicates that you are recording
or sending your recording to
out other users.

Note: Other users will be able
to hear you only if your
Mute button is released.

Inviting Conference Members

You can invite a person or a group of people to an InPerson conference by doing the

following:

1. Choose the Invite... command from the Conference menu. An Invite dialog box

similar to the following appears.

Invite

jilian(@rainbow. netmanage.com Close

cal |
Real Name: [ add |

Addiess

Subiect Jhisws Product Design

Inwitation List

Address Baok.

Help

2. Specify who you want to invite by adding names to the Invitation List box. To add
names, do the following:

If the InPerson address book already includes the name of the person or group
you want to invite, choose the Address Book... button. In the Address Book
dialog box, double-click each name or group you want to add to the Invitation
List box. When you finish adding all the names or groups you want to invite,
choose the Close button.

You can store the names and addresses of frequently invited members in
the InPerson address book. For information about how to make entries in
the address book, see the Adding New Addresses to the Address Book
section.

To invite someone not included in the InPerson address book, do the following:
b) Type the person’s InPerson address in the Address text box.

InPerson addresses can be in any of the following formats:
user@hostname, hostname, user@|Paddress, or IPaddress. When
inviting SGI InPerson users, be sure to use the format user@host or
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user@IPaddress. For example, to specify user Jillian on host rainbow,
type jillian@rainbow or jillian@156.27.50.200.

c) Type the name you want to appear in the title bar of the person’s member
window. This step is optional. If you leave the Real Name text box blank,
the address entered in the Address text box will appear in the member
window.

Suppose you enter jillian@rainbow in the Address text box and Jill in the
Real Name text box. Jill rather than jillian@rainbow will appear in the
title bar of Jillian’s member window.

d) Choose the Add button.

3. If you want to provide members with a brief description of the conference, type one
in the Subject field.

4. Choose the Call button.

Users are prompted to accept or decline your invitation unless they have selected the
Auto Accept Incoming Call check box as discussed in the online help.

Note: Users can receive an invitation only if they are currently running InPerson.
Therefore, any users planning to frequently participate in InPerson sessions
should add InPerson to their Windows Startup group.

The InPerson conference will continue until all members disconnect from the session.
However, the conference will end for all members if the person who established the
conference disconnects.

Defining the InPerson Address Book

The InPerson address book contains a list of names and addresses. Define the InPerson
address book if you want to be able to invite people by selecting names rather than
typing information in the Invite dialog box.

When defining address book entries, you can

» add addresses to the address book
» create address book groups

» change address book entries

» delete address book entries

Separate discussions on each task follow.
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Adding New Addresses to the Address Book

To add addresses to the address book, do the following:

1. Choose the Invite... command from the Conference menu.

2. Inthe Invite dialog box that appears, choose the Address Book... button.

The Address Book dialog box appears.

Addiess Book
Adchess Book List

&) anna van gooh

%) flian monet

%]

Clase
Mew Address...

Mew Group,
Change

Help

3. Choose the New Address... button. The New Address dialog box appears. In the
Address text box, type the InPerson address of the person you want to add.

InPerson addresses can be in any of the following formats: user@hostname,
hostname, user@IPaddress, or IPaddress. When inviting SGI InPerson users, be
sure to use the format user@host or user@IPaddress. For example, to specify user
Jillian on host rainbow, type jillian@rainbow or jillian@156.27.50.200.

4. If you want the address book entry to include the person’s actual name, type that
name in the Real Name text box. This step is optional. If you leave the Real Name
text box blank, the address entered in the Address text box will appear in the
member window.

Suppose you enter jillian@rainbow in the Address text box and Jill in the Real
Name text box. Jill rather than jillian@rainbow will appear in the title bar of
Jillian’s member window.

5. Choose the OK button.
InPerson adds the person to the Address Book List box.
6. You can continue adding names to the address book by repeating steps 3 through 5.

7. When you are done adding addresses to the address book, choose the Close button

Creating an Address Book Group

If you frequently invite the same group of people to conferences, you may want to create
a group for those users. An address book group consists of two or more address entries
previously added to the InPerson address book. You can send an invitation to all
members of the group by simply selecting the group name rather than having to select
each individual’'s name.
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To create an address book group, do the following:

1. Choose the Invite... command from the Conference menu.
The Invite dialog box appears.

2. Choose the Address Book... button.
The Address Book dialog box appears.

3. If you have not already done so, add an address book entry for each person you want
to include in the group. For details, see the Adding New Addresses to the Address
Book section.

4. Choose the New Group... button.

The New Group dialog box appears.

[ ] ced|

5. Inthe Address Book List box, select the names of each person you want to include
in the group.

6. Inthe Group text box, type a group name.

7. Choose the OK button.

InPerson adds the group to the Address Book dialog box.

8. To close the Address Book dialog box, choose the Close button.

Changing Address Book Entries

To change address book entries, do the following:

1. Choose the Invite... command from the Conference menu. The Invite dialog box
appears.

2. Choose the Address Book... button.
3. Inthe Address Book dialog box, select the name or group you want to change.

4. Choose the Change button.

If you selected an individual's name, the Change Address dialog box appears.
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If you selected a group, the Change Group dialog box appears.

5. Do one of the following:

» If you are modifying an individual's entry, edit the text boxes of the Change
Address dialog box as necessary.

If the entry you modify is included in any groups, you will also need to
change those groups to reflect your change. Suppose you change the entry
Jillian to Jill. You will need to make sure that any groups that include

Jillian list her as Jill instead.

» If you are modifying a group’s entry, select each name you want to include in
the group. Unselected names will not be included in the group.

You can make multiple selections using the CTRL and SHIFT keys as
discussed in your Windows documentation.

6. Choose the OK button.

7. To close the Address Book dialog box, choose the Close button.

Deleting Address Book Entries

To delete an address book entry, do the following:

1. Choose the Invite... command from the Conference menu. The Invite dialog box
appears.

2. Choose the Address Book... button to open the Address Book dialog box.

3. Select each name or group you want to delete from the Address Book List box. If
you want to select more than one name or group, hold down the CTRL key while
making your selections.

4. Choose the Delete button.

5. When InPerson prompts you to confirm you want to delete the selected entry,
choose the Yes button.

6. To close the Address Book dialog box, choose the Close button.

Conversing with Other Members

How you carry on InPerson conversations depends on whether the application is in half-
duplex mode or full-duplex mode.

Full-duplex cards are bi-directional and can record and play sounds at the same time.
This lets you talk and listen at the same time.

Unlike full-duplex cards, half-duplex cards are unidirectional and are unable to record
and play at the same time. When you are in half-duplex mode, InPerson can record your
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conversation if it is not playing another member’s recording. You cannot talk and listen
at the same time if InPerson is in the half-duplex mode.

If you are in the half-duplex mode and want to talk to other members without being
interrupted, depress the Talk button. To return to listening to the other members,
release the Talk button.

In either the full-duplex or half-duplex mode, other users will be able to hear you if the
Mute button is released. This is the default. If you want to listen to other users but do
not want them to be able to hear you, depress the Mute button.

Drawing on the Whiteboard

The whiteboard is designed so you can easily draw simple shapes. InPerson provides
five drawing tools — a tool for drawing freehand and tools for drawing arrows, lines,
circles, and boxes. You draw on the whiteboard by selecting one of the drawing tools
and a pen color and width.

To select a drawing tool, choose the appropriate button from the toolbar or choose the
Pen, Arrow, Circle, Line, or Rectangle command from the Object menu. When you
select a drawing tool, the cursor changes to reflect the selected tool. For example, the
cursor changes to a circle when the circle tool is selected.

If you choose the pen tool (the default), you can draw freehand. If you select one of the
other drawing tools, draw the selected shape by dragging the mouse until the arrow,
circle, line, or box is the desired size.

You can select an object’s color using the Pen Color command. You can also select the
width of an object’s lines by using the Pen Width command. For details on these
commands, see the InPerson online Help.

You can find out who created an object on the whiteboard. To do so, move the cursor to
the object you want to examine. The name of the person who placed the object on the
whiteboard page is highlighted in that person’s member window.

InPerson automatically assigns a different cursor symbol to each conference member.
This helps you identify who is currently working on the whiteboard. When a person
works on the whiteboard, the cursor on your computer will look like that person’s cursor
symbol.

Adding Text to the Whiteboard

You can add text to a whiteboard page at any time. To do so, choose the text button
from the toolbar and then begin typing in the whiteboard.

When adding text to the whiteboard, you can perform the following operations:

« Start a new line of text by pressing the Enter key.
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Delete characters by pressing the Backspace key.

Paste text copied from another application by choosing Paste from the Edit menu.
When you paste text from another application, tab settings and font characteristics
are lost.

Additional Online Information

The online help file for InPerson includes a description of each menu command, plus
the following information in the "How to Use" section:

Adding New Addresses to the Address Book
Changing Address Book Entries

Conversing with Other Members

Creating an Address Book Group

Deleting Address Book Entries

Inviting Conference Members

Moving Objects

Selecting Objects

Setting Preferences

Troubleshooting

The following list includes troubleshooting information for InPerson:

O

If you cannot hear other members but you can talk to them, you may be locked in
recording mode. (The Out light is on while you are recording.) If you are in half-
duplex mode, unlock the recording mode by either releasing the Talk button or
pressing the F9 key. This is equivalent to releasing the F8 key if you are holding it
down.

If other members cannot hear you and you selected GSM voice compression, verify
whether the other members are using version 5.0 or earlier of the NetManage
InPerson application.

You can use GSM voice compression only if all members are using either the
Silicon Graphics InPerson application or version 6.0 of the NetManage InPerson
application. If one or more members are using version 5.0 or earlier of the
NetManage InPerson program, select either IDVI8 or IDVI16 voice compression as
discussed in your online help.

If you cannot establish a connection to conference members, ensure that all the
invited conference members are in the correct format and make sure that all invited
members are currently running InPerson.
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O If you can work in the whiteboard but cannot send or receive audio or video, use the
Ping application to verify that all members’ machines are able to resolve each others
host names.

O If the video images you receive are not coming in well, adjust the video quality as
discussed in your online help.

O If the audio you receive is not coming in well, adjust the audio quality as discussed
in your online help.
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Chapter 24. WebSurfer

WebSurfer allows you to browse multimedia information on the World Wide Web
(WWW). WebSurfer displays hypertext documents and supports multimedia such as
soundvideo,and interactive graphics.

About the World Wide Web

The WWW is a set of servers on the Internet that are that are linked. Hypertext is a
method of presenting information that lets you jump easily from one topic to another or
to an expanded base of information on that topic.

WebSurfer Features

WebSurfer supports the following features:

Netscape standard web frames, which enable multiple HTML view spaces

Rapid Search, which lets you search previously visited pages using specific search
criteria by means of the Indexing Agent

Microsoft video tags, which provide interoperability between Microsoft and
NetManage video services

AVI streaming, which provides the ability to view audio and video in a continuous,
uninterrupted manner

stationary background tags, a Microsoft extension, which provide support for non-
scrolling backgrounds

Microsoft background sounds extension, which is similar to background images
Microsoft font tag support, which is used to change fonts within a text range

Microsoft cookies extensions, which provides for HTTP-oriented, client-specific
Web page customization (This is defined by each Web site individually.). Cookies
actually contain a sub-domain ID from a specific server and include a cache of tags
from this server that correspond to certain information. This information is saved in
a cookies.txt file.

Netscape support for full-screen or embedded plug-ins

formatted documents display (electronic text in a variety of fonts, bold and italic,
bulleted lists, extended characters sets)

Direct access to NetManage Tech Support using the Support Wizard
hypertext-linked documents browsing
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links to FTP, Gopher, Telnet and other NetManage applications using the Go
IntraNet! feature

hypermedia document display, including interactive graphics, sounds, and movies
creation of hot list folders for organizing documents

access to other tools without closing WebSurfer

context-sensitive menus using the right mouse button

caching of information downloaded to your local drive from the Web

tracking of links of your search through Web documents, and quick backtracking
using the History list

TrueSpeech and RealAudio embedded third-party applications: the TrueSpeech
Player and Encoder lets you bring real-time, streaming audio playback over the
Internet; the RealAudio Player lets you bring live and on-demand audio to the
desktop over the Internet using RealAudiolinks

Chaco VRML external viewer for 3D graphics embedded plug-in (works on
Windows 95 only)

Adobe Acrobat Reader embedded plug-in so you can read and print documents in
PDF (portable document file) format

Macromedia's Shockwave for Director plug-in, which provides multimedia in a
Web page on the Internet (works on Windows 95 only)

external editors and viewers, such as WebSpider, NEWTView, and NEWTSound,
SO you can view text, image, and video files, and listen to sound files

About Uniform Resource Locators (URLS)

Uniform Resource Locators (URLS) let you identify where a resource resides anywhere
on the Internet by linkingVeb documents on HTTP servers. If you know the
document’s URL, you can retrieve it. URLs provide information about resource type,
location, and path.

Resource types indicate the type of server on which the document resides. WebSurfer
supports the following resource types:

http:// is the HTTP Server
ftp:// is the FTP Server

file:// is the locaHTML file
telnet:// is the Telnet Server
gopher:// is the Gopher Server
mailto:// is an e-mail address
news:// is a Usenet Newsgroup
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Note: For more information about using resource types other than HTTP, refer to
WebSurfer online help.

For example, the NetManage home page document title is NetManage Home Page and
its URL is:

http://www.netmanage.com:80/netmanage/index.html

where:
http is the resource type (HTTP Server)
/lIwww.netmanage.com:80 is the resource location

/netmanage/index.html is the path and filename

Setting Preferences in WebSurfer

You can set preferences in WebSurfer to indicate your selections for the startup
document, network software, document viewers, proxy server, document retrieval
behavior, and plug-ins. Preferences are grouped within six tabs: General, Network,
Viewers, Proxies, Cache, and Hotlist.
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Using WebSurfer

When you start WebSurfer, the NetManage home page is displ@ednterface
consists of the document window and the menus and controls surrounding the
document.
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The Title bar at the top of the window displays the document title. The Menu bar
displays all the menu names, with each menu containing drop down lists of commands.
The Toolbar contains buttons that serve as shortcuts for WebSurfer menu items.

Below the Toolbar is the Dialog bar, which displays the URL address of the current
document. As you move the mouse around the document, the Status bar displays the
URLs for any anchors or links over which the mouse passes.

A document can contain text and pictures, some of which are hypertext links to other
multimedia documents or objects. The links are highlighted in blue. You can change
the document format (that is, how it appears on your screen) by using the Style Schemes
command from the Settings menu.

To gather information about the document you are currently viewimapse the

Properties command from the Retrieve menu. The Properties dialog box is displayed,
and shows information such as: title, URL, file type, and the local file where the
document is located.

You can browse through the document ahdosethe highlighted text to link to another
document. WebSurfer downloads and displays the new document, including any
graphics that may be a part of it. To return to the previous pagesethe Back
command from the Retrieve menu or the Back button on the toolbar. To return to the
home pageshoosehe Home command from the Retrieve menu or the Home button on
the toolbar.

Opening Documents in WebSurfer

There are two methods of opening documents in WebSurfer:

* usingits URL
e using an existing local .HTM file from the local file system
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Opening Documents Using URLSs

While navigating through a Web document, you can open another document by:

» single-clicking the left mouse button on the highlighted text

» choosing the Go To URL command from the Retrieve méran entering a
document’s URL

* entering a document’s URL in the Dialog bar

All three methods will retrieve the chosen document from the network or local cache
(local drive)anddisplay it for you.

Opening Existing Local HTML Files

You can open existing local .HTM files from your local file system. This is useful if you
want to edit your own .HTM files. You can open either an unformatted or formatted
version of the file.

To open an unformatted version of a local .HTM file, choose the Source command and
then the Text Editor option from the Edit menu. To edit a document, you can also
choosehe Properties command from the Retrieve menu and choose either the Edit
HTML command or the View/Play button in the Properties dialog box.

Both commands display the .HTM file in the default text view if the file is a text file. It
displays the file with the default image viewer if it is an image file, and plays the file
with the default player if it is a sound or movie file.

After you have edited and saved the file, you can view its changes immediately by
choosingthe ReloadFrom Disk command from the Retrieve menu.

To open a formatted version of a local .HTM file, choose the Source command, then the
HTML Editor option from the Edit menu. The formatted file is displayed in the HTML
editor you have designated. WebSpider is the default HTML editor for WebSurfer.

Caching Documents

A major feature thatVebSurfer provides is the ability to cache documents or files.
Caching keeps a copy of documents that you have opened, in your local cache (local
drive). When you reopen a previously opened document, you do not have to wait while
the information downloads again from the network.

Default Caching

Initially when you retrieve a document from the Web, it is retrieved directly from the
network and automatically placed in your local cache for the current session. If you want
to reuse a document you have already retrieved during the current session, WebSurfer
will retrieve it for you automatically from your local cache.

Chameleon ATX User's Guide 213



However, when you close the current session, the documents in your local cache are not
saved. If you want to revisit a document you opened during a previous s#ssinthe
document is automatically retrieved from the network and once again placed in your
local cache.

Default caching behavior for documents is established using the Preferences command
(global behavior of all documents) and the Properties command (individual behavior of
a specific document). Note that the settings for the caching behavior of a document in
the Properties command overrides those set in the Preferences command.

Overriding Default Caching

There are several ways you can override default caching of documents:

* ChooseheReload From Network command from the Retrieve menu to
automatically refresh a document retrieved from your local cache with its latest
version from the network.

e To retrieve documents directly from the network and not your local cache,
regardless of how many times you re-visit the same document in the current session,
deselect the Reuse Retrieved Documents Within Session check box located in both
the Properties and Preferences dialog boxes.

+ To save documents to your local drive between sessions, dheoSave Cached
Documents Between Sessions check box, locatbdtinthe Properties and
Preferences dialog boxes. Use this setting to retrieve the same document from your
local drive between sessions.

Using the Hotlist

The Hotlist contains documents (Web pages) that you find particularly interesting and

want to access regularly without having to search for them within the Web. You can

display the Hotlist by doing one of the following:

» choosing the Show Window command from the Hotlist menu

» selecting the Hotlist button in the toolbar

» positioning the mouse cursor on the left-hand border of the WebSurfer window and
dragging the border to the right.

The hot list appears in the left pane of the WebSurfer window, while the selected
document is displayed in the right pane.

The Hotlist feature lets you add items, create folders for organizing items, display folder
properties, import Mosaic or Netscape hot list information, and merge existing hot list
items into your current hot list.

You can add items to your hot list by doing one of the following:
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* choosing the Add Item command from the Hotlist menu

» placing the cursor on the highlighted link or image, then clicking the right mouse
button and dragging it to a folder in your hot list

You can also split the Hot list screen by choosing the Split Hotlist button on the toolbar
or the Split Hotlist command from the Hotlist menu. Splitting the hot list lets you better
organize the items in your hot lists and move items easily from one hot list to another.

Launching Other Applications in WebSurfer

You can now launch other Chameleon applications directly from the WebSurfer Tools
menu instead of Program Manager. All applications other than Forum will appear in
separate windows. Choose the Customize command from the Tools menu, then select
the application you want to start. The application selected automatically opens in a new
window while WebSurfer is still open.

Plug-Ins

WebSurfer now supports embedded third-party applications, called plug-ins. You can
start these applications directly from within WebSurfer. Plug-ins include the following:

* Acrobat Reader

e TrueSpeech Player/Encoder

* RealAudio Player

* Chaco VRML 3D Viewer

» Shockwave Multimedia Viewer/Player

To access these applications, choose the Preferences command from the Settings menu,

then choose the Viewers tab. WebSurfer opens a new window when it runs a plug-in
application.
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Additional Online Information

The online help file for WebSurfer includes a description of each menu command, plus
the following information in the "How to Use" section:

» Accessing Other Resources

e Caching Documents

» Importing NCSA MOSAIC.INI and Netscape File Information
» Launching Forum and Other Applications

*  Modifying Document Styles

»  Printing Documents

» Using Rapid Search

e Using Short Cut Menus

* Using the Hotlist

» Using Web Frames

e Using WebSurfer
* Viewing a History of Documents
» Viewing Files in WebSurfer

Troubleshooting

If you experience difficulties using the WebSurfer application, refer to the following
items:

O If you get a message, "Failed to launch viewer for file *.bmp, *.tif and so on, check
file associations; check for viewer;" do the following:

a) Go to File Manager.
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b) Choose the Associate command from the File Menu.

c) For the file type: bmp, tif, and so on., select the viewers using the Browse
button.

You can also add, modify or delete viewers automatically from the Settings menu,
by choosing the Preferences command, then the Viewers tab.

0 NEWTSound and NEWTView are NetManage sound and viewer applications
provided for your use. Other example viewers are PAINTBRUSH.EXE and
WINGIF.EXE.

0 When you get messages such as "Unable to resolve the hostname," check for the
following:

* Can you ping the hostname?

» If you have upgraded to the current version, make sure that you are not using the
old configuration file and that the corresponding entry for this application is
removed from the TCPIP section of the WIN.INI file.

» Check whether the correct configuration file has been opened in Custom, and all
the settings are correct.

Note: The previous item refers to users running the Windows 3.1 or Windows
95 operating system only.

O If you are not retrieving any images in the documents, see whether the Defer Images
command from the Settings menu is enabled. Disabling it will help you to retrieve
the images automatically.

O If you experience difficulties in retrieving the updated documents for example,
Stock Quote information and reading newspaper articles, make sure that the Reuse
retrieved documents within session check box is deselected. If it is selected, then
the cached documents are displayed instead of the new updated documents from the
network.
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Chapter 25. Personal Web Server

The Personal Web Server application allows you to publish your own Web page on the
World Wide Web so that other users can access it using a Web client such as WebSurfer.
Your Web page can include HTML (Hypertext Markup Language) other documents,
images, sound files, and movies.

What is a Web Page?

A Web page is a collection of HTML documents and other files you want to serve to
Web clients. This collection of documents and files reside in your Windows file system
and the starting point of this collection is called the Web Root Directory.

You can have subdirectories under the Web Root Directory and you can place the file
that you want to serve in both the Web Root Directory and subdirectories. Only the Web
Root Directory and its subdirectories are visible to Web clients.

NetManage provides a sample Web page to help you set up your own Web server. These
sample files are located in the Web Root Directory. Open the Personal Web Server icon
and choose the Configure... command from the Settings menu to view this directory.

Default HTML File

The Web Server can serve an HTML file by default if you have configured it to do so.
The sample Web Server is configured to serve a file called INDEX.HTM fif this file

exists in the directory requested by the user. You can change the name INDEX.HTM to
another name by changing the filename in the Default HTM File field in the Personal
Web Server Configuration dialog box. To use this feature, create the default files in
each directory where you want this capability.

Note: The name of these default files must be exactly what you specify in the Default
HTML File field in the Configuration dialog box. If you do not change this field,
then your default files must be named INDEX.HTM.

Directory Listings

The Personal Web Server first checks to see if the default file that is being requested
exists. If it does not exist, the Web Server will try to generate a directory listing for the
user. The user can browse this listing and request further file fetches by selecting the
filenames in the listing.
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Setting Up Your Own Web Page

Look through the files that make up the sample Web page can help you understand how
to set up your own Web documents and files. Once you have created your Web files, you
are ready to reconfigure the Web Server to make it serve files from your Web rather than
the sample Web. To do this follow the instructions in the next section that describes
how to configure your own Web server.

Configuring the Personal Web Server for the First
Time

To start and configure the Personal Web Server, do the following:

1.
2.

Start Personal Web Server.

Choose the Configure... command from the Settings menu. The Personal Web
Server Configuration dialog box appears.

= Personal Web Server Configuration
Pt ‘m Security.

Admin EMAIL Address: ‘

Detault HTML File: ‘ index htrm

‘web Root Directory: ‘c:\ne(manag 324webdocs Browse...

| oK | | Cancel ‘ ‘UseDefauIts| | Help |

Enter the communications port number in the Port field. The default port number is
80.

In the Admin EMAIL Address field, enter your local e-mail address (for example,
lindas@netmanage.com). The Default HTML File field contains the NetManage
supplied default file DEFAULT.HTM, which resides in the default directory

specified in the Web Root Directory field. This file contains a sample server home
page that you can change at any time. If you rename this default file, then you must
also change its name in the this field.

When a user is trying to access your Web server (using a Web client), and specifies
a directory but does not request a specific file, than the NetManage default file
DEFAULT.HTM (sample server home page) is displayed. If the .HTM file exists in
the requested directory, it is displayed. If it does not exist or is not in the requested
directory, a directory listing is displayed. The user needs to select the file desired
from this directory listing.

You can create your own home page or customize the sample home page, if desired.
However, if you rename the DEFAULT.HTM file or place it in another directory,
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then change the default HTML filename and the document root directory to reflect
your changes.

6. Enter the root directory where the Web resides in the Web Root Directory field.
NetManage has already created a directory called WEBDOCS that contains the
DEFAULT.HTM file. Note that you are not limited to one directory for your Web
documents; you can have a multiple directories from which to select files.

7. Choose the Browse... button to display the Select Document Root Directory dialog
box. Select a new root directory, then choose the OK button.

8. Choose the Security button if you want to limit the number of users who access your
Web server. If you are already a Root Administrator, the Administrator Login
dialog box appears. Fill in your username and password in the Administrator Login
dialog box, then choose the OK button.

Root administrators are authorized to add, modify, or delete Web administrators,
and have complete authority to remotely manage all Web server ports. Web
administrators are authorized to remotely manage user and group access to secure
Web pages on a certain port's server. Certain users may be authorized to access
secure Web areas. To establish secured Web server settings, you must fill in the
fields shown in the Secured Settings dialog box for each of the three tabs: Root,
Administrators, and Users. You can also add or delete root administrators, Web
administrators, and users.

= Security Settings
Root IAdmlmstra{Drsl Users }
Fioot Administrator: (IS nanag + Add
Email Adlcl 6
et
Full Name: ‘
Description:
Riootadministriors are authorized to add/modify/delete web administrators, and
have complete autharity to remately manage all web server pors.
| 8] | ‘ Cancel ‘ ‘ ‘

Your Personal Web Server is now configured. You can reconfigure the server at any
time by following the steps listed previously.

Additional Online Information

The online help file for Personal Web Server includes a description of each menu
command, plus the following information in the "How to Use" section:

» Configuring the Personal Web Server for the First Time
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* Requesting a File from the Web Client
e Setting Up Your Own Web Page

Troubleshooting

If you experience difficulties using the Personal Web Server application, refer to the
following items:

O After configuring the Web Server, if the web client is not able to access the Web
Server, check the port number in the Personal Web Server Configuration. If the
port number is other than 80 (this is the default port number), then it has to be
specified in the URL. If the port number is not specified, the error message "World
Wide Webserver not active on hostname" is displayed.
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Chapter 26. WebSpider

WebSpider is used to create and design documents to be viewed over the World Wide
Web (WWW). Documents for the Web are written in the Hyper Text Markup Language
(HTML), which is a text-based languagelTML documents, unlike word processor
documents, can be viewed over many different platforms using various browsers, such as
the NetManage WebSurfer.

HTML is simple ASCII text with embedded tags. These tags allow you to add graphics
to your text, change the appearance of the text, and create hypertext links. The
WebSpider allows you to create such HTML documents without having to learn HTML.

WebSpider makes formatting an HTML document as easy as formatting any regular text
document. You can use its convenient toolbar and menus to apply styles, headings,
links, lists, forms, and insert images. WebSpider automatically inserts tags, without
making you aware of the HTML implementation. Therefore, HTML tags are defined,

but not displayed.

The Editor displays the HTML in a WYSIWYG format (What You See Is What You
Get), meaning the created documents appear in the Editor as they will appear when
viewed in the Browser.

The advanced editing features are fully supported for HTML 2.0 files or files created in
the WebSpider. HTML syntax validation and the WYSIWYG viewing also supports
HTML 3.0 files.

WebSpider can be used with other NetManage applications to publish your own HTML
pages for the World Wide Web (WWW). Refer to online Help for details on Publishing
HTML pages.

Formatting Text

WebSpider provides a quick and easy way to format text. The typical word processor
functions are available through the Edit menu: cut, copy, paste, delete, find and replace.
All of these options are documented in the online Help. In addition, HTML formatting
tools are available: character styles, paragraph styles (including various headings),
document styles and lists.

Character Styles
Character styles apply the following style options to the characters selected:

« Bold
« |talics
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e Underline
e Strong (HTML tag)

Used to emphasize text. The display implementation is Browser dependent. The
common implementation is Bold.

» Cite (HTML tag)

Used to mark citations. The display implementation is Browser dependent. The
common implementation is italics.

* Fixed Font (HTML TT tag)

Indicates that the text should be displayed using monospace (fixed size) font. The
font is Browser dependent. The common implementation is Courier.

o  Strikethrough (HTML S tag)
* Size

Character styles are accessed through the Format menu. Refer to online Help for details
on applying these styles.

Paragraph Styles

Paragraph styles apply to the paragraph containing the current selection. The HTML
editor creates tags specifying how to format that paragraph.

The following styles are available:

* HltoH6

Defines text in relatively different size fonts for emphasis. HL1 is the larger font,
common implementation is bold. Each of these styles becomes progressively
smaller. H6 common implementation is smaller than the normal font.

* Preformatted

Defines that the current paragraph should be displayed in a fixed font, and that no
Browser adjustments should be performed on this text. For example, Browsers will
usually eliminate white space such as double spaces and tabs. In a preformatted
paragraph, no adjustments will be performed. The common implementation uses
the Courier font.

e Address

Defines that the current paragraph should be displayed as an Address. The
common Browser implementation is italic. This style is often used for emalil
addresses.

« Normal

Defines that the current paragraph should be displayed as a regular paragraph, no
styles applied.
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Paragraph styles are accessed through the Format menu.

Left Indent and Center

The Left Indent and Center styles are applied to blocks of text, to format their
justification. Indent styles are accessed through the Format menu or button bar.

Document Styles

Document styles apply to the whole document. You may set a background image (wall
paper) for your document or the following colors: background color, text color, link
color. Visited link color and active link color.

Document styles are accessed through the Format menu. Refer to online Help for details
on applying these styles.

Lists

WebSpider allows you to create different types of lists to enhance text. All lists are
indented from the left. The list styles available are:
* Ordered

Automatically inserts item numbers.

* Unordered
Automatically inserts bullets.
* Dir
Bulleted list similar to the Unordered list, consisting of short items, typically up to

20 characters each. Items in a directory list may be arranged in columns, typically
24 characters wide. The common browser implementation is as an Unordered list.

*  Menu
Bulleted list of items with typically one line per item, making it more compact than
the ordered list style. The common browser implementation is as an Unordered list.

Increase List Indent creates a nested list by moving a list item right by one tab stop.
Decrease List Indent moves a nested list item back (to the left) one tab stop.

Note: Increase and Decrease List Indent commands will be available only when cursor
position is in a list.
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Links

Links are used to create a jump (hyperlink) from the selected text to another specified
document or Internet resource. Links are used to reference any resource on the Internet.
When a link appears in the document, the Web Browser uses the link to go directly to
that resource, using the protocol selected when creating the link. There are three types
of links:

» Internal links jump to a reference in the same document
» Relative links jump to a file in the same directory
» External links jump to a file on another computer.

To create a link:
1. Select the text you want to link to the destination document.

2. Choose Create Link from the Link menu or use the icon from the tool bar.

- Lk
Lirk. infarmatior
Target file lozation components

Protocol: Host: Fort: Path and file name: Target in file:
|HTTF' |i| |Isr an |a’c:\netmanag. 32%netm.htm Infa
Uszer name: Pazzword:

| Albert | xxxxxxx

Target file location:

| http: /12804 e: Anetmanag. 32/ netm2. htm#l nfa Browse...
Title:
|Books

[[_ok__ ][ Testiink ][ Cancel || Help

A Link dialog box appears.

Specify the target file location components (URL). The information that you must
supply depends upon the type of link that you are creating:

» Protocol - Select the communication protocol required to access the destination
Host: HTTP, GOPHER, FTP, FILE, TELNET, MAILTO, NEWS.

For Relative links, select none for Protocol and leave the Host and Port
empty. For Internal links, select none for Protocol, and leave the Host,
Port, and Path and File Name empty.

* Host - Enter the name of the destination Host.

» Port - The Port displayed is the standard port used by the chosen protocol. Itis
recommended to keep the standard port.
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» Path and file name - The destination file name, including directory path if
necessary. Use the Browse button to select the desired file.

» Target in file - Optional, by default the link transfers to the beginning of the
targeted document. With HTTP and File protocols, it is possible to link to a
specified point inside a document, if it has been defined as a Target. Enter the
Target name you want to link to. Use this option to link to a different point
within the same document.

» Username - Enter the appropriate username for Protocols that require a
username for connection.

» Password - Enter the appropriate password for Hosts that require a password for
connection.

» Target file location - The information that you entered in the Target file
location components fields, automatically appears in this field.

» Title - Allows you to provide an alternative name for the destination document.
Enter the name you require.

You can enter the string, if known, directly into the Target file location field,
eliminating the need to fill in all the components. You may also use the Browse
button to browse for a target file.

Note: It is advised to enter the details into each of the Target file location
components fields, since the input is automatically converted into a valid
URL, displayed in the Target file field. Advanced users, or users that know
the exact target file location (URL) they wish to link to, may enter the
information directly into the Target file field.

e Test Link - Choose this button to test the link you just created.
3. Choose the OK button.

The style of the selected text changes to reflect the existence of a Link.

Note: The Create Link command is available only when text, that is not already a
link, is selected.

You can test, modify and remove Links - refer to the online help for details.

Targets

Links automatically jump by default to the beginning of documents. If you want a Link
to jump to a specific part of a document, you must create a Target at that point. The
Link can be specified to jump to the target. The Create Targets command is accessed
from the Link menu. Refer to online help for details on creating, editing, and moving
targets.

If the Highlight Targets command from the Settings merselisced, the Targets in the
document will appear in a different style so that they can be distinguished from the other
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text. The reflection of the Targets in the Editor is for your convenience. The common
Browser implementation of Targets will not display the targets in a different style.

Note: The Create Target command is available only when text is selected which is not
an existing target.

Forms and Controls

A Form is the computer equivalent of a paper form that enables the client to interact
with a Web page. Forms enable two-way communication through the use of HTML.
You create a Form in WebSpider and place it on the Web and this information is
returned to the URL specified when the Form was created. Commands include Create
Form..., Edit Form Attributes..., and Select Form

Forms may contain various Controls, such as radio buttons, submit buttons, image
buttons, text boxes, selection lists and password boxes. These are interactive building
blocksthatcan be brought together and defined as Forms. These allow the user of the
Web page to enter information and submit the form. WebSpider provides ready made
controls for easy use. The user just uses the convenient controls palette and enters the
relevant information into the pop-up dialog box, as in the example below.

= Wiy Weatpien: mmuﬂlnk |2)=
i el Domare s Dl = A Rk bl e NS
Jlglﬂ-_ﬂ_:'-—J:l:lEJ.—_[‘_ 12| ﬂl_ﬂ
Selolai] =] o] o [0] ETo &) g8 (==l o] s
My Lventd wodid & T elT Mis m = F
Yemm e rhorh bermn & -
s L o |
I I =}
[ T . L
i =
=] 5]
=T}
e I-
T "I
= ———— — |

After you launch the page on the Web that you have created it will appear like the
example below. See Online help for more details on Forms and Controls.

Forrms provide a wariety of ways you can ask questions or get information. You can use radio  |*

buttons:

My faworite color is O red or O blue

Tou can use check bozes

[ Red

™ Green

[ Blue

Tou can have drop dewn boxes which have preset answers in them: Product: red j
orange

You can have lines where users provide information

| Name

[ Address

I Phone Number
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Insert Inline Image

You can insert a picture into the document as an inline image at the current cursor
position, and set the image's attributes. Various graphic formats are supported, but it is
advised to use the GIF format for maximum browser compatibility. If your graphics are
of a format other than the GIF format, you may use NEWTView to convert the existing
graphic to the GIF format. You can access Insert Inline Image through the Element
menu. Refer to the online Help for more details.

WebSpider provides you with a library of icons and graphics, found in the
NETMANAG\WEBSPID directory. To use these icons or graphics, refer to online help.

Example HTML files

WebSpider provides you with a small library of example HTML files and graphics in the
NETMANAG\WEBSPID directory. Also, you may look at the WebSurfer library,
provided in NETMANAG\WEBDOCS. To use these files first open an example file,
save as another name, and edit as you wish.

Launch WebSurfer

This command can be found under the Tools menu and as an icon and will launch the
WebSurfer with the current document, allowing you to view and test your document in
the Browser environment.

Spell-Checking

You can use the Check Spelling command from the Tools menu (or use the toolbar icon)
to check the current document for spelling mistakes. Detected errors can be fixed, using
one of the suggested replacements or a replacement of your own. Detected errors may
also be ignored or added as a valid word into one of your dictionaries. You may set
various spell-checking options.

Additional Online Information

The online help file for WebSpider includes a description of each menu command, plus
the following information in the "How to Use" section:

* Examples

» Formatting

* Forms and Controls

» Graphics

*  Hypertext

*  Publishing HTML Pages
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Chapter 27. Forum

The Forum application allows you to subscribe to News Servers in your local Intranet
environment or on the Usenet. You can connect to more than one news server,
subscribe to newsgroups, work offline, read articles, and post and mail articles
containing multi-media (HTML) and attachments.

Forum is used to exchange information in the form of news articles that are broadcast to
discussion groups to which a group of members are subscribed. News articles are posted
into newsgroups according to their subject matter. The number and type of newsgroups
available to you are set by your system administrator.

Forum in previous versions was called NEWTNews. The icon for NEWTNews (Internet
Access group) and the icon for Forum (Group Collaboration group), both open the same
application.

Using Forum
To use Forum:
1. Choose the Forum or NEWTNews Icon

2. Log into Forum using the same name and password which you would use for mail.

If you are already logged into a NetManage mail application, the login pop up will
not appear.

3. The first time you are using Forum, enter the name of the directory where you want
your configuration files saved and articles downloaded and choose the OK button.

4. You are automatically connected to the enabled Servers specified in the news tab of
the Network Settings dialog box. If there are no active servers specified, select
Network Settings from the Settings menu and enter the appropriate information (see
Section News Servers) . The groups you are subscribed to are displayed. If you are
not subscribed to any groups, select Subscribe from the Groups menu and subscribe
to newgroups.

Whenever there are no servers defined, or none of the defined servers are active, or no
subscribed newgroups exist for a server, a Forum popup tip outlines the above step.

5.  You may toggle the Forum connectivity state, by choosing the Go Online and Go
Offline commands.
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News Servers

To specify the news servers used during your Forum sessions complete the following:

1. Select Network Settings from the Settings menu.

Network Settings

ntamet| 0% | FaxcFAxS | IMAPT news | Add
MNews Server Profiles:
Bemove
janet Add
university
x Hel
NEws Madity [=
Disable
Delete
Default Senser:

OK Cancel

2. The Network Settings dialog appears with the news tab selected. This dialog
contains a list of all the profiles in the current configuration file. All enabled
profiles appear with an asterisk to the left of the profile name (disabled servers do
not have an asterisk).

3. To create a new profile choose the Add button, the Add Server dialog appears.

Add Server Profile [ x|

|news2

Profile Name:

Server Information

Hast news.netvision.neti Part 119 E

Lagin

Usemame: |

Faseword: |

General Preferences
¥ Check for new groups at starup

¥ Check for new aricles:

Check Interval: El@ hrs DE min

QK Cancel | Help |

4. Specify the Profile Name: This is the name that will appear in the News Server
Profiles list box.

5. Specify the News Server:
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Host: the name or IP address of the remote news server.
Port: the number of the port to connect to on the news server. The default is 119.

Note: There may be several profiles for the same news server.

6. Specify the Login details (for servers that require Authentication):
Username: the user name used to log into the news server.

Password: the password used to log into the news server. The password is not
displayed.

7. Specify any required option in the General Preferences section:

Check new groups at startup: when checked, each time the Forum program is
started, a check for new groups will be performed on the news server. You can view
new groups in the Subscribe dialog.

Check for new articles: when checked, performs periodic checks for new articles in
the subscribed groups on the news server, according to the set interval.

Check interval: specifies the interval for checking for new articles (in
hours and minutes).

8. Choose the OK button
The new profile appears in the profile list, in the Network Settings dialog.

Enable / Disable button: used to enable or disable the currently selected profile. Enabled
profiles are active during the Forum session, whereas the disabled profiles are kept in
the configuration file, but are not active and are not displayed. All enabled profiles
appear with an asterisk to the left of the profile name.

The Modify, Add buttons: activate the server dialog box. The Delete button deletes the
selected profile.

Default Server: select which profile should be used as your default server. It is advised to
set the profile defining the Usenet server, as this default. Forum will use the server
specified in this profile, in the following cases:

* When as articles sent form Forum specifies news group addresses that do not
specify a server. Forum will post the article to the news group in the Default
Server.

*  When Forum receives a URL request (e.g. when activating a jump to a news
group from the WebSurfer) which does not specify a server. The specified news
group or article will be searched for on the Default Server.

Note: Forum supports URLs using the NEWS protocol.
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Subscribing and Unsubscribing to Newsgroups

This section describes how to subscribe and unsubscribe to available newsgroups.

To subscribe to a news group:

1.

Choose the Subscribe command from the Groups menu. The Subscribe dialog box

appears.
T |
T T |
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Select the News Server you require.
Select the appropriate radio button for the view you require of Unsubscribed groups:

e All: full list of groups - default view
* New: a list of the newest groups on the server

Note: The list of the new groups is preserved locally and can be displayed at any
time by choosing the New view radio. This list is recreated each time Forum
performs a check for new groups on the server, either at startup or when
using Update List.

» Pull down list of hierarchies: a list of the groups according to the type of group
which can be viewed by selecting the radio button.

If you know the name or part of the name of the news groups you want to subscribe
to, then type text into the edit box above the list. The current list will be filtered
according to what you enter.

Once you locate the desired news group(s) to which you want to subscribe, highlight
them and choose the right arrow (>>) button. The selected groups will appear in
the Subscribed groups list.
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Additional activities available in the Subscribe dialog:

Rebuild List - choose the Rebuild List button to connect to the server and retrieve
the full list of all groups from the server. The groups will appear in the list of
Unsubscribed groups (except those you are already subscribed to - which will appear
in the list of Subscribed groups, on the right side).

Note: This operation may take several minutes - depending on the amount of
groups on the server.

Update List - choose the Update List button to connect to the server and retrieve a
list of all the new groups from the server. These groups will be added into your
current list of Unsubscribed groups.

Cancel - choose the Cancel button to abort the Rebuild List or Update List
operations.

When you are finished, choose the Close button to update your subscriptions.

To unsubscribe or delete your subscription to a news group:

1.
2.

Select the news group which you want to unsubscribe.

Choose the Unsubscribe command from the Groups menu. The selected news group
will disappear from the view or

highlight the group in the list of Subscribed groups and choose the left arrow (<<)
button.

Handling and Reading Articles

To list and view the articles in a news group, do the following:

1.

Select the news group whose articles you want to view. Shown next to each news
group are the number of unread articles and the total number of articles.

Choose the Open command from the Groups menu or double-click on the group.
The articles will appear in the right pane of the Forum main window.

The Threading feature organizes the article listing so that all articles and their
associated responding articles (RE: and FW:) are grouped together. You can
display an article and its associated responding articles hierarchically by selecting
the Expand All/Current command or double-clicking on the thread. Use Expand
All only if you want to expand all threaded articles. If you want to hide all the
responding articles hierarchically, then select the Collapse All/Current
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3. Select the article(s) you want to view and choose the View command from the
Articles menu or double click the article.

4. After you read the article, choose the Exit command from the File menu to close the
article and return to the main screen.

Note that an open book icon appears to the left of a previously read article.

Use Catch Up to mark all articles in a particular news group as read, even if you have
not read any of them. All read articles may disappear when you exit the current news
group (if so set in the Preferences).

Printing Articles

To print an article, do the following:

1. Select or view the article, then choose the Print command from the File menu to
display the Print dialog box.

2. Choose the OK button to print the article.

Saving Articles as Text

To save an article to a specified file, do the following:

1. Select or view the article, then choose the Save as Text from the Articles menu.
2. Enter the Filename, File Type, Directory, and Drive and choose the OK button.

Note that you can select multiple messages and save them all at once.

Posting and Replying to Articles

You may post articles to news groups and email addresses. The following options are
available from the Articles menu:
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» Post: Send an article to the selected news group.

* Reply to: Send a reply to the selected article, you have a choice of different
recipients: Newsgroups, Current Newsgroup, Sender and All.

+ Forward: Forward the selected article.

Downloading Articles to Your Local Drive

Downloading articles enables reading the articles at your own leisure, when Offline. To
download articles, do the following:

Select or view the article, then choose the Download command from the Articles menu
(you may select more than one article by holding down the Shift key while selecting the
articles).

or
Select a group, then choose the Download Group command from the Groups menu.

The articles will be downloaded to your local drive. The articles are automatically
downloaded to your news directory.

Note: The icon of downloaded articles or groups has a picture of a small diskette on it,
indicating the article or group are downloaded.
Settings Menu

You may set the mode for editing and viewing of articles to either the plain text mode or
the HTML mode. The HTML mode will enable creating multimedia articles, with styles,
images, links and so on.

You can set preferences to control which articles you want to read and how they should
be displayed.

You can set fonts, colors and display information.
You can define the News Servers that you want active during your Forum session.

Refer to Forum online help for detailed information using the Settings menu.

Services Menu

You may define and edit Address books, launch the Outbox, display the log and test the
connection to a server.

Additional Online Information

The online help file for Forum includes a description of each menu command, plus the
following information in the "How to Use" section:
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* Additional Publications

* Addressing Articles

* Login Directory

* News Group Types

» Posting and Replying to Articles
* Reading and Handling Articles
* The Usenet

» Using Address books

* Using Forum
* Using the Outbox

Troubleshooting
If you experience difficulties using the Forum program, refer to the following items:

O Make sure the host name to which you are trying to connect to and its profile
information are correctly entered in the Network Setting dialog, and that the system
administrator assigned you access permissions to that server.

O If Forum reports a failure to connect, use the Diagnose Connection command from
the Services menu, which will verify the connection to the remote host.

O Verify that the Forum settings are correct and the timer settings for retrieval of new
articles from the host are set appropriately.
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Chapter 28. Archie

Archie helps you to retrieve text, graphics, and sound files from anonymous FTP hosts
(hosts that can be accessed by anyone on the Internet using a special userid named
anonymous).

The NetManage Archie client program provides a menu-driven interface that lets you
browse through the various Archie servers on the Internet as though you were browsing
through card catalogues of remote libraries.

Archie is an Internet information service for gathering data and indexing widely
distributed collections of data. The anonymous FTP hosts contain certain directories
that are designated for public access. Other computers, called Archie servers, provide
an archiving search service to help Internet users find directories and files on the
anonymous FTP hosts.

Starting an Archie Search

You can start a search in either of the following ways:

» Specify the desired search criteria in the dialog bar and press ENTER.

» Select the Search menu. Specify the search criteria in the Search dialog box, and
choose the OK button.

Note: Search parameters can be specified either in the dialog bar or the Search menu
popup dialog box.

Selecting an Archie Server

You can start a search using the Archie default server. You can change the server by
selecting a different server using the Server command from the Services Menu, or by
selecting a different server from the scrolling list in the Search menu dialog box. The
contents of the Archie database are usually the same on different servers. If you cannot

Chameleon ATX User's Guide 239



connect to one server (the servers are often busy), you can select a different server. You
can use the Query option from the Search menu to find additional Archie servers.

Specifying the Object of the Search

You can specify the object of the search in either of the following ways:

» Type atext string in the empty field in the Archie dialog bar.

» Select the Search menu and type a text string in the Keyword field of the Search
dialog box.

Whatls

Whatls searches for the specified text string in a collection of information called the
"Software Description Database." The Software Description Database contains short
descriptions of programs, documents, and other files that are located on the anonymous
FTP server archives. These descriptions are provided optionally by the person who
submitted the file to the anonymous FTP server. Note that these descriptions are
submitted on a voluntary basis, are not edited, and are not updated on a regular basis.

Whatls is an alternative to the Search command. If your Whatls search is successful, it
can help to narrow your search of the Archie archives themselves. However, you may
often be able to find files in the Archie archives even though the Whatls search was not
successful.

When you select Whatls, Archie displays a popup dialog box with a blank field in which
you can type a word (or text string).

You can select the Whatls command either from the Search menu or from the scrolling
Query list in the Search dialog box.

Retrieving Information

After Archie has successfully connected and logged in to the selected server, Archie
displays a list of items retrieved.

The display of items retrieved includes the following columns (from left to right): the
name of the anonymous FTP host, the size of the file, the path of the directory or, and
either a file name or short comment. Note that the icons in the furthermost left column
indicates whether the retrieved item is a directory or a file.
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Quote

The Chameleon Archie application provides you with a menu-driven point-and-click
interface for conducting an Archie search. However, if you wish, you can also type the
UNIX-based Archie commands by using the Quote command in the Services menu. To
display a listing of all the Archie commands, type the word "help" within the Quote text
box.

Additional Online Information

The online help file for Archie includes a description of each menu command, plus the
following information in the "How to Use" section: command

* Retrieving Information

» Selecting an Archie Server

e Setting Up Archie

»  Specifying the Object of the Search

» Starting an Archie Search
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Chapter 29. Talk

The Talk application lets you participate in real-time conversations with remote users.
Talk acts as both a client and server, and notifies you of remote Talk invitations by
displaying a popup dialog box with or without sound.

Preparing to Talk

You can specify a remote user and host (using the format <user>@<machine>) in the
Talk With field of the main Talk window, or you can use a conversation profile.

The host name identifies the physical machine to which you want to connect. If the
machine is being used by only one user, you can specify just the host name
(@<machine>). For example, you could specify: @lizzie.netmanage.com.

If the physical machine is being used by more than one user, you can send a Talk
invitation to the particular user that you want to talk with by specifying both the user
name and the host name (<user>@<machine). For example, you could specify:
chamboy@lizzie.netmanage.com.

A conversation profile stores necessary connection information, so that you can establish
a conversation with a remote user without reentering connection details. After you
create a Conversation Profile for a remote user, you will be able to send a Talk invitation
by selecting the user's profile from a drop-down menu. You can define as many
conversation profiles as you wish.
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Establishing a Conversation

To establish a conversation with a remote user:

1.

In the Talk With field, type a remote user and host name or select an existing
Conversation Profile from the drop-down menu (click the down arrow next to the
Talk With field to display the menu).

» user. Enter the name of the remote user with whom you wish to connect. In
general, you should specify both the user and the host name.

» host Enter the name of the remote host to which you wish to connect. The
remote host identifies the physical machine that is being used by the user with
whom you wish to talk.

For example, if Camille had a PC, we might identify her PC's host name as
camille.netmanage.com or as its IP address ( such as,

111.22.3.444). The host name must match the name or IP address that is
listed in the Domain Name Server (DNS). When you type the host name
in the Talk With field, you should put the @ in front of it. For example,

type @camille.netmanage.com or @111.22.3.444.

Choose the Talk button to open a conversation window.

Type your message in your section of the window, which is the box located near
your username.

You can also enter information by using the Edit menu’s Copy and Paste options.

Talk sends your message to the remote user. If the user responds to your Talk
message, the response is displayed in that user’s section of your conversation
window. You can continue conversing with the user.

If you want to save the information displayed in the conversation window, take the
following steps:

* Choose the Save button.

» A Save Conversation File As... dialog box appears.

»  Specify the file in which you want to save the conversation.
* Choose the OK button.

» If the specified file exists, Talk prompts you to append the information. Talk
saves your portion of the conversation in one section of the file and the remote
user's portion in another section.

After you finish conversing, choose the Disconnect button.
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Receiving Talk Invitations

You can use Custom to configure your system so that Talk can respond to Invitations
without having to keep your Talk application activated.

Note: Steps 1 through 5 apply to Windows 95 and Windows 3.1 users only. If you are
using Windows NT, both users must have the Talk application open to talk to
each other.

To configure Custom, do the following:
1. Open your Custom application.
2. Choose the INETD Configuration option from the Services menu.

3. Add both Talk servers to the list of installed servers by selecting NTALK or TALK
server from the list of servers and clicking on the right arrow button.

» Check to make sure that the Server name now appears in the list of Installed
Servers.

* Repeat this procedure for the other server.
4. Choose the OK button and close the INETD Configuration dialog box.
5. Restart Windows.

When you receive a Talk invitation, a Can We Talk? dialog box appears. You can set up
Talk to also notify you audibly by selecting an option from the Preferences dialog box.

» To converse with the sender, choose the Accept button. Talk displays the sender’s
message in the conversation window.

» To refuse the invitation and notify the sender you decline to talk, choose the Decline
button.

» To refuse the invitation without notifying the sender you decline to talk, choose the
Ignore button.

Ending Conversations

To end a Talk conversation and close Talk, choose the Exit option from the File menu or
choose the Disconnect button.

Additional Online Information

The online help file for Talk includes a description of each menu command, plus the
following information in the "How to Use" section:

» Creating Conversation Profiles
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Modifying Conversation Profiles
Deleting Conversation Profiles
Establishing Conversations
Receiving Talk Invitations
Responding to Talk Invitations
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Chapter 30. Internet Relay Chat

Internet Relay Chat (IRC) is a multi-user, multi-channel chatting network. It lets people
connected to the Internet talk to one another in real-time. Conversations take place in
areas called channels. A channel is a separate and distinctive electronic meeting area
where people can talk simultaneously. There can be any number of channels in IRC, and
any number of people within a channel. Some channels exist all the time, while others
come and go as the need arises.

Each channel usually has at least one operator, who is responsible for managing the
channel. Channel operators control the channel and have special privileges to maintain
it. The initial creator (and the first person) of a channel has channel operator privileges
and can give or take away these privileges to others on the channel.

Users are known by a nickname. This nickname must be unique on the network at the
time and is limited to nine characters. Nicknames are really not owned because you may
find your normal nickname in use the next time you connect to IRC, and will be asked to
use another nickname for that session.

While on a channel, all normal text that you enter goes to the channel for all others to

see. The one exception to this is if the text starts with a slash. A slash means the text

that follows should be interpreted as a server command. You can log the text of a chat
session on a specific channel and save it automatically to a text file.

During a chat session, you can also send files to channel members using the DCC (direct
client-to-client) protocol. This protocol handles any file transfer type, including text and
binary. You can send one or several files to only one nickname per request, but you can
send multiple requests at the same time.

If you want to keep a record of whatever you see on a channel, you can use the logging
function. You can log each session on a channel separately and save it automatically to a
file.

The IRC server that you connect to defines what network you are on. There is one main
network often referred to as EFFNET. EFFNET usually hosts about 2500 channels with
up to 5000 people at peak times. Other networks have improved the servers in varying
ways and have fewer members (examples include UNDERNET and DALNET).
Volunteers, usually at colleges and universities, operate and maintain these networks of
servers. These networks are not secure; do not assume any form of privacy.

Connecting to IRC

To start the IRC application, choose the IRC icon to display the main IRC window.
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There are two types of tabs: a Server tab and a Channel tab. There is only one Server
tab, which has two main text areas. The top text area, the Server Information box,
displays server output. This area can also contain error messages if local operations fail.
The bottom text area, the Channel box, lists the current channels on the connected
server. It displays the channel name, the number of users on the channel, and the topic.

There are as many channel tabs as there are channels that you have joined (the
maximum is ten). When you join a channel, a new channel tab is created and brought to
the top. It contains a small text box on top with the topic and any status information,

and a large area for the channel conversation text on the bottom.

To connect, do the following:

1. Select either the Connect! menu option on the menu bar or the Connect button on
the Server tab to display the Information not found dialog box. This dialog box
explains what information you must enter to connect to an IRC server as a first-time
user.

2. Choose the OK button to display the Preferences dialog box, then choose the User
tab.

Complete the information in the following fields for preferences listed on the User tab:

Field Description
Default nickname Under the User tab, enter your nickname. This hame can be nine

characters or less.

Alternate nickname  Enter another nickname in this check box if you want to
automatically try another nickname when your default nickname

is in use.
Username Enter your username if it is blank.
Hostname Enter your hostname. The local hostname is the actual machine

name. The username and local hostname may be filled in if the
IRC client can get this information from the local machine.
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Field Description

Description Enter a single line of text identifying yourself (this is optional).

"Away" text Enter a single line of text that will be sent to people when you
are away from IRC, but still connected and someone sends you a
private message. This is also optional.

When you have entered information in all these fields, choose the Server tab to redisplay
the Preferences dialog box.

Complete the information in the following fields for preferences listed on the Server tab:

Field Description
Server Shows a list of all IRC servers available on a specific

network. You can select a server from the list in the drop-
down menu or enter one in this field.

Port Leave 6667 as the port number unless you know a server
uses a different port number.

Current server list from file ~ Shows the default server selected on that network.
Choose the Browse button to display the Select server list
dialog box. From this field, you can select a different
server than the one listed or change the server that you
want to connect to for your next IRC session.

Select one of the server networks listed in the File Name list box, then choose the OK
button. The Current server list from file field is then updated with the network server
that you have selected.

Select the Connect button on the Server tab or the Connect! menu option.
After connecting, the Server Information box shows the following information:

*  The number of IRC users
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* The number of channels being used
»  Other information that the server may send

{000 O 1 I
|.

Note: You can change the IRC server selected by choosing the Server icon in the
Toolbar, or by choosing the Set Server (shortcut) command from the Settings
menu. Choosing this command places you directly in the Preferences dialog box,
with the Server tab selected. You can make a change to the server you have
selected quickly and easily, then return to your current IRC session. You will
connect to the new server you have selected when you start a new IRC session.
This feature is only available in Windows 95 and Windows NT.

After connecting, the Channel List box shows the following information:

e The Channel column shows the names of channels in use.
* The Users column shows the number of users on that channel.
* The Topic column describes the subject being discussed and may be blank.

Note: Your currently used nickname now appears in the Nickname: field.

From here, you can browse the channel list, join a channel, or create a new channel.

e |
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Additional Online Information

The online help file for Internet Relay Chat includes a description of each menu
command, plus the following information in the "How to Use" section:

e Connecting to IRC

» Changing Nicknames

* Creating a Channel

e Getting Current User Information

e Getting Past User Information

* Transferring Files

* Using Filters

» Banning a User

» Entering Text Commands

» Using Configuration Files

Troubleshooting

If you experience difficulties using IRC, refer to the following items:

O If you cannot connect to a server:

Make sure that a valid server name appears in Preferences on the Server tab.
The port number is almost always 6667, unless otherwise instructed.

Select the Help menu and choose the Diagnose Connection... command to see if
you can ping the server.

Wait; sometimes the servers takes several minutes to respond.
You or your site has been banned from that server.

0 If changes do not occur immediately after you make them:

Be aware that very busy servers may respond slowly.

Wait; you may not see a screen display change until the server confirms the
action you performed.

O If you made a change and nothing happened:

A server may silently ignore an incorrect or redundant request. For example, if
you try to set a mode on a channel that already has that mode, nothing happens
and you receive no error messages.

Check the Server Information box on the Server tab: it may have an error
message. Error dialogs do not appear because they may be out of order and be
confusing.
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O If you repeatedly get disconnected when you connect to a server:
» Check the server information box for any messages.
» Try changing your nickname or try another IRC server or another IRC network.

O If you cannot join or create a channel, check the Server Information box on the
Server tab. Perhaps the channel already exists and is Invite only, needs a keyword,
has a user limit, or has banned you.

O Itis possible that the servers listed in the Current server list from file: field are no
longer available. If you know the name of a valid IRC server, enter it in this field.
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Chapter 31. NEWTView and
NEWTSound

NEWTView

NEWTView is a tool for displaying, copying, and printing bit-mapped graphics files
produced by various applications. For example, NEWTView lets you view, copy, or
print a graphics file received as an attachment from e-mail or downloaded from Gopher
or Archie. You can view, copy, or print the graphics file without using or having the
application that created it. NEWTView can also be used for displaying, copying, or
printing electronic documents transmitted via fax.

Supported File Formats

The NEWTView dialog box contains a list of currently supported file extensions.
Supported file formats include the following:

« .BMP
« .GIF
« JPG
« XBM
« TIF
« .PCX
« .DCX
« .DIB

.WPG (Word Perfect image files)
* .PCT (Mac PICT files)

Additional Online Information

The online help file for NEWTView includes a description of each menu command.

NEWTSound

The NEWTSound application enables you to run a sound file.

Note: You must also have a sound board or a sound-board emulator installed in your
computer to use this application.
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* When you open the application, a NEWTSound dialog box is displayed, allowing
you to select a directory and a sound file.

The NEWTSound application does not contain any additional menus. However, the
NEWTSound dialog box does contain a few buttons. To play a sound file, select the file,
then choose the Play button. To stop the sound file, choose the Stop button.

Supported File Formats

The NEWTSound dialog box contains a list of currently supported file extensions. The
supported sound file formats are:

« AU

« .MOD
« .SND
« VOC
« WAV

Additional Online Information

The online help file for NEWTSound includes a description of each menu command.
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Chapter 32. Gopher

Gopher is an Internet access protocol tool. It allows you to browse through large
amounts of information residing on the Gopher system called GopherSpace.
GopherSpace organizes information into hierarchical menus related to subject matter or
the Gopher server's geographical location.

Much like browsing through a remote library's card catalogue and automatically
fetching the material you want, Gopher helps you access any of the data it presents.

The resource material in GopherSpace consists of data in a variety of formats such as
text, images, sounds, and services such as Telnet connections, index servers, and phone
book servers. Each item is labeled by an icon that identifies it as a directory, text file
(.TXT), graphics file (.GIF), phone book, or searchable index.

While documents reside on many servers, it does not matter where the resources are
located, as long as they are part of GopherSpace.

Setting Up Gopher

The NetManage Gopher client requires no special setup or configuration. However, the
network on which Gopher runs must be properly configured, and you need to make sure
that the File Manager associations exist between certain file types and their viewers. To
see if the proper network connection exists, choose the Diagnose Connection command
from the Help menu.

Gopher uses the File Manager file association system to determine the appropriate
viewer program for viewing different kinds of files. For example, files with the .TXT
extension should be associated with a text viewer such as Notepad or Write. To view
GIF images, associate files with a .GIF extension to NEWTView or any other GIF
viewer. Associate sound files with NEWTSound.

Starting Gopher

When you first start Gopher, a split window appears. The left half displays a directory
tree and the right half displays only a directory of the current server's contents. The
directory tree contains the contents of all the Gopher servers visited in the current
session, as well as any servers saved in your configuration file.

The Gopher interface resembles a file system like File Manager and tracks two types of
items: directories and resources. All resources are accessed through directories. Choose
the Symbol Legend... command under the Help menu for a list of all resource types.
Directories and individual resources are labeled with their own distinct icons.
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Gopher maintains a configuration file (usually GOPHER.CFG) that stores your user
preferences and GopherSpace hierarchy information.

Retrieving Resources from the Network

To increase retrieval performance, Gopher stores everything it retrieves in a local
directory on your computer. Published Gopher resources do not change often and at
times the resources may be difficult to retrieve (servers may not always be up and
communication links may be slow). When Gopher cannot retrieve a desired resource
from the network, it looks for it in your local directory instead.

Gopher retrieves two types of information:

» Hierarchical information, which appears in the GopherSpace display and is stored
in the configuration file.

You can open a Gopher item by choosing the Retrieve Item option from the Item
menu. This option retrieves the selected item directly from the Gopher server and
then opens it. When you close the item it is automatically placed in your Gopher
cache directory.

» File information, which is stored in the Gopher cache directory (which you set up in
Preferences). These files are often named with the letter G, a number, and an
extension indicating file type.

After an item is closed and placed in the Gopher cache directory you can open it
again using the Open command from the Item menu. However, this item may not
contain the most current update since you did not retrieve and open the item directly
from the Gopher server.

The configuration file defaults to the name GOPHER.CFG and the Gopher cache
directory is called gopher. By default, both are stored in the same directory in which
Gopher was installed.

Navigating Around GopherSpace

The GopherSpace hierarchy is divided into two sections: bookmarks and Gopher
servers. Bookmarks are items of specific interest which have been copied from
elsewhere in the hierarchy for convenient access using the Set Bookmark command
from the Item menu.

Servers are references to the Gopher server machines which act as a starting point for
exploring the Gopher hierarchy.

In the left side of the Gopher window, you can select items by clicking on them or using
the arrow keys. For example, to view the contents of a directory, double-click on its
name. Additional directories and/or files, index searches, or phonebooks may also
appear. As you continue to move through the directory in search of items of interest, the

256 Chameleon ATX User's Guide



file system will expand. To collapse any part of the file structure, double-click the
directory you want to close.

You can retrieve items in the right side of window, but you cannot select items from the
right window because the right side tracks the left side.

Additional Online Information

The online help file for Gopher includes a description of each menu command, plus the
following information in the "How to Use" section:

Setting Up Gopher

Starting Gopher

Retrieving Information
Navigating Around GopherSpace
Saving to a Gopher Server

Troubleshooting

If you experience difficulties using the Gopher application, refer to the following items:

O

If you cannot connect to a specific server during peak hours, try connecting again
during off hours. Use the Diagnose Connection command from the Help menu to
start Ping and verify that the server is available.
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Chapter 33. Whols

The Whols application is a TCP/IP Internet username directory service that displays
information about Internet users who are listed in that directory.

For example: Smith, Mary (SC178) msmith@SENCO.COM (513) 333-232
Information about a user includes:

» full name (for example, Smith, Mary)

* handle - a unique identifier, in parentheses. For individuals, the handle is
composed of the person's initials and where necessary, a trailing number (for
example, (SC178)).

» network mailbox for Defense Data Network (DDN) users (who are registered in the
Network Information Center (NIC) database) (for example msmith@SENCO.COM)

» telephone number (for example, (513) 333-232)
* US mailing address

Using Whols

The Host field contains the hostname of a Whols Server. The default server is
rs.internic.net. You can search the Whols directory on a different server by selecting or
typing the hostname of another Whols server in this field.

Note: To view a list of Internet Whols servers, select the Whols Servers List option
from the Help Contents menu command. A list of Internet Whols servers is also
available using anonymous FTP to sipb.mit.edu, in the PUB/WHOIS directory.

To start a search, do the following:
1. Type or select the name of an alternative Whols server or use the default server.
2. Type the username or text you wish to search for in the User field.

3. Choose the Whols button to start the search.

Search Options

Whols allows you to perform a comprehensive search or a more specific search. In
general, searches are conducted in the way outlined in the following paragraphs, but this
may vary between Whols servers. Most Whols servers provide their own help files.
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* General search: If you specify a string of alpha characters, Whols searches for a
name, handle, or mailbox matching that string. For example, if you specify "Smith"
in the User field, Whols searches for the name Smith, the handle (Smith) and the
mailbox Smith@.

» Name-only search: Precede the name with a period. For example, if you specify
".Smith, Jane" in the User field, Whols searches only for the name Jane Smith (not
for the handle or mailbox).

» Handle only search: Precede the handle with an exclamation point. For example, if
you specify "ISmith" in the User field, Whols searches only for handle Smith, such
as Smith College (Smith).

» Mailbox only search: Type the @ character after the name. For example, if you
specify "Smith@" Whols searches for the mailbox Smith only, such as Smith@
CVR.COM.

» Group or organization entry search: Type an asterisk as the first character. For
example, if you specify *SRI-NIC, Whols searches for all users in that group entry.

» Partial search, to find all entries starting with specific text: After the text you want
to search for, type a dot or series of dots (for example, Robert... looks for all names
preceding with the letters ROBERT, such as Robert, Roberts, Robertson and so on).

Note: If there are a large number of members, it will take longer for the list to display.
The Whols button remains dimmed until the full list is displayed.

If the User field is blank and the Whols button selected, any Help or information files
available from the directory specified in the Host field are displayed.

Additional Online Information

The online help file for Whols includes a description of each menu command, plus the
following information in the "How to Use" section:

* Using Whols

Troubleshooting
If you experience difficulties using the Whols application, refer to the following items:

0 Use the Diagnose Connection command from the Help menu to verify connectivity
to any remote system to which you want access.

O Verify that the Host is a Whols server. Note that not all Internet hosts are Whols
servers. ChameleonNFS for Windows Whols provides the major Internet Whols
server (rs.internic.net) in the Hosts drop-down list by default. A list of Internet
Whols servers is available using anonymous FTP to sipb.mit.edu, in the
PUB/WHOIS directory. Alternatively, select the Whols Server list option from the
Help Contents menu command.
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Chapter 34. Internet Viewer

The Internet Viewer allows you to view several different aspects of the Internet from a
single, integrated application. This integrated application includes a News client, a
Weather viewer, a Stock quote service, a Web browser, and a link to NetManage's
What's Hot home page. In addition to retrieving information interactively (that is, in
real-time), the Internet Viewer also provides background retrieval, which lets you define
how frequently you want to retrieve updated information. You need to set a timer for
background retrieval using the Personalize command from the Settings menu.

You can change the view of the amount of data presented. If you double-click a feature
button (such as Forum) or in the feature window, the screen splits in two. When the
screen is split, you can see the HTML viewer and the Forum News group list at the same
time. To return to full-screen mode, choose the button again or click once within the
panel. You can view only the Forum News client and the WebSurfer Web browser in
full-screen or in split-screen mode.

Icons for each feature are displayed in the main panel at the bottom, below the ticker
tape. When you are accessing information, these icons have a status bar that shows
which feature is being updated. Different icons are provided to show active (occurring in
the foreground) and passive (occurring in the background) retrieval for each feature,
except for retrieval from Web sites, where there is only one. If no processing is
occurring, no status bar is displayed.

Each feature is discussed in the following paragraphs.

Note: This application works only on Windows NT and Windows 95.

Forum News Client

The Forum News client allows you to specify a News server to log into, and to download
a copy of all the current news groups available. You may double-click individual News
groups to subscribe to them. When you have selected a News group, a tab is added that
contains the group title. The new tab shows a list with all the items available for the
topic. When you choose an article, it is downloaded and displayed in HTML format.
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The Forum News client provides background processing for both articles and groups.
Each article may appear as one of five colors in the list, depending on its status:
* Yellow: Article has not been downloaded at this time.

* Red: Article was downloaded using background processing and has been added
since you subscribed to a selected group.

* White: Article has been viewed.

* Green: Article has been downloaded, but has not been viewed.

e Gray: Invalid article. Article is out of date and has been removed from the server.
When you set the options to allow background news retrieval, unread articles for
subscribed groups are automatically retrieved. If new articles have been added to the

subscribed group since you originally subscribed, these articles are appended to the list
and eventually will also be retrieved using background processing.

When you close the application, all subscribed groups and article status (that is, read,
unread, invalid, and so on) are saved, as well as any entries or changes you have made
to the application configuration.

Note: There is no limit to the number of articles or newsgroups that you can download.

To start the Forum News client, choose the Forum button.

Weather Viewer

The Weather Viewer allows you to configure and tailor the type of weather images or
Web pages you would like to view.

Note: These images and home pages need not be weather related at all. This feature
provides you with a mechanism to download data and images over the Web using
active retrieval or passive retrieval (by using background processing).
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The Internet Viewer comes configured with several links to weather sites, but you may
add other sites to the drop-down lists contained in the Personalize dialog box. You add
other sites to the list by entering the URL to retrieve, then pressing the Enter key. All
your changes will be saved when the you close the application. When you choose the
Weather button, eight tabs are displayed that let you select from the following:

Satellite: Satellite view of the US

Marine: Coastal marine forecast from the National Weather Service

IR: Infrared satellite view of the US

UV: Ultraviolet satellite view of the US

Temps: Listings for surface temperature, radar, and wind velocity in the US
Precip: Forecast for rain in the US

Doppler: Satellite view of the US showing Doppler effect on weather
Forecast: Projected temperatures shown for various parts of the US

To start the Weather viewer, choose the Weather button.

Stock Quote Service

The Stock Quote service, like the Forum News client, allows both active and passive
retrieval of data. When you choose the Stock Quote tab, stock information for a company
you have requested previously is retrieved.
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The Display Settings box shows a list of 15 items that you can select to display certain
stock information. When you select a stock, the settings you have selected are displayed
in an easy-to-read table. You can scroll to see information in all the columns using the
scroll bar, located below the table.

The Symbol list shows four buttons that you can choose to do the following:

» Choose the Plus button to add a new ticker symbol to the Symbol list box.
» Choose the Printer button to print the stock information shown.

» Choose the Graph button to display the Stock Performance Graph dialog box. You
can select from various graph or chart types, including bar, pie, line, log, and Gantt.
Select the chart type you want, then choose the OK button.

» Choose the Water Mark button to show the Water Marks dialog box.

Water marks indicate pre-established stock prices that you enter for notification
purposes. Enter the high and low prices in the correct fields. If you want

notification when specific stocks reach these prices, you can do either or both of the
following in the Notify box:

» Select the Sound Alarm check box to be notified by a beep on your computer.

» Select the Tag-It! check box to be notified by a Tag-It! message. When you are
done, choose the OK button.

You can receive late-breaking stock news in the shaded text box below the stock
information table. Share prices for various stocks are also shown in real-time on a ticker
tape at the bottom of the panel.

To start the Stock Quotes viewer, choose the Business button.

What's Hot

What's Hot is a ready-to-use hot list that contains a single URL to the NetManage home
page. Included are news flashes and press releases about NetManage products, provided
for your information.
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To download the What's Hot home page, choose the What's Hot button.

WebSurfer Web Browser

The WebSurfer Web browser is a fully functional browser that includes a hot list from
which you may add or delete URLs. When you choose a URL provided on the list, the
home page and data associated with the URL are downloaded automatically. There is no
background processing for the Web Browser panel. All URLs you add to your hot list

will be saved between sessions.

If you want to access a specific Web site immediately, choose the plus (+) button next to
the URL list box or double-click a selected URL.

To start the WebSurfer Web browser, choose the Internet button.

Additional Online Information

The online help file for the Internet Viewer includes a description of each menu
command, plus the following information in the "How to Use" section:

* Using the Forum News Client

» Using the Stock Quote Service

» Using the What's Hot Home Page

» Using the Weather Viewer

» Using the WebSurfer Web Browser

» Personalizing Your Internet Viewer

» Defining Retrieval Settings
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Troubleshooting

If you experience difficulties using the Internet Viewer application, refer to the
following items:

O

To prevent your network from getting unnecessarily slow, you should choose timer
values for the background processing that seem reasonable (That is, updating the
weather every 5 minutes is not very useful since most weather images and reports
are only updated twice a day.).

If you enter URLSs that do not have an address cached on the local proxy server, it
may cause performance problems. To minimize this occurring, set timers to
download data during light-traffic times on the network.

| f you experience difficulties loading the Internet Viewer after it has been run the
first time, delete the .CFG and .DAT files from the root directory and restart the
application.
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Chapter 35. Automatic Internet

Automatic Internet lets you sign up for a new Internet account and automatically
configure your software for connecting to the Internet. Automatic Internet typically only
needs to be used once for each account for which you sign up.

Note: You can use this application only if you are running the Windows 95 or
Windows 3.1 operating system.

Using Automatic Internet

To use Automatic Internet, do the following:

1. Open Automatic Internet. The Select Internet Provider dialog box appears that
includes a tab for each Internet Service Provider and an Others tab. The Others tab
allows you to configure your existing Internet Service Provider account.

2. Select the tab of the Internet Service Provider you want to use and then choose the
Signup button. You can obtain more information on each Provider by selecting the
More Info...button.

— Select Internet Provider

[ CERFret 1 Portal 1 InterRiame.
NetManags T IBM Internet T AlerMet

& NETHANAGE"

Automatic Internet”

Account Sign-up &
Software Configuration

to
Automated Internet Signup and Configuration
Pleas: lect the More Info Button

[ sionup | [ Moretmio | | Help | | Cancel ]

An Automatic Internet Account Sign Up: NetManage dialog box appears. This is
where you enter your personal registration information to send to the Provider.
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3.

Automatic Internet Account Sign-Up: NetManage

Please fill out this registration form T Fill thiz additional foim out as well

Personal Information: Ciedit Card Information:

First Name: Middle Name:  Last Name: Card Type:
[warren ‘ |innes @® Visa C Master Card
(@) C American Express
Address:
[10725 N D& Anza Bivd Card Number: Expiration
| 0000 0000 0000 0000 |01/99
City: State/Province: Zip Code: Y .
|Cupellinu ‘m |95m4
Country: Telephone: Far
[us [#] [smeszazimi |
| Send | ‘ Phone List... | | Advanced... ‘ ‘ Help | | Cancel ‘

Type your name, address, and phone numbers in the appropriate fields. Enter your
name and address as it appears on your credit card. You can enter information in
the State/Province and Country fields by either selecting it or typing it.

Note: Automatic Internet uses a secure phone call to communicate with the
registration server. Your credit card number will not be sent over the
Internet.

You will be presented with various connection options and prices when you actually
connect with the Provider’s server. You will have an option to cancel the sign-up
process after you have connected with a registration server.

Select the type of credit card to which you want to charge the Internet services, and
enter that card’s number and expiration date. You must enter the expiration date
using the following format: mm/yy.

Depending on the Service Provider you choose, there may or may not be additional
tabs to supply additional informatidhat theProvider is requesting at signup.
Select these tabs if they are present and supply the requested information.

Choose the Phone List button on the bottom button bar to open the Phone List
dialog box.

Bl Phonelist |

9-1-703-904-427

Phone List:

9-1-703-904-4273
9-1-703-904-4274
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The phone numbers listed are used to send in your registration inform@tionse
the one most local to you. You may edit this number to add special dialing prefixes
(such as 9) if required by your phone system.

Note that this is not the access number you use to call your Provider for connecting
to the Internet. You will not be communicating your registration information over
the Internet. That number will be downloaded from the Provider upon signup.

7. Return to the first registration tab and choose the Send button to sign up for your
account. Once you choose the Send button, the status area on the lower right will
indicate the progress of your connection and signup. The traffic lights signal the
flow of the registration data from your computer through the phone line to the
Provider’s server and back. Accompanying status messages are displayed in the
text box located below the traffic lights.

8. Choose the Advanced button in the bottom bar only if you need to specify a different
communications port. The Automatic Internet application will automatically sense
your modem on the appropriate COM port. If your modem does not initialize
correctly, please verify the COM setting by selecting the Advanced button and
choosing the correct COM port.

In a few minutes, the Provider’s server will send back your personalized account
information and automatically configure your software. An interface will be created
for Custom that defines how you connect to your Provider. This includes your
username, password and dialup number. Automatic Internet will also create a Z-
Mail® Pro account for you and set WebSurfer, Forum and Gopher defaults
according to your Provider’s specifications. A welcome message from your
Provider will be displayed; you are now ready to explore the Internet.

9. Reboot your system, then run the Custom application to connect to the Internet as
described in the following paragraphs.

Caution: Creating a second account from a new Provider will overwrite the
domain name server, Z-Mail® Pro server and gateway, NNTP News
Server, and WebSurfer default home page settings. Therefore, before
creating a second account, you should write down these settings or back
up the .CFG files.

Verifying or Modifying Your Configuration

The first time after you run Automatic Internet, you should verify the settings for port,
modem, and dial under Setup in the Custom application. If you are using an ISDN card
that supports direct interface with the card usingM@SDN standard, and if your

Provider has downloaded an ISDN interface, you will need to select the Hardware Type
in the Setup menu. You need to verify these settings only once. Use Automatic Internet
only once to sign up for each account.
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Note: NetManage is not an Internet Service Provider; you can only register the software
with us or configure an existing account. However, it is easier to use Custom to
configure an existing account.

Connecting to the Internet

You use Custom to initiate your dial-up Internet connection. After verifying your
settings, simply select Connect from the Custom menu. For more information about
Custom, refer to the NetManage Configuration Guide.

Additional Online Information

The online help file for Automatic Internet includes a description of each menu
command, plus the following information in the "How to Use" section.

» Choosing and Signing Up for an Internet Service Provider

» Configuring an Existing Internet Account

» Connecting to the Internet

» Filling Out Internet Registration Cards

» Verifying Your Automatic Internet Connection

Troubleshooting
If you experience difficulties using Automatic Internet, refer to the following items:

O Be sure to fill out all the input fields before you send your registration information
in. An account application must be completely filled out to be accepted by the
Provider.

0 Enter your name as it appears on your credit card.

O If the Provider's server takes too long to respond, your connection will be timed out.
Try to send your registration information later, or increase the Timeout before
Disconnecting option in the Custom application (use the Setup menu,
Communications command, Dial option).

See Automatic Internet online help for additional troubleshooting tips.
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Chapter 36. NEWTToolbar

NEWTToolbar maintains a list of applications that you can start without having to
switch to a window. You can make additions, modifications, and deletions to
NEWTToolbar’s list of applications.

Starting NEWTToolbar

When you install Chameleon ATX, NEWTToolbar is automatically added to your
Startup group and the Desktop Management group. If you do not want NEWTToolbar
to be started each time you start Windows NT, Windows 95, or Windows 3.1, remove
the NEWTToolbar icon from your Startup group. You can then start NEWTToolbar by
choosing it from the Desktop Management group.

Note: The NEWTToolbar application is automatically placed in the group called
Startup. If you are running non-English Windows, your system has a startup
group with a different name that automatically launches applications. Therefore,
you need to copy the NEWTToolbar application from the group called Startup to
the group in your system that automatically launches applications.

After NEWTToolbar is started, the toolbar appears. The toolbar includes a button for
each application that is on the NEWTToolbar application’s list. By default,
NEWTToolbar includes buttons for the following applications:

* Go IntraNet!

e Z-Mail® Pro

* Forum
*  WebSurfer
*  WebSpider
» Telnet

For details on an application included in the NEWTToolbar, see the appropriate chapter.

Main Menu

To open the main menu, use the right mouse button to click on either the NEWTToolbar
clock or on the outside of any toolbar button.

Note: Be sure to click on the outside of a button and not directly on a button.
Otherwise, you will open the button menu.
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The main menu includes the following commands:

Main Menu commands Description

Add Toolbar Buttons... Lets you add an application to the NEWTToolbar list. For
details, see the Adding Applications to NEWTToolbar
section.

Docking Controls where you can move the NEWTToolbar window. If

this command is disabled, you can move the window
anywhere. If this command is enabled, you can move the
window only to the top, bottom, left side, right side, or a
corner of the screen.

Fit to Screen Fits the toolbar to the size of your computer screen and fits
the toolbar buttons to the size of the NEWTToolbar window.
This command is useful if some buttons are not currently
displayed.

Always on Top Lets you control whether the toolbar is always on top of other
applications. Select this option if you frequently use Go
IntraNet! When you select text to shoot to Z-Mail® Pro or
WebSurfer, you must select the desired text first, and then
immediately choose the Go IntraNet! button and drag your
cursor to the desired menu option.

Display Icon Only Lets you control whether toolbar buttons include only an
application’s icon or the application’s name and icon.

About NEWTToolbar... Displays information about the NEWTToolbar application.

Choose the Copy button to copy version information to the
clipboard. You can then paste this information into any
application.

Choose the OK button to continue.
Close NEWTToolbar Exits the NEWTToolbar application

If you enable the Docking, Fit to Screen, Always on Top, or Display Icon Only
command, a check mark appears next to the command’s nhame.

Button Menu

To open the button menu, use the right mouse button to click on any toolbar button.

Note: Be sure to click directly on a button and not on the outside of a button.
Otherwise, you will open the main menu.
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The button menu includes the following commands:

Button Menu Command  Description

Remove Toolbar Button Removes the application and its associated button from the
NEWTToolbar application’s list.

Note: You cannot remove the Go IntraNet! button.

Modify Toolbar Button...  Lets you modify the application’s button name and
command line information. For details, see the
Modifying Toolbar Buttons section.

Adding Applications to NEWTToolbar

Add an application to NEWTToolbar if you want to be able to start that application from
NEWTToolbar. To add an application, do the following:

1. Use the right mouse button to click on either the NEWTToolbar clock or on the
outside of a toolbar button. The main menu appears.

2. Choose the Add Toolbar Button... command from the main menu.

3. Inthe dialog box that appears, type the name you want to use for the application
you are adding. This name will appear on the toolbar button if the Icons Only
command is not enabled.

4. In the command line text box, enter the path for the .EXE file of the application
you want to add. If necessary, choose the Browse button to help you locate the
desired file.

5. If you want to include any command line options for the application, type those
options in the command line text box.

For example, suppose you do not want the Z-Mail® Pro splash screen (large Z-
Mail® Pro box with copyright information) to appear each time you start Z-Malil®
Pro from within NEWTToolbar. You can bypass this screen by entering the
following in the command line text box:

C:\NETMANAG\MAIL.EXE -nologo
6. Choose the Add button.

Modifying NEWTToolbar Buttons

To change a toolbar button’s name or command line information, do the following:

1. Use the right mouse button to click on any toolbar button. The Button menu
appears.
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2. Choose the Modify Toolbar Button... command from the button menu.

3. Edit the dialog box as desired.

For details on entering information in the command line text box, see the Adding
Applications to NEWTToolbar section.

4. Choose the OK button.

Starting an Application in NEWTToolbar

To start an application in NEWTToolbar, use the left mouse button to click on the
button of the application you want to start.

Note: Be sure to click with the left mouse button. Otherwise, you will open the button
menu. If you try to start an application that is already running, that application’s
window becomes the active window.

Exiting NEWTToolbar

To exit NEWTToolbar, use the right mouse button to click on either the NEWTToolbar
clock or on the outside of a toolbar button. Choose the Close NEWTToolbar command
from the main menu.

Any changes made in NEWTToolbar are saved to the NEWTToolbar application’s
configuration file.
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Chapter 37. Virtual Desktop Manager

Note: This application is only available on the Windows NT and Windows 95 operating
systems.

The Virtual Desktop Manager (VDM) enables you to manage windows in a virtual
desktop, one much larger than the physical display area. When running the Virtual
Desktop Manager each active application is represented as a small window known as the
virtual window. The normal application window is known as a real window.

The default dimensions of the virtual screen are three real screens in width by two in
height. You can manage virtual windows as you would real windows. This means you
can move, scale, minimize or maximize them. You can put a window any place in the
virtual or real area and VDM reflects the changes. You can also reposition your
windows indirectly using the VDM. Many of the features of the VDM make it a
program manager for the virtual screen.

Getting Started with VDM

When you activate the Virtual Desktop Manager for the first time, the virtual windows
are displayed as set in the default settings. Assuming there is an active application
running, you will see a yellow frame, known as the scope, surrounding a virtual window
(assuming the application is not minimized or maximized). The scope and the virtual
windows are objects in the Virtual Screen. Fro example, if you have Z-Mail® Pro and
WebSurfer running on your screen, the VDM contains a scope and a virtual window for
both of these applications.

When first activating the VDM, you will also see a status bar at the bottom of the virtual
screen. The right hand corner of the status bar lists the scale for defining the
relationship of real to virtual objects. If you place the mouse over one of the virtual
windows, the left corner of the status bar will contain the caption of the application
running in that window. Otherwise, you will see the word Ready.

Note: If you are restarting VDM, it will automatically restart with the previous
configuration file.
Managing Virtual Windows

Every active application that is not minimized or maximized on your screen is
represented in the VDM.

You can move both real and virtual windows by dragging them on the screen.
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When you move a real window, you see its related virtual window move. When you
move a virtual window by dragging it in the VDM, you will see its related real window
move.

When you select a virtual window to put it in the foreground, the real window also
moves to the foreground. The opposite is also true. When you put a real window on top
of all other windows, its related virtual window also pops to the top of all virtual
windows.

Resizing the active virtual window by dragging its border, also resizes the real window
and vice-versa.

Closing an application, also closes the related virtual window.

Note: Minimized and maximized windows may be displayed on the Minimized or
Maximized Bar described in the Displaying Minimized and Maximized
Application section of this chapter.

Moving the Scope

To move the scope, grab the scope and move it to the new location. You will know it is
ready to be moved when the cursor changes to a hand.

There are two ways of moving the scope: Continuous or Shadow. To set the method:

1. Choose the Preferences... option of the Settings menu. The Preference Dialog
appears.

2. Select either Continuous or Shadow. If you select Continuous, all real windows
move as you move the scope. If you select Shadow, the scope draws a shadow of
itself while you are holding the left mouse button down. After you release the left
mouse button, the real windows move.

Note: When moving the scope all virtual windows stay where they are.

Rescaling the Virtual Screen

You can rescale the virtual screen manually or automatically. To manually set the
current scaling factor:

1. Choose the Preferences... option from the Settings menu.

2. Enter the new scale in the current scale display area. The default is 8 when the
VDM is installed. Otherwise, it is the last setting.

3. Choose the OK button.
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Another way to rescale VDM is to grab a corner of the VDM window and drag it to the
desired scale. As you drag the screen you will see the scale changing in the status bar.
This is the most commonly used method.

To rescale the VDM automatically:
Choose the Rescale VDM option from the View menu.

Note: You might use this method if you are dragging a real window past the limits of
the Virtual Desktop area. A virtual window cannot be dragged past the limits of
the Virtual Desktop area, however, real windows can be moved anywhere on the
screen. Therefore, to reflect this, VDM tries to move all other objects (excluding
the window being moved) in the opposite direction, if possible. If it is not
possible, it enlarges the manageable virtual area by automatically rescaling the
VDM.

Displaying Minimized and Maximized Applications

Special types of status bars known as the Minimized and Maximized Bar let you display
the minimized and maximized applications.

Minimized Bar

To display the Minimized Bar:

1. Select the Show Minimized option from the Settings menu. This displays the
Minimized Bar with icons of all the minimized application. If a minimized
application has no icon, VDM assigns a default icon.

2. Place the mouse over the icon to see its caption in the status bar.

To restore a minimized application to the VDM, double click on its icon in the
minimized bar. If you double click on a virtual window, the window is minimized and
shown on the minimized bar.

Maximized Bar
To display the Maximized Bar:

1. Select the Show Maximized from the Settings menu. This displays a Maximized
Bar with icons of all the maximized windows. If a maximized application has no
icon, VDM assigns a default icon.

2. Place the mouse over the icon to see its caption in the status bar.

To restore a maximized application to the VDM, double click on its icon in the
maximized bar.
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It is possible to activate a menu option of an application or see its menu bar when it is
in the maximized bar.
Viewing Application Menu from Virtual Window

It is possible to activate a menu option of an application or see its menu bar using the
VDM.

To do this:

1. Hold down the right mouse button. For example, if Z-Mail® Pro is one of the
virtual windows, holding down the right mouse button will display a drop down list
box with the Z-Mail® Pro Menu bar: File, Message, Folders, Services, Settings,
Help.

2. Choose one of the menu commands to list the command options.

You can also activate a menu option of a maximized or minimized virtual window in
the same way:

1. Place the cursor over the icon in the Maximized or Minimized bar

2. Hold down the right button.

Using VDM as a Filter

The Virtual Desktop Manager can be used as a filter for viewing only specific
application windows. To use VDM as a filter, invoke it from the Command Line with
one of the following options:

-cclass types  displays special classes listed in class types. These are additional
classes that are not direct descendants of the desktop.

-f filename uses the settings in the configuration file specified in filename.

-i activates VDM in iconic mode, that is, VDM starts normally and is
immediately minimized.

-0 classes displays only those applications listed in classes. For example, if you
enter -o NMEditView, VDM will display only the edit windows of a
NetManage application. This means it will display only the edit
window of a new mail.

Additional Online Information

The online help file for VDM includes a description of each menu command, plus
information on How To:

* Trim NonVirtual Area
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* Rescale the VDM
* Change Colors
* Set Preferences

Troubleshooting
If you experience difficulties using the VDM application, refer to the following items:

O If your windows are not being displayed correctly, first try rescaling. Many
problems are a result of improper scaling.

O If rescaling does not work, try closing VDM and reactivating it.
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Chapter 38. Ping - Network Testing

The Ping application is a network diagnostic tool used to verify connectivity to a

particular system on your network. The Ping application transmits any number of echo
requests to a particular system and displays the results for each echo reply. This
exchange is referred to as pinging. These echo requests and replies are supported by all
systems on the network, including those that are currently running one or more
Chameleon for Windows applications. This is accomplished through the use of the
Internet Control Message Protocol (ICMP). If you encounter a problem in an

application, pinging determines if the problem is with the application or due to a non-
responding host. You may have multiple instances of the Ping application active
simultaneously.

The current options and host name can be saved to a configuration file named
PING.CFG (default). The configuration file is loaded when the Ping application is
started. If a host name or IP address is specified, the Ping application immediately
begins pinging that host. You can also supply a command line option to specify the host
name or IP address.

Ping Host
To ping another system, do the following:
1. Select Start. The Host dialog box appears.

2. Type or select a host name or IP address in the Host dialog box.

3. Choose the OK button. The application sends an echo request and waits for the
echo reply. If no reply is received within the timeout value (default is 6 seconds),
the ping fails.

A single ping produces summary lines in the Ping window. Multiple iterations or
continuous pinging produces a single summary line for each ping. After each ping,
summary lines are generated, giving the total statistics for this sequence of pings.

Note: When minimized, an animated icon of a ping-pong ball indicates active pinging.
The ball moving back and forth indicates successful pings.
Ping Settings

The Ping Settings menu lets you access the Preferences dialog box and the Auto Start
option.
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The Preferences dialog box contains the following options:

Iteration : Specify the number of echo requests to transmit (1 through 9999 seconds); for
an unlimited number of iterations, select Continuous.

Data Length: Specify the length of each echo request (0 through 1,400 bytes). The
default is 64 bytes

Interval : Specify the time the application waits for a response to the ICMP_ECHO
request sent (1 through 999 seconds). If there is no response after the specified time the
ping returns "0 bytes received

Timeout: Specify the timeout value for the echo reply (1 through 999 seconds).
To automatically start Ping through your Windows application, do the following:
1. Choose the Auto Start command from the Settings menu.

2. Choose Run from the Start menu and type the following command line:
ping<system name>

Additional Online Information

The online help file for Ping includes a description of each menu command.

Troubleshooting
If you experience difficulties using the Ping application, refer to the following items:

O Try to Ping by using the IP address (instead of host name) to determine if there is a
name resolving problem.

O The network portion of the IP address must be a locally connected interface, or a
default gateway must have been specified to route unknown networks.

O Alocal host table or domain server must be specified when pinging by host name.
The host name entry must specify the correct IP address.

O For a Windows system, the NEWT application must be running for Chameleon for
Windows 95 or Windows 3.1 to respond to an echo request.

0 Make sure that the Ethernet type is correct: it should be Ethernet/DIX in almost all
cases.
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Chapter 39. Finger

Finger is an Internet utility that enable you to get information about a user on a specific
host. This information includes the person's name, job title, and e-mail address. You can
set up Finger to retrieve one or more text files that contain information, such as a
resume, that you want made public.

To use Finger, do the following:

1. Start Finger to display the Finger dialog box.

2. Select or type the desired host in the Host field.
3. Type the desired username in the User field.

If a username is not specified in the User field, Finger displays information on all
the users currently logged in to the specified host.

4. Choose the Finger button.

Verbose Option
Choose the Verbose option from the Settings menu.

Verbose displays information provided by the Finger application for each user logged on

to the specified host. This information includes:

* login name

+ full name

* home directory

* login shell

» time of login (if user is currently logged in)

» time of last login (if user is not currently logged in)

« terminal or host from which the user logged in

+ last time the user received and read mail, and idle time

« information of any plan contained in the file .plan and any project described in the
file .project, both are located in the user's home directory

By default, Finger displays one line of information per user including login name,
username, TTY, idle time, time of login, and terminal or host from which the user
logged in.
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Additional Online Information

The online help file for Finger includes a description of each menu command, plus the
following information in the "How to Use" section:

» Using Finger

Troubleshooting

If you experience difficulties using the Finger application, refer to the following items:

0 Use the Diagnose Connection from the Help menu to start Ping and verify
connectivity to any remote system to which you want access.

O Verify that the host entered is a valid Finger server.
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Chapter 40. Bind - Name Server

The Bind application provides name server functions as a simplified Domain Name
Server (DNS). You can specify multiple domains and a list of host names within each
domain. Bind provides hostnames to IP address resolution according to the DNS
protocol. DNS is used to administer host and domain names from a central location,
which is simpler than maintaining a hosts file on each network host

Name Server Setup
To specify a domain:
1. Choose the Add button in the toolbar. The Domain dialog box is displayed.

2. Enter the name of a domain (for example, netmanage.com), then choose the OK
button.

3. Choose the Save button to save changes to the list of domains and any hosts defined

for each domain. The saved information is in a standard format as a collection of
files for each domain.

To add host definitions to a domain:

1. Select the domain and choose the Modify button. A dialog box appears with the
domain name as the title. You may add, modify, or delete individual host
definitions.

2. Enter the name of the host and its IP address. The name should not specify the full

domain. For example, defining a host named howard resolves requests for both
howard and howard.netmanage.com.

3. Choose the OK button when you are done.

Additional Online Information

The online help file for Bind includes a description of each menu command, plus the
following information in the "How to Use" section:

e Using Bind
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Troubleshooting
If you experience difficulties using the Bind application, refer to the following items:

O The Bind application must be running to respond to name server requests. You can
place a copy of Bind in your Startup group to ensure this. You may run Bind
minimized, as an icon.

O Verify that the domain server IP address is entered correctly in the system
originating the name lookup request.

O Verify that the domain name and host name definitions are entered correctly in the
Bind application.
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Chapter 41. PC Net-Time

PC Net-Time is a client/server application that allows you to synchronize the time
between your PC and any time server. As a client, you can use PC Net-Time to
automatically synchronize your PC's time with the server, or to update the time

manually by selecting the update button. You can also set your preferences so that your
PC Net-Time will act as a server with which other PC Net-Time clients can synchronize
their PC's time.

Setting Up PC Net-Time
To set up PC Net-Time, do the following:
1. Start PC Net-Time.

2. Select Preferences... from the Settings menu.

= NetTime Preferences

LCurrent Locatiot
Local Mame
[GMT
Local Time Zone
[IGMT] Greenwich Mean Time: Dubin, Edinbur| %]

Update Local Time front
Femote Name
| Egupt
Host Time Zone
[(GMT+02 00) Cairo (2]

Host:

Fort:
| mainbranchi®netmange |3? E’

[ Exit After Update

Time Services

[ Listen on Part: ’_

oK Cancel

3. Select the desired options in the dialog box. The options are as follows:

e Current Location: Specify the time zone where your PC is located. Using the
drop-down list box, you can select the time zone according to its geographical
area or its relationship to GMT (Greenwich Mean Time).

* Host: Type or select the name of the time server with which you are
synchronizing the time of your PC.

» Port: Type or select the time server's port number. The default port is 37 (as
defined in RFC 868).
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» Host Location: Specify the time zone where your host is located. Using the
drop-down list box, you can select the time zone according to its geographical
area or its relationship to GMT.

» Exit after Update: When you start PC Net-Time it automatically updates or
synchronizes the time of your PC with the specified host. Select the check box
for the application to automatically exit after the update is completed.

» Listen on port: Enables Time Services, which allows your PC to act as a server
to PC Net-Time clients. Other PC Net-Time users can identify your PC as the
host for synchronizing the time of their PCs.

» Port number: Select or type the time server's port number that should be
listened to for incoming time requests (if Time Services is enabled).

4. When you have finished selecting the desired options, choose the OK button.

Updating and Getting Local and Host Times

You can easily update the local time or get the host time by using the Commands menu
options or the Update and Get buttons. You should do this after making any changes in
the Preferences dialog box.

Changing Between Analog Clock/Digital Clock
To change the clock's screen display choose either the Analog Clock command or the
Digital Clock command from the Settings menu.

Changing the Default Time Zones

An advanced user can create another timezone.ini file by copying and renaming the
default file, then editing it to include the additional country and time zone. Each listed
country is followed by the time difference from GMT. To expand the list, add the
country and time difference in the same format. For example:

Hongkong=GMT+08:00
To change the default time zone file used:

1. Select the Preferences option from the Settings menu.
2. Choose Local Time Zone.

3. Choose the OK button to save the changes to the new configuration file.

Automatic Startup

Select the Run at Startup option from the Settings menu if you want the PC Net-Time
application to start automatically when Windows is started.
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Additional Online Information

The online help file for PC Net-Time includes a description of each menu command,
plus the following information in the "How to Use" section:

* Using PC Net-Time

Troubleshooting

If you experience difficulties using the PC Net-Time application, refer to the following
items:

0 Use the Diagnose Connection option from the Help menu to verify connectivity to
any remote system to which you want access.

Verify that the correct time zone has been set.
Verify that a valid host is selected.
Verify the time on the selected host.

O Oogo o

Verify the time zone of the selected host.
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Chapter 42. Name Resolver

The Name Resolver application enables you easily to retrieve the IP address of a known
host or the hostname of an IP address.

To find the IP address of a host:

Enter the host name in the IP Address or Hostname field, then choose the Lookup button
or press the Enter key.

To find the host name of an IP address:

Enter the IP address in the IP Address or Hostname field, then choose the Lookup button
or press the Enter key.

If Name Resolver is able to locate what you are looking for, both IP address and host
name are displayed. Otherwise, a message is displayed stating why the host name or IP
address cannot be found.

Additional Online Information

The online help file for Name Resolver includes a description of each menu command.

Troubleshooting

If you experience difficulties using the Name Resolver application, refer to the following
items:

0 Use the Ping application to verify connectivity to any remote system to which you
want access.

0 Check to make sure that your network DNS servers are set up and correct.
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Chapter 43. R-Commands

The R-Commands application lets you enter and execute the rcp (remote copy) and rsh
(remote shell) UNIX commands in a Windows environment:

» rcp (remote copy) is a network version of the UNIX cp command. Use this
command to copy files from one computer to another system on the network.

» rsh (remote shell) is a network version of the UNIX sh command. Use this
command to establish a connection to a remote UNIX system and then execute a
command on that system.

Both the rcp and the rsh commands eliminate the need to first log in to a remote system.
Passwords are also bypassed, by creating "trusted" Hosts or Usernames, avoiding the
need to send passwords over a network. Therefore, you may find these commands more
convenient to use than the standard UNIX cp and sh commands.

The commands you enter can be executed immediately or saved for later use. Save
commands if you want to add them to a Command Profile or execute them later.
Similar to a batch file, a Command Profile is a series of rcp and rsh commands that are
executed one after the other. Like the commands, a Command Profile can be executed
immediately or saved and then executed later.

Setting Up R-Commands

Note: "Local user" refers to the user entering the R-commands.

"Remote user" refers to the user connected to the UNIX system where the
command will be executed.

Entries in UNIX /ETC/HOSTS.EQUIV and .RHOSTS files determine whether the Local
user is permitted to access a Remote user's login account. These files define all Local
usernames and their host (machine) names that are allowed to access the remote login
account. You may edit these files. They are plain text files with the entries in the
following format:

hostname <space> username

hostname <space> username

Where -

"hostname" is the name of the UNIX or PC Host from which the rcp/rsh will be
performed

"username" is the Local user, who is granted the right to access this account and to
perform any rcp/rsh commands using this account.
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Adding an entry into the UNIX /ETC/HOSTS.EQUIV file allows the Local user access
to all login accounts on that host.

Adding an entry into the .rhosts file allows the Local user access only to this specific
account. The file, belongs to the Remote user's login account and resides in the user's

home directory, with the other "." (dot) files. The owner of the specific login account
may need to create the .rhosts file.

If the Local user's name does not appear in either of these files, access to the remote
login account will be denied.

To set up R-Commands, do the following:

1. Start R-Commands.

2. Choose Preferences... from the Settings menu.
3. Inthe UserName field, type your username.
4

In the Working dir field, specify the directory from which you want to take and/or
place files. Choose the Working dir button to browse through the directories.

5. If desired, specify one or both of the Confirm On options:

» Select the File Replace option to confirm when a file replaces an existing local
file.

» Select the List box selection delete option to confirm the deletion of a command
in the command list selection region.

By default both the Confirm On options are selected.

6. Choose the OK button.

Entering rcp Commands

The rcp command lets you copy files or directories between two systems on the network.
Use the rcp command to copy files or directories from:

» your local computer to a remote system
e aremote system to your local computer
e one remote system to another remote system

To enter an rcp command, do the following:
1. Choose the Build... option from the Commands menu.
2. Choose the RCP tab.

3. Inthe Description field, type a name for the command you are entering.
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7.

Select a direction from the Transfer direction file drop-down list.

The Transfer direction selection determines which fields (From and To) must be
specified:

local to remote transfer: specify only the To fields
remote to local transfer: specify only the From fields
remote to remote transfer: specify both sets of fields

To define the From field, do the following:

In the From Name field, select or type your username for the machine from
which you plan to copy the file.

The UserName you entered when setting up R-Commands is listed in the
drop-down list.

In the From Host field, select or type the name of the host on which the file or
directory you want to copy resides.

If you plan to copy a file or directory from a remote system, include a
backslash (\), quotation mark (") or apostrophe (') in the remote host's path.
This ensures the metacharacters of the remote system are interpreted
remotely.

In the From File field, enter the name of the file or directory you want to copy

For a local PC, the machine on which your working directory is located is
the default. You specify your working directory as discussed in "Setting
Up R-Commands."

To define the To field:

In the To Name field, type the username assigned to you on the host to which
you want to copy the file or directory.

In the To Host field, select or type the name of the host to which you want to
copy the file or directory.

Note: If you plan to copy a file or directory to a remote system, include a backslash

(\), quotation mark (") or apostrophe (') in the remote host's path. This
ensures the metacharacters of the remote system are interpreted remotely.

In the To File field, enter the file or directory to which you want to copy.

For local connection you can choose the browse button to help you locate
and select the desired file.

If desired, specify either or both of the rcp command options.

Select the -r (copy each subtree) check box to copy any subdirectories rooted at
the directory of the original file for the remote to local or remote to remote.
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» Select the -p (attributes) check box to assign the original file's modification
time, access time and modes to the duplicate file.

8. Choose the OK button to save the command to the commands list so that later you
can execute it or add it to a Command Profile.

9. Choose the Run button to execute the command immediately without saving it to
the commands list.

Entering rsh Commands

The rsh command establishes a remote host connection and executes a specified UNIX
command or a batch file containing multiple UNIX commands. Output from rsh is
displayed in the R-Commands window's output region unless you redirect the output to a
file.

To enter an rsh command, do the following:

1. Choose the Build... option from the Commands menu.

2. Choose the RSH tab.

3. Inthe Description field, type a name for the command you are entering.
4

In the Shell command field, type the UNIX command you plan to execute on the
remote host. For example, the Is UNIX command lists directories. For details on
UNIX commands, see your UNIX documentation.

The From Name, Host and File fields are inapplicable, and therefore dimmed.

5. Inthe To Name field, type the username assigned to you on the host to which you
want to establish a connection.

In the To Host field, select or type the nhame of the remote host to which you want to
establish a connection.

Type the file's complete path in the Output field to send output to a file rather than
display it in the R-Commands window's output region. Select the local path check
box to send an output to a local file. Selecting the local path check box enables the
browse button, to help you locate and select the file.

6. If you redirect output to an existing file and want to overwrite that file's contents,
select the rewrite an existing file check box.

Note: If the rsh command causes conflicts between rsh and the shell on the remote
host, select the -n option. This redirects the input of rsh to /DEV/NULL.

7. Choose the OK button to save the command to the commands list, so that later you
can execute it or add it to a Command Profile.
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8. Choose the Run button to execute the command immediately without saving it to
the commands list.

Creating Command Profiles

Command Profiles, which are similar to batch files, contain a set of rcp and rsh
commands that are executed in a series. Create a Command Profile using the rcp and
rsh commands that were previously saved to the commands list.

You can execute a Command Profile immediately after you create it, or you can save it
to the commands list, in the main window, and execute it later. The commands are
executed in the order they are listed in the profile.

To create a Command Profile, do the following:

1. Choose the Build... option from the Commands menu.

2. Choose the Profile tab.

3. Inthe Description field, type a name for the Command Profile you are creating.
4

Add commands to the Profile commands box in the order in which you want them
executed. To do so, select a command in the List of commands box and a command
in the Profile commands box. Then do one of the following:

» Choose the Before button to add the command before the one currently selected
in the Profile commands box.

» Choose the After button to add the command after the one currently selected in
the Profile commands box.

You can delete a command from the profile by selecting the command in the Profile
commands box and then choosing the Delete button.

5. After you have added all desired commands to the profile, perform one of the
following operations:

» Choose the OK button to save the profile to the commands list so you can
execute it later.

» Choose the Run button to execute the profile immediately without saving it to
the commands list.

The bottom status bar displays details about the highlighted command.
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Executing Commands List Items

To execute commands or Command Profiles previously saved to the commands list do
the following:

1. Select the desired command or profile from the R-Commands window’s commands
list.

2. Choose the Run button, or double click the command.

An executed command or Command Profile's output is displayed in the output region of
the R-Commands window. You can copy this information to another application, delete
it or print it.

To copy the information to the clipboard, select it and choose the Copy option from the
Edit menu. You can then copy the information from the clipboard to another
application.

To delete the information displayed in the output region, choose the Clear Buffer option
from the Edit menu.

To print the information, select it and then choose the Print... option from the File
menu.
Modifying Commands or Command Profiles

You can modify a command or Command Profile by performing either of the following
operations:

* Select a command and edit it in the Command field of the R-Commands window.

e Select it from the commands list and then choose the Maodify... option from the
Commands menu. A Modify dialog box appears. This dialog box contains the
same fields as the Build dialog boxes. For details on a command or profile’s fields,
see the previous section in this chapter that discusses that command or profile.

Deleting Commands or Command Profiles

To delete a command or Command Profile from the R-Commands window's commands
list do the following:

1. Select the command or profile from the commands list.

2. Select the Delete option from the Commands menu.

Stopping Command Profiles

You can stop a Command Profile while it is running.
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To stop a Command Profile while it is running, select the Abort option from the
Commands menu.
Additional Online Information

The online help file for R-Commands includes a description of each menu command,
plus the following information in the "How to Use" section:

e Setting up R-Commands

* Entering RCP Commands

* Entering RSH Commands

e Creating Command Profiles

* Executing Commands List Items

e Command Line Options

Command Line Options

You can use command line options to automatically connect to a host, run a command,
or run R-commands minimized.

To do this, from the Program Manager, select the File menu, then the Run command
and type:

rcmd.exe [option]

You can use the following options:
-c<command name>

Use specified command from the command list.
For example:

c:\netmanag\rcmd.exe-c weekly

Invokes R-Commands application and executes the command weekly, as defined in the
command list.
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-p<profile name>

Use specified profile from the command list.
For example:

c:\netmanag\rcmd.exe-p backup

Invokes R-Commands application and executes all the commands listed under the
backup profile, as defined in the command list.

-i
Runs the R-Command application minimized.

For example:
c:\netmanag\rcmd.exe-i

Troubleshooting

If you experience difficulties using the R-Commands application, refer to the following
items:

O Verify that the installation and setup steps have been successfully completed.

0 Use the Diagnose Connection option in the Help menu to verify connectivity to any
remote system to which you want access if a failure to connect is reported.

O Interactive programs such as word processors and spread sheet programs should
not be run in R shell.

0 Make sure you only copy individual files and not entire directories from Local to
Remote Hosts (including use of the -r or *.* commands).
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Chapter 44. Modem Server

The Modem Server lets you use one of your PCs as a modem server for other PCs on the
same LAN. Rather than configuring separate modems on each of your PCs, you can
centralize your physical access to the modem to one PC, which has a modem and is
configured with Modem Server. The other PCs can connect to the Modem Server PC
through any Telnet client.

Note: You may connect to the Modem Server through any Telnet client on any
platform, including UNIX, Macintosh, and other.

In this way, the other PCs connect to a modem that is available through the Modem
Server PC and dial through that modem to external hosts (such as BBS). If you have
access to a Modem Server over the Internet, you can save costs on international calls by
using the Modem Server for those connections.

Preparing Your Machine to Act as a Modem Server
To make your machine available as a Modem Server for other users, do the following:
1. Connect 1-4 modems to the PC that will be functioning as the Modem Server.

2. Open your Modem Server application.

3. Select a Listening Port to be used for the connection by choosing the Listen
command from the Connection menu, or use the default port setting, port 23.

4. Specify desired settings by choosing commands from the Settings menu (such as,
specifying the baud rate for your COM ports by using the Asynchronous Preferences
command).

5. After you have completed your settings, you can make your Modem Server COM
port(s) available to be accessed by other users by choosing the COM Port
Connecting command from the Connection menu. Users cannot connect to a port
until you make it available by using this command.

Note: If you change the settings for a port that is currently busy, the changes will take
effect only after the port has been released.

6. Notify potential users of your machine’s IP address or host name, and listening port.

7.  You may minimize the application after opening it.
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Connecting to a Modem Server

To make a connection to a Modem Server, do the following:

1. Using the Telnet and ASCII application, specify the IP address or host name of the
Modem Server as the host to which you wish to connect.

2. Select the appropriate port (usually 23).

3.  When you have connected to the Modem Server host, a short menu of commands
will be displayed.

Note: When you first connect to the Modem Server host, you are not actually connected
to a port. You cannot dial out or connect to another host through the Modem
Server, until you have used one of the connect or dial commands listed in the
Welcome menu.

4. Type the letter of the command you wish to use. You should use the "I" command
before trying to make a connection, so that you can find out what ports and modems
are currently available for use.

Additional Online Information

The online help file for the Modem Server includes a description of each menu
command, plus further information in the "How to Use" section.

Troubleshooting
If you experience difficulties using Modem Server, refer to the following items:

O If you get disconnected without notice when trying to connect, check that you have
opened the port for use in Modem Server and connected to the modem from the
Preferences dialog.

O If you receive a NO CARRIER message when trying to dial out, check that the line
is connected to the modem. Do not press the Enter key after choosing d for dialing.
Type only the telephone number followed by the Enter key.

O Increase the size of the Port Receive Buffer in the Asynchronous Communications
Settings dialog, if you are getting too many general errors when connected.

302 Chameleon ATX User's Guide



Chapter 45. Serial to Telnet

Note: This application is only available for Windows 3.1 Operating System.

The Serial to Telnet application lets you use any serial terminal emulation application
(such as, the Windows Terminal application) in your system to communicate over
Telnet (TCP/IP). The Serial to Telnet application includes the following main features:

» Lets you redirect specific COM ports to Telnet

*  Emulates a Hayes™-compatible modem.

+ Can be used to access network modems.

» Can provide Telnet connections on up to 8 COM ports (COM1-8).

Redirecting COM Ports to Telnet

The Serial to Telnet application has only one main dialog box, which lets you select and
configure the COM ports that you want to redirect to Telnet.

1. Select one or more COM ports (COM 1-8) to redirect to Telnet.
2. Select the desired Terminal Type emulation for the port(s) you have chosen.

3. If you would like to assign additional, optional characteristics to a selected port,
choose the Advanced button. For a description of the Advanced options, see the
table in the following section, "Advanced Configuration Options."

4. When you have completed the configuration of the ports, choose the OK button in
the Serial to Telnet Configuration dialog box and close the application.

5. A prompt will be displayed, asking you if you wish to restart Windows at this time.
When Windows restarts, the COM ports will be redirected as you specified.

6. To stop redirecting the ports, you should uninstall the configuration by choosing the
Uninstall button from the Configuration dialog box.

Advanced Configuration Options

You may assign the advanced configuration options to your redirected COM ports.
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Selecting COM Port Numbers

It is recommended that you select all port numbers which you are not using, so that you
can have the maximum number of simultaneous Telnet connections. However, note the
following guidelines:

» Do not select ports that do have devices attached (such as a modem or a serial
mouse) or else you be unable to access that port while the Serial to Telnet
Configuration is installed.

» Because of a limitation in how Windows operates in 386-Enhanced mode, most
machines will only be able to use COM1-COM4. You may be able to use the higher
port numbers if you have a multi-port board that comes with a 386 virtual device
driver, which supports port numbers higher than 4.

Configuring Your Communications Program for Serial
to Telnet

To interface between your serial communications program and the Serial to Telnet
application, do the following:

» Instruct your communications program to use one of the COM ports that you
selected in the Serial to Telnet Configuration.

» Configure your communications program to use one of the Hayes™-compatible
modems (Hayes Smartmodem, OPTIMA, or ULTRA).

» Set the communications parameters in your communications program to any baud
rate, with 8 bits, no parity, and 1 stop bit.

» Instead of a phone number, you specify either the IP address or host name of the
host to which you wish to connect.

Removing the Redirection of COM Ports

To stop redirecting the ports, you should uninstall the configuration as follows:

1. Open the Serial to Telnet application.

2. Choose the Uninstall button from the Serial to Telnet Configuration dialog box.

3. Close and restart Windows.
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Additional Online Information

The online help file for Serial to Telnet includes a description of each menu command,
plus further information in the "How to Use" section.

Troubleshooting

If you experience difficulties using the Serial to Telnet application, refer to the following
items:

0 Because of a limitation in how Windows operates in 386-Enhanced mode, most
machines will only be able to use COM1-COM4. You may be able to use the higher
port numbers if you have a multi-port board that comes with a 386 virtual device
driver, which supports port numbers higher than 4.

0 On some machines, you may run into problems when redirecting COM3 and
COMIr. Certain terminal programs may either give unnecessary warnings or refuse
to access the port. This may be caused by the terminal program’s attempts to detect
and avoid possible hardware conflicts. To overcome this type of problem, add the
following lines to the [386Enh] section of the SYSTEM.INI file:

COM3IRQ=11
COM3BASE=3ES8
COM4IRQ=15
COM4BASE=2E8

Caution: If any of the above lines already exist in the [386Enh] section of the
SYSTEM.INI file, especially if you have real hardware attached to COM3
and/or COM4, do nateplace them with the above lines. Doing so may cause
you to be unable to access the physical port.

Note: If adding the above lines does not solve your problem, you may find it
necessary to adjust the numbers provided in these lines.

O Trouble with host name: You should instruct your communications program to use
the IP address or host name of the host to which you wish to connect (instead of
specifying a telephone number as you would for a serial connection). If you specify
a hostname, such as ftp.netmanage.com, some terminal programs may try to
substitute the Touch-Tone (digit) equivalents for each letter in the host name. In
this case, you will need to use the IP address.

Also, if your host name begins with "t" or "p", you may need to insert either a space
or a comma in front of the name in order for it to work properly.

O Trouble with IP address: Some terminal programs strip out the period in an IP
address, which results in incorrect dialing. If this happens, remove the periods
from the IP address and expand each portion of the IP address to 3 digits. For
example, the address 11.222.44.1 would be changed to 011222044001.
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If you want to connect to a port on the remote host other than the standard Telnet
port (port number 23), add the port number in brackets after the IP address. For
example, specifying the number 11.222.44.1[25] would connect you to the SMTP

server (port 25) on that host.
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Chapter 46. NISLookup

The NISLookup application, which uses the Network Information Service (NIS)
protocol, displays information retrieved from NIS including map entries, domain and
server names.

Note: You can use this application only if you are running the Windows 3.1 operating
system.

NIS maintains centralized network administrative information in tables or maps. You
can select a map name from the map list or enter the name manually. Some of the more
common NIS map names, such as host and password maps, are included in the list.

NIS domains consist of NIS clients and servers sharing common information. NIS
clients request information from a domain, rather than from a server. This allows server
configuration to occur dynamically, which is completely transparent to the clients.

Looking Up Map Entries

To look up an NIS map entry, you must specify the map name in the Map field and key
name in the Key field and choose the Lookup button. The corresponding map entry is
then retrieved from NIS and shown in the display window. For example, a host name
and IP address can be retrieved.

Retrieving Entire NIS Maps

You can retrieve a host map using NIS. To retrieve an entire NIS map:

Specify the map name in the Map field and choose the Retrieve button. The entire map
is retrieved from NIS and displayed.

Retrieving NIS Domain Names

To retrieve the NIS domain name:

Select the Domain option from the Settings menu.

To configure the NIS domain name, use the Custom application. Refer to the
NetManage Configuration Guide for additional information on configuring the NIS
client.
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Retrieving the Domain NIS Server Name

You can retrieve the NIS server name for the domain by selecting the Server command
from the Settings menu. Although an NIS domain may contain multiple NIS servers,
only one server, the first to respond, is used.

Additional Online Information

The online help file for NISLookup includes a description of each menu command, plus
the following information in the "How to Use" section:

» Looking Up Map Entries

» Retrieving Entire NIS Maps

* Retrieving NIS Domain Names

* Retrieving the Domain NIS Server Name

Troubleshooting
If you have problems using the NISLookup application, refer to the following items:

O Verify that an NIS domain has been specified in Custom. Contact your System
Administrator for the NIS domain name. From a UNIX host, you can retrieve the
domain name using the Domain Name command.

O Verify that an NIS server is serving the specified NIS domain. From a UNIX host,
you can retrieve the server using the ypwhich command. You can use the
Portmapper application to determine if the ypserv program is running on the NIS
server.

O Verify that you can connect to the NIS server using the Ping application.
0 Verify that the NIS server resides on the same subnet as your machine.
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Appendix A. MultiLAN Driver

Note: Read this appendix if you are running NFS in Windows 3.1 and you want to
switch between different networks. The information in this appendix does not
apply to Windows NT or Windows 95 users.

Chameleon ATX lets you switch dynamically between different networks installed in
Windows without having to exit Windows.

The Windows Setup program lets you select only one network that you can connect to
Windows. To switch between Novell and NFS, you have to run Setup again and restart
Windows for the change to take affect.

With NetManagés MultiLAN driver, you can add and remove networks dynamically
without having to exit Windows to initialize your selection. MultiLAN currently
supports MtManagés Chameleon ATXNovell's NetWare, Banyan Vines, Windows for
Workgroups, and LAN Manager networks.

Note: We recommend that you install all required networks, such as Novell's NetWare,
through the Windows Setup program, prior to the installation of Chameleon
ATX. Adding networks after the installation of Chameleon ATX will necessitate
re-installing the Chameleon ATX product.

Because certain Windows operations depend on the type of network installed, select one
of the networks installed to be your default network. To define a default network, do the
following:

1. Start the Control Panel.

2. Choose the Network icon. If the Microsoft Windows Network dialog box appears,
choose the Other Net button.

The Networks dialog box appears.

3. Select the network you want to set as your default network from the Installed
Networks box.

4. Choose the Set As Default Network button.
The name of the network will appear in the Default Network box.

Operations such as Browse inside File Manager, will use the appropriate functions
as supplied by your Default Network.
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5. Choose the Network button... to display a dialog box that describes different
facilities of the network selected in the Installed Networks box. The dialog box is
designed by the vendor of that specific network.

The following figure is an
NetWare Driver:

o Messages di

example of the dialog box provided by Novell for the

[ Message Status at Startup
@ Hessages enabied:

Netware Device Driver Set
for Microsoft Windows 3.1
sabled Version 2.00

[" 386 Enhanced

O NwShare handles Novell Netware 0S Yersion 3.11a

NetWare Shell Yersion 3.26a

[ Restore drives
.
FPinting N
Maximum jobs 8

3500 Buffer size
Coppright 1992 Novell, Inc.

30

Update secands All Rights Reserved

Network Warning
IVIZI Network warnings

[Coxk ][ cancel |[ Hew ]

The following figure is an
Chameleon ATX network

example of the dialog box provided by NetMafwadhe

= NetManage ChameleonNFS
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4

NFS CLIENT Version 4.5
NFS RPC Version 4.5
NMPCIP DLL Version 4.00 AN

NDIS Driver Version 17.23

Copyright © 1990-1993 NetManage, Inc.
Serial Number: 3444334004813553

Adding Networks

Note: Before adding a network, you should install the drivers for your new network
through the standard Windows Setup program.

To add networks, do the following:

1. Start the Control Panel.

2. Choose the Network icon. If the Microsoft Windows Network dialog box appears,
choose the Other Net button.

The Networks dialog box

appears.

3. From the Networks dialog box, choose the Add>> button.
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The dialog box expands to include a list of available networks from which to
choose.

4. Select a name from the list, then choose the Install... button.

The new network name will be added to the list of Installed Networks.

Removing Networks
To remove networks, do the following:
1. Start the Control Panel.

2. Choose the Network icon. If the Microsoft Windows Network dialog box appears,
choose the Other Net button.

The Networks dialog box appears.

3. From the Networks dialog box, select the network you want to remove from the list
of installed networks and choose the Remove button.

4. Choose the OK button.
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Appendix B. Removing Your Product

How you remove your NetManage product depends on the environment in which NEWT
is installed. This appendix describes how to remove a NetManage product from
Windows NT, Windows 95, or Windows 3.1.

Removing a NetManage Product from Windows NT

You can use the NetManage Uninstaller program to remove part or all of your
NetManage product from the Windows NT environment.

To remove your NetManage product from the Windows NT environment, do the
following:

1. If the NetManage product’s folder (directory) contains files that you added after
installing that product, back up those files.

2. Start Uninstaller by doing the following:

a) In Program Manager or File Manager, choose the Run command from the File
menu and enter the command that starts the Uninstaller program
(UNINST.EXE).

UNINST.EXE is located in the directory in which you installed your
NetManage product. For example, if the product is installed in
NETMANAG on your C drive, start Uninstaller by entering the following
command:

C:\NETMANAG\UNINST.EXE
b) Choose the OK button

3. Choose the Remove button.

The Remove Option dialog box appears.

4. Do one of the following:

» To remove only specific applications, choose the Custom option button and
then the Next button. Select the check boxes of the applications you want to
remove and choose the Next button.

» Toremove all NetManage applications currently installed on your system,
choose the Complete option button and then the Next button. When prompted
to verify that you want to delete all your NetManage product’s files, choose the
Yes button.
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Caution: Choosing the Complete button deletes the folder in which you installed
your NetManage product and all of that folder’s contents.

If an application’s files are not in the directory in which your product is installed,
the application’s command will not be removed from the appropriate menu and
some items (such as an application’s files and shortcuts) are not removed.

5. If you removed all of the NetManage applications, remove the NetManage directory
from the path specified in your NT registry.

Removing a NetManage Product in Windows 95

You can use the NetManage Uninstaller program to remove part or all of your
NetManage product from the Windows 95 environment.

Note: If you used the Windows 95 registry editor to change or delete the Path key for
the folder containing your NetManage product, you will not be able to run the
Uninstaller program.

To remove your NetManage product, do the following:

1. If the NetManage product’s folder (directory) contains files that you added after
installing that product, back up those files.

2. Start Uninstaller by doing the following:
a) Open the Control Panel and choose the Add/Remove Programs icon.

b) From the Install/Uninstall tab, select NetManage. Then choose the
Add/Remove button.

3. Choose the Remove button.

The Remove Option dialog box appears.

4. Do one of the following:

» Toremove only specific applications, choose the Custom option button and
then the Next button. Select the check boxes of the applications you want to
remove and choose the Next button.

» To remove all NetManage applications currently installed on your system,
choose the Complete option button and then the Next button. When prompted
to verify that you want to delete all your NetManage product’s files, choose the
Yes button.

Caution: Choosing the Complete button deletes the folder in which you installed
your NetManage product and all of that folder’s contents.
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If an application’s files are not in the directory in which your product is installed,
the application’s command will not be removed from the appropriate menu and
some items (such as an application’s files and shortcuts) are not removed.

5. If you were using the NetManage TCP/IP stack (NEWT) and want to remove it,
delete the lines from the TCPIP section of your WIN.INI file.

6. If you removed all of the NetManage applications, remove the NetManage directory
from the path specified in your AUTOEXEC.BAT file.

Removing a NetManage Product from Windows 3.1

To remove your NetManage product from the Windows 3.1 environment, do the
following:

1. Edit the files that were modified during the installation process so that those files
reflect that the NetManage product will no longer be available.

SETUP.EXE modifies some files when you install a product. The files it modifies
and the changes it makes to those files depends on whether you installed the product
in an NDIS, ODI, or Windows for Workgroups environment.

For information about the changes made in the NDIS environment, see the Files
Modified in the Windows 3.1 NDIS Environment section of this appendix.

For information about the changes in the Windows 3.1 ODI or Windows for
Workgroups environment, see the appropriate appendix in your NetManage
Configuration Guide.

2. Reboot your system.

3. Delete the NETMANAG directory and all of its contents.

Files Modified in the Windows 3.1 NDIS Environment

When you install a NetManage product in the Windows 3.1 NDIS environment, changes
are made to the following files: AUTOEXEC.BAT, CONFIG.SYS, WIN.INI,

SYSTEM.INI, and PROTOCOL.INI. If you want to remove your NetManage product
from the Windows 3.1 environment, modify these files so they reflect that the
NetManage product has been removed.

The following examples for an NDIS installation assume that the C:\ANETMANAG
directory was specified and a 3COM EtherLinkll (3C503) network adapter was selected
during the installation process. Your files may differ slightly, depending on the network
adapter you actually select.
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AUTOEXEC.BAT Changes

» The following line is inserted at the beginning of your PATH variable in your
AUTOEXEC.BAT file:
PATH=C:\NETMANAG;

* The following line is added to your AUTOEXEC.BAT file:

C:\NETMANAG\NETBIND

Note that the NETBIND.COM program is not unigue to your NetManage product; it is
actually the standard Microsoft program used in LAN Manager and other applications.

CONFIG.SYS Changes

The following lines are added to your CONFIG.SYS file:

DEVICE=C:\NETMANAG\PROTMAN.DOS /l:C:\NETMANAG
DEVICE=C:\NETMANAG\ELNKII.DOS
DEVICE=C:\NETMANAG\NETMANAG.DOS

Note that the Protocol Manager (PROTMAN.DOS) and the NDIS driver (ELNKII.DOS)
are not unique to your NetManage product; they are actually the standard Microsoft
driver for LAN Manager and the NDIS driver from your network adapter vendor.

The Protocol Manager driver entry must use the /I: parameter to point to the location of
the PROTOCOL.INI file.

WIN.INI Changes

The following lines are added to your WIN.INI file. The WIN.INI file’s TCP/IP section
may also include information about NetManage applications you started.
[TCPIP]

FILE=C:\NETMANAG\TCPIP.CFG
ID=XXXX

Caution: Back up your TCP/IP section in the WIN.INI file because it contains vital
information about your NetManage product.

SYSTEM.INI Changes

» The following lines are added to your SYSTEM.INI file:
[BOOT]
NETWORK.DRV=C:\NETMANAG\mult46.DRV

[BOOT DESCRIPTION]
NETWORK.DRV=NETMANAGE CHAMELEON ATX

[386Enh]
DEVICE=C:\NETMANAG\NMTCPIP.386
DEVICE=C:\NETMANAG\NMREDIR.386
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* The following directory is created:
C:\NETMANAG

* The following files are copied to your CANETMANAG directory:

PROTOCOL.INI

PROTMAN.DOS

NETMANAG.DOS

NETBIND.COM

Applications and Help files

NDIS driver for your specific network internet card

PROTOCOL.INI Changes

The following lines are added to your PROTOCOL.INI file:

[EtherLinklI]
DRIVERNAME=ELNKII$
INTERRUPT=3
TRANSCEIVER=0OnBoard
IOADDRESS=0x300

[NETMANAGE]
DRIVERNAME=NETMNGS$
BINDINGS=EtherLinklI

The EtherLinkll section describes values for your network adapter. These values must
match those configured for your network adapter either using hardware jumpers, or a
software setup program supplied with the network adapter.

The NETMANAGE section describes a network protocol for NEWT. The BINDINGS
statement binds the protocol to your network adapter. You may specify additional
bindings for a protocol if you have more than one network adapter section.
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Glossary

access
account
address mask

ANSI

API

application

ARP

ASCII

authenticator

AUTOEXEC.BAT

Entry to or communication with a particular object, such as
an operating system, specific files, or accounts.

An entity which is established as an authorized user of the
system.

A bit mask used to select bits from an IP address for subnet
addressing. The mask is 32 bits long and selects the network
portion of the IP address and one or more bits of the local
portion.

The American National Standards Institute sets standards for
the US computer industry. ANSI participates in defining
network protocol standards.

Application Program Interface. A standard interface that
allows upper-layer applications to work with different
communication protocol stacks. Some of the most commonly
used ones include NetBIOS, Berkeley Sockets, and Named
Pipes.

An application is a computer program that performs a certain
task. FTP, Telnet, TN3270 are some of the applications
provided by NetManage.

Address Resolution Protocol. The TCP/IP protocol used to
dynamically bind a high-level IP address to a low-level
physical hardware address. ARP is only across a single
physical network and is limited to networks that support
hardware broadcast.

The American Standard Code for Information Interchange,
widely accepted code for representing alphanumeric
information.

A password or code that verifies the identity of individual
system or network users.

A file that resides on all PCs and contains a series of
commands that are executed when the computer starts up.
This file includes the path command that points to the
NETMANAG directory where the applications reside.
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backup

Bind

buffer

client

command line

CONFIG.SYS file

daemon

DLL

default

device name

DNS

domain

The process of preserving copies of files on a different drive,
directory, or media to protect against the destruction or loss
of the original files.

The Bind application provides name server functions, such as
a Domain Name Server (DNS). You can specify multiple
domains and a list of host names within each domain. (See
also Domain Name System.)

A temporary storage area for data during the transfer of that
data between the computer and a peripheral, or between parts
of a computer, to prevent loss of information.

A computer system that uses resources provided by another
machine on the network. Most of NetManage’s applications
can run as both client and server.

The entire command string, including the command and any
parameters or qualifiers that it may have. A command is an
instruction or request for the system to perform a particular
action.

This file resides on all PCs and defines which device drivers
to install.

An agent program that runs continuously on a server system
in a UNIX environment and provides resources to client
systems on the network.

Dynamic Link Library. Windows automatically loads the
applications into memory when required and unloads it when
space is needed for other applications. The Chameleon for
Windows 95 applications are 100% DLL.

A value supplied by the system when a user does not specify a
required command, parameter, or qualifier.

Identification of a physical device: for example, LPT1 for a
printer. Can also be a logical name that is equated to a
physical device name.

Domain Name System. An online distributed database that
maps machine names into IP addresses. (See also Bind.)

A named group of machines on the network. A domain name
consists of a sequence of names (labels) separated by periods
(dots).
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driver

Ethernet

Ethernet address

export

file access

file server

Finger

FTP

group Id

HLLAPI

host

host table

A software module that controls an input/output port or
external device such as a keyboard or a monitor. TCP/IP uses
a driver to control the network interface cards.

Ethernet is a type of network that supports high-speed
communication among systems.

A six-part hexadecimal number in which a colon separates
each part (for example, 8:0:20:1:2f:0). This number
identifies the Ethernet communications board installed in a
PC and is used to identify the PC as a member of the
network.

The process that makes a file available so that other systems
can access it.

Allows users to work with a remote file as if the file were
local.

A process running on a computer that provides access to files
on that computer to programs running on remote machines.

A standard protocol that lists who is currently logged in on
another host.

File Transfer Protocol. The FTP application is used to

provide file transfer services across a wide variety of systems.
Usually implemented as application-level programs, FTP uses
the Telnet and TCP protocols. The server side requires a
client to supply a login identifier and password before it will
honor requests.

A unique number associated with each group nhame on the
server.

High-Level Language Application Program Interface, which
you can use to program in high-level languages such as
COBOL, Pascal, BASIC, or C.

Any end-user computer system that connects to a network.
Hosts range in size from personal computers to
supercomputers.

ASCII text file in which each line is an entry consisting of
one numeric address and one or more names associated with
that address.

Chameleon ATX User's Guide

321



HTML

ICMP

IMAP

Internet

Intranet

IP address

IPX/link

Hypertext Markup Language is the document formatting
language used by World Wide Web browsers. It enables text
formatting, embedded pictures, and hypertext links to other
documents and different locations within documents.

Internet Control Message Protocol. The ICMP delivers error
and control messages from hosts to the requesters. An ICMP
test can determine whether a destination is reachable and
responding.

Internet Message Access Protocol. Defines a way for malil
programs to access mailboxes on remote computers as if they
were local. Includes operations for creating, deleting, and
renaming mailboxes; checking for new messages, and
permanently removing messages. It also allows users to
share remote folders (mailboxes), to connect from multiple
locations, and see a consistent mailbox structure and content.

When capitalized, the world-wide network of networks
connected to each other using the IP and other similar
protocols. The Internet provides file transfer, remote login,
electronic mail and other services. When not capitalized, any
collection of distinct networks working together as one.

A private enterprise network that uses TCP/IP standards-
based networking technologies for host access, workgroup
collaboration, desktop and network resources management,
and developer tools for custom applications to maximize the
enterprise’s productivity. For example, Web began as an
Internet application and has now been incorporated into
internal company applications.

The TCP/IP standard protocol defined as a unit of

information passed across the Internet, providing the basis for
packet delivery service. IP includes the ICMP control and
error message protocol as an integral part. The entire
protocol suite is often referred to as TCP/IP because TCP and
IP are the two most fundamental protocols.

Internet Protocol address. This is a 32-bit address assigned to
host on a TCP/IP Internet. The IP address has a host
component and a network component.

The IPX/link application for NetWare connects your PC
Novell NetWare LAN through the Network Device Interface
Specification (NDIS) developed by Microsoft and 3COM.
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Java

log in

log out

LPR/LPD

Mail server

MIB

MIB-II

MIME

mount

NDIS

NetBIOS

NETBUI

A programming language. It can also be a program that can
be included in an HTML page on the Web.

To perform a sequence of actions at a terminal that establish
a user's communication with the operating system and sets
up default characteristics for the user’s terminal session.

To terminate interactive communication with the operating
system, and end a terminal session.

Line Printer Remote/ Line Printer Daemon. An application
that allows you to print to network printers.

A host and its associated software that offer electronic mail
reception and forwarding service. Users may send messages
to, and receive messages from, any other user in the system.

Management Information Base. The set of variables that a
gateway running SNMP maintains.

An extended management database that contains variables
not shared by SNMP.

Multi-purpose Internet Mail Extensions. MIME enables: files
to be attached to mail messages; multiple objects in a single
message; an unlimited line length or overall length for text;
character sets other than ASCII; multi-font messages, binary
or application specific files; images, audio, video and multi-
media messages.

NFS user command that makes remote file systems and
resources available to the local PC.

Network Device Interface Specification. NDIS is used for all
communication with network adapters. The specification was
developed by Microsoft and 3COM to provide a common
programming interface for MAC drivers and transport
drivers. NDIS works primarily with LAN Manager and

allows multiple protocol stacks to share a single network
interface card.

Network Basic Input/Output system. Provides a Session Layer
interface between network applications running on a PC and
the underlying protocol software of the Transport and
Network Layers.

The NetBOIS Extended User Interface. This is the transport
layer driver frequently used by LAN Manager.
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NetWare
NetWare IP

network address

network printing

NEWT

NFS

NIC

OfficeVision

PCNSD authenticator

Ping

Plug-in

A network operating system developed by Novell.

Feature offered by Novell to allow Windows clients to access
Novell servers using the Internet Protocol (IP). Once
NetWare IP is installed, you can access all standard NetWare
server features normally available from Windows.

A unique number associated with a host that identifies it to
other hosts during network transactions.

Printing to a shared printer locally attached to one of the PCs
on the network.

NetManage TCP/IP communication stack for Microsoft
Windows. NEWT provides users with a degree of network
access previously only available to workstation and
mainframe users.

Network File System. A protocol developed by Sun
Microsystems that uses IP to allow a set of computers to
access each other’s file systems as if they were local.
Originally designed for UNIX systems, this protocol has been
implemented on many other operating systems, including
DOS and Windows.

Network Information Center. The NIC at SRI in Menlo Park,
California, assigns IP addresses and network numbers by
request. The number assigned is appropriate to the number
of host devices on the network.

An electronic mail application that runs on an IBM
mainframe. Z-Mail® Pro supports OfficeVision transport
that allows you to exchange electronic mail messages and
calendar information between your PC and the IBM
mainframe.

A program that runs continuously and authenticates a user
name and password before attempting to mount a network
drive, access files, or print on the network.

The Packet Internet Groper is a program that is useful for
testing and debugging networks. It sends an echo packet to
the specified host, and waits for a response. It reports success
or failure and statistics about its operation.

A third-party embedded application that you can launch from
within its "host" application.
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POP

PROFS

prompt

RAM
remote
remote host

remote printer

RFC

router

RPC

script
server

SMTP

SNMP

Post Office Protocol. This protocol is used by mail
applications to retrieve electronic mail services from the
Internet.

An electronic mail application that runs on an IBM
mainframe. Z-Mail® Pro supports PROFS transport that
allows you to exchange electronic mail messages and
calendar information between your PC and the IBM
mainframe.

Word or words used by the system to assist a user’s response.
Such messages generally ask the user to respond by typing
some information in a supplied field.

RAM is Random Access Memory.
Files, devices, and users not attached to your local machine.
The computer receiving a network command.

In LPR/LPD, a printer with a special network card, or a PC
or workstation.

Request For Comment. The RFC documents describe all
aspects and issues associated with the Internet protocols.

A router has two or more network interfaces to different
networks. The primary function of a router is to direct
packets between these networks, delivering them to their final
destination or to another router. When used with TCP/IP, the
term refers to an IP gateway that routes data using IP
destination addresses.

Remote Procedure Call. A mechanism defined by Sun
Microsystems that provides a standard for initiating and
controlling processes on remote or distributed computer
systems.

A sequence of ASCII text lines stored in a file.
A computer that provides services to a network.

Simple Mail Transfer Protocol. A protocol used by mail
applications to send and retrieve electronic mail messages
from the Internet.

Simple Network Monitoring Protocol. A standard protocol
used to monitor network activity on "agent" nodes from
management stations.
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subnet A field used by routers and hosts for routing packages on the
network.

subnet address An extension for the IP addressing that allows a site to use a
single IP network address for multiple physical networks.

subnet mask Identifies the subnet field of a network address. The subnet
mask is a 32-bit Internet address written in dotted-decimal
notation with all the 1s in the network and subnet portions of
the address.

TCP/IP Transmission Control Protocol/Internet Protocol. TCP allows
a process on one machine to send data to a process on another
machine using the IP protocol. TCP can be used as a full
duplex or one-way simplex connection.

Telnet Provides virtual terminal services for a wide variety of remote
systems using the Telnet protocol. The application allows a
user at one site to interact with a remote system at another
site as if the user’s terminal were connected to the remote
machine.

terminal emulator A program that makes a PC screen and keyboard act like a
video display terminal of another computer.

TFTP Trivial File Transfer Protocol. A standard TCP/IP protocol
that allows simple file transfer to and from a remote system
without directory or file listing. TFTP is used where FTP is
not available.

token-ring A type of ring-shaped network that supports high-speed
communications between computers. A distinguishing
packet, called a "token," is transferred from machine to
machine. Only the machine that holds the token can transmit
the packet.

TSR Terminate-and Stay-Resident. A DOS program that is loaded
into memory before Windows and stays in memory until the
machine is rebooted.

userid A unique number, created by your system, that is associated
with each user name on a server system.

user name A character string, usually assigned by the system
administrator that identifies a user on the system.

utility A command or operation that works at the level of the
operating system.
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Weighted Fair
Queuing (WFQ)

VRML

ChameleonNFS feature that can guarantee bandwidth to
specified IP traffic. WFQ is particularly useful for
applications that require real-time performance capabilities
across routed networks. Applications for which WFQ is
useful include video-conferencing programs (such as
NetManage’s InPerson), video servers, internet telephony,
real-time simulations, and other performance critical
networking task software.

Virtual Reality Modeling Language. Uses a 3D rendering
engine to render the image progressively in pieces. Supports
the .GIF, .JPEG, .BMP, and SFImage file formats, as well as
extensions such as background color.
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Index

—3—

3270 Printer, 81
3278 printer, 55

—A—

Acrobat Reader, 210
activating NetManage applications, 21
adding addresses
to the InPerson address book, 202
adding applications
to NEWTToolbar, 273
adding groups
to the InPerson address book, 202
adding text, 205
additional online information
Archie, 241
FTP, 105
InPerson, 206
LPR/LPD, 113
NFS Utilities, 126
NISLookup, 308
additional online information, IRC, 251
additional online information, NEWT View,
254
Address Book, 151
adding InPerson addresses, 202
adding InPerson groups, 202
changing InPerson entries, 203
deleting InPerson entries, 204
InPerson, 201
Advanced Options
TN3270, 60
TN5250 Connections, 74
anonymous
username in FTP, 104
anonymous FTP hosts, 239
APA Graphics, 62
Appending Z-Mail® Pro, 144
applications
starting, 10
Archie, 239

default server, 239

retrieving information, 240

servers, 239

starting a search, 239
articles, listing and viewing, 235
AS400, 71
ASCII, 100, 106, 116, 118
ASCII Terminal, 27
ASCII-EBCDIC translation, 65
Assist menu

Visual Script Editor, 95
Associate command

3270 Printer, 85
Async connection type, 31
Asynchronous Communication Settings, 32
Asynchronous Connection Type, 31
attaching a signature, 156
Attachments, 146
Attachments, sending, 146
audio requirements

for InPerson, 197, 199
audio/video toolbar, 198

InPerson, 198
Auto Mode, 52
Auto Start option, 281
AUTOEXEC.BAT, 316
Automatic Internet, 267

Additional Online Information, 270
Autoreconnect, 62

—B—
baud rate, 41

BBS, 13, 27

binary, 100, 106, 116, 118
Bind, 285

BINDINGS, 317

bit-mapped graphics files, 253
bulletin board service, 27

—C—

caching documents, 213
Capture to File, 34
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carriage return, 39
cc:Mail, 177
Chameleon ATX for Windows, 1
changing
InPerson address book entries, 203
changing passwords in Mail, 157
Check Spelling, 148
clear signal
CICS, 68
clearing data
Telnet and ASCII Terminal, 37
closing
NEWTToolbar, 274
column order, changing, 12
column width, changing, 12
COM ports, 303
Command Class
VSE, 95
Command Description
VSE and VBA, 95
command line options
Telnet, 28
TN3270, 56
Command Profiles,, 297
communications parameters
ASCII Terminal, 53
compact mailbox, 166
completing draft message, 145, 146
Compuserve, 13
CONFIG.SYS file, 316
configuration files, 11
configuring the Personal Web Server, 220
Configuring your Communications Program
for Serial to Telnet, 304
Connect Options
TN3270, 57
Connecting to a Host
TN3270, 56
Connecting to a Modem Server, 302
connecting to IRC, 248
Connecting to the Internet, 270
connection profile, 92
Telnet and ASCII Terminal, 33
TN5250, 74
Connection Profile fields
TN3270, 59
TN5250, 75
connection types
ASCII Terminal, 27
Async, 27

Rlogin, 27
Control Mode, 52
controlling

printing, 109
conversing

in InPerson, 204
converting

files, 125
copy, 119
Copy and Paste functions, 35
copying messages to files, 144
create and send a fax, 159
creating a template, 145
creating and routing messages, 143
creating draft message, 145
creating Z-Mail® Pro messages, 137
customer support, 12, 15

—D—

Decrypting text, 140
default caching, 213
default print type, 111
Defense Data Network, 259
deleting
InPerson address book entries, 204
NetManage products
in Windows 3.1, 315
in Windows 95, 314
in Windows NT, 313
deleting phone messages, 185
deleting Z-Mail® Pro, 144
Detect, 43
Device name
TN3270, 61
Device Name command
3270 Printer, 85
Dial field, 31
dialing parameters, 42
dialog box fields, 11
Directory Server, 181
Disk list, 67
DLL, 1
Documents for the Web, 223
Domain Name Server (DNS), 285
downloading articles to local drive, 237
drawing
in InPerson, 205
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—E—

ECCO Setup option, 153
echo

local, 30
echo reply, 281
empty trash, 144
emulated printer buttons, 85
Encryption, 139
Eudora, 177
Exit on Disconnect, 62
exiting

NEWTToolbar, 274
expanded packets, 65
Extended Attributes, 61
Extended data stream, 61

— F—

Fax Network Settings, 133
Faxes, 158
File and Disk Replicator, 119
File Conversion, 67
file transfer options, 65
File Transfer Protocol (FTP), 97
files
converting, 125

manipulating, 125
file-transfer protocols

ASCII Terminal, 49
finding help, 9
Finger, 283
firewall

default, 102

defining, 102

for specific connections, 102
flow control, 41
folders, Trash, 144
font size

Program Symbol Graphics, 63
Forum, 231

NEWTToolbar button, 271
forwarding a memo, 185
forwarding Z-Mail® Pro, 141
FTP, 97, 119
FTP Server, 104
full-duplex mode, 199, 204

—G—

generate mailbox, 166
Go Intranet!
NEWTToolbar button, 271
Go IntraNet! feature, 2, 21
Gopher, 255
gopher bookmarks, 256
gopher servers, 256
Graphics, 62
graphics options
TN3270, 62
groups
InPerson, 202
GSM voice compression
InPerson support, 206

— H—

half-duplex mode, 204
hardware requirements
InPerson, 197, 198
history buffer, 35
scrolling, 36
size, 36
HLLAPI, 69, 74, 78
Hold button
printer, 85
Host
Talk, 244
TN3270, 57
Host File Format, 67
host name
Talk, 244
TN5250, 73
Hotlist, 214
hotspots, 64, 78
HTML, 141, 210, 219, 223
editing, 142
viewing, 141
HTML Editor, 213
HTML files, 213
Hyperlink, 226

IBM, 55

IBM 3270 keyboard, 64
IBM Office Vision, 71
ICMP, 281
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icon column —K—
Session Manager, 91

IDVI116 voice compression Key Mappings, 78
InPerson support, 206 Telnet, 37
IDVI8 voice compression TN3270, 64
InPerson support, 206
IMAP, 157 —L—
IMAP4 Network Settings, 131
In button LAN Manager., 316
InPerson, 199 launching WebSurfer, 20
INDS$FILE, 65 license violation, 12
Indexing Agent, 171 lights
inline image, 229 In, 199
InPerson, 197 Out, 200
adding address book entries, 202 line feed, 39
adding groups to address book, 202 line mode, 30
audio/video toolbar, 198 Line Printer Daemon (LPD) protocol, 107
changing address book entries, 203 Line Printer Daemon protocol, 107
conversing with other members, 204 Line Printer Remote protocdbeel PR
deleting address book entries, 204 list articles, 235
drawing on the whiteboard, 205 list box
hardware requirements, 197, 198 connection profile, 33
In button, 199 local user name, 31
inviting members, 200 login
member window, 198 trouble with, 70
menu bar, 198 Login Script, 47
Mute button, 199, 205 Logout Script, 47
Out button, 200 LPD, 107
Send Image button, 199 in Windows 3.1, 113
software requirements, 197, 198 in Windows 95, 113
Talk button, 199, 205 LPR, 107
toolbar, 198 printing to a file, 108
whiteboard, 198, 205 printing to network printer, 107
International character sets, 71 LPR query commands, 109
Internet Control Message Protocol (ICMP), LU name, 61
281
Internet Mail Network Settings, 130 — M—
Internet Relay Chat (IRC) description, 247
Internet Viewer description, 261 Mail Alias Viewer, 175
Internet Viewer Forum Mailbox Converter, 177
troubleshooting, 266 Mailbox Converter Troubleshooting, 180
Internet Viewer Forum News client, 262, mainframe address books, 163
265 Mainframe Mail Network Settings, 133
Internet Viewer Weather viewer, 262 member window, 198
Internet Viewer What's Hot Web page, 264 merge two mailboxes, 166
inviting Method
to an InPerson conference, 200 dialing, 42
IP address, 73 Model
Itelnet, 45 TN3270, 57
modem, 42
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model, 42
Modem Server application, 301
modems, 301
monochrome terminal emulation, 71
More button, 32

TN3270, 60
MultiLAN, 309
Mute button

InPerson, 199, 205

—N—

Name Resolver, 291

National Character Set, 39
NDIS, 315, 316

NETBIND.COM program, 316
NetWare IP, 2

Network Information Center, 259
Network Policy Management, 2

Network Policy Management Enforcer, 1

network printer, 82

Network Virtual Terminal (NVT) mode

TN3270, 56
newsgroups, subscribing, 234
NEWT, 282
NEWTCal, 191
deleting appointments, 194
modifying appointments, 194
responding to requests, 195
scheduling appointments, 192
setting preferences, 192
viewing, 191
NEWTNews, 231
NEWTSound, 253
NEWTToolbar
adding applications, 273
button menu, 272
exiting, 274
main menu, 271
modifying buttons, 273
starting, 271
starting applications from, 274
NEWTView, 253
NFS Utilities, 125
NIS domain name, 307
NIS map entries, 307
NIS map entry, 307
NIS server name, 308
NISLookup, 307
NRC replacement, 39

NVT mode, 30

—0O—

Offline option, 150
ONC RPC/XDR, 7
Out button
InPerson, 200
Outbox, 165
overriding default caching, 214
overview, 1

—p—

PC Net-Time, 287
Personal Web Server, 219
Phone Tag, 183
Ping, 169, 281
pinging, 281
POP, 127
port, 69
posting articles, 236
Postmaster, 135
Preparing your machine, 301
print

status, 109
print file, 88
Print Mode, 51
Printer application, 81
Printer Configurations, 82
printing

to a file, 108

to a remote network printer, 107
PROFS/OV, 177
PROFS/OV Transport Mail, 160
Program Symbol Graphics, 63
progress box, 67
Protocol Manager, 316
PROTOCOL.INI, 317

_Q_
Quiet, 67
quitting
NEWTToolbar, 274
Quote command
Archie, 241
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—R—
Rapid Search, 171

Rapid Search and Indexing Agent, 209

R-Commands, 293
rcp command, 294
RealAudio Player, 210
Redirecting COM Ports, 303
redirecting printing, 108
Redirection of COM Ports
removing, 304
registration card, 12
remote login, 31
remote user name, 31
removing
NetManage products
in Windows 3.1, 315
in Windows 95, 314
in Windows NT, 313
replication, 119
replying to Z-Mail® Pro, 141
Reset key, 70
Reset Size command
Telnet and ASCII Terminal, 52
Retries
dialing, 42
retrieve message header, 149
Retrieving Information
Archie, 240
RFC 1041, 55
RFC1647, 55
right mouse button, 278
Rlogin, 27
routing hubs, 30
Routing Slip feature, 142
RPC-SDK, 7
rsh command, 296
Rules, 154

—S—

Screen Mode, 51
script

definition, 93
Script Commands, 95
script components, 93
Script Types, 94
search mail, 150

security for the Personal Web Server, 221

Selecting COM Port Numbers

Serial to Telnet application, 304
selecting preferences, 185
Send Image button

InPerson, 199
sending draft message, 145, 146
sending Z-Mail® Pro messages, 137
serial number, 12
Serial Port Diagnostic, 43
Serial to Telnet

application, 303
server information box, IRC, 249
server preferences, IRC, 249
Session Manager, 91
session short name, 74
setting preferences, Forum, 237
setting up Z-Mail® Pro, 129
shared mailboxes, 158
Shockwave plug-in, 210
Smart Buttons, 11
Smart POP, 149
SMTP, 127, 168
Software Description Database, 240
software requirements

InPerson, 197, 198
sound file, 253
starting applications, 10
status

print job, 109
Status Bar, 11, 275
subscribing to newsgroups, 234
suggestions, 148
Support Wizard, 15
SYSTEM.INI, 316

.

Tag-It!

forwarding messages, 188

preferences, 189

sending messages, 187
Talk, 243

ending conversations, 245

exiting, 245
Talk button

InPerson, 199, 205
talking

in InPerson, 204
Technical Support, 15
Technical Support Wizard, 2
Telnet, 27
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keymappings, 37
NEWTToolbar button, 271
Telnet and ASCII Terminal
Troubleshooting, 52
Telnet Connection settings, 29
Telnet connection type, 29
terminal emulation
serial, 303
Terminal Emulators
viewing session status, 91
terminal types supported
Telnet and ASCII Terminal, 27
Text Editor, 213
Timeout, 65
dialing, 42
timing parameters, 157
Title, 62, 74
TN3270, 55
Advanced Options, 60
Connect Options, 57
connecting to a host, 56
Connection Profile fields, 59
Device name, 61
features, 55
graphics options, 62
keymappings, 64
More button, 60
transferring files:, 65
Troubleshooting, 69
TN3270 Connection Profile, 161
TN3270 Connection Type, 57
TN3270E, 61
TN3270E server, 85
TN3270E standard, 55
TN5250, 71
connection profile, 74
features, 71
TN5250 Connect Type
Advanced Options, 74
Connect Options, 73
Connection Profile, 75
Toolbar, 11
InPerson, 198
transfer program name, 65
Transferring Files
TN3270, 65
TN3270 options, 65
Translation Table, 65
Trash folder, 144
Trivial File Transfer Protocol (TFTP), 115

Troubleshooting
Automatic Internet, 270
Indexing Agent and Rapid Search, 173
script, 96
Telnet and ASCII Terminal, 52
TN3270, 69
TN5250, 79

troubleshooting, IRC, 251

TrueSpeech Player and Encoder, 210

—U—

Uniform Resource Locators, 210
Uninstaller, 314

in Windows NT, 313
UNIX, 177
UNIX commands, 293
updating draft message, 145, 146
URL, 210, 211, 212, 213
Usenet, 231
user preferences, IRC, 248
Using Automatic Internet, 267
uudecode, 147
uuencode, 147

—\V—

Verbose, 283
Verifying or Modifying Your Configuration,
269
video requirements
for InPerson, 197, 199
view a message, 140
viewing and saving file attachments, 147
viewing articles, 235
viewing phone messages, 185
viewing routed messages, 143
Virtual Desktop Manager, 275
virtual window, 275
visual script editor, 93
visual script player, 93
voice compression
InPerson support, 206
VRML viewer, 210

—\W—

Web, 219
setting up your own, 220
WebSpider, 142, 223
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NEWTToolbar button, 271
WebSurfer, 209, 210
activating, 20
NEWTToolbar button, 271
Plug-Ins, 215
Whatls, 240
whiteboard, 198, 205
Whols, 259
WIN.INI, 316
window display, 70
Telnet and ASCII Terminal, 52
Windows Terminal application, 303

7

Z-Mail, 177
ZMail Pro
NEWTToolbar button, 271
Z-Mail® Pro, 127
deleting, 144
replying to and forwarding, 141
signatures, 156
suggestions, 148
timing parameters, 157
TN3270 connection profile, 161
troubleshooting, 167
Z-Mail® Pro Administration, 166
Z-Mail® Pro command line, 155
Z-Mail® Pro setup, 129
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Reader's Comment Form

Chameleon ATX for All Windows® Platforms User's Guide, Version 6.0
Part No. 3000-60-0696

NetManage, Inc. welcomes your comments and suggestions on the quality and
usefulness of this publication. Your input is an important part of the information used
for revision.

« Did you find any errors?

» Is the information clearly presented ?

» Do you need more information? if so, where?

If you find any errors or have any suggestions for improvement, please indicate the
topic, chapter, and page number.

Please mail or fax your comments to:

Technical Publications, NetManage, Inc.

10725 N. De Anza Blvd., Cupertino, CA 95014, USA
Phone: (408) 973-7171 Fax: (408) 973-8272
e-mail: doc@netmanage.com

If you would like a reply, please give your name, company name, address, and telephone
number below. We are committed to responding promptly to your suggestions.

We are grateful for your assistance.
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